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IMPORTANT!
READ CAREFULLY BEFORE USE.

KEEP THIS GUIDE FOR FUTURE REFERENCE.

This is a User's Guide for a series of products. Not all products support all firmware features. Screenshots
and graphics in this book may differ slightly from your product due to differences in your product
firmware or your computer operating system. Every effort has been made to ensure that the information
in this manual is accurate.

Related Documentation
* Quick Start Guide
The Quick Start Guide shows how to connect the Switch.
¢ Online Help
Click the help link for a description of the fields in the Switch menus.
* Nebula Control Center (NCC) User's Guide

Go to nebula.zyxel.com or support.zyxel.com to get this User’'s Guide on how to configure the Switch
using Nebula.

* More Information
Go to https://businessforum.zyxel.com for product discussions.
Go to support.zyxel.com to find other information on the Switch.
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Document Conventions

Warnings and Notes

These are how warnings and notes are shown in this guide.

Warnings tell you about things that could harm you or your device.

Note: Notes tell you other important information (for example, other things you may need to
configure or helpful fips) or recommendations.

Syntax Conventions
* All models may be referred to as the “Switch” in this guide.
* Product labels, screen names, field labels and field choices are all in bold font.

¢ Aright angle bracket ( > ) within a screen name denotes a mouse click. For example, Basic Setting >
IP Setup > IP Configuration > Network Proxy Configuration means you first click Basic Setting in the

navigation panel, then the IP Setup sub menu, then IP Configuration and finally Network Proxy
Configuration fo get to that screen.

Icons Used in Figures

Figures in this user guide may use the following generic icons. The Switch icon is not an exact
representation of your device.

Switch Generic Router Wireless Router / Access Point

©

Generic Switch Smart TV Desktop

-"'\,_
@ A
IP Camera Printer

Server
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CHAPTER 1
Getting to Know Your Switch

1.1 Introduction

This chapter introduces the main features and applications of the Switch.
The XS1930 Series consists of the following models:

e XS1930-10
* XS$1930-12HP
* XS1930-12F

References to POE model in this User's Guide only apply to XS1930-12HP.

The Switch is a smart managed switch supporfing Multi-Gigabit ports. The Switch provides SFP+ slots for
uplink. By integrating stafic route functions, the Switch performs wire-speed layer-3 routing in addition to
layer-2 switching.

The Switch supports NebulaFlex for hybrid mode which can set the Switch to operate in either
standalone or Nebula cloud management mode. When the Switch is in standalone mode, it can be
configured and managed by the Web Configurator. When the Switch is in Nebula cloud management
mode, it can be managed and provisioned by the Zyxel Nebula Control Center (NCC).

The following table describes the hardware features of the Switch by model.

Table 1 XS1930 Series Model List

PORT DESCRIPTION XS1930-10 XS1930-12HP XS1930-12F
100M, 1G, 2.5G, 5G, and 10G RJ-45 Ethernet Ports 8 2 2
100M, 1G, 2.5G, 5G, and 10G PoE Ports No 8 No
1G, 10G SFP+ Interface 2 2 10
Total System Ports 10 12 12

1.1.1 Multi-Gigabit

A 10 Gigabit port supports speeds of 10G if the connected device supports 10G and a Cat éa (up to 100
m) or Cat 6 cable (up to 50 m) is used. The speed drops to 1G if these criteria are not met; it drops to
100M if a Cat 5 cable is used (up to 100 m).

If a network device such as a 5G network card, gaming computer, server, Network Attfached Storage
(NAS) or Access Point (AP) only supports 2.5 Gigabit or 5 Gigabit connectivity, then the maximum speed
potential of these devices is never reached.

In addition, at the time of writing, most existing cabling is Cat 5e or Cat 6, further limiting maximum
speed or distance potential.
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Multi-Gigabit (IEEE 802.3bz) solves these problems by additionally supporting 2.5 Gigabit and 5 Gigabit
Ethernet connections over Cat 5e and higher Ethernet cables. Multi-Gigabit ports are also backward
compatible with 100 Mbps and 1 Gigabit ports.

Figure 1 Multi-Gigabit Application

100 Mbps, 1 Gbps, 2.5 Gbps, 5 Gbps, 10 Gbps

SmartTV Desktop ~ Game Console

Server

See the following table for the cables required and distance limitation to attain the corresponding

speed.

Table 2 Cable Types
CABLE TRANSMISSION SPEED MAXIMUM DISTANCE | BANDWIDTH CAPACITY
Category 5 100M 100 m 100 MHz
Category 5e 1G/25G /5G 100 m 100 MHz
Category 6 5G /110G 50m 250 MHz
Category éa 10G 100 m 500 MHz
Category 7 10G 100 m 650 MHz

Note: Make sure to select the correct speed for the port in Basic Setting > Port Setup.

1.1.2 Management Modes

NebulaFlex means you can setf the Switch to operate in either standalone or cloud mode (but not both
at the same time).

Use the Web Configurator to configure and manage the Switch directly in standalone mode or use
Nebula Control Center (NCC) to configure and manage the Switch in cloud mode. The Nebula Control
Center (NCC) is an alternative cloud-based network management system that allows you to remotely
manage and monitor the Switch. You may also access a minimized version of the Web Configurator in
cloud mode.
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Nebula Cloud Management

To have Nebula manage the Switch, you must first register it at the Nebula web portal at https://
nebula.zyxel.com, and ensure that Nebula Control Center Discovery is enabled in Basic Setting > Cloud
Management > Nebula Control Center Discovery in the Switch Web Configurator.

Note: See the Switch’s datasheet for the feature differences between standalone and
Nebula cloud management modes. You can find the Switch's datasheet at the Zyxel
website.

See the NCC (Nebula Control Center) User's Guide for how to configure the Switch using Nebula.

1.1.3 Mode Changing

This section describes how to change the Switch’'s management mode.

Note: If you change the Switch's management mode from standalone mode to Nebula-
managed mode, the configuration settings of the Switch will be overwritten with what
you have configured in Nebula.

Note: If you change the Switch’'s management mode from Nebula-managed mode to
standalone mode, the Switch will reset to its factory-default settings.

From Standalone to Nebula Cloud Management

To manage your Switch through Nebula, connect the Switch to the Internet, and register it to a site and
organization at the Nebula web portal (https://nebula.zyxel.com).

See the following steps or the Switch Quick Start Guide for how to do device registration.

Go to the NCC to Register the Switch

1 Go to the Nebula web portal in one of three ways.

¢ Type https://nebula.zyxel.com in a supported web browser. See the Nebula User's Guide for more
information about supported browsers.

» Click Visit Nebula in the Switch's login page.
» Click the Nebula icon in the upper right of the Switch's Web Configurator.

2 Click Login in the Nebula web portal. Enter your myZyxel account information. You will be redirected to
another screen where you can sign up for a myZyxel account if you do not have one.

3 Create an organization and a site or select an existing site using the Nebula setup wizard.

4 Register the Switch by entering its MAC address and serial number and assign it to the site. The serial
number and MAC address can be found in the Status screen or the device back label on the Switch.

Use the Zyxel Nebula Mobile App to Register the Switch

1 Download and open the Zyxel Nebula Mobile app in your mobile device. Click Sign Up to create a
myZyxel account or enter your existing account information to log in.

2 Create an organization and site, or select an existing site using the Zyxel Nebula Mobile app.
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3 Select asite and scan the Switch's QR code to add it to the site. You can find the QR code:
¢ On alabel on the Switch or
¢ Onits box or

* In the Web Configurator at Basic > Cloud Management > Nebula Switch Registration.

See Section 3.3 on page 40 for more information about the CLOUD LED or Section 7.2 on page 78 for
more information about the Hybrid Mode field in the Status screen to see if the Switch goes into Nebula
cloud management mode successfully.

Note: The Switch goes into Nebula-managed mode automatically after it can access the
Nebula web portal and is successfully registered there. Its login password and settings
are then overwritten with what you have configured in the Nebula web portal.

From Nebula-managed to Standalone

To return to direct management standalone mode, just remove (unregister) the Switch from the
organization or site in the Nebula web portal. The Switch will reboot and restore the factory default
settings.

1.1.4 ZON Utility

With its built-in Web Configurator, including the Neighbor Management feature (Section 7.2.1 on page
80), viewing, managing and configuring the Switch and its neighboring devices is simplified.

In addition, Zyxel offers a proprietary software program called Zyxel One Network (ZON) Utility, it is a
utility tool that assists you to set up and maintain network devices in a more simple and efficient way.
You can download the ZON Utility at www.zyxel.com and install it on a PC (Windows operation system).
For more information on ZON Utility see Section 4.3 on page 48.

1.1.5 PoE

The Switch is a Power Sourcing Equipment (PSE) because it provides a source of power through its
Ethernet ports. Each device that receives power through an Ethernet port is a Powered Device (PD).

The Switch can adjust the power supplied to each PD according to the PoE standard the PD supports.
PoE standards are:

» |EEE 802.3af Power over Ethernet (PoE)
» |EEE 802.3at Power over Ethernet (PoE) +
» |EEE 802.3bt Power over Ethernet (POE) ++

The following table describes the PoE features of the Switch by model.

Table 3 XS1930 Series Model and PoE Features

PoE FEATURES XS1930-12HP
|IEEE 802.3af PoE Yes
|IEEE 802.3at PoE+ Yes
|EEE 802.3bt PoE++ Yes
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Table 3 XS1930 Series Model and PoE Features (continued)

PoE FEATURES XS1930-12HP
Power Management Mode | Consumption mode (default) / Classification mode
PoE Power Budget 375W

Table 4 PoE Standards
PoE FEATURES PoE POE+ POE++
IEEE Standard IEEE 802.3af IEEE 802.3at IEEE 802.3bt
POE Type Type 1 Type 2 Type 3
Switch Port Power
Maximum Power Per Port 154 W 30W 60 W
Port Voltage Range 44 -57 V 50-57V 50-57V
Cables
Twisted Pairs Used 2-pair 2-pair 4-pair
Supported Cables Cat3 or better Cats or better Catb or better

1.2 Example Applications

This section shows a few examples of using the Switch in various network environments. Note that the
Switch in the figure is just an example Switch and not your actual Switch.

1.2.1 PoE Example Application

The following example figure shows a Switch supplying POE (Power over Ethernet) to Powered Devices
(PDs) such as an IP camera, a wireless router, an IP telephone and a general outdoor router that are not
within reach of a power outlet.

XS1930 Series User's Guide

24



Chapter 1 Getting to Know Your Switch

Figure 2 PoE Example Application

) O

1.2.2 Backbone Example Application

The Switch is an ideal solution for small networks where rapid growth can be expected in the near future.
The Switch can be used standalone for a group of heavy fraffic users. You can connect computers and
servers directly o the Switch's port or connect other switches to the Switch.

In this example, all computers can share high-speed applications on the server. To expand the network,
simply add more networking devices such as switches, routers, computers, print servers, and so on.

Figure 3 Backbone Application
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1.2.3 Bridging or Fiber Uplink Example Application

In this example, the Switch connects different company departments (RD and Sales) to the corporate
backbone. It can alleviate bandwidth contention and eliminate server and network bottlenecks. All
users that need high bandwidth can connect to high-speed department servers through the Switch.
You can provide a super-fast uplink connection by using a Gigabit Ethernet or SFP port on the Switch.

Moreover, the Switch eases supervision and maintenance by allowing network managers to centralize
multiple servers at a single location.

Figure 4 Bridging or Fiber Uplink Example Application

Fiber
—— Ethernet

1.2.4 High Performance Switching Example

The Switch isideal for connecting two networks that need high bandwidth. In the following example, use
link aggregation (trunking) fo connect these two networks.

Switching to higher-speed LANs such as ATM (Asynchronous Transmission Mode) is not feasible for most
people due to the expense of replacing all existing Ethernet cables and adapter cards, restructuring
your network and complex maintenance. The Switch can provide the same bandwidth as ATM at much
lower cost while still being able to use existing adapters and switches. Moreover, the current LAN
structure can be retained as all ports can freely communicate with each other.

This helps you switch to higher-speed LANs without the need for replacing all existing Ethernet cables
and adapter cards, restructuring your network and complex maintenance.
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Figure 5 High Performance Switched Workgroup Application

Trunk

1.2.5 IEEE 802.1Q VLAN Application Examples

A VLAN (Virtual Local Area Network) allows a physical network to be partitioned info multiple logical
networks. Stations on a logical network belong to one or more groups. With VLAN, a station cannot
directly talk to or hear from stations that are not in the same groups unless such traffic first goes through
a router.

1.2.5.1 Tag-based VLAN Example
Ports in the same VLAN group share the same frame broadcast domain thereby increase network
performance through reduced broadcast traffic. VLAN groups can be modified at any time by adding,
moving or changing ports without any re-cabling.
Shared resources such as a server can be used by all ports in the same VLAN as the server. In the
following figure only ports that need access to the server need to be part of VLAN 1. Ports can belong to

other VLAN groups too.

Figure 6 Shared Server Using VLAN Example

VLAN 1

1.3 Ways to Manage the Switch

Use any of the following methods to manage the Switch.

* NCC (Zyxel Nebula Confrol Center). With the NCC, you can remotely manage and monitor the
Switch through a cloud-based network management system. See the NCC User’s Guide for detailed
information about how to access the NCC and manage your Switch through the NCC. See the NCC
User's Guide for how to configure Nebula managed devices.
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* Web Configurator. This is recommended for everyday management of the Switch using a (supported)
web browser. See Chapter 4 on page 44.

¢ FTP. Use File Transfer Protocol for firmware upgrades and configuration backup or restore. See Section
37.8.1 on page 304.

* SNMP. The Switch can be monitored and/or managed by an SNMP manager. See Section 38.8.1 on
page 318.

¢ Cluster Management. Cluster Management allows you to manage multiple switches through one
switch, called the cluster manager. See Chapter 42 on page 336.

» ZON Utility. ZON Utility is a program designed to help you deploy and perform inifial setup on a
network more efficiently. See Section 4.3 on page 48.

1.4 Good Habits for Managing the Switch

Do the following regularly to make the Switch more secure and to manage the Switch more effectively.

¢ Change the password. Use a password that is not easy to guess and that consists of different types of
characters, such as numbers and letters.

¢ Write down the password and put it in a safe place.

* Back up the configuration (and make sure you know how to restore it). Restoring an earlier working
configuration may be useful if the device becomes unstable or even crashes. If you forget your
password, you will have to reset the Switch to its factory default settings. If you backed up an earlier
configuration file, you would not have to totally re-configure the Switch. You could simply restore your
last configuration.
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Hardware Installation and
Connection

2.1 Installation Scenarios

This chapter shows you how to install and connect the Switch.

The Switch can be:

Placed on a desktop.

Rack-mounted on a standard EIA rack.

2.2 Safety Precautions

Please observe the following before using the Switch:

It is recommended to ask an authorized technician to attach the Switch on a desk or to the rack or
wall. Use the proper screws to prevent damage to the Switch. See the Installation Requirements
sections in this chapter to know the types of screws and screwdrivers for each mounting method.

Make sure there is at least 2 cm of clearance on the top and bottom of the Switch, and at least 5 cm
of clearance on all four sides of the Switch. This allows air circulation for cooling.

Do NOT block the ventilation holes nor store cables or power cords on the Switch. Allow clearance for
the ventilation holes to prevent your Switch from overheating. This is especially crucial when your
Switch does not have fans. Overheating could affect the performance of your Switch, or even
damage it.

The surface of the Switch could be hot when it is functioning. Do NOT put your hands on if. You may
get burned. This could happen especially when you are using a fanless Switch.

The Switches with fans are not suitable for use in locations where children are likely to be present.

To start using the Switch, simply connect the power cables to turn it on.

2.3 Desktop Installation Procedure

1

2

Make sure the Switch is clean and dry.

Remove the adhesive backing from the rubber feet.
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3 Aftach the rubber feet to each corner on the bottom of the Switch. These rubber feet help protect the
Switch from shock or vibration and ensure space between devices when stacking.

Figure 7 Attaching Rubber Feet

4 Setthe Switch on a smooth, level surface strong enough to support the weight of the Switch and the
connected cables. Make sure there is a power outlet nearby.

Cautions:
* Avoid stacking fanless Switches to prevent overheating.
¢ Ensure enough clearance around the Switch to allow air circulation for cooling.

¢ Do NOT remove the rubber feet as it provides space for air circulation.

2.4 Mounting the Switch on a Rack

The Switch can be mounted on an EIA standard size, 19-inch rack or in a wiring closet with other

equipment. Follow the steps below to mount your Switch on a standard EIA rack using a rack-mounting
kit.

Note: Make sure there is enough clearance between each equipment on the rack for air
circulation.

2.4.1 Installation Requirements

* Two mounting brackets.
¢ Eight M3 flat head screws and a #2 Philips screwdriver.

¢ Four M5 flat head screws and a #2 Philips screwdriver.

2.4.2 Precautions

* Make sure the rack will safely support the combined weight of all the equipment it contains. The
maximum weight a bracket can hold is 21.5 kg.

* Make sure the position of the Switch does not make the rack unstable or fop-heavy. Take all
necessary precautions fo anchor the rack securely before installing the unit.
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2.4.3 Attaching the Mounting Brackets to the Switch

1 Position a mounting bracket on one side of the Switch, lining up the four screw holes on the bracket with
the screw holes on the side of the Switch.

Figure 8 Aftaching the Mounting Brackets

2 Using a #2 Philips screwdriver, install the M3 flat head screws through the mounting bracket holes into
the Switch.

3 Repeatsteps 1 and 2 to install the second mounting bracket on the other side of the Switch.

4 You may now mount the Switch on a rack. Proceed to the next section.

2.4.4 Mounting the Switch on a Rack

1 Position a mounting bracket (that is already attached to the Switch) on one side of the rack, lining up
the two screw holes on the bracket with the screw holes on the side of the rack.

Figure 9 Mounting the Switch on a Rack
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2 Using a #2 Philips screwdriver, install the M5 flat head screws through the mounting bracket holes into
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the rack.

Note: Make sure you tighten all the four screws to prevent the Switch from getting slanted.

3 Repeatsteps 1 and 2 to aftach the second mounting bracket on the other side of the rack.
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CHAPTER 3
Hardware Panels

This chapter describes the front panel and rear panel of the Switch and shows you how to make the
hardware connections.

3.1 Front Panel Connections

The following figures show the front panels of the Switch.

Figure 10 Front Panel: XS1930-10
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The following table describes the ports.

Table 5 Front Panel Connections

CONNECTOR

DESCRIPTION

and 10G RJ-45
Ethernet Ports

100M, 1G, 2.5G, 5G,

These are 10GBase-T auto-negotiating and auto-crossover Ethernet ports.

Connect these ports to a notebook computer, a gaming computer, a NAS (network-
attached storage), a server, a workstation, a WiFi 6 (802.11ax) router, a WiFi 6 (802.11ax) AP
(Access Point), or an Ethernet switch.

and 10G RJ-45 PoE
Ports

100M, 1G, 2.5G, 5G,

These are 10GBase-T auto-negotiating and auto-crossover Ethernet ports.

Connect these ports to a PTZ (pan, filt and zoom) camera, a WiFi 6 (802.11ax) router, a WiFi 6
(802.11ax) AP, or an Ethernet switch.

1G, 10G SFP+ Slots

Use SFP+ transceivers in these ports for high-bandwidth backbone connections. You can
also insert an SFP+ Direct Attach Copper (DAC) in the SFP+ slof.
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Table 5 Front Panel Connections (continued)

CONNECTOR DESCRIPTION

Reset Press the RESET button to reboot the Switch without turning the power off. See Section 3.3 on
page 40 for more information about the LED behavior.

Restore Press the RESTORE button for 3 to 6 seconds to have the Switch automatically reboot and
restore the last-saved custom default file. See Section 3.3 on page 40 for more information
about the LED behavior.

Press the RESTORE button for more than 7 seconds to have the Switch automatically reboot
and restore the factory default file. See Section 3.3 on page 40 for more information about
the LED behavior.

3.1.1 Gigabit Ethernet Ports

The Switch has 10GBase-T auto-negotiating, auto-crossover Ethernet ports. In Multi-Gigabit Ethernet, the
speed can be 100M, 1G, 2.5G, 5G, or 10G. The duplex mode can be full duplex only.

An auto-negotiating port can detect and adjust to the optimum Ethernet speed (100M, 1G, 2.5G, 5G,
and 10G) and full duplex mode of the connected device.

An auto-crossover (auto-MDI/MDI-X) port automatically works with a straight-through or crossover
Ethernet cable.

When auto-negotiation is turned on, an Ethernet port negotiates with the peer automatically to
determine the connection speed and duplex mode. If the peer Ethernet port does not support auto-
negotiation or turns off this feature, the Switch determines the connection speed by detecting the signal
on the cable and using half duplex mode. When the Switch's auto-negotiation is turned off, an Ethernet
port uses the pre-configured speed and duplex mode when making a connection, thereby requiring
you to make sure that the settings of the peer Ethernet port are the same in order to connect.

3.1.1.1 Default Ethernet Negotiation Settings
The factory default negotiation settings for the Gigabit ports on the Switch are:

* Speed: Auto
* Duplex: Auto
¢ Flow control: Off

* Link Aggregation: Disabled

3.1.1.2 Auto-crossover

All ports support auto-crossover, that is auto-MDIX ports (Media Dependent Interface Crossover), so you
may use either a straight-through Ethernet cable or crossover Ethernet cable for all Gigabit port
connections. Auto-crossover ports automatically sense whether they need to function as crossover or
straight ports, so crossover cables can connect both computers and switches or hubs.

3.1.2 PoE (XS1930-12HP)

The Switch supports the IEEE 802.3af Power over Ethernet (PoE), IEEE 802.3af Power over Ethernet (PoE)
plus and IEEE 802.3bt Power over Ethernet (PoE) plus plus standards. The Switch is a Power Sourcing
Equipment (PSE) because it provides a source of power through its Ethernet ports. Each device that
receives power through an Ethernet port is a Powered Device (PD).
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3.1.3 SFP Slots

The fransceiver slotfs are for Small Form-Factor Pluggable (SFP), SFP+ transceivers or DAC (Direct Aftach
Copper) cables. The SFP+ (SFP Plus) and the DAC cable are enhanced versions of the SFP and support
data rates of up to 10G. A fransceiver is a single unit that houses a transmitter and a receiver. Use a
fransceiver or a DAC cable to connect a fiber cable to the Switch. The Switch does not come with
fransceivers nor DAC cables. You must use tfransceivers or DAC cables that comply with the Small Form-
factor Pluggable (SFP) Transceiver MultiSource Agreement (MSA). See the SFF committee’s INF-8074i
specification Rev 1.0 for details.

You can change fransceivers or the DAC cables while the Switch is operating. You can use different
fransceivers fo connect to Ethernet switches with different types of fiber connectors.

e Type: SFP or SFP+ connection interface

¢ Connection speed: 1 or 10 Gigabit per second (Gbps)

WARNING! To avoid possible eye injury, do not look into an operating
fiber module’s connectors.

HANDLING! All transceivers are static sensitive. To prevent damage from
electrostatic discharge (ESD), it is recommended you attach an ESD
preventive wrist strap to your wrist and to a bare metal surface when
you install or remove a transceiver.

STORAGE! All modules are dust sensitive. When not in use, always keep
the dust plug on. Avoid getting dust and other contaminant into the
optical bores, as the optics do not work correctly when obstructed with
dust.

3.1.3.1 Transceiver Installation

Use the following steps to install a tfransceiver.

1 Attach an ESD preventive wrist strap to your wrist and to a bare metal surface.
2 Align the fransceiver in front of the slot opening.

3 Make sure the latch is in the lock position (latch styles vary), then insert the transceiver into the slot with
the exposed section of PCB board facing down.

4 Press the transceiver firmly until it clicks into place.

5 The Switch automatically detects the installed fransceiver. Check the LEDs to verify that it is functioning
properly.

6 Remove the dust plugs from the transceiver and cables (dust plug styles vary).

7 Identify the signal fransmission direction of the fiber cables and the transceiver. Insert the fiber cable into
the fransceiver.
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Figure 13 Latch in the Lock Position

3.1.3.2 Transceiver Removal

Use the following steps to remove an SFP fransceiver.

1 Aftach an ESD preventive wrist strap to your wrist and to a bare metal surface on the chassis.
2 Remove the fiber cables from the tfransceiver.

3 Pull out the latch and down o unlock the fransceiver (latch styles vary).

Note: Make sure the fransceiver’s latch is pushed all the way down, so the transceiver can be
pulled out successfully.

4 Pullthe latch, or use your thumb and index finger to grasp the tabs on both sides of the fransceiver, and
carefully slide it out of the slot.

Note: Do NOT pull the transceiver out by force. You could damage it. If the transceiver will not
slide out, grasp the tabs on both sides of the transceiver with a slight up or down motion
and carefully slide it out of the slot. If unsuccessful, contact Zyxel Support to prevent
damage to your Switch and transceiver.

5 Insert the dust plug into the ports on the transceiver and the cables.

Figure 16 Removing the Fiber Cables
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Figure 17 Opening the Transceiver's Latch Example
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Figure 18 Transceiver Removal Example

3.2 Rear Panel

The following figures show the rear panels of the Switch. The rear panels contain:

Figure 19 Rear Panel: XS1930-10

3.2.1 Grounding

Grounding is a safety measure to direct excess electric charge to the ground. It prevents damage to
the Switch, and protects you from electrocution. Use the grounding screw on the rear panel and the
ground wire of the AC power supply to ground the Switch.

The grounding terminal and AC power ground where you install the Switch must follow your country's
regulations. Qualified service personnel must ensure the building’s protective earthing terminals are
valid terminals.

Installation of Ethernet cables must be separate from AC power lines. To avoid electric surge and
electromagnetic interference, use a different electrical conduit or raceway (tube/trough or enclosed
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conduit for protecting electric wiring) that is 15 cm apart, or as specified by your country’s electrical
regulations.

Any device that is located outdoors and connected to this product must be properly grounded and
surge protected. To the extent permissible by your country’s applicable law, failure to follow these
guidelines could result in damage fo your Switch which may not be covered by its warranty.

Note: The specification for surge or ESD protection assumes that the Switch is properly
grounded.

Remove the M4 ground screw from the Switch's rear panel.

Secure a green or yellow ground cable (16 AWG or smaller) to the Switch's rear panel using the M4
ground screw.

Figure 22 Grounding

&

Attach the other end of the ground cable to a grounding bar located on the rack where you install the
Switch or to an on-site grounding ferminal.

Figure 23 Attach Ground Cable to Grounding Bar or On-site Grounding Terminal

The grounding terminal of the server rack or on-site grounding terminal must also be grounded and
connected to the building’s main grounding electrode. Make sure the grounding terminal is connected
to the buildings grounding electrode and has an earth resistance of less than 10 ohms, or according to
your country’s electrical regulations.
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Figure 24 Connecting to the Building’s Main Grounding Electrode
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If you are uncertain that suitable grounding is available, contact the appropriate electrical inspection
authority or an electrician.

This device must be grounded. Do this before you make other
connections.

3.2.2 AC Power Connection

Note: Make sure you are using the correct power source as shown on the panel and that no
objects obstruct the airflow of the fans (located on the side of the unit).

To connect power to the Switch, insert the female end of the power cord to the AC power receptacle
on the rear panel. Connect the other end of the supplied power cord to a power outlet.
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3.3 LEDs

After you connect the power to the Switch, view the LEDs to ensure proper functioning of the Switch
and as an aid in troubleshooting.

Table 6 LED Descriptions

LED COLOR STATUS DESCRIPTION
PWR Green On The Switch is receiving power from the power source.
Blinking The Switch is returning fo the custom default configuration
settings.
Amber On The Switch is returning to its factory default configuration
settings.
Off The Switch is not receiving power from the power source.
SYS Green On The Switch is on and functioning properly.
Blinking The Switch is rebooting and performing self-diagnostic tests.
Red On The Switch is functioning abnormally.
Off The power is off or the Switch is not ready/malfunctioning.
CLOUD Green On The Switch is managed by the NCC (Nebula Control Center).
Blinking The Switch is connected fo the NCC, but not registered.
Amber On The Switch is in Nebula cloud management mode. It was trying
to connect to the NCC, but failed.
Blinking The Switch is in standalone mode. It was trying to connect to
the NCC, but failed.
Off Nebula cloud management mode is disabled.
LOCATOR Blue On The Switch is uploading firmware. While the Switch is doing this,

do not turn off the power.

Blinking Shows the actual location of the Switch between several
devices in a rack. The default timer is 30 minutes when you are
configuring the Switch.

Off The locator is not functioning or malfunctioning.
PoE MAX Green On Each bar represents 20% of PoE Power consumption.
(XS1930-12HP) (Barl — Bar3) Bar 1: PoE power usage is below 20 percent of the power

supplied budget.
Barl is the bar at PP °

the bottom; bar Bar 2: PoE power usage is below 40 percent of the power
5is the bar at supplied budget, but over 20 percent of the power supplied
the top. budget.

Bar 3: POE power usage is below 60 percent of the power
supplied budget, but over 40 percent of the power supplied

budget.
Yellow On PoE power usage is below 80 percent of the power supplied
(Bar4) budget, but over 60 percent of the power supplied budget.
ar.
Red On PoE power usage is more than 80 percent of the power
supplied budget.
(Bar5) PP o

Blinking Less than 5 percent of the power supplied budget remains. 5
percent is the default value.

Off PoE power usage is 0 percent of the power supplied budget.

10GBase-T Ports
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Table 6 LED Descriptions (confinued)

LED COLOR STATUS DESCRIPTION
LNK/ACT Blue On The link to a 10G Ethernet network is up.
1-8 (XS1930-10) Blinking The Switch is transmitting/receiving to/from a 10G Ethernet
network.
9 —10 (XS1930-
12HP) ( Purple On The link fo a 5G Ethernet network is up.
Blinkin The Switch is transmitting/receiving to/from a 5G Ethernet
11 =12 (XS1930- InKIng wien ! ftfing/receiving fo/
network.
12F)
Sky Blue On The link to a 2.5G Ethernet network is up.
Blinking The Switch is tfransmitting/receiving to/from a 2.5G Ethernet
network.
Green On The link to a 1000M Ethernet network is up.
Blinking The Switch is transmitting/receiving to/from a 1000M Ethernet
network.
Amber On The link to a 100M Ethernet network is up.
Blinking The Switch is fransmitting/receiving to/from a 100M Ethernet
network.
Off The link to an Ethernet network is down.
PoE 10GBase-T Ports
LNK/ACT Blue On The link fo a 10G Ethernet network is up.
1 -8 (XS$1930- Blinking The Switch is fransmitting/receiving to/from a 10G Ethernet
12HP) network.
Purple On The link fo a 5G Ethernet network is up.
Blinking The Switch is fransmitting/receiving to/from a 5G Ethernet
network.
Sky Blue On The link to a 2.5G Ethernet network is up.
Blinking The Switch is fransmitting/receiving to/from a 2.5G Ethernet
network.
Green On The link to a 1000M Ethernet network is up.
Blinking The Switch is fransmitting/receiving to/from a 1000M Ethernet
network.
Amber On The link to a 100M Ethernet network is up.
Blinking The Switch is fransmitting/receiving to/from a 100M Ethernet
network.
Off The link to an Ethernet network is down.
PoE Mode Blue Oon Power supplied to all POE Ethernet ports meets the IEEE 802.3bt
standard.
1 -8 (XS1930-
12HP) Green On Power supplied to all POE Ethernet ports meets the IEEE 802.3at
standard.
Yellow On Power supplied to all PoE Ethernet ports meets the IEEE 802.3af
standard.
Off There is no power supplied.

1G/10G SFP+ Slots

XS1930 Series User's Guide

41




Chapter 3 Hardware Panels

Table 6 LED Descriptions (confinued)

LED COLOR STATUS DESCRIPTION
LNK/ACT Green On The port has a successful 1000M connection.
910 (XS1930- Blinking The port is transmitting or receiving data at T000M.
10) Blue On The port has a successful 10G connection.
1112 (XS1930- Blinking The port is fransmitting or receiving data at 10G.
12HP

) Off This link is disconnected.
1-10 (XS1930-
12F
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CHAPTER 4
Web Configurator

4.1 Overview

This section infroduces the configuration and functions of the Web Configurator.

The Web Configurator is an HTML-based management interface that allows easy system setup and
management through Internet browser. Use a browser that supports HTMLS5, such as Microsoft Edge,
Internet Explorer 11, Mozilla Firefox, or Google Chrome. The recommended minimum screen resolution is
1024 by 768 pixels.

In order to use the Web Configurator you need to allow:

e Web browser pop-up windows on your computer.
» JavaScript (enabled by default).

e Java permissions (enabled by default).

4.2 System Login

1  Start your web browser.

2 The Switchis a DHCP client by default. Type “http://DHCP-assigned IP" in the Location or Address field.
Press [ENTER].

Also, you can use the ZON Ufility to check your Switch’s IP address. See Section 4.3 on page 48 for more
information on the ZON ufility.

3 The following screen appears.
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Figure 25 Web Configurator: Login

ZYXEL
X$1930-12HP
Enter User Name/Password and click to login.
@ admin
@ e
Login
\‘1 . -
-"\ Manage Your Network with the Freedom of Cloud. 5 * 7
nebula [vannesia | /47

Click Login fo log into the Web Configurator to manage the Switch directly. The default user name is
admin and associated default password is 1234.

The Setup Wizard screen will appear. You can use the Setup Wizard screen to configure the Switch’s IP,
login password, SNMP community, link aggregation, and view a summary of the settings. When you finish
configuring the settings, you can click the Apply & Save button to make the settings take effect, and
save your configuration info the Switch's non-volatile memory at once. Check the screens fo see if the
settings are applied.

Otherwise, click the Exit button. You can select the Ignore this wizard next time check box and click
Apply & Save if you do not want the Setup Wizard screen to appear the next time you log in. If you want
to open the Setup Wizard screen later, click the Wizard icon in the upper right hand corner of the Web
Configurator.
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Figure 26 Web Configurator: Wizard

Setup Wizard

® Wizard will overwrite the existing configuration.
® |{ is recommended fo change password and SNMFP community string to avoeid potential security breach.

® Wizard can be terminated at any fime.

Protection .

Ignere this wizard next time
Apply & Save

If you did not change the default administrator password and/or SNMP community values, a warning
screen displays each time you log into the Web Configurator and select Standard Mode. Click Password
/ SNMP to open a screen where you can change the administrator password and SNMP community
string simultaneously. Otherwise, click Ignore to close it.

Password/SNMP Setting

Figure 27 Web Configurator: Warning
Message Center b4

Warning:

1. As a security precaution, it is highly recommended that you should
change the admin possword.

2. The SMMP community is used for SMMP management and is set to public
by default. To avoid secunty breach, please change the community string
to a value other than defoult setting.

Configure Password [ SNMP  setting
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Figure 28 Web Configurator: Password

Adminstrator

Old Password
MNew Password

Retype to confirm

General Setting

Version
Get Community
Set Community

Trap Community

V2T ~

public

public

public

Change the default administrator and/or SNMP passwords, and then click Apply to save your changes.

Table 7 Web Configurator: Password/SNMP

LABEL

DESCRIPTION

Administrator

This is the default administrator account with the "admin” user name. You cannot change the default administrator

user name.

Old Password

Enter the existing system password (1234 is the default password when shipped).

New Password

Enter your new system password. Up to 32 characters are allowed for the new password
except[2 [ [].['].["] [space]. or[,].

Retype to confirm

Re-enter your new system password for confirmation.

General Setting

Use this section to specify the SNMP version and community (password) values.

Version

Select the SNMP version for the Switch. The SNMP version on the Switch must match the version
on the SNMP manager. Choose SNMP version 2c (v2c), SNMP version 3 (v3) or both (v3v2c).

Note: SNMP version 2c is backwards compatible with SNMP version 1.

Get Community

Enter the Get Community string, which is the password for the incoming Get- and GetNext-
requests from the management station.

The Get Community string is only used by SNMP managers using SNMP version 2c or lower.

Set Community

Enter the Set Community string, which is the password for the incoming Set- requests from the
management station.

The Set Community string is only used by SNMP managers using SNMP version 2c or lower.

Trap Community

Enter the Trap Community string, which is the password sent with each frap to the SNMP
manager.

The Trap Community string is only used by SNMP managers using SNMP version 2c or lower.

Apply Click Apply to save your changes fo the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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4.3 Zyxel One Network (ZON) Utility

ZON Utility is a program designed to help you deploy and manage a network more efficiently. It detects
devices automatically and allows you to do basic settings on devices in the network without having to
be nearit.

The ZON Utility issues requests through Zyxel Discovery Protocol (ZDP) and in response to the query, the
device responds back with basic information including IP address, firmware version, location, system
and model name in the same broadcast domain. The information is then displayed in the ZON Ufility
screen and you can perform tasks like basic configuration of the devices and batch firmware upgrade
in it. You can download the ZON Utility at www.zyxel.com and install it in a computer (Windows
operating system).

4.3.1 Requirements

Before installing the ZON Ufility in your computer, please make sure it meefts the requirements listed
below.

Operating System
At the fime of writing, the ZON Utility is compatible with:

¢ Windows 7 (both 32-bit / 64-bit versions)
* Windows 8 (both 32-bit / 64-bit versions)
¢ Windows 8.1 (both 32-bit / 64-bit versions)
¢ Windows 10 (both 32-bit / 64-bit versions)

Note: To check for your Windows operating system version, right-click on My Computer >
Properties. You should see this information in the General tab.

Hardware
Here are the minimum hardware requirements to use the ZON Utility on your computer.

e Core i3 processor

* 2GBRAM

* 100 MB free hard disk

* WXGA (Wide XGA 1280 by 800)

4.3.2 Run the ZON Utility

1 Double-click the ZON Utility to run it.

2 The first time you run the ZON Utility, you will see if your device and firmware version support the ZON
Utility. Click the OK button fo close this screen.
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Figure 29 Supported Devices and Versions

ﬂ Supported model and firmware version *

Please refer to the table to ensure your device firmware is supporting the ZOM utility.

From V4.60
3800 series A
* XS3800-28: ABML.O

From V4.10

G52210-8: AASP.0
G52210-8HPF: AASQLOD
G52210-24: AAND .2
G52210-24HP: AANE. 2
G52210-48: AAHV. 2
GE2210-48HP: AAHW. 2

2210 series

From V4.50

1930 series & X(G51930-28: ABHT.0
* XGS51930-28HF: ABHS.0
* XGS51930-52: ABHU.O
& XGS1930-52HF: ABHV.0

From V4.20
Switch * XS1920-12: AASR.O
From V4.10

G51920-24: AMOB. 2

G51920-24HP: AADC. 2
GE1920-48: AANZ. 2 v
G51920-48HP: AADA 2

Cramn WA BN

1920 series

If you want to check the supported models and firmware versions later, you can click the Show
information about ZON icon in the upper right of the screen. Then select the Supported model and
firmware version link. If your device is not listed here, see the device release notes for ZON Utility support.
The release notes are in the firmware zip file on the Zyxel web site.

Figure 30 ZON Utility Screen

B 7yxel One Network Utility — m} #

—~TN

® O @ Cd P l;@}) zAC (@) ) 3

Type Model Firmware Ver... | MAC Address IP Address | System Name Location status
B xsaroo-24 V4,30(AASS.0)... AC-E4-CB-83-4.. 192.168.1.1 12A_08

ﬁ X33700-24 V4.30[AASS.D)... E4-18-6B-F7-A7... 192.168.1.1 11A_01 HQ2_R101
k XGS3700-48 V4.30(AAGE.1)... E4-18-6B-F7-BA... 192.168.1.1 12A3_84 R102

B xcsaroo4s V4.30(AAGE.1)... E4-18-6B-F7-BA... 0.0.0.0 11A03_66 R101_A3-66
ﬁ XG33700-48 V4,30(AAGE.1)... E4-18-6B-F7-BA... 192.168.1.1 12A2_83 R102

k XGS3700-48 V4.30(AAGE.1)... E4-18-6B-F7-BB-... 192.168.1.1 12A1_82 R102

ﬁ XGS3700-48 V4.30(AAGE.1)... E4-18-6B-F7-B9-... 192.168.1.1 12A4_85 R102

B xcGsaroo-48 V4,30(AAGE.1)... E4-18-6B-F7-BA... 192.168.1.1 11A01_64 R101

ﬁ XGS3700-48 V4.30[AAGE.1)... E4-18-6B-F7-C1... 192.168.1.1 11A02_65 R101

& G51350-6HP V4.70[ABPLO)b... BC-CF-4F-47-7... 172.21.40.3 G51350
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3 Select a network adapter to which your supported devices are connected.
Figure 31 Network Adapter

ZYXEL

Welcome to ZON utility.

This initial setup will help you to select a network adapter and
discover all devices in the fisrt time.

Please choose the interface for discovering devices on the
connected network and click 'Go' button to discover devices.

MNetwork Adapter

Realtek PCle GBE Family Controlle

4 Click the Go button for the ZON Utility to discover all supported devices in your network.

Figure 32 Discovery
[ Discovery *

Discovery progress

5 The ZON Utility screen shows the devices discovered.
Figure 33 ZON Utility Screen

n Zywel One Network Utility

—T

(wocme )
\ ’

Firmware Ver... | MAC Address IP Address | System Name Location

Em  xsar0024 V4.30(AASS.0)... AC-E4-CB-83-4... 192.168.1.1 12A_08

B 570024 V4.30(AAS5.0)... E4-18-6B-F7-A7... 192.168.1.1 114_01 HGQ2_R101
™ xcsaroo4s V4.30{AAGE.1)... E4-18-6B-F7-BA... 192.168.1.1 12A3 84 R102

Em  xcsazoo-48 V4.30(AAGE.1)... E4-18-6B-F7-BA... 0.0.0.0 11AC3 86 R101_A3-66
B xcsaroo-ss V4.30(AAGE.1)... E4-18-6B-F7-BA... 192.168.1.1 1242 _83 R102

B3 xcsarooss V4.30(AAGE.1)... E4-18-6B-F7-BB-... 192.168.1.1 12A1_82 R102

Em  xcsaroo-4s V4.30(AAGE.1)... E4-18-6B-F7-BF-... 192.168.1.1 12A4_85 R102

6 Select a device and then use the icons to perform actions. Some functions may not be available for
your devices.

Note: You must know the selected device admin password before taking actions on the
device using the ZON Utility icons.
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Figure 34 Password Prompt

E Password Authentication

proceed.

Device :

Password

Please enter the administrator password to

The following table describes the icons numbered from left to right in the ZON Utility screen.

Table 8 ZON Utility Icons

ICON

DESCRIPTION

1 IP Configuration

Change the selected device's IP address.

2 Renew IP Address

Update a DHCP-assigned dynamic IP address.

3 Reboot Device

Use this icon to restart the selected devices. This may be useful when froubleshooting
or upgrading new firmware.

4 Reset Configuration to
Default

Use this icon fo reload the factory-default configuration file. This means that you will
lose all previous configurations.

5 Locator LED

Use this icon to locate the selected device by causing its Locator LED to blink.

6 Web GUI

Use this to access the selected device Web Configurator from your browser. You will
need a user name and password fo log in.

7 Firmware Upgrade

Use this icon to upgrade new firmware to selected devices of the same model. Make
sure you have downloaded the firmware from the Zyxel website to your computer and
unzipped it in advance.

8 Change Password

Use this icon to change the admin password of the selected device. You must know
the current admin password before changing to a new one.

9 Configure NCC

You must have Internet access to use this feature. Use this icon to enable or disable the

Discovery Nebula Control Center (NCC) discovery feature on the selected device. If it is
enabled, the selected device will fry to connect to the NCC. Once the selected
device is connected to and has registered in the NCC, it will go into the Nebula cloud
management mode.

10 ZAC Use this icon to run the Zyxel AP Configurator of the selected AP.

11 Clear and Rescan

Use this icon fo clear the list and discover all devices on the connected network again.

12 Save Configuration

Use this icon to save configuration changes to permanent memory on a selected
device.

13 Seftings

Use this icon to select a network adapter for the computer on which the ZON utility is
installed, and the utility language.

The following fable describes the fields in the ZON Utility main screen.

Table 9 ZON Utility Fields

LABEL

DESCRIPTION

Type

This field displays an icon of the kind of device discovered.

Model

This field displays the model name of the discovered device.

Firmware Version

This field displays the firmware version of the discovered device.

MAC Address

This field displays the MAC address of the discovered device.
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Table 9 ZON Utility Fields (confinued)

LABEL

DESCRIPTION

IP Address

This field displays the IP address of an internal interface on the discovered device that
first received a ZDP discovery request from the ZON Utility.

System Name

This field displays the system name of the discovered device.

Location

This field displays where the discovered device is.

Status

This field displays whether changes to the discovered device have been done
successfully. As the Switch does not support IP Configuration, Renew IP address and
Flash Locator LED, this field displays “Update failed”, “Not support Renew IP address”
and “Not support Flash Locator LED” respectively.

Controller Discovery

This field displays if the discovered device supports the Nebula Control Center (NCC)
discovery feature. If it is enabled, the selected device will fry to connect to the NCC.
Once the selected device is connected to and has registered in the NCC, it will go
info the Nebula cloud management mode.

Serial Number

Enter the admin password of the discovered device to display its serial number.

Hardware Version

This field displays the hardware version of the discovered device.

4.4 Wizard

The Setup Wizard contains the following parts:

* Basic - to configure the Switch IP address, DNS server, system password, SNMP community and link

aggregation (trunking).

* Protection - fo enable loop guard and broadcast storm control on the Switch and its ports.

¢ VLAN - fo create a static VLAN, assign ports to the VLAN and set the ports to fag or untag outgoing

frames.

* QoS - to determine a port’s IEEE 802.1p priority level for QoS.

4.4.1 Basic

In Basic, you can set up IP/DNS, set up your password, SNMP community, link aggregation, and view

finished results.

In order to set up your IP/DNS, please do the following. Click Wizard > Basic > Step 1 IP fo access this

screen.
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Figure 35 Wizard > Basic > Step 1 IP

2  Password 3 Link Aggregation 4  Summary

Setup IP

Host Name:
P Interface:
ViD:

P Address:

P Subnet Mask:

DMS Server:

Default Gateway:

X51930

Static IP Address ) DHCF Client

Each field is described in the following table.

Table 10 Wizard > Basic > Step 1 IP

LABEL DESCRIPTION

Host Name This field displays a host name.

IP Interface Select DHCP Client if the Switch is connected to arouter with the DHCP server enabled. You
then need to check the router for the IP address assigned to the Switch in order to access
the Switch’s Web Configurator again.

Select Static IP Address when the Switch is NOT connected to a router or you want to assign
it a fixed IP address.

VID This field displays the VLAN ID.

IP Address The Switch needs an IP address for it to be managed over the network.

IP Subnet Mask

The subnet mask specifies the network number portion of an IP address.

Default Gateway

Type the IP address of the default outgoing gateway in dotted decimal notation, for
example 192.168.1.254.

DNS Server DNS (Domain Name System) is for mapping a domain name to its corresponding IP address
and so forth. Enter a domain name server IP address in order to be able to use a domain
name instead of an IP address.

Next Click Next to show the next screen.

Cancel Click Cancel to exit this screen without saving.

After clicking Next, the Password screen appears.
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Figure 36 Wizard > Basic > Step 2 Password

2 Password 3 Link Aggregation 4 Summary

STEP
Change administrator's password and SNMP

It is recommended to change password and SNMP community string to avoid potential security breach.

Administrater's Password SNMP
Current password: SNMP: © tnabled Disabled
New password: Vemian e i
Confi password: Get Community public
Set Community public
Trap Community public

Each field is described in the following table.

Table 11 Wizard > Basic > Step 2 Password

LABEL DESCRIPTION

Administrator's Password

Current password Type the existing system password (1234 is the default password when shipped).

New password Enter your new system password. Up to 32 characters are allowed for the new password
except[2L [ | L.['LL["]. [space], or[,].

Confirm password Retype your new system password for confirmation.

SNMP

SNMP Select Enabled to let the Switch act as an SNMP agent, which allows a manager station to
manage and monitor the Switch through the network. Select Disabled to turn this feature
off.

Version Select the SNMP version for the Switch. The SNMP version on the Switch must match the
version on the SNMP manager. Choose SNMP version 2c (v2c), SNMP version 3 (v3) or both
(v3v2c).

Note: SNMP version 2c is backwards compatible with SNMP version 1.

Get Community Enter the Get Community string, which is the password for the incoming Get- and
GetNextrequests from the management station.

The Get Community string is only used by SNMP managers using SNMP version 2c or lower.

Set Community Enter the Set Community string, which is the password for the incoming Set- requests from
the management station.

The Set Community string is only used by SNMP managers using SNMP version 2c or lower.
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Table 11 Wizard > Basic > Step 2 Password (confinued)

LABEL DESCRIPTION
Trap Community Enter the Trap Community string, which is the password sent with each frap to the SNMP
manager.

The Trap Community string is only used by SNMP managers using SNMP version 2c or lower.

Previous Click Previous to show the previous screen.
Next Click Next to show the next screen.
Cancel Click Cancel to exit this screen without saving.

After clicking Next, the Link Aggregation screen appears.

Figure 37 Wizard > Basic > Step 3 Link Aggregation

2 Password 3 link Aggregation. 4  Summary

STEP
Link Aggregation
s | 14 | 15|

Stafic w | | Stafic w || Stafic w | | Static || Stafic w|
portl  port2 port3 porid  portS  porté | { 11 { {

port?7  port8 port? portl0 portll porti2

TI - |

Unsslected  [il] Seiscted

Each field is described in the following table.

Table 12 Wizard > Basic > Step 3 Link Aggregation

LABEL DESCRIPTION
Link Aggregation
T1-Tx Click the arrows to add or delete icons located on the left to desired preference.

Select Static if the ports are configured as static members of a trunk group.

Select LACP if the ports are configured to join a frunk group through LACP.

Previous Click Previous to show the previous screen.
Next Click Next to show the next screen.
Cancel Click Cancel to exit this screen without saving.

After clicking Next, the Summary screen appears.
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Figure 38 Wizard > Basic > Step 4 Summary

2 Password 3 linkAggregation 4 Summary
STEP
Summary
Setup IP Change administrator's password and activate SNMP
Hest Mame: X31%30 Mew password:
IP Interface: DHCP Client SMMP: Enabled
WID: 1 Version: v2e
IP Address: 192.168.1.1 Get Community: public
IP Subnet Mask: 255.255.2550 Set Community: public
Defoult Gateway: Trap Community: public
DNS Server:

Link Aggregation

= N

Each field is described in the following table.

Table 13 Wizard > Basic > Step 4 Summary

LABEL DESCRIPTION

Setup IP

Host Name This field displays a host name.

IP Interface This field displays whether the WAN interface is using a DHCP IP address or a static IP
address.

VID This field displays the VLAN ID.

IP Address The Switch needs an IP address for it to be managed over the network.

IP Subnet Mask The subnet mask specifies the network number portion of an IP address.

Default Gateway Type the IP address of the default outgoing gateway in dotted decimal notation, for

example 192.168.1.254.

DNS Server DNS (Domain Name System) is for mapping a domain name to its corresponding IP address
and vice versa. Enfer a domain name server IP address in order to be able to use a domain
name instead of an IP address.

Change administrator's password and activate SNMP

New Password This field displays asterisks when a new password has been created.
SNMP This field displays whether the Switch acts as an SNMP agent.
Version This field displays the SNMP version for the Switch.

Get Community This field displays the Get Community string.

Set Community This field displays the Set Community string.

Trap Community This field displays the Trap Community string.

Link Aggregation

Group This field displays the group number.
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Table 13 Wizard > Basic > Step 4 Summary (continued)

LABEL DESCRIPTION

Type This field displays Static or LACP of this group.

Member This field displays the members of this group.

Previous Click Previous to show the previous screen.

Finish Review the information and click Finish to create the task.
Cancel Click Cancel to exit this screen without saving.

4.4.2 Protection

In Protection, you can set up loop guard and broadcast storm confrol.

In order to set up loop guard, please do the following. Click Wizard > Protection > Step 1 Loop Guard fo
access this screen.
Figure 39 Wizard > Protection > Step 1 Loop Guard

Loop Guard 2 Broadcast Storm Conirol 3 Summary

Loop Guard

Jelect all ports
2 4 & & 10 12
1 3 5 7 b 1

Unsslscied [l Selscted

Each field is described in the following table.

Table 14 Wizard > Protection > Step 1 Loop Guard

LABEL DESCRIPTION
Loop Guard
Select all ports Select all ports to enable the loop guard feature on all ports.

You can select a port by clicking it.

Next Click Next to show the next screen.

Cancel Click Cancel to exit this screen without saving.
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After clicking Next, the Broadcast Storm Control screen appears.

Figure 40 Wizard > Protection > Step 2 Broadcast Storm Control

Loop Guard Broadcast Storm Control 3 Summary

Broadcast Storm Control

Select oll ports /]
Broadcast pkifs 1000
2 4 & 8 10 2
- - -
1000 1000 1000 1000 1000 joca
L] L]
1 3 5 7 9 1
1000 1000 1000 1000 1000 1000
Unsslected [l Selected

Each field is described in the following table.

Table 15 Wizard > Protection > Step 2 Broadcast Storm Confrol

LABEL DESCRIPTION

Broadcast Storm Control

Select all ports Select all ports to apply settings on all ports.

You can select a port by clicking it.

Broadcast pkt/s Specify how many broadcast packets the port receives per second.
Previous Click Previous to show the previous screen.

Next Click Next to show the next screen.

Cancel Click Cancel to exit this screen without saving.

After clicking Next, the Summary screen appears.
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Figure 41 Wizard > Protection > Step 3 Summary

Loop Guard 2 Broadcast Storm Conirol

Summary

Loop Guard

2 4 & i} 10 12

1 3 5 7 9 11
Unsslected [l Selected
Broadcast Storm Control
2 4 ] 8 10 12
- -
1000 1000 1000 1000 1000 1000
- - .
1 3 5 7 ? 11
1000 000 1000 1000 1000 1000
Ursslscted [l Sslect=d

Each field is described in the following table.

Table 16 Wizard > Protection > Step 3 Summary

LABEL DESCRIPTION
Summary
Loop Guard If the loop guard feature is enabled on a port, the Switch will prevent loops on this port.
Broadcast Storm If the broadcast storm control feature is enabled on a port, the number of broadcast
Control packets the Switch receives per second will be limited on this port.
Previous Click Previous to show the previous screen.
Finish Review the information and click Finish to create the task.
Cancel Click Cancel to exit this screen without saving.
4.4.3 VLAN

In VLAN, you can create VLAN, and fag VLAN settings.

Click Wizard > VLAN > VLAN Setting tfo access this screen.
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Figure 42 Wizard > VLAN > VLAN Setting

VLAN Setting

1o

Trunk Tagged port

VLAN

rt rt F3  portd  pors i
ri ri ri ri portl0
portll  portl2 &
Unsslected  [il] Selscted et o

EEEN<«—3

Q

WLAM member port Untagged Tagge

Unsslscted [l Selscted

Each field is described in the following table.

Table 17 Wizard > VLAN > VLAN Setting

LABEL

DESCRIPTION

VLAN Setting

Default VLAN 1 /
Access Untagged
port

After you create a VLAN and select the VLAN ID from the drop-down list box, select ports
and use the right arrow to add them as the untagged ports to a VLAN group.

VLAN member port

VLAN

Type a number between 2 and 4094 to create a VLAN.

Trunk Tagged port

Select ports and use the downward arrow to add them as the tagged ports to the VLAN
groups you created.

Finish

Review the information and click Finish to create the task.

Cancel

Click Cancel to exit this screen without saving.

4.4.4 QoS

In QoS, you can create QoS setftings.

In order to create QoS setftings, please do the following. Click Wizard > QoS > QoS Setting to access this

screen.

XS1930 Series User's Guide

60




Chapter 4 Web Configurator

Figure 43 Wizard > QoS > QoS Setting

QoS Setting

Select ports first then apply QoS priority
Select oll ports

2 4 ] &

=}
[

Each field is described in the following table.

Table 18 Wizard > QoS > QoS Setting

LABEL DESCRIPTION
QoS Setting
Select all ports Select all ports to apply settings on all ports.

You can select a port by clicking it.

High Select ports and click the High button, so they will have high priority.

The port’s IEEE 802.1p priority level will be setf to 5. Use the Basic Setting > Port Setup screen to
adjust the value.

Medium Select ports and click the Medium button and, so they will have medium priority.

The port’s IEEE 802.1p priority level will be set to 3. Use the Basic Setting > Port Setup screen to
adjust the value.

Low Select ports and click the Low button, so they will have low priority.

The port’s IEEE 802.1p priority level will be setf to 1. Use the Basic Setting > Port Setup screen to
adjust the value.

Finish Review the information and click Finish to create the task.

Cancel Click Cancel to exit this screen without saving.

4.5 Web Configurator Layout

The Status screen is the first screen that displays when you access the Web Configurator.

This guide uses the XS1930-12HP screens as examples. The screens may vary slightly for different models.
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The following figure shows the navigating components of a Web Configurator screen.

Figure 44 Web Configurator Home Screen (Status)

ZYXEL xsi1930 @eﬁeshvmumwgg b
» [ J

Menu
Basic Seffing [ Sfolos |
Advanced Application Device Informafi
1P Application Device Type X51930-12HP System Name X51930
Boot Version V1.00 | 04/17/2019 System Location aloert test
Management = .
Firmware Version V4.70[ABGQF.0)b] | 05/11/72021 System Time 01/01/2020 03:26:21
| Hordware Version V1.0 System Up Time 000 days.03 hours, 24 mins, 24 secs
| MAC Address 58:8b:f3:ffee 7 Legin Timeout{mins| 55
| Serial Number 5192055000015 Registration MAC Address 58:8b:f3:ffee 7]
| Hybnd Mode Standalone QR Code Cloud Conirol Status Disconnected
PoE Usage 0.0/375.0 W [0F)
| Detail
..IPV4 Address 172.21.40.5
| Subnet Mask 255.255.2520
Default Gateway 172.21.43.254 IP Setup
IPV$ Global Unicost Address
IPV$ Link-Local Address [Pvé configurafion
.STP Disable Setfing SMMP Status 1) Enable Sefting
| Port Mirrcring Disable Setfing B802.1X Status Disable Seiting
| Storm Conirol Disable Setting DHCP Relay Disoble Setting
| IGMP Snooping Disable Setfing
Port Status PoE Status Link Aggregation Status MAC Toble
Eouting Table IF Table Dicgnostic System Log
| Remote Access Control Tech-support VLAN Setup Service Access Control

A - Click the menu items to open sub-menu links, and then click on a sub-menu link to open the screen
in the main window.

B. C, D, E, F, G - These are quick links which allow you to perform certain tasks no matter which screen
you are currently working in.

B - Click this link to update the information in the screen you are viewing currently.

C - Click this link to save your configuration into the Switch's non-volatile memory. Non-volatile memory
is the configuration of your Switch that stays the same even if the Switch's power is turned off.

D - Click this link fo go to the status page of the Switch.

E - Click this icon to open the wizard screen where you can configure the Switch’s IP, login password,
SNMP community, link aggregation, and so on.

F - Click this link to log out of the Web Configurator.

G - Click this link to display web help pages. The help pages provide descriptions for all of the
configuration screens.

H - Click this link to go to the Zyxel Community Biz Forum.

I - Click this link to go to the NCC (Nebula Control Center) portal website.
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J - Click this link to

go to the Neighbor screen where you can see and manage neighbor devices

learned by the Switch.

In the navigation panel, click a main link to reveal a list of sub-menu links.

Table 19 Navigation Panel Sub-links Overview

BASIC SETTING

ADVANCED APPLICATION | IP APPLICATION MANAGEMENT

Menu

Basic Sefting
Advanced Application
IP Application

Management

System Info
General Setup
Switch Setup

IP Setup

Port Setup

PoE Setup

Interface Setup

IPvé

Cloud Management

Menu

Basic Seffing
Advanced Applicafion
IP Application

Management

VLAN

Siatic MAC Forwarding
Static Mulficast Forwarding
Filtering

Spanning Tree Protocol
Bandwidth Control
Broadcast Storm Conirol
Mirroring

Link Aggregation

Port Avthenfication

Port Security

Time Range

Classifier

Policy Rule

Queving Method
Mullicast

AAA

DHCP Snooping

Loop Guard

Layer 2 Protocol Tunneling
PPPoE

Erdisable

Green Ethernet

LIDP

Hardware Monitor

Menu

Basic Seffing
Advanced Application
IP Application

Management

Shatic Roufing
DHCP
ARP Setup

Menu

Basic Setfing

Advanced Applicafion
IP Application

Management

Maintenance
Access Conirol
Diagnostic

System Log

Syslog Selup
Cluster Management
MAC Table

IP Table

ARP Table

Routing Table

Path MTU Table
Configure Clone
IPvé Neighbor Table
Port Status

The following table describes the links in the navigation panel.

Table 20 Navigation Panel Links

LINK

DESCRIPTION

Basic Settings

System Info

This link takes you to a screen that displays general system information.

General Setup

This link takes you to a screen where you can configure general identification information
about the Switch.

Switch Setup This link takes you to a screen where you can set up global Switch parameters such as VLAN
type and priority queues.

IP Setup This link takes you to a screen where you can configure the IP address and subnet mask
(necessary for Switch management) and set up to 64 IP routing domains.

Port Setup This link takes you to a screen where you can configure settings for individual Switch ports.

PoE Setup For POE models.

This link fakes you to a screen where you can set priorities, POE power-up settings and schedule
so that the Switch is able to reserve and allocate power to certain PDs.

Interface Setup

This link takes you to a screen where you can configure settings for individual interface type
and ID.

IPvé

This link takes you to a screen where you can view IPvé status and configure IPvé settings.
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Table 20 Navigation Panel Links (continued)

LINK DESCRIPTION
Cloud This screen displays a link to a screen where you can enable or disable the Nebula Control
Management Center Discovery feature. If it is enabled, you can have the Switch search for the NCC (Nebula

Control Center). Another link takes you to the Nebula Switch Registration screen which has a
QR code containing the Switch's serial number and MAC address for handy registration of the
Switch af NCC.

Advanced Application

VLAN This link fakes you to screens where you can configure port-based or 802.1Q VLAN (depending
on what you configured in the Switch Setup menu). You can also configure a voice VLAN, a
MAC based VLAN or a vendor ID based VLAN in these screens.

Static MAC This link takes you to a screen where you can configure static MAC addresses for a port. These

Forwarding static MAC addresses do not age out.

Static Multicast This link takes you to a screen where you can configure static multicast MAC addresses for

Forwarding ports. These statfic multicast MAC addresses do not age out.

Filtering This link takes you to a screen to set up filtering rules.

Spanning Tree This link takes you to screens where you can configure the RSTP to prevent network loops.

Protocol

Bandwidth This link takes you to a screen where you can configure bandwidth limits on the Switch.

Control

Broadcast Storm
Control

This link takes you to a screen to set up broadcast filters.

Mirroring This link takes you to screens where you can copy tfraffic from one port or ports to another port
in order that you can examine the traffic from the first port without interference.

Link Aggregation | This link takes you to screens where you can logically aggregate physical links to form one
logical, higher-bandwidth link.

Port This link takes you to a screen where you can configure IEEE 802.1x port authentication as well

Authentication as MAC authentication for clients communicating through the Switch.

Port Security

This link fakes you to a screen where you can activate MAC address learning and set the
maximum number of MAC addresses to learn on a port.

Time Range This link takes you to a screen where you can define different schedules.

Classifier This link takes you to screens where you can configure the Switch to group packets based on
the specified criteria.

Policy Rule This link takes you fo a screen where you can configure the Switch to perform special freatment

on the grouped packets.

Queuing Method

This link takes you to a screen where you can configure queuing with associated queue
weights for each port.

Multicast This link fakes you fo screens where you can configure various multicast features and IGMP
snooping.

AAA This link takes you to a screen where you can configure authentication, authorization and
accounting services through external servers. The external servers should be RADIUS (Remote
Authentication Dial-In User Service).

DHCP Snooping This link takes you to screens where you can configure filtering of unauthorized DHCP packetsin
your network.

Loop Guard This link takes you to a screen where you can configure protection against network loops that

occur on the edge of your network.

Layer 2 Protocol
Tunneling

This link takes you to a screen where you can configure L2PT (Layer 2 Protocol Tunneling)
settings on the Switch.

PPPOE

This link takes you to screens where you can configure how the Switch gives a PPPoE
termination server additional subscriber information that the server can use to identify and
authenticate a PPPoE client.
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Table 20 Navigation Panel Links (continued)

LINK

DESCRIPTION

Errdisable

This link takes you to screens where you can view errdisable status and configure errdisable
settings in CPU protection, errdisable detect, and errdisable recovery.

Green Ethernet

This link takes you to a screen where you can configure green Ethernet settings in EEE, auto
power down, and short reach for each port.

LLDP This link takes you to screens where you can configure LLDP setftings.

Hardware This link takes you to a screen where you can enable the Switch to get the SFP transceiver
Monitor operating temperature and adjust the fan speed accordingly.

IP Application

Static Routing

This link takes you to a screen where you can configure static routes. A stafic route defines how
the Switch should forward fraffic by configuring the TCP/IP parameters manually.

DHCP This link takes you to screens where you can configure the DHCP settfings.
ARP Setup This link takes you to screens where you can configure the ARP learning settings for each port.
Management

Maintenance

This link takes you to screens where you can perform firmware and configuration file
maintenance as well as reboot the system.

Access Control

This link takes you to screens where you can change the system login password and configure
SNMP and remote management.

Diagnostic This link takes you to a screen where you can ping IP addresses, run fraceroute, test ports and
show the Switch'’s location.

System Log This link takes you to a screen where you can view system logs.

Syslog Setup This link takes you to a screen where you can setup system logs and a system log server.

Cluster This link takes you to screens where you can configure clustering management and view ifs

Management status.

MAC Table This link takes you to a screen where you can view the MAC addresses (and types) of devices
attached to what ports and VLAN IDs.

IP Table This link takes you to a screen where you can view the IP addresses and VLAN ID of a device
attached to a port.You can also view what kind of device it is.

ARP Table This link takes you to a screen where you can view the MAC addresses — IP address resolution
table.

Routing Table This link takes you to a screen where you can view the routing table.

Path MTU Table

This link fakes you to a screen where you can view the path MTU aging time, index, destination
address, MTU, and expire settings.

Configure Clone

This link takes you to a screen where you can copy attributes of one port to other ports.

IPvé Neighbor
Table

This link takes you to a screen where you can view the IPvé neighbor table which includes
index, interface, neighbor address, MAC address, status and type.

Port Status

This link takes you to a screen where you can view the port statistics.

4.5.1 Change Your Password

After you log in for the first fime, it is recommended you change the default administrator password.
Click Management > Access Control > Logins to display the next screen.
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Figure 45 Change Administrator Login Password

Access Control

dministrator

Old Password

MNew Password

Retype to confirm /

Please record your new password whenever you change it. The system will lock you out if you have
forgotten your password.

Edit Logins

R R

4.6 Save Your Configuration

When you are done modifying the settings in a screen, click Apply to save your changes back to the
run-time memory. Settings in the run-time memory are lost when the Switch's power is turned off.

Click the Save link in the upper right of the Web Configurator to save your configuration to non-volatile

memory. Non-volatile memory refers to the Switch’s storage that remains even if the Switch's power is
furned off.

Note: Use the Save link when you are done with a configuration session.

4.7 Switch Lockout

You could block yourself (and all others) from managing the Switch if you do one of the following:

1 Delete the management VLAN (default is VLAN 1).

2 Delete all port-based VLANs with the CPU port as a member. The "CPU port” is the management port of
the Switch.

3  Filter all traffic to the CPU port.

4 Disable all ports.

5 Misconfigure the text configuration file.

6 Forget the password and/or IP address.

7 Prevent all services from accessing the Switch.

8 Change a service port number but forget it.
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9 You forgot to log out of the Switch from a computer before logging in again on another computer.

Note: Be careful not to lock yourself and others out of the Switch.

4.8 Reset the Switch

If you lock yourself (and others) from the Switch or forget the administrator password, you will need to
reload the factory-default configuration file or reset the Switch back to the factory defaults.

4.8.1 Restore Button

Press the RESTORE button for 7 to 10 seconds to have the Switch automatically reboot and restore the
factory default file. See Section 3.3 on page 40 for more information about the LED behavior.

4.8.2 Restore Custom Default

Press the RESTORE button for 3 to 6 seconds to have the Switch automatically reboot and restore the last-
saved custom default file. See Section 3.3 on page 40 for more information about the LED behavior.

4.8.3 Reboot the Switch

Press the RESET button to reboot the Switch without turning the power off. See Section 3.3 on page 40 for
more information about the LED behavior.

4.9 Log Out of the Web Configurator

Click Logout in a screen to exit the Web Configurator. You have to log in with your password again after
you log out. This is recommended after you finish a management session for security reasons.

Figure 46 Web Configurator: Logout Screen

Thank you for uzing the Web Configurator.

Please close the browser before next login.
Goodbye!

4.10 Help

The Web Configurator's online help has descriptions of individual screens and some supplementary
information.

Click the Help link from a Web Configurator screen to view an online help description of that screen.
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CHAPTER 5
Initial Setup Example

5.1 Overview

This chapter shows how to set up the Switch for an example network.
The following lists the configuration steps for the initial setup:

¢ Create a VLAN
e Setf Port VID

¢ Configure Switch Management IP Address

5.1.1 Create a VLAN

VLANs confine broadcast frames to the VLAN group in which the ports belongs. You can do this with
port-based VLAN or tagged static VLAN with fixed port members.

In this example, you want to configure port 1 as a member of VLAN 2.

Figure 47 Initial Setup Network Example: VLAN

1 Click Advanced Application > VLAN > VLAN Configuration in the navigation panel and click the Static
VLAN Setup link.
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VLAN Configuration VLAN Status
Gtatic VLAN Setup Click Here )
VLAN Port Setup Click Here
Voice VLAMN Setup Click Here
Vendor ID Bosed VLAM Setup Click Here

2 Inthe Static VLAN screen, select ACTIVE, enter a descriptive name in the Name field and enter 2 in the
VLAN Group ID field for the VLAN2 network. Use the default VLAN type, Normal, in the VLAN Type field.

| staficVIAN | VLAN Configuration

ACTIVE

Name Example

VLAN Group ID 2
- MNormal ~ Tx Tagging

Q O Neormal ® Fixed O Eorbidden O 1 Tcggir@

2 ® Normal O Fixed O Eorbidden Tx Tagging
3 ® Normal O Fixed O Eorbidden Tx Tagging
4 ® Normal O Fixed O Eorbidden Tx Tagging
5 ® Normal O Fixed O Eorbidden Tx Tagging
[ ® Normal O Fixed O Eorbidden Tx Tagging
7 ® MNormal O Fixed O Forbidden Tx Tagging
8 ® Normal O Fixed O Eorbidden Tx Tagging

0

® Normal O Forbidde Top””
\/\/W\W

L]

1 Yes 1 O

10 fes 10 O
20 Yes 20 O
30 Yes 20 O
40 Yes 40 O
100 Yes 100 O

Delete | Cancel

Note: The VLAN Group ID field in this screen and the VID field in the IP Setup screen refer to the
same VLAN ID.

3 Since the VLAN2 network is connected to port 1 on the Switch, select Fixed to configure port 1 to be a
permanent member of the VLAN only.

4 To ensure that VLAN-unaware devices (such as computers and hubs) can receive frames properly, clear
the TX Tagging check box to set the Switch to remove VLAN tags before sending.

5 Click Add to save the settings to the run-time memory. Settings in the run-time memory are lost when the
Switch's power is turned off.
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5.1.2 Set Port VID

Use PVID to add a tag to incoming untagged frames received on that port so that the frames are
forwarded to the VLAN group that the tag defines.

In the example network, configure 2 as the port VID on port 1 so that any untagged frames received on
that port get sent to VLAN 2.

Figure 48 Initial Setup Network Example: Port VID

1 Click Advanced Applications > VLAN > VLAN — ViANronsemg | VLAN Configuration
Configuration in the navigation panel. Then GVRP
click the VLAN Port Setup link.

2 Enfer 2in the PVID field for port 1 and click
Apply to save your changes back to the run- ( 2
fime memory. Setftings in the run-fime memory 2 i ]

1
1
1
1
1

are lost when the Switch's power is turned off.

el EIERE

5.1.3 Configure Switch Management IP Address

If the Switch fails to obtain an IP address from a DHCP server, the Switch will use 192.168.1.1 as the
management IP address. You can configure another IP address in a different subnet for management
purposes. The following figure shows an example.
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Figure 49 Initial Setup Example: Management IP Address

192.168.1.x 192.168.2.1

1 Connect your computer to any Ethernet port on the Switch. Make sure your computer is in the same
subnet as the Switch.

2 Open your web browser and enter 192.168.1.1 (the default IP address) in the address bar to access the
Web Configurator. See Section 4.2 on page 44 for more information.

3 Click Basic Setting > IP Setup > IP Configuration in the navigation panel.

IP Configurafion IP Status Metwork Proxy Configuration

Default Gateway 0.0.0.0

Domain Mame Server 1

Domain Name Server 2

IP Interface
IP Address O DHCF Client
Static P Address \
IP Address 192.168.2.1

IP Subnet Mask 255.255.255.0

]
1 172.21.40.36 2552552520 1 DHCP O
2 192.168.1.1 255.255.2550 1 Static O

4 Configure the related fields in the IP Configuration screen.

5 For the VLAN2 network, enter 192.168.2.1 as the IP address and 255.255.255.0 as the subnet mask.
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In the VID field, enter the ID of the VLAN group to which you want this management IP address to
belong. This is the same as the VLAN ID you configure in the Static VLAN screen.

Click Add to save your changes back to the run-time memory. Settings in the run-time memory are lost
when the Switch’s power is turned off.
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CHAPTER ©
Tutorials

6.1 Overview

This chapter provides some examples of using the Web Configurator to set up and use the Switch. The
futorials include:

e How to Use DHCPv4 Relay on the Switch

6.2 How to Use DHCPv4 Relay on the Switch

This tutorial describes how to configure your Switch to forward DHCP client requests to a specific DHCP

server. The DHCP server can then assign a specific IP address based on the information in the DHCP
requests.

6.2.1 DHCP Relay Tutorial Introduction

In this example, you have configured your DHCP server (192.168.2.3) and want fo have it assign a
specific IP address (say 172.16.1.18) to DHCP client A based on the system name, VLAN ID and port
number in the DHCP request. Client A connects to the Switch's port 2 in VLAN 102.

Figure 50 Tutorial: DHCP Relay Scenario

DHCP Server Eﬁ:;z_ 102
192.168.2.3 -
A
172.16.1.18

6.2.2 Create a VLAN

Follow the steps below fo configure port 2 as a member of VLAN 102.

1 Access the Web Configurator through the Switch's management port.
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2

Go to Basic Setting > Switch Setup and set the VLAN type to 802.1Q. Click Apply to save the settings to
the run-fime memory.

Figure 51 Tutorial: Set VLAN Type to 802.1Q

® 5302.1Q
VLAN Type o
Port Base
MAC Address Learning Aging Time 300 seconds
ARP Aging Time Aging Time 300 seconds
Join Timer 200 milliseconds
GARP Timer Leave Timer 600 milliseconds
Leave All Timer 10000 | miliseconds
Priority Queue Assignment Priority7 ;v
Priorityé 6w
Priority5 S5
Priority4 4
Priority3 3
Priority2 1
Priority1 0w
Priority0 2
ApDly

Click Advanced Application > VLAN > VLAN Configuration > Static VLAN Setup.

In the Static VLAN screen, select ACTIVE, enter a descriptive name (VLAN 102 for example) in the Name
field and enter 102 in the VLAN Group ID field.

Select Fixed to configure port 2 to be a permanent member of this VLAN.
Clear the TX Tagging check box to set the Switch to remove VLAN tags before sending.

Click Add to save the seftings to the run-time memory. Settings in the run-time memory are lost when the
Switch's power is turned off.

XS1930 Series User's Guide
74



Chapter 6 Tutorials

Figure 52 Tutorial: Create a Static VLAN

 Soicvian | VIAN Confoumaior
{ ACTIVE '
Name WLARN 102
\V_AN Group ID 102
Mormal v ¥ Tx Togging
I 2 Llormngl Flxed Egroidden ¥ T:looging
C2 Mormal * Fixed Forbidden Tx Tagging
3 ® Mormal Fixed Forbidden ¥ Tx Tagging
4 ® Mormal Fixed Forbidden ¥ Tx Tagging
3 ® Mormal Fixed Forbidden ¥ Tx Tagging
é ® Mormal Fixed Foroidden #| Tx Togsing
7 ® Mormal Fixed Forbidden ¥ Tx Tagging
8 ® Mormal Fixed Forbidden ¥ Tx Tagging
g . | ich
Fins <n ¥ T¥Togging
(==
1 Yes 1

Cancel

8 Click the VLAN Configuration link in the Static VLAN Setup screen and then the VLAN Port Setup link in the
VLAN Configuration screen.

Figure 53 Tutorial: Click the VLAN Port Setting Link

VLAN Configuration VLAN Status
Static VLAN Setup Click Here
(CVLAN Port Setup Click Here )
Voice VLAMN Setup Click Here
Vendor ID Bosed VLAM Setup Click Here

9 Enter 102 in the PVID field for port 2 to add a tag to incoming untagged frames received on that port so
that the frames are forwarded to the VLAN group that the tag defines.

10 Click Apply to save your changes back to the run-time memory.
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Figure 54 Tutorial: Add Tag for Frames Received on Port 2

VLAN Port Sefting VLAN Configuration
GVRP
* Al v
1 1 Al v
( 2 1072 Al v )
3 1 Al v
4 1 Al v
5 100 Al v

11 Click the Save link in the upper right of the Web Configurator to save your configuration permanently.

6.2.3 Configure DHCPv4 Relay

Follow the steps below to enable DHCP relay on the Switch and allow the Switch to add relay agent
information (such as the VLAN ID) to DHCP requests.

1 Click IP Application > DHCP > DHCPv4 and then the Global link to open the DHCP Relay screen.
2 Select the Active check box.

3 Enter the DHCP server's IP address (192.168.2.3 in this example) in the Remote DHCP Server 1 field.
4 Select defaultl or default2 in the Option 82 Profile field.

5 Click Apply to save your changes back to the run-time memory.

Figure 55 Tutorial: Set DHCP Server and Relay Information

DHCP Relay Stafus Port
Active
Remote DHCP Server 1 192.168.2.3
Remote DHCP Server 2 0.0.0.0
Remote DHCP Server 3 0.0.0.0
Option 82 Profile default e

6 Click the Save link in the upper right of the Web Configurator to save your configuration permanently.

7 The DHCP server can then assign a specific IP address based on the DHCP request.

6.2.4 Troubleshooting

Check client A's IP address. If it did not receive the IP address 172.16.1.18, make sure:
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Client Ais connected to the Switch's port 2 in VLAN 102.

You configured the correct VLAN ID, port number and system name for DHCP relay on both the DHCP
server and the Switch.

You clicked the Save link on the Switch to have your settings take effect.
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CHAPTER 7/
Status

7.1 Overview

This chapter describes the screens for System Status and Neighbor Details.

7.1.1 What You Can Do

* Use the Status screen (Section 7.2 on page 78) to see the Switch’s general device information, system
status, and IP addresses. You can also display other status screens for more information.

¢ Use the Neighbor screen (Section 7.2.1 on page 80) to view a summary and manage Switch's
neighbor devices.

* Use the Neighbor Detail screen (Section 7.2.2 on page 82) to view more detailed information on the
Switch’s neighbor devices.

7.2 Status

The Status screen displays when you log into the Switch or click Status at the top right of the Web
Configurator. The Status screen displays general device information, system status, and its IP addresses.
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Figure 56 Status

Device Type

Boot Version
Firmware Version
Hardware Version
MAC Address
Serial Mumber
Hybrid Mode

FoE Usage

Detail

IPV4 Address
Subnet Mask

Default Gateway

IPVé Link-Local Address
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Port Mirroring
Storm Control
IGMP Snooping

Port Status
Eouting Table

Eemote Access Control

IPVé Global Unicost Address

MNeighbor

X51930-12HP
VI1.00 | 041772019
V4. 70{ABGQFO)b]

X31930
albert test
01/01/2020 04:03:20

Systerm Mame
Systerm Location

05112021 System Time

V1.0 Systerm Up Time 000 days,06 hours,03 mins, 33 secs
58:8b:f3:ffeed] Login Timeout{mins) 55
5192155000015 Registration MAC Address 58:8b:f3:ffeed]

Standalone QR Code
0.0/375.0 W [0%)

Cloud Confrol Status Disconnected

172.21.40.5
255.255.252.0
172.21.43.254 IP Setup
IPvé configuration
Disable Setting SMMP Stotus (1) Enable Setting
Disable Setting 802.1X Status Disable Setting
Disable Setting DHCP Relay Disable Setting
Disable Setting
PoE Status Link Aggregation Status MAC Toble
IE Table Diognostic Systermn Log
Tech-support VLAN Setup Service Acces: Control

The following table describes the labels in this screen.

Table 21 Status

LABEL

DESCRIPTION

Device Information

Device Type

This field displays the model name of this Switch.

System Name

This field displays the name used to identify the Switch on any network.

Boot Version

This field displays the version number and date of the boot module that is currently on the
Switch.

System Location

This field displays the geographic location of your Switch. You can change the setfting in the
Basic Setting > General Setup screen.

Firmware This field displays the version number and date of the firmware the Switch is currently running.
Version

System Time This field displays the current date and fime in the UAG. The format is mm-dd-yyyy hh:mm:ss.
Hardware This field displays the hardware version number of the Switch. The integer is the generation
Version number of the Switch series, and the decimal is the version of the hardware change. For

example, V1.0 is a hardware version for the Switch where 1 identifies the first generation of the
Switch series, and .0 is the first hardware change.

System Up Time

This field displays how long the Switch has been running since it last restarted or was turned on.

MAC Address

This field displays the MAC addresses of the Switch.

Login
Timeout(mins)

This field displays how many minutes a management session can be left idle before the session
fimes out. After it fimes out you have to log in with your password again.

Serial Number

This field displays the serial number of this Switch. The serial number is used for device tracking
and control.

Registration
MAC Address

This field displays the MAC address of the Switch that you must use to register at myZyxel.com or
the NCC (Nebula Control Center).

Hybrid Mode

This field displays whether the Switch is in Standalone mode or Cloud mode. In Standalone mode
you can see a link fo a QR code to register the Switch to use NCC (Nebula Confrol Center).
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Table 21

Status (continued)

LABEL

DESCRIPTION

Cloud Control
Status

This field displays the registration and connection status between the Switch and the NCC
(Nebula Control Center).

In Standalone mode, the status will display Disconnected or Unregistered. In cloud mode the
status will display Connected or Disconnected.

Connected - The Switch is registered with and connected to the NCC.
Disconnected — The Switch is not connected to the NCC.

Unregistered — The Switch is not registered with the NCC.

PoE Usage

This field displays the amount of power the Switch is currently supplying to the connected PoE-
enabled devices and the total power the Switch can provide to the connected PDs. It also
shows the percentage of PoE power usage.

When PoE usage reaches 100%, the Switch will shut down PDs one-by-one according to the PD
priority which you configured in Basic Setting > PoE Setup.

Detail

Click this link to go fo the Basic Setting > System Info screen to check other detailed information,
such as system resource usage and the Switch temperature, fan speeds or voltage.

IP Address Information

IPv4 Address

This field displays the Switch's current IPv4 address.

Subnet Mask

This field displays the Switch’s subnet mask.

Default This field displays the IP address of the Switch'’s default gateway.
Gateway

IP Setup Click the link to go to the Basic Setting > IP Setup screen.

IPVé6 Global This field displays the Switch's IPvé global unicast address
Unicast Address

IPVé Link-Local This field displays the Switch's IPvé link-local address.

Address

IPvé Click the link to go to the Basic Setting > IPv6 screen.
configuration

Device Status

This section shows whether a feature is enabled or not on the Switch. You can click a feature’s

and Quick Setting link to go to the configuration screen for the feature.
Configuration . . . .

Hover your cursor over a red exclamation mark to display information about the feature.
Quick Links This section provides the shortcut link fo a specific configuration screen.

7.2.1 Neighbor Screen

The Neighbor screen allows you to view a summary and manage the Switch's neighboring devices. It
uses Layer Link Discovery Protocol (LLDP) to discover all neighbor devices connected to the Switch

including non-Zyxel devices. You can use this screen to perform tasks on the neighboring devices like
login, power cycle (turn the power off and then back on again), and reset to factory default settings.

This screen shows the neighboring device first recognized on an Ethernet port of the Switch. Device
information is displayed in gray when the neighboring device is offline.

Click Status > Neighbor to see the following screen.
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Figure 57 Status > Neighbor

Status Neighbor Detail

[

Fush

The following table describes the fields in the above screen.

Table 22 Status > Neighbor

LABEL DESCRIPTION

Port This shows the port of the Switch, on which the neighboring device is discovered.

Port Name This shows the port description of the Switch.

Link This shows the speed (either 100M for 100 Mbps, 1G for 1 Gbps, 2.5G for 2.5 Gbps, 5G for 5
Gbps, or 10G for 10 Gbps) and the duplex (F for full duplex or H for half). This field displays
Down if the port is not connected to any device.

PoE Draw (W) This shows the consumption that the neighboring device connected to this port draws from

the Switch. This allows you to plan and use within the power budget of the Switch.

System Name

This shows the system name of the neighbor device.

IPv4

This shows the IPv4 address of the neighbor device. The IPv4 address is a hyper link that you
can click to log into and manage the neighbor device through its Web Configurator.

IPvé This shows the IPvé address of the neighbor device. The IPvé address is a hyper link that you
can click to log into and manage the neighbor device through its Web Configurator.
PWR Cycle Click the Cycle button to turn OFF the power of the neighbor device and turn it back ON

again. A count down button (from 5 to 0) starts.

Note: The Switch must support power sourcing (PSE) or the network device is a
powered device (PD).

Reset to Default

Click the Reset button to reset the neighboring device to its factory default settings. A
warning message “Are you sure you want to load factory default?” appears prompting you
to confirm the action. After confirming the action a count down button (from 5 to 0) starts.

Note:

¢ The Switch must support power sourcing (PSE) or the network device is a powered
device (PD).

¢ If multiple neighbor devices use the same port, the Reset button is not available.
¢ You can only reset Zyxel powered devices that support the ZON utility.

Select an entry’s check box to select a specific port. Otherwise, select the check box in the
table heading row to select all ports.

Flush

Click the Flush button to remove information about neighbors learned on the selected
ports.
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7.2.2 Neighbor Detail

Use this screen to view detailed information about the neighboring devices. Device information is
displayed in gray when the neighboring device is currently offline.

Up to 10 neighboring device records per Ethernet port can be retained in this screen even when the
devices are offline. When the maximum number of neighboring device records per Ethernet port is
reached, new device records automatically overwrite existing offline device records, starting with the
oldest existing offline device record first.

Click the Neighbor Detail link in the Status > Neighbor screen to see the following screen.

Figure 58 Status > Neighbor > Neighbor Detail

Switch Neighbor Detail Switch Neighbor
Local Port 1

Desc. - Link Down PoE Draw (W) [o1s] PWR Cycle
| Local Port 2

Desc. - Link 1G/F PoE Draw [W) 0.0 PWR Cycle

Remote

System Home - Meodel - Frmware - MAC dodo3edlec:5f
|Pvd — Pwé —
Port doida3ed

Oeos5t Desc. — Location — Reset to Default
[ Local Port 3
Desc. — Link Down PoE Draw (W) [21s] PWR Cycle
|
Desc. - Link Down PoE Draw [W) 0.0 PWR Cycle
| Local Port 5
Desc. — Link Down PoE Draw (W) Q0 PWR Cycle
[ tocal Port s
Desc. - Link 100M/F PoE Draw [W) 0.0 PWR Cycle
Remote
System Name 12A3 84 Model XG53700-48 Frmware  V430[AAGEZ] | 12/12/2018 | MAC E4-18-6B-F7-BA-0D
IPvd 0.0.00 IPvé -
Port 3% Desc. Location HGQ2_R102 Reset to Default
| Local Port 7
Desc. - Link Down PoE Draw (W) 00 PWR Cycle
[ Local Port 8
Desc. — Link Down PoE Draw (W) [21s] PWR Cycle
[ ocal Port 9
Desc. - Link Down PoE Draw [W) 0.0 PWR Cycle
| Local Port 10
Desc. — Link D PoE Draw (W) Q0 PWR C.
N = Down Pol ] 7 PWR Cycle

The following table describes the fields in the above screen.

Table 23 Status > Neighbor > Neighbor Detail

LABEL DESCRIPTION

Local Port This shows the port of the Switch, on which the neighboring device is discovered.

Desc. This shows the port description of the Switch.

Link This shows the speed (either 200M for 100 Mbps, 1G for 1 Gbps, 2.5G for 2.5 Gbps, 5G for 5

Gbps, or 10G for 10 Gbps) and the duplex (F for full duplex or H for half). This field displays
Down if the port is not connected to any device.

PoE Draw (W) This shows the consumption that the neighboring device connected to this port draws
from the Switch. This allows you to plan and use within the power budget of the Switch.

PWR Cycle Click the Cycle button to turn OFF the power of the neighbor device and turn it back ON
again. A count down button (from 5 to 0) starts.

Note: The Switch must support power sourcing (PSE) or the network device is a
powered device (PD).

Remote
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Table 23 Status > Neighbor > Neighbor Detail (continued)

LABEL

DESCRIPTION

System Name

This shows the system name of the neighbor device.

Model

This shows the model name of the neighbor device. This field will show “~" for devices that
do not support the ZON ufility.

Firmware This shows the firmware version of the neighbor device. This field will show “~" for devices
that do not support the ZON utility.

MAC This shows the MAC address of the neighbor device.

IPv4 This shows the IPv4 address of the neighbor device. The IPv4 address is a hyper link that
you can click to log into and manage the neighbor device through its Web Configurator.

IPvé This shows the IPvé address of the neighbor device. The IPvé address is a hyper link that
you can click fo log intfo and manage the neighbor device through its Web Configurator.

Port This show the number of the neighbor device's port which is connected fo the Switch.

Desc. This shows the description of the neighbor device's port which is connected to the
Switch.

Location This shows the geographic location of the neighbor device. This field will show “-" for

devices that do not support the ZON utility.

Reset to Default

Click the Reset button fo reset the neighbor device to its factory default settings. A
warning message “Are you sure you want to load factory default?” appears prompting
you to confirm the action. After confirming the action a count down button (from 5 to 0)
starts.

Note:

* The Switch must support power sourcing (PSE) or the network device is a powered
device (PD).

* If multiple neighbor devices use the same port, the Reset button is not available.
* You can only reset Zyxel powered devices that support the ZON ufility.
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CHAPTER 8
Basic Setting

8.1 Overview

This chapter describes how to configure the System Info, General Setup, Switch Setup, IP Setup, Port
Setup, PoOE Setup, Interface Setup, IPv6, and Cloud Management screens.

8.1.1 What You Can Do

Use the System Info screen (Section 8.2 on page 84) to check the firmware version number and
monitor the Switch temperature.

Use the General Setup screen (Section 8.3 on page 86) to configure general settings such as the
system name and time.

Use the Switch Setup screen (Section 8.5 on page 89) to choose your VLAN type and assign priorities
to queues.

Use the IP Setup screen (Section 8.6 on page 90) to configure the Switch IP address, default gateway
device, management VLAN ID, and proxy server.

Use the Port Setup screen (Section 8.7 on page 95) to configure Switch port setftings.

Use the PoE Setup screens (Section 8.8 on page 97) to view the current amount of power that PDs are
receiving from the Switch and set the priority levels for the Switch in distributing power to PDs. This
screen is available for POE models only.

Use the Interface Setup screens (Section 8.9 on page 103) to configure Switch interface type and
interface ID settings.

Use the IPv6 screens (Section 8.10 on page 104) to view IPvé status and IPvé configuration.

Use the Cloud Management screen (Section 8.11 on page 117) to display links to Nebula Control
Center Discovery and Nebula Switch Registration screens.

8.2 System Information

In the navigation panel, click Basic Setting > System Info fo display the screen as shown. Use this screen
to view general system information.
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Figure 59 Basic

Setting > System Info
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The following table describes the labels in this screen.

Table 24 Basic Setting > System Info

LABEL

DESCRIPTION

System Name

This field displays the descriptive name of the Switch for identification purposes.

Product Model

This field displays the product model of the Switch. Use this information when searching for
firmware upgrade or looking for other support information in the website.

ZyNOS F/W This field displays the version number of the Switch 's current frmware including the date created.
Version

Ethernet This field refers to the Ethernet MAC (Media Access Conftrol) address of the Switch.

Address

CPU Utilization

CPU utilization quantifies how busy the system is. Current (%) displays the current percentage of
CPU utilization.

Memory Memory utilization shows how much DRAM memory is available and in use. It also displays the
Utilization current percentage of memory utilization.
Name This field displays the name of the memory pool.

Total (byte)

This field displays the total number of bytes in this memory pool.

Used (byte)

This field displays the number of bytes being used in this memory pool.

Utilization
(%)

This field displays the percentage (%) of memory being used in this memory pool.

Hardware Monito

r

Temperature The Switch has temperature sensors that are capable of detecting and reporting if the
Unit temperature rises above the threshold. You may choose the temperature unit (Centigrade or
Fahrenheit) in this field.
Temperature BOARD / MAC and PHY refers to the location of the temperature sensor on the Switch printed
(C/F) circuit board.
Current This shows the current temperature at this sensor.
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Table 24 Basic Setting > System Info (continued)

LABEL DESCRIPTION
MAX This field displays the maximum temperature measured at this sensor.
MIN This field displays the minimum temperature measured at this sensor.
Threshold This field displays the upper temperature limit at this sensor.
Status This field displays Normal for temperatures below the threshold and Error for those above.
FAN Speed A properly functioning fan is an essential component (along with a sufficiently ventilated, cool
(RPM) operating environment) in order for the device fo stay within the temperature threshold. Each
fan has a sensor that is capable of detecting and reporting if the fan speed falls below the
threshold shown.
Current This field displays this fan's current speed in Revolutions Per Minute (RPM).
MAX This field displays this fan's maximum speed measured in Revolutions Per Minute (RPM).
MIN This field displays this fan's minimum speed measured in Revolutions Per Minute (RPM). "<41" is
displayed for speeds too small to measure (under 2000 RPM).
Threshold This field displays the minimum speed at which a normal fan should work.
Status Normal indicates that this fan is functioning above the minimum speed. Error indicates that this
fan is functioning below the minimum speed.
Voltage(V) The power supply for each voltage has a sensor that is capable of detecting and reporting if the
voltage falls out of the tolerance range.
Current This is the current voltage reading.
MAX This field displays the maximum voltage measured at this point.
MIN This field displays the minimum voltage measured at this point.
Threshold This field displays the percentage tolerance of the voltage with which the Switch sfill works.
Status Normal indicates that the voltage is within an acceptable operating range at this point;
otherwise Error is displayed.

8.3 General Setup

Use this screen to configure general settings such as the system name and time. Click Basic Setting >
General Setup in the navigation panel to display the screen as shown.
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Figure 60 Basic Setting > General Setup
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The following table describes the labels in this screen.

Table 25 Basic Setting > General Setup

LABEL

DESCRIPTION

System Name

Choose a descriptive name for identification purposes. This name consists of up to 64 printable
characters; spaces are allowed.

Location

Enter the geographic location of your Switch. You can use up to 128 printable ASCII
characters; spaces are allowed.

Contact Person's
Name

Enfer the name of the person in charge of this Switch. You can use up to 32 printable ASCI
characters; spaces are allowed.

Use Time Server
when Bootup

Enter the time service protocol that your time server uses. Not all time servers support all
protocols, so you may have to use frial and error o find a protocol that works. The main
differences between them are the time format.

When you select the Daytime (RFC 867) format, the Switch displays the day, month, year and
fime with no fime zone adjustment. When you use this format it is recommended that you use a
Daytime timeserver within your geographical fime zone.

Time (RFC-868) format displays a 4-byte integer giving the fotal number of seconds since 1970/
1/1 at 0:0:0.

NTP (RFC-1305) is similar to Time (RFC-868).

None is the default value. Enter the fime manually. Each time you turn on the Switch, the time
and date will be reset to 2020-01-01 0:0:0.

Time Server IP
Address

Enter the IP address or domain name of your timeserver. The Switch searches for the timeserver
for up to 60 seconds.

Time Server Sync
Interval

Enter the period in minutes between each time server synchronization. The Switch checks the
fime server after every synchronization interval.

Current Time

This field displays the time you open this menu (or refresh the menu).

New Time
(hh:min:ss)

Enter the new time in hour, minute and second format. The new time then appears in the
Current Time field after you click Apply.

Current Date

This field displays the date you open this menu.

New Date (yyyy-
mm-dd)

Enter the new date in year, month and day format. The new date then appears in the Current
Date field after you click Apply.
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Table 25 Basic Setting > General Setup (continued)

LABEL DESCRIPTION

Time Zone Select the time difference between UTC (Universal Time Coordinated, formerly known as GMT,
Greenwich Mean Time) and your time zone from the drop-down list box.

Daylight Saving Daylight saving is a period from late spring to early fall when many countries set their clocks
Time ahead of normal local time by one hour to give more daytime light in the evening.

Select this option if you use Daylight Saving Time.

Start Date Configure the day and time when Daylight Saving Time starts if you selected Daylight Saving
Time. The time is displayed in the 24 hour format. Here are a couple of examples:

Daylight Saving Time starts in most parts of the United States on the second Sunday of March.
Each fime zone in the United States starts using Daylight Saving Time at 2 A.M. local time. So in
the United States you would select Second, Sunday, March and 2:00.

Daylight Saving Time starts in the European Union on the last Sunday of March. All of the time
zones in the European Union start using Daylight Saving Time at the same moment (1 AAM. GMT
or UTC). So in the European Union you would select Last, Sunday, March and the last field
depends on your time zone. In Germany for instance, you would select 2:00 because
Germany's fime zone is one hour ahead of GMT or UTC (GMT+1).

End Date Configure the day and time when Daylight Saving Time ends if you selected Daylight Saving
Time. The time field uses the 24 hour format. Here are a couple of examples:

Daylight Saving Time ends in the United States on the first Sunday of November. Each fime
zone in the United States stops using Daylight Saving Time at 2 A.M. local fime. So in the United
States you would select First, Sunday, November and 2:00.

Daylight Saving Time ends in the European Union on the last Sunday of October. All of the time
zones in the European Union stop using Daylight Saving Time at the same moment (1 AAM. GMT
or UTC). So in the European Union you would select Last, Sunday, October and the last field
depends on your fime zone. In Germany for instance, you would select 2:00 because
Germany's fime zone is one hour ahead of GMT or UTC (GMT+1).

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

8.4 Introduction to VLANS

A VLAN (Virtual Local Area Network) allows a physical network fo be partitioned info multiple logical
networks. Devices on a logical network belong to one group. A device can belong fo more than one
group. With VLAN, a device cannot directly talk to or hear from devices that are not in the same groups;
the traffic must first go through a router.

In MTU (Multi-Tenant Unit) applications, VLAN is vital in providing isolation and security among the
subscribers. When properly configured, VLAN prevents one subscriber from accessing the network
resources of another on the same LAN, thus a user will NOT see the printers and hard disks of another
user in the same building.

VLAN also increases network performance by limiting broadcasts to a smaller and more manageable

logical broadcast domain. In tfraditional switched environments, all broadcast packets go to each and
every individual port. With VLAN, all broadcasts are confined to a specific broadcast domain.

Note: VLAN is unidirectional; it only governs outgoing traffic.
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8.5 Switch Setup

Click Basic Setting > Switch Setup in the navigation panel to display the screen as shown. The VLAN
setup screens change depending on whether you choose 802.1Q or Port Based in the VLAN Type field in
this screen.

Figure 61 Basic Setting > Switch Setup
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The following table describes the labels in this screen.

Table 26 Basic Setting > Switch Setup

LABEL DESCRIPTION

VLAN Type Choose 802.1Q or Port Based. The VLAN Setup screen changes depending on whether you
choose 802.1Q VLAN fype or Port Based VLAN type in this screen.

MAC Address Learning

MAC address learning reduces outgoing traffic broadcasts. For MAC address learning to occur on a port, the port
must be active.

Aging Time Enter a time from 10 to 1000000 seconds. This is how long all dynamically learned MAC
addresses remain in the MAC address table before they age out (and must be relearned).

ARP Aging Time

Aging Time Enter a time from 60 to 1000000 seconds. This is how long dynamically learned ARP entries
remain in the ARP table before they age out (and must be relearned). The setting here applies
to ARP enftries which are newly added in the ARP table after you click Apply.

GARP Timer: Switches join VLANs by making a declaration. A declaration is made by issuing a Join message using
GARP. Declarations are withdrawn by issuing a Leave message. A Leave All message terminates all registratfions.
GARP timers set declaration timeout values. See the chapter on VLAN setup for more background information.

Join Timer Join Timer sets the duration of the Join Period timer for GVRP in milliseconds. Each port has a Join
Period timer. The allowed Join Time range is between 100 and 65535 milliseconds; the default is
200 milliseconds. See the chapter on VLAN setup for more background information.

Leave Timer Leave Time sets the duration of the Leave Period timer for GVRP in milliseconds. Each port has a
single Leave Period timer. Leave Time must be two fimes larger than Join Timer; the default is 600
milliseconds.

Leave All Timer Leave All Timer sefs the duration of the Leave All Period timer for GVRP in milliseconds. Each port
has a single Leave All Period fimer. Leave All Timer must be larger than Leave Timer.
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Table 26 Basic Setting > Switch Setup (continued)

LABEL DESCRIPTION

Priority Queue Assignment

|IEEE 802.1p defines up to eight separate traffic types by inserting a tag into a MAC-layer frame that contains bits to
define class of service. Frames without an explicit priority tag are given the default priority of the ingress port. Use
the next fields to configure the priority level-to-physical queue mapping.

The Switch has eight physical queues that you can map to the eight priority levels. On the Switch, traffic assigned to
higher index queues gefs through faster while traffic in lower index queues is dropped if the network is congested.

Priority Level (The following descriptions are based on the traffic types defined in the IEEE 802.1d standard (which
incorporates the 802.1p).

To map a priority level to a physical queue, select a physical queue from the drop-down menu on the right.

Priority 7 Typically used for network conftrol traffic such as router configuration messages.

Priority 6 Typically used for voice traffic that is especially sensitive to jitter (jitter is the variations in delay).

Priority 5 Typically used for video that consumes high bandwidth and is sensitive to jitter.

Priority 4 Typically used for confrolled load, latency-sensitive fraffic such as SNA (Systems Network
Architecture) fransactions.

Priority 3 Typically used for “excellent effort” or better than best effort and would include important
business traffic that can tolerate some delay.

Priority 2 This is for “spare bandwidth™.

Priority 1 This is typically used for non-critical “background” traffic such as bulk transfers that are allowed
but that should not affect other applications and users.

Priority O Typically used for best-effort traffic.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these

changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

8.6 IP Setup

Use the IP Setup screen to configure the default gateway device, the default domain name server and
add IP domains.

The Switch needs an IP address for it to be managed over the network. The factory default IP address is
192.168.1.1. The subnet mask specifies the network number portion of an IP address. The factory default
subnet mask is 255.255.255.0.

You can configure up fo 32 IP domains which are used to access and manage the Switch from the ports
belonging to the pre-defined VLANS.

Note: You must configure a VLAN first. Each VLAN can have multiple management IP
addresses, and you can log info the Switch through different management [P
addresses simultaneously.
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8.6.1 IP Status

Figure 62 Basic Setting > IP Statfus

[ iPSiaius | IP Configuration
172.21.10.1 DHCPv4
IP Interface
1 172.21.40.36 255255.252.0 1 DHCP Renaw Release
2 192.148.1.1 255.255.255.0 1 Static

The following table describes the labels in this screen.

Table 27 Basic Setting > IP Status

LABEL

DESCRIPTION

IP Status

Domain Name
Server

This field displays the IP address of the DNS server.

Source This field displays whether the DNS server address is configured manually (Static) or obtained
automatically using DHCPv4.

IP Interface

Index This field displays the index number of an entry.

IP Address This field displays the IP address of the Switch in the IP domain.

IP Subnet Mask

This field displays the subnet mask of the Switch in the IP domain.

VID

This field displays the VLAN identification number of the IP domain on the Switch.

Type This shows whether this IP address is dynamically assigned from a DHCP server or manually
assigned (Static).

Renew Click this fo renew the dynamic IP address.

Release Click this to release the dynamic IP address.

8.6.2 IP Status Details

Use this screen to view IP status details. Click a number in the Index column in the IP Status screen to
display the screen as shown next.

Figure 63 Basic Setting > IP Setup > IP Status Details: Static

i status
Type Static
VD 1
IP Address 172.21.40.3

IP Subnet Mask

255.255.252.0
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The following table describes the labels in this screen.

Table 28 Basic Setting > IP Setup > IP Status Details: Static

LABEL DESCRIPTION

Type This shows the IP address is manually assigned (Static).

VID This is the VLAN identification number to which an IP routing domain belongs.

IP Address This is the IP address of your Switch in dotted decimal notation for example 192.168.1.1.

IP Subnet Mask

This is the IP subnet mask of your Switch in dotted decimal notation for example 255.255.255.0.

Figure 64 Basic Setting > IP Setup > IP Status Details: DHCP

Renew Time
Rebind Time
Lease Time Start
Lease Time End
Default Gateway
DNS Server

DNS Server

IP Status
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VID ]
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2020-01-02 00:01:24
172.21 43254
172.21.10.1
172.21.5.1

The following table describes the labels in this screen.

Table 29 Basic Setting > IP Setup > IP Status Details: DHCP

LABEL DESCRIPTION

Type This shows the IP address is dynamically assigned from a DHCP server (DHCP).

VID This is the VLAN identification number to which an IP routing domain belongs.

IP Address This is the IP address of your Switch in dotted decimal notation for example 192.168.1.1.

IP Subnet Mask

This is the IP subnet mask of your Switch in dotted decimal notation for example 255.255.255.0.

Lease Time

This displays the length of time in seconds that this interface can use the current dynamic IP
address from the DHCP server.

Renew Time

This displays the length of time from the lease start that the Switch will request fo renew its
current dynamic IP address from the DHCP server.

Rebind Time

This displays the length of fime from the lease start that the Switch will request to get any
dynamic IP address from the DHCP server.

Lease Time Start

This displays the date and time that the current dynamic IP address assignment from the DHCP
server began. You should configure date and time in Basic Setting > General Setup.

Lease Time End

This displays the date and time that the current dynamic IP address assignment from the DHCP
server will end. You should configure date and time in Basic Setting > General Setup.

Default This displays the IP address of the default gateway assigned by the DHCP server. 0.0.0.0 means
Gateway no gateway is assighed.
DNS Server This displays the IP address of the primary and secondary DNS servers assigned by the DHCP

server. 0.0.0.0 means no DNS server is assigned.

8.6.3 IP Configuration

Use this screen to configure the default gateway device, the default domain name server and add IP

domains.
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Figure 65 Basic Setting > IP Setup > IP Configuration

Default Gateway
Domain Name Server |1

Domain Name Server 2
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® DHCP Client
O static IP Address
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IP Subnet Mask 0.0.0.0

The following tab

le describes the labels in this screen.

Table 30 Basic Setting > IP Setup > IP Configuration

LABEL DESCRIPTION
Default Type the IP address of the default outgoing gateway in dotted decimal notation, for example
Gateway 192.168.1.254.

Domain Name

Enter a domain name server IPv4 address in order to be able to use a domain name instead of

Server 1/2 an IP address.

Apply Click Apply to save your changes fo the Switch’s run-time memory. The Switch loses these
changes ifitis furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

IP Interface

Use these fields to

create or edit IP routing domains on the Switch.

DHCP Client | Select this option if you have a DHCP server that can assign the Switch an IP address, subnet
mask, a default gateway IP address and a domain name server IP address automatically.

Stafic IP Select this option if you do not have a DHCP server or if you wish to assign static IP address

Address information to the Switch. You need to fill in the following fields when you select this option.

IP Address Enter the IP address of your Switch in dotted decimal notation, for example, 192.168.1.1. This is
the IP address of the Switch in an IP routing domain.

IP Subnet Enter the IP subnet mask of an IP routing domain in dotted decimal notation, for example,

Mask 255.255.255.0.

VID Enter the VLAN identification number to which an IP routing domain belongs.

Add Click this to create a new entry.

This saves your changes fo the Switch’s run-time memory. The Switch loses these changes if it is
turned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

XS1930 Series User's Guide

93




Chapter 8 Basic Sefting

Table 30 Basic Setfting > IP Setup > IP Configuration (continued)

LABEL DESCRIPTION
Cancel Click Cancel to reset the fields to your previous configuration.
Index This field displays the index number of an entry.
IP Address This field displays the IP address of the Switch in the IP domain.
IP Subnet Mask This field displays the subnet mask of the Switch in the IP domain.
VID This field displays the VLAN identification number of the IP domain on the Switch.
Type This field displays the type of IP address status.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Note: Deleting all IP subnets locks you out of the Switch.

Cancel Click Cancel to clear the check boxes.

8.6.4 Network Proxy Configuration

The proxy server of an organization may prohibit communication between the Switch and NCC (Nebula
Confrol Center) (Section 8.11 on page 117). Use this screen to enable communication between the
Switch and NCC through the proxy server.

Figure 66 Network Proxy Configuration Application

Proxy

NCC
N2

o —) SN

As of this writing, this setting only allows communication between the Switch and the NCC.

Figure 67 Basic Setting > IP Setup > IP Configuration > Network Proxy Configuration

Network Proxy Configuration IP Configurafion
Active O
Server
Port
Avuthentication O
Username
Password
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The following table describes the labels in this screen.

Table 31 Basic Setting > IP Setup > IP Configuration > Network Proxy Configuration

LABEL DESCRIPTION

Active Select this option fo enable communication between the Switch and NCC through a proxy
server.

Server Enter the IP address (dofted decimal notation) or host name of the proxy server. When entering
the host name, up to 128 alphanumeric characters are allowed for the Server except [2]. [ | ].
['Lor["]

Port Enter the port number of the proxy server (1 — 65535).

Authentication Select this option to enable proxy server authentication using a Username and Password.

Username Enter a login user name from the proxy server administrator. Up to 32 alphanumeric characters
are allowed for the Username except [2], [ | ].['].or ["].

Password Enter a login password from the proxy server administrator. Up to 32 alphanumeric characters
are allowed for the Password except [¢ ], [ | ].['].or ["].

Apply Click Apply to save your changes to the Switch’s run-fime memory. The Switch loses these

changes if it is furned off or loses power, so use the Save link on the fop navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

8.7 Port Setup

Use this screen to configure Switch port settings. Click Basic Setting > Port Setup in the navigation panel
to display the configuration screen.

Figure 68 Basic Setting > Port Setup
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The following table describes the labels in this screen.

Table 32 Basic Setting > Port Setup

LABEL

DESCRIPTION

Port

This is the port index number.

*

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first fo set
the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Active

Select this check box to enable a port. The factory default for all ports is enabled. A port must
be enabled for data fransmission fo occur.

Name

Type a descriptive name that identifies this port. You can enter up to 128 ASCII characters
except[¢L [ |1 ["]or["].

Note: Due to space limitations, the port name may be fruncated in some Web
Configurator screens.

Speed/Duplex

Select the speed and the duplex mode of the Ethernet connection on this port. The choices are
Auto, Auto-1G, 100-an (100M/auto-negotiation), 2.5G / Full Duplex, 5G / Full Duplex, and 100M /
Full Duplex for a 100Base-T connection. 1G / Full Duplex is supported by both 1000Base-T and
1000Base-X connections. 10G / Full Duplex is supported by the 10 Gigabit Ethernet connections
on the Switch that has a 10 Gigabit interface.

Selecting Auto-1G or Auto (auto-negotiation) allows one port to negotiate with a peer port
automatically to obtain the connection speed and duplex mode that both ends support. When
auto-negotiation is furned on, a port on the Switch negotiates with the peer automatically to
determine the connection speed and duplex mode. If the peer port does not support auto-
negotiation or furns off this feature, the Switch determines the connection speed by detecting
the signal on the cable and using half duplex mode. When the Switch's auto-negotiation is
turned off, a port uses the pre-configured speed and duplex mode when making a connection,
thus requiring you to make sure that the settings of the peer port are the same in order to
connect.

Flow Control

A concentration of fraffic on a port decreases port bandwidth and overflows buffer memory
causing packet discards and frame losses. Flow Control is used to regulate fransmission of signals
to match the bandwidth of the receiving port.

The Switch uses IEEE 802.3x flow control in full duplex mode and backpressure flow confrolin half
duplex mode.

IEEE 802.3x flow confrol is used in full duplex mode to send a pause signal to the sending port,
causing it to temporarily stop sending signals when the receiving port memory buffers fill.

Back Pressure flow confrol is typically used in half duplex mode to send a "collision” signal to the
sending port (mimicking a state of packet collision) causing the sending port to temporarily stop
sending signals and resend later. Select Flow Control to enable it.

802.1p Priority

This priority value is added to incoming frames without a (802.1p) priority queue tag.

Media Type

You can insert either an SFP+ transceiver or an SFP+ Direct Attach Copper (DAC) cable into the
10 Gigabit interface of the Switch.

Select the media type (sfp_plus or dac10g) of the SFP+ module that is attached to the 10
Gigabit interface.

Apply

Click Apply to save your changes o the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel fo save
your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.
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8.8 POE Status

Note: The following screens are available for the PoE model only.
The PoE models supports the IEEE 802.3bt High Power over Ethernet (PoE) standard.

A powered device (PD) is a device such as an access point or a switch, that supports PoE (Power over
Ethernet) so that it can receive power from another device through an Ethernet port.

In the figure below, the IP camera and IP phone get their power directly from the Switch. Aside from
minimizing the need for cables and wires, POE removes the hassle of trying to find a nearby electric
outlet to power up devices.

Figure 69 Powered Device Examples

You can also set priorities so that the Switch is able to reserve and allocate power to certain PDs.

Note: The PoE (Power over Ethernet) devices that supply or receive power and their
connected Ethernet cables must all be completely indoors.

To view the current amount of power that PDs are receiving from the Switch, click Basic Setting > PoE
Setup.

Figure 70 Basic Setting > PoE Statfus
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95

Consuming Power (W) 0.0
Allocated Power (W) FA
Remaining Power (W) 40.0

m PoE Time Range Setup PoE Setup
PoE Mode Consumption
Total Power (W] 40.0
PoE Usage (%) W]

1 Enable 0 Low 802.3bt 0.0 0.0
2 Enable 0 Low 802.3bt 0.0 0.0
3 Enable 0 Low 802 .3at 00 0
Lo
5 80>t 0.0

XS1930 Series User's Guide

97




Chapter 8 Basic Setting

The following table describes the labels in this screen.

Table 33 Basic Setting > PoE Status

LABEL

DESCRIPTION

PoE Mode

This field displays the power management mode used by the Switch, whether it is in
Classification or Consumption mode.

Total Power (W)

This field displays the total power the Switch can provide to the connected PoE-enabled
devices on the PoE ports.

PoE Usage (%)

This field displays the amount of power currently being supplied to connected PoE devices (PDs)
as a percentage of the total POE power the Switch can supply.

When PoE usage reaches 100%, the Switch will shut down PDs one-by-one according to the PD
priority which you configured in Basic Setting > PoE Setup.

PoE Usage
Threshold (%)

This field displays the percentage of PoE usage. The Switch will generate a tfrap and/or a log
when the usage exceeds the specified threshold.

Consuming
Power (W)

This field displays the amount of power the Switch is currently supplying to the connected PoE-
enabled devices.

Allocated Power
(W)

This field displays the fotal amount of power the Switch (in classification mode) has reserved for
PoE affer negotiating with the connected PoE devices. It shows NA when the Switch is in
consumption mode.

Consuming Power (W) can be less than or equal but not more than the Allocated Power (W).

Remaining
Power (W)

This field displays the amount of power the Switch can still provide for PoOE.

Note: The Switch must have at least 16 W of remaining power in order to supply
power to a PoE device, even if the PoE device needs less than 16 W.

Port

This is the port index number.

State

This field shows which ports can receive power from the Switch.

* Disable - The PD connected to this port cannot get power supply.
* Enable - The PD connected to this port can receive power.

Class

This shows the power classification of the PD. Each PD has a specified maximum power that fall
under one of the classes.

The Class is a number from 0 to 6, where each value represents the range of power that the
Switch provides to the PD. The power ranges in POE standards are as follows.

¢ Class 0 -default: 0.44 W to 15.4 W.
e Class 1-default: 0.44 W to 4 W.

e Class 2-default: 0.44 W to 7 W.

e Class 3—-default: 0.44 W to 15.4 W.
e Class 4 — default: 0.44 W to 30 W.

¢ Class 5-default: 0.44 W fo 45 W.

e Class 6 — default: 0.44 W to 60 W.

Note: You can extend or set a limit on the maximum power the connected PD can
use on a port in Basic Setting > PoE Setup > PoE Setup.

Priority

When the total power requested by the PDs exceeds the total POE power budget on the Switch,
you can set the priority to allow the Switch to provide power to ports with higher priority first.

e Critical has the highest priority.
¢ High has the Switch assign power to the port after all critical priority ports are served.

¢ Low has the Switch assign power to the port after all critical and high priority ports are
served.

Power-Up

This field displays the PoE standard the Switch uses to provide power on this port.

Consuming
Power (W)

This field displays the current amount of power consumed by the PD from the Switch on this port.
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Table 33 Basic Setting > PoE Status (continued)

LABEL

DESCRIPTION

Max Power (W)

This field displays the maximum amount of power the PD could use from the Switch on this port.

Time-Range
State

This field shows whether or not the port currently receives power from the Switch according to its
schedule.

e Itshows “In" followed by the time range name if PoE is currently enabled on the port.
e |t shows “Out” if PoE is currently disabled on the port.
¢ It shows “~" if no schedule is applied to the port. PoE is enabled by default.

8.8.1 PoE Time Range Setup

Use this screen to apply a schedule to the ports on the Switch. You must first configure a schedule in the
Advanced Application > Time Range screen.

Click the PoE Time Range Setup link in the Basic Setting > PoE Status screen. The following screen opens.

Figure 71 Basic Setting > PoE Setup > PoE Time Range Setup

PoE Time Range Setup PoE Status|
Port
Time Ronge

%% len e Je by |—

The following table describes the labels in this screen.

Table 34 Basic Setting > PoE Setup > PoE Time Range Setup

LABEL DESCRIPTION

Port Enter the number of the port to which you want to apply a schedule.

Time Range This field displays the name of the schedule that you have created using the Advanced
Application > Time Range screen.
Select a pre-defined schedule to control when the Switch enables PoE to provide power on the
port. To select more than one schedule, press [SHIFT] and select the choices at the same time.

Apply Click Apply to save your changes fo the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Clear Click Clear to clear the fields to the factory defaults.
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Table 34 Basic Setfting > PoE Setup > PoE Time Range Setup (continued)

LABEL

DESCRIPTION

Port

This field displays the index number of the port. Click a port number to change the schedule
settings.

Time Range
Profiles

This field displays the name of the schedule which is applied fo the port.

PoE is enabled at the specified time or date.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row fo select all entries.

Delete

Check the rules that you want to remove and then click the Delete button.

Cancel

Click Cancel to clear the selected check boxes.

8.8.2 PoOE Setup

Use this screen to set the PoE power management mode, priority levels, power-up mode and the
maximum amount of power for the connected PDs.

Click the PoE Setup link in the Basic Setting > PoE Status screen. The following screen opens.

Figure 72 Basic Setting > PoE Setup

PoE Status
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7 [low ~]| [z02.30t v | | O
8 [Low ~| [s02.30f v | | O
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The following table describes the labels in this screen.

Table 35 Basic Setting > PoE Setup

Threshold (%)

LABEL DESCRIPTION
PoE Mode Select the power management mode you want the Switch fo use.

¢ Classification — Select this if you want the Switch to reserve the maximum power for each PD
according to the PD’s power class and priority level. If the total power supply runs out, PDs
with lower priority do not get power to function. In this mode, the maximum power is reserved
based on what you configure in Max Power or the standard power limit for each class.

e Consumption — Select this if you want the Switch to supply the actual power that the PD
needs. The Switch also allocates power based on a port's Max Power and the PD’s power
class and priority level. The Switch puts a limit on the maximum amount of power the PD can
request and use. In this mode, the default maximum power that can be delivered to the PD is
33 W (IEEE 802.3at Class 4) or 22 W (IEEE 802.3af Classes 0 to 3).

Pre-Allocate Select this to have the Switch pre-allocate power to each port based on the classification of the

PD device.

Power Up Select this to allow PoE ports to be powered up one-by-one randomly or clear to allow them all to
Sequence be powered up at the same fime.

Delay

PoE Usage Enter a number ranging from 1 to 99 to set the threshold. The Switch will generate a trap and/or

log when the actual PoE usage is higher than the specified threshold.

Port

This is the port index number.

*

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Changes in this row are copied to all the ports as soon as you make them.

Active Select this to provide power to a PD connected to the port.
If left unchecked, the PD connected to the port cannot receive power from the Switch.
Priority When the total power requested by the PDs exceeds the total POE power budget on the Switch,

you can set the PD priority to allow the Switch to provide power to ports with higher priority.
Select Critical to give the highest PD priority on the port.

Select High to set the Switch to assign the remaining power to the port after all critical priority
ports are served.

Select Low fo set the Switch fo assign the remaining power to the port after all critical and high
priority ports are served.
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Table 35 Basic Setting > PoE Setup (confinued)

LABEL

DESCRIPTION

Power-Up

Set how the Switch provides power to a connected PD at power-up.

802.3af - the Switch follows the IEEE 802.3af Power over Ethernet standard fo supply power to the
connected PDs during power-up.

Legacy - the Swifch can provide power to the connected PDs that require high inrush currents at
power-up. Inrush current is the maximum, instantaneous input current drawn by the PD when first
furned on.

Pre-802.3at — the Switch initially offers power on the port according to the IEEE 802.3af standard,
and then switches to support the IEEE 802.3at standard within 75 milliseconds after a PD is
connected to the port. Select this option if the Switch is performing 2-event Layer-1 classification
(PoE+ hardware classification) or the connected PD is NOT performing Layer 2 power
classification using Link Layer Discovery Protocol (LLDP).

802.3at - the Switch supports the IEEE 802.3at High Power over Ethernet standard and can supply
power of up to 30W per Ethernet port. IEEE 802.3at is also known as PoE+ or PoE Plus. An IEEE
802.3at compatible device is referred to as Type 2. Power Class 4 (High Power) can only be used
by Type 2 devices. If the connected PD requires a Class 4 current when it is turned on, it will be
powered up in this mode.

Force-802.3at — the Switch offers power of up to 33 W on the port without performing PoE
hardware classification. Select this option if the connected PD does not comply with any PoE
standard and requests power higher than a standard power limit.

Pre-802.3bt — the Switch offers power on the port according to the IEEE 802.3bt standard. Select
this option if the connected PD was developed before the IEEE 802.3bt standard is implemented
but requires power between 33 W and 60 W. |EEE 802.3bt is also known as PoE++ or PoE Plus Plus.

802.3bt — the Switch supports the IEEE 802.3bt standard and can supply power of up to 60 W per
Ethernet port to the connected PDs at power-up.

Max Power
(mWw)

Specify the maximum amount of power the PD could use from the Switch on this port. If you leave
this field blank, the Switch refers to the standard or default maximum power for each class.

Note: The setting you enter here will NOT take effect when the power-up mode is setf to
802.3bt.

Wide Range
Detection

Select this to let the Switch have a wider detection range for the PD.

The Switch detects whether a connected device is a powered device or not before supplying
power to the port. For the PD detection, the Switch applies a fixed voltage to the device and
then receives returned current. If the returned current is within the IEEE 802.3af/at standard range,
the device will be considered as a valid PD by the Switch.

However, in real cases, environmental interferences might easily cause the returned current to be
out of the standard range.

LLDP Power Via
MDI

Select this to have the Switch negotiate PoOE power with the PD connected to the port by
fransmitting LLDP Power Via MDI TLV frames. This helps the Switch allocate less power to the PD on
this port. The connected PD must be able to request PoE power through LLDP.

The Power Via MDI TLV allows PoE devices to advertise and discover the MDI power support
capabilities of the sending port on the remote device.

e Port Class

¢ MDI Supported

¢ MDI Enabled

e Pair Conftrollable
e PSE Power Pairs
¢ Power Class
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Table 35 Basic Setting > PoE Setup (confinued)

LABEL DESCRIPTION

Apply Click Apply to save your changes o the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

8.9 Interface Setup

An IPvé6 address is configured on a per-interface basis. The interface can be a physical interface (for
example, an Ethernet port) or a virtual interface (for example, a VLAN). The Switch supports the VLAN
interface type for IPvé at the time of writing.

Use this screen to set IPvé interfaces on which you can configure an IPvé address to access and
manage the Switch.

Click Basic Setting > Interface Setup in the navigation panel to display the configuration screen.

Figure 73 Basic Setting > Interface Setup

Interfoce Type

Interface ID

m Cancel

o

VLAN 1 VLANI

Delete | Cancel

The following table describes the labels in this screen.

Table 36 Basic Setting > Interface Setup

LABEL

DESCRIPTION

Interface Type

Select the type of IPvé interface for which you want to configure. The Switch supports the VLAN
interface type for IPvé at the time of writing.

Interface ID

Specify a unique identification number (from 1 to 4094) for the interface.

To have IPvé function properly, you should configure a static VLAN with the same ID number in the
Advanced Application > VLAN screens.

Add

Click this to creafte a new enfry.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
turned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to reset the fields to your previous configuration.

Index

This field displays the index number of an entry.

Interface Type

This field displays the type of interface.

Interface ID

This field displays the identification number of the interface.

XS1930 Series User's Guide

103




Chapter 8 Basic Setting

Table 36 Basic Setting > Interface Setup (confinued)

LABEL DESCRIPTION

Interface This field displays the interface’s descriptive name which is generated automatically by the
Switch. The name is from a combination of the interface type and ID number.
Select an entry’s check box to select a specific entfry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel fo clear the check boxes.

8.10 IPv6

Use this screen to view the IPvé interface status and configure the Switch's management IPvé addresses.

8.10.1 IPv6 Status

Click Basic Setting > IPv6 in the navigation panel to display the IPvé status screen as shown next.

Figure 74 Basic Setting > IPvé

IPvé Table

1

| iPvéSialus | IPv6 Configuration

VLANI Yes

The following table describes the labels in this screen.

Table 37 Basic Setting > IPvé

LABEL DESCRIPTION

IPvé Status

Domain Name | This field displays the IP address of the DNS server.

Server

Source This field displays whether the DNS server address is configured manually (Static) or obfained
automatically using DHCPv6.

IPvé Table

Index This field displays the index number of an IPvé interface. Click on an index number to view more
interface details.

Interface This is the name of the IPvé interface you created.

Active This field displays whether the IPvé interface is activated or not.

8.10.2 IPv6 Interface Status

Use this screen to view a specific IPvé interface status and detailed information. Click an interface index
number in the Basic Setting > IPv6 screen. The following screen opens.
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Figure 75 Basic Setting > IPvé > IPvé Interface Status

IPvé Interface Status IPvé Status

Interface: VLANI

IPvé Active enable

MTU Size 1500

ICMPvé Rate Limit Bucket Size 100

ICMPvé Rate Limit Error Interval 1000

Link Local Address fell::219:coff-fel1:b0d/é4 [prefered]

Global Unicost Address(es)
ffo2::2
ff01::1

Joined Group Address|es) 021

i02::1:Ff01:0d
ND DAD Acfive enable
Mumber of DAD Attermpts 1
MS-Interval [millisecond) 1000

MND Reachable Time (millsecond) 30000

DHCPvé Client Active Yes
1A Type 1 A-FA
1AID 11
Tl 0
T2 0
Identity Association State
SID
Address
Prefered Lifetime 0
Valid Lifetime 0
DMS

Domain List

Restart DHCPvé Client

The following table describes the labels in this screen.

Table 38 Basic Setting > IPvé > IPvé Interface Status

LABEL DESCRIPTION

IPvé6 Active This field displays whether the IPvé interface is activated or not.

MTU Size This field displays the Maximum Transmission Unit (MTU) size for IPvé packets on this inferface.
ICMPvé6 Rate This field displays the maximum number of ICMPvé error messages which are allowed o fransmit
Limit Bucket in a given fime interval. If the bucket is full, subsequent error messages are suppressed.

Size

ICMPV6 Rate This field displays the fime period (in milliseconds) during which ICMPvé error messages of up to

Limit Error the bucket size can be transmitted. 0 means no limit.

Interval

Link Local This field displays the Switch’s link-local IP address and prefix generated by the interface. It also
Address shows whether the IP address is preferred, which means it is a valid address and can be used as a

sender or receiver address.

Global Unicast | This field displays the Switch’s global unicast address to identify this interface.
Address(es)

Joined Group | This field displays the IPvé multicast addresses of groups the Switch’s interface joins.
Address(es)
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Table 38 Basic Setting > IPvé > IPvé Interface Status (continued)

LABEL

DESCRIPTION

ND DAD Active

This field displays whether Neighbor Discovery (ND) Duplicate Address Detection (DAD) is
enabled on the interface.

Number of
DAD Attempts

This field displays the number of consecutive neighbor solicitations the Switch sends for this
interface.

NS-Interval This field displays the time interval (in milliseconds) at which neighbor solicitations are re-sent for
(millisecond) this interface.

ND Reachable | This field displays how long (in milliseconds) a neighbor is considered reachabile for this interface.
Time

(millisecond)

DHCPvé Client
Active

This field displays whether the Switch acts as a DHCPvé client fo get an IPvé address from a
DHCPvé server.

DHCPvé Client

Identity An Identity Association (IA) is a collection of addresses assigned to a DHCP client, through which
Associafion the server and client can manage a set of related IP addresses. Each IA must be associated with
exactly one interface.

A Type The IA type is the type of address in the IA. Each IA holds one type of address. IA_NA means an
identity association for non-temporary addresses and IA_TA is an identity association for
temporary addresses.

IAID Each IA consists of a unique IAID and associated IP information.

T This field displays the DHCPvé6 T1 timer. After T1, the Switch sends the DHCPvé server a Renew
message.

An IA_NA option contains the T1 and T2 fields, but an IA_TA option does not. The DHCPvé6 server
uses T1 and T2 to control the time at which the client contacts with the server to extend the
lifetimes on any addresses in the IA_NA before the lifetimes expire.

T2 This field displays the DHCPvé T2 timer. If the time T2 is reached and the server does not respond,
the Switch sends a Rebind message to any available server.

State This field displays the state of the TA. It shows
Active when the Switch obtains addresses from a DHCpvé server and the TA is created.

Renew when the TA's address lifetime expires and the Switch sends out a Renew message.
Rebind when the Switch does not receive a response from the original DHCPvé server and sends
out a Rebind message to another DHCPvé server.

SID This field displays the DHCPvé server's unique ID.

Address This field displays the Switch’s global address which is assigned by the DHCPvé6 server.

Preferred This field displays how long (in seconds) that the global address remains preferred.

Lifetime

Valid This field displays how long (in seconds) that the global address is valid.

Lifetime

DNS This field displays the DNS server address assigned by the DHCPvé server.

Domain List This field displays the address record when the Switch queries the DNS server to resolve domain
names.

Restart Click Click Here to send a new DHCP request to the DHCPvé server and update the IPvé address

and DNS information for this interface.

8.10.3 IPv6 Configuration

Use this screen to configure IPvé settings on the Switch. Click the IPv6 Configuration link in the Basic
Setting > IPv6 screen. The following screen opens.
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Figure 76 Basic Setting > IPvé > IPvé Configuration

IPvé Global Setup

IPvé Interface Setup

IPvé Addressing

IPvé Meighbor Discovery

IPvé Meighbor Setup
DHCPwé Client Setup

1Pvé Status
Click Hers
Click Hers
IPvé Link-Local Address Setup Click Here
IPvé Global Address Setup Click Here
IPvé Meighbor Discovery Setup Click Here
|IPvé Router Discovery Setup Click Here
IPvé Prefix Setup Click Here
Click Hers
Click Hers

The following table describes the labels in this screen.

Table 39 Basic Setting > IPvé > IPvé Configuration

LABEL

DESCRIPTION

IPvé6 Global Setup

Click the link to go to a screen where you can configure the global IPvé settings on the
Switch.

IPvé Interface Setup

Click the link to go fo a screen where you can enable an IPvé interface on the Switch.

IPvé Addressing
IPvé6 Link-Local Click the link to go to a screen where you can configure the IPvé link-local address for an
Address Setup interface.
IPvé Global Click the link fo go to a screen where you can configure the IPvé global address for an
Address Setup interface.

IPvé Neighbor

Discovery

IPvé Neighbor
Discovery Sefup

Click the link fo go to a screen where you can configure the IPvé neighbor discovery
settings.

IPvé Router
Discovery Sefup

Click the link to go to a screen where you can configure the IPvé router discovery settings.

IPvé Prefix Setup

Click the link to go to a screen where you can configure the Switch’s IPvé prefix list.

IPv6 Neighbor Setup

Click the link to go to a screen where you can create a static IPvé neighbor enfry in the
Switch's IPvé neighbor table.

DHCPvé Client Setup

Click the link to go to a screen where you can configure the Switch DHCPvé client setftings.

8.10.4 IPv6 Global Setup

Use this screen to configure the global IPvé settings. Click the link next to IPv6 Global Setup in the IPv6

Configuration screen

to display the screen as shown next.

Figure 77 Basic Setting > IPvé > IPvé Configuration > IPvé Global Setup

IPvé Global Setup IPvé Configuration
IPvé Hop Limit &4
ICMPvé Rate Limit Bucket Size 100
ICMPvé Rate Limit Error Interval 1000 miliseconds
==
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The following table describes the labels in this screen.

Table 40 Basic Setting > IPvé > IPvé Configuration > IPvé Global Setup

LABEL DESCRIPTION

IPvé Hop Limit | Specify the maximum number of hops (from 1 to 255) in router advertisements. This is the
maximum number of hops on which an IPvé packet is allowed to fransmit before it is discarded by
an IPvé router, which is similar to the TTL field in IPv4.

ICMPvé6 Rate Specify the maximum number of ICMPVé error messages (from 1 to 200) which are allowed to

Limit Bucket fransmit in a given time interval. If the bucket is full, subsequent error messages are suppressed.

Size

ICMPvé6 Rate Specify the time period (from 0 to 2147483647 milliseconds) during which ICMPvé error messages

Limit Error of up to the bucket size can be fransmitted. 0 means no limit.

Interval

Apply Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

8.10.5 IPv6 Interface Setup

Use this screen to turn on or off an IPvé interface. Click the link next to IPv6 Interface Setup in the IPv6
Configuration screen to display the screen as shown next.

Figure 78 Basic Setting > IPvé > IPvé Configuration > IPvé Interface Setup

IPvé Interface Setup IPvé Configuration
Interface
Active

VLANI fes

The following table describes the labels in this screen.

Table 41 Basic Setting > IPvé > IPvé Configuration > IPvé Interface Setup

LABEL DESCRIPTION

Interface Select the IPvé interface you want to configure.

Active Select this option to enable the interface.

Apply Click Apply to save your changes to the Switch'’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the settings.

Interface This is the name of the IPvé interface you created.

Active This field displays whether the IPvé interface is activated or not.
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8.10.6 IPv6 Link-Local Address Setup

A link-local address uniquely identifies a device on the local network (the LAN). It is similar to a “private IP
address” in IPv4. You can have the same link-local address on multiple interfaces on a device. A link-
local unicast address has a predefined prefix of fe80::/10.

Use this screen to configure the interface’s link-local address and default gateway. Click the link next to
IPv6 Link-Local Address Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 79 Basic Setting > IPvé > IPvé Configuration > IPvé Link-Local Address Setup

Link-Local Address

Default Gateway

1 VLANI

IPvé Link-Local Address Sefup IPvé Configuration
Interface VLANT ~

[ Aoply | Concel | Cleor

The following table describes the labels in this screen.

Table 42 Basic Setting > IPvé > IPvé Configuration > IPvé Link-Local Address Setup

LABEL DESCRIPTION

Interface Select the IPvé interface you want to configure.

Link-Local Manually configure a static IPvé link-local address for the interface.

Address

Default Set the default gateway IPvé address for the interface. When an interface cannot find a routing

Gateway information for a frame’s destination, it forwards the packet to the default gateway.

Apply Click Apply to save your changes to the Switch'’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear fo reset the fields to the factory defaults.

Index This is the interface index number. Click an index number to change the setftings.

Interface This is the name of the IPvé interface you created.

IPvé Link-Local | This is the static IPvé link-local address for the interface.

Address

IPvé6 Default This is the default gateway IPvé address for the interface.

Gateway

8.10.7 IPv6 Global Address Setup

Use this screen to configure the interface’s IPvé global address. Click the link next to IPvé Global Address
Setup in the IPv6 Configuration screen to display the screen as shown next.
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Figure 80 Basic Setting > IPvé > IPvé Configuration > IPvé Global Address Setup

IPvé Global Address Setup

Domain Name Server 1

Domain Name Server 2

IPvé Global Address Setup

Interface

IPvé Global Address

Prefix Length

IPvé Configuration

O eurs4
]

Delete | Cancel

The following table describes the labels in this screen.

Table 43 Basic Setting > IPvé > IPvé Configuration > IPvé Global Address Setup

LABEL DESCRIPTION

Domain Name | Enfer a domain name server IPvé address in order to be able to use a domain name instead of an

Server 1/2 IP address.

Apply Click Apply to save your changes to the Switch'’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the Domain Name Server values in this screen to their last-saved values.

Interface Select the IPvé interface you want to configure.

IPvé6 Global Manually configure a static IPvé global address for the interface.

Address

Prefix Length

Specify an IPvé prefix length that specifies how many most significant bits (start from the left) in
the address compose the network address.

EUI-64 Select this option to have the interface ID be generated automatically using the EUI-64 format.

Add Click this to create a new entry.
This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
turned off or loses power, so use the Save link on the top navigation panel fo save your changes
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click an index number to change the settings.

Interface This is the name of the IPvé interface you created.

IPvé Global This field displays the IPvé global address and prefix length for the interface.

Address/Prefix

Length

EUI-64 This shows whether the interface ID of the global address is generated using the EUI-64 format.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.
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Table 43 Basic Setting > IPvé > IPvé Configuration > IPvé Global Address Setup (confinued)

LABEL DESCRIPTION

Delete Check the entries that you want to remove and then click Delete to remove the selected entries
from the summary table.

Cancel Click Cancel to clear the check boxes.

8.10.8 IPv6 Neighbor Discovery Setup

Use this screen to configure neighbor discovery settings for each interface. Click the link next to IPv6
Neighbor Discovery Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 81 Basic Setting > IPvé > IPvé Configuration > IPvé Neighbor Discovery Setup

IPvé Neighbor Discovery Sefup IPvé Configuration
Interface WLAMNT ~
DAD Atternpts 1
N5 Interval 1000 milliseconds
Reachable Time 30000 milliseconds
==
1 WVLANI 1 1000 30000

The following table describes the labels in this screen.

Table 44 Basic Setting > IPvé > IPvé Configuration > IPvé Neighbor Discovery Setup

LABEL

DESCRIPTION

Interface

Select the IPvé interface you want to configure.

DAD Attempts

The Switch uses Duplicate Address Detection (DAD) with neighbor solicitation and advertisement
messages to check whether an IPvé address is already in use before assigning it fo an interface.

Specify the number of consecutive neighbor solicitations (from 0 to 600) the Switch sends for this
interface. Enter O to turn off DAD.

NS Interval Specify the time interval (from 1000 to 3600000 milliseconds) at which neighbor solicitations are re-
sent for this interface.

Reachable Specify how long (from 1000 to 3600000 milliseconds) a neighbor is considered reachable for this

Time interface.

Apply Click Apply to save your changes fo the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click on an index number to change the seftings.

Interface This is the name of the IPvé interface you created.

DAD Attempts

This field displays the number of consecutive neighbor solicitations the Switch sends for this
inferface.
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Table 44 Basic Setting > IPvé > IPvé Configuration > IPvé Neighbor Discovery Setup (confinued)

LABEL DESCRIPTION

NS Interval This field displays the fime interval (in milliseconds) at which neighbor solicitations are re-sent for
this interface.

Reachable This field displays how long (in milliseconds) a neighbor is considered reachable for this interface.

Time

8.10.9 IPv6 Router Discovery Setup

Use this screen to configure router discovery settings for each interface. Click the link next to IPvé Router
Discovery Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 82 Basic Setting > IPvé > IPvé Configuration > IPvé Router Discovery Setup

IPvé Router Discovery Selup IPvé Configuration

Interface VELAMIZZ Y

Managed Config Flag

Flags

Other Config Flag
Minimum Interval 200 seconds
Maximum Interval &00 seconds
Lifetime 1800 seconds
Suppress

Firy P bl
0 800 lo

=]
=
=]
o
s

1 WLAM123

The following table describes the labels in this screen.

Table 45 Basic Setting > IPvé > IPvé Configuration > IPvé Router Discovery Setup

LABEL DESCRIPTION
Interface Select the IPvé inferface you want to configure.
Flags Select the Managed Config Flag option to have the Switch set the “managed address

configuration” flag (the M flag) to 1 in IPvé router advertisements, which means IPvé hosts
use DHCPvé to obtain IPvé stateful addresses. De-select the option fo set the flag to 0 and
the host will not use DHCPvé6 to obtain IPvé stateful addresses.

Select the Other Config Flag option to have the Switch set the "Other stateful
configuration” flag (the O flag) to 1 in IPvé router advertisements, which means IPvé hosts
use DHCPvé to obtain additional configuration settings, such as DNS information. De-select
the option to set the flag to 0 and the host will not use DHCPvé fo obtain additional
configuration seftings.

Minimum Interval Specify the minimum time interval (from 3 to 1350 seconds) at which the Switch sends
router advertisements for this interface.

Note: The minimum time interval cannot be greater than three-quarters of the
maximum time interval.

Maximum Interval Specify the maximum time interval (from 4 to 1800 seconds) at which the Switch sends
router advertisements for this interface.
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Table 45 Basic Setting > IPvé > IPvé Configuration > IPvé Router Discovery Setup (continued)

LABEL DESCRIPTION

Lifetime Specify how long (from 0 to 000 seconds) the router in router advertisements can be used
as a default router for this interface.

Suppress Select this option o set the Switch to not send router advertisements and responses to
router solicitations on this interface.

Apply Click Apply fo save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click an index number to change the setftings.

Interface This is the name of the IPvé interface you created.

Flags This field displays whether IPvé hosts use DHCPvé to obtain IPvé stateful addresses (M) and/

or additional configuration settings (O).

Minimum Interval

This field displays the minimum time interval at which the Switch sends router
advertisements for this interface.

Maximum Interval

This field displays the maximum fime interval at which the Switch sends router
advertisements for this inferface.

Lifetime This field displays how long the router in router advertisements can be used as a default
router for this interface.
Suppress This field displays whether the Switch sends router advertisements and responses to router

solicitations on this inferface (No) or not (Yes).

8.10.10 IPv6 Prefix Setup

Use this screen to configure the Switch's IPvé prefix list for each interface. Click the link next to IPv6 Prefix
Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 83 Basic Setting > IPv6 > IPvé Configuration > IPvé Prefix Setup

Interface
Prefix

Prefix Length
Valid Lifetime

Prefemred Lifetime

Flags

IPvé Prefix Setup

IPvé Configuration

VLAMNI23 ¥

2592000 seconds
504800 seconds
Mo-Autoconfig Flag

Mo-Onlink Flag

Mo-Advertize Flag
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8.10.11

The following table describes the labels in this screen.

Table 46 Basic Setting > IPvé > IPvé Configuration > IPvé Prefix Setup

LABEL DESCRIPTION
Interface Select the IPvé interface you want to configure.
Prefix Set the IPvé prefix that the Switch includes in router advertisements for this inferface.

Prefix Length

Set the prefix length that the Switch includes in router advertisements for this interface.

Valid Lifetime

Specify how long (from 0 to 4294967295 seconds) the prefix is valid for on-link
determination.

Preferred Lifetime

Specify how long (from 0 to 4294967295 seconds) that addresses generated from the prefix
remain preferred.

The preferred lifetime cannot exceed the valid lifetime.

Flags Select No-Autoconfig Flag to not allow IPvé hosts to use this prefix.
Select No-Onlink Flag to not allow the specified prefix to be used for on-link determination.
Select No-Advertise Flag o set the Switch fo not include the specified IPvé prefix, prefix
length in router advertisements for this interface.

Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch’s run-time memory. The Switch loses these changes if
it is turned off or loses power, so use the Save link on the tfop navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click an index number to change the settings.

Interface This is the name of the IPvé interface you created.

Prefix/Prefix Length

This field displays the IPvé prefix and prefix length that the Switch includes in router
advertisements for this interface.

Valid Lifetime

This field displays the IPvé prefix valid lifetime.

Preferred Lifetime

This field displays the preferred lifetime of an IPvé address generated from the prefix.

Select an entry’s check box fo select a specific entry. Otherwise, select the check box in
the table heading row to select all enftries.

Delete Check the entries that you want to remove in the Delete column and then click Delete to
remove the selected entries from the summary table.
Cancel Click Cancel to clear the Delete check boxes.

IPv6 Neighbor Setup

Use this screen to create a static IPvé neighbor entry in the Switch’s IPvé neighbor table to store the
neighbor information permanently. Click the link next to IPvé Neighbor Setup in the IPv6 Configuration
screen to display the screen as shown next.
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Figure 84 Basic Setting > IPvé > IPvé Configuration > IPvé Neighbor Setup

IPvé Neighbor Sefup IPvé Configuration

Interfoce Type WLAMN v
Interface ID

Meighbor Address

MAC

Delete | Cancel

The following table describes the labels in this screen.

Table 47 Basic Setting > IPvé > IPvé Configuration > IPvé Neighbor Setup

LABEL DESCRIPTION

Interface Type | Select the type of IPvé interface for which you want to configure. The Switch supports the VLAN
interface type for IPvé at the time of writing.

Interface ID Specify a unique identification number (from 1 to 4094) for the interface.

A static IPvé neighbor entry displays in the Management > IPv6 Neighbor Table screen only when
the interface ID is also created in the Basic Setup > Interface Setup screen.

To have IPvé function properly, you should configure a static VLAN with the same ID number in the
Advanced Application > VLAN screens.

Neighbor Specify the IPvé address of the neighboring device which can be reached through the interface.

Address

MAC Specify the MAC address of the neighboring device which can be reached through the
interface.

Add Click this to create a new enftry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
turned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click an index number to change the settings.

Interface This is the name of the IPvé interface you created.

Neighbor This field displays the IPvé address of the neighboring device which can be reached through the

Address interface.

MAC This field displays the MAC address of the neighboring device which can be reached through the
interface.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the table
heading row fo select all entries.

Delete Check the enfries that you want to remove and then click Delete to remove the selected entries
from the summary table.

Cancel Click Cancel to clear the check boxes.

XS1930 Series User's Guide

115



Chapter 8 Basic Setting

8.10.12 DHCPv6 Client Setup

Use this screen to configure the Switch’s DHCP settings when it is acting as a DHCPvé client. Click the link
next to DHCPv6 Client Setup in the IPv6 Configuration screen to display the screen as shown next.

Figure 85 Basic Setting > IPvé > IPvé Configuration > DHCPvé Client Setup

DHCPwvé Client Selup IPvé Configuration
Interface
1A Type O 1ana Rapid-Commit
|3
OCptions Do
[ pomain-List

Information Refresh Minimum 84400 seconds

VLANI No No No No 26400

= T

The following table describes the labels in this screen.

Table 48 Basic Setting > IPvé > IPvé Configuration > DHCPvé Client Setup

LABEL DESCRIPTION

Interface Select the IPvé interface you want to configure.

IA Type Select IA-NA to set the Switch to get a non-temporary IP address from the DHCPvé server for this
interface.
Optionally, you can also select Rapid-Commit to have the Switch send its DHCPvé Solicit message
with a Rapid Commit option fo obtain information from the DHCPvé server by a rapid two-
message exchange. The Switch discards any Reply messages that do not include a Rapid
Commit option. The DHCPvVé server should also support the Rapid Commit option to have it work
well.

Options Select DNS to have the Switch obtain DNS server IPvé addresses and/or select Domain-List to
have the Switch obtain a list of domain names from the DHCP server.

Information Specify the time interval (from 600 to 4294967295 seconds) at which the Switch exchanges other

Refresh configuration information with a DHCPvé6 server again.

Minimum

Apply Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the interface index number. Click an index number to change the settings.

Interface This is the name of the IPvé interface you created.

IA-NA This field displays whether the Switch obtains a non-temporary IP address from the DHCPvé server.

Rapid-Commit | This field displays whether the Switch obtains information from the DHCPvé server by a rapid fwo-
message exchange.

DNS This field displays whether the Switch obtains DNS server IPvé addresses from the DHCPvé server.

Domain-List This field displays whether the Switch obtains a list of domain names from the DHCP server.

Information This field displays the time interval (in seconds) at which the Switch exchanges other configuration

Refresh information with a DHCPvé server again.

Minimum
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8.11 Cloud Management

The Zyxel Nebula Control Center (NCC) is a cloud-based network management system that allows you
to remotely manage and monitor Zyxel Nebula APs, Ethernet switches and security gateways.

The Switch is managed and provisioned automatically by the NCC (Nebula Control Center) when:

* |fis connected to the Internet.

* The Nebula Control Center Discovery feature is enabled.

¢ It has been registered in the NCC.

This screen displays links to Nebula Control Center Discovery where you can have the Switch search for

the NCC (Nebula Control Center) and to Nebula Switch Registration which has a QR code containing
the Switch'’s serial number and MAC address for handy registration of the Switch at NCC.

Click Basic Setting > Cloud Management in the navigation panel to display this screen.

Figure 86 Basic Setting > Cloud Management

Mebula Control Center Discovery Click Here

@]

Mebula Switch Registration ick Here

8.11.1 Nebula Center Control Discovery

Click Basic Setting > Cloud Management > Nebula Control Center Discovery to display this screen.

Figure 87 Basic Setting > Cloud Management > Nebula Control Center Discovery

Nebula Control Center Discovery Cloud Management

Active

Select Active to turn on NCC discovery on the Switch. If the Switch has Internet access and has been
registered in the NCC, it will go into cloud management mode.

In cloud management mode, NCC will first check if the firmware on the Switch needs to be upgraded. If
it does, the Switch will upgrade the firmware immediately. If the frmware does not need to be
upgraded, but there is newer firmware available for the Switch, then it will be upgraded according to
the firmware upgrade schedule for the Switch on the NCC. Below is the process for upgrading firmware:

1 Download firmware through the NCC.
2 Upgrade the firmware and reboot.
Note: While the Switch is rebooting, do NOT turn off the power.

Clear Active to turn off NCC discovery on the Switch. The Switch will NOT discover the NCC and remain
in standalone mode.
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8.11.2 Nebula Switch Registration

Click Basic Setting > Cloud Management > Nebula Switch Registration to display this screen.

Figure 88 Basic Setting > Cloud Management > Nebula Switch Registration

Nebula Swiich Regisirafion Clovd Management

Mebula Contral Center is just few steps away! Use "Mebula Mobile” app from App store or

Google ploy store. Scan this QR code to register the Switch and you can start to enjoy the
power of Cloud Management.

This screen has a QR code containing the Switch's serial number and MAC address for handy NCC
registration of the Switch using the Nebula Mobile app. First, download the app from the Google Play
store for Android devices or the App Store for iOS devices and create an organization and site.
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CHAPTER 9
VLAN

9.1 Overview

This chapter shows you how to configure 802.1Q tagged and port-based VLANs.

The type of screen you see here depends on the VLAN Type you selected in the Switch Setup screen.

9.1.1 What You Can Do

¢ Use the VLAN screen (Section 9.3 on page 122) to view and search all static VLAN groups.

* Use the VLAN Detail screen (Section 9.3.1 on page 123) to view detailed port settings and status of the
static VLAN group.

¢ Use the Static VLAN Setup screen (Section 9.5 on page 125) to configure a stafic VLAN for the Switch.

* Use the VLAN Port Setup screen (Section 9.6 on page 126) to configure the statfic VLAN (IEEE 802.1Q)
settings on a port.

¢ Use the Voice VLAN Setup screen (Section 9.7 on page 127) to set up VLANs that allow you to group
voice traffic with defined priority and enable the Switch port to carry the voice fraffic separately from
data fraffic to ensure the sound quality does NOT deteriorate.

* Use the Vendor ID Based VLAN Setup screen (Section 9.8 on page 129) to set up VLANs that allow you
to group untagged packets into logical VLANs based on the source MAC address of the packet. You
can specify a mask for the MAC address to create a MAC address filter and enter a weight to set the
VLAN rule’s priority.

* Use the Port-Based VLAN Setup screen (Section 9.9 on page 131) to set up VLANs where the packet
forwarding decision is based on the destination MAC address and its associated port.

9.1.2 What You Need to Know

Read this section to know more about VLAN and how to configure the screens.

9.2 Introduction to IEEE 802.1Q Tagged VLANSs

A tfagged VLAN uses an explicit fag (VLAN ID) in the MAC header to identify the VLAN membership of a
frame across bridges - they are not confined to the switch on which they were created. The VLANs can
be created statically by hand or dynamically through GVRP. The VLAN ID associates a frame with a
specific VLAN and provides the information that switches need to process the frame across the network.
A tagged frame is 4 bytes longer than an untagged frame and contains 2 bytes of TPID (Tag Protocol
Identifier, residing within the type or length field of the Ethernet frame) and 2 bytes of TCI (Tag Control
Information, starts after the source address field of the Ethernet frame).

The CFI (Canonical Format Indicator) is a single-bit flag, always set to zero for Ethernet switches. If a
frame received at an Ethernet port has a CFl setf fo 1, then that frame should not be forwarded as it is to
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an untagged port. The remaining twelve bits define the VLAN ID, giving a possible maximum number of
4096 VLANs. Note that user priority and VLAN ID are independent of each other. A frame with VID (VLAN
Identifier) of null (0) is called a priority frame, meaning that only the priority level is significant and the
default VID of the ingress port is given as the VID of the frame. Of the 4096 possible VIDs, a VID of O is
used to identify priority frames and value 4095 (FFF) is reserved, so the maximum possible VLAN
configurations are 4094.

TPID User Priority CFl VLAN ID

2 Bytes | 3 Bifs 1 Bit 12 bits

Forwarding Tagged and Untagged Frames

Each port on the Switch is capable of passing tfagged or untagged frames. To forward a frame from an
802.1Q VLAN-aware switch to an 802.1Q VLAN-unaware switch, the Switch first decides where to
forward the frame and then strips off the VLAN tag. To forward a frame from an 802.1Q VLAN-unaware
switch to an 802.1Q VLAN-aware switch, the Switch first decides where to forward the frame, and then
inserts a VLAN tag reflecting the ingress port's default VID. The default PVID is VLAN 1 for all ports, but this
can be changed.

A broadcast frame (or a multicast frame for a multicast group that is known by the system) is duplicated
only on ports that are members of the VID (except the ingress port itself), thus confining the broadcast to
a specific domain.

9.2.0.1 Automatic VLAN Registration

GARP and GVRP are the protocols used to automatically register VLAN membership across switches.

GARP

GARP (Generic Attribute Registration Protocol) allows network switches to register and de-register
attribute values with other GARP participants within a bridged LAN. GARP is a protocol that provides a
generic mechanism for protocols that serve a more specific application, for example, GVRP.

GARP Timers

Switches join VLANs by making a declaration. A declaration is made by issuing a Join message using
GARP. Declarations are withdrawn by issuing a Leave message. A Leave All message terminates alll
registrations. GARP timers set declaration timeout values.

GVRP

GVRP (GARP VLAN Registration Protocol) is a registration protocol that defines a way for switches to
register necessary VLAN members on ports across the network. Enable this function to permit VLAN
groups beyond the local Switch.
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Please refer to the following table for common IEEE 802.1Q VLAN terminology.

Table 49 |EEE 802.1Q VLAN Terminology

VLAN PARAMETER

TERM

DESCRIPTION

VLAN Type

Permanent VLAN

This is a statfic VLAN created manually.

Dynamic VLAN

This is a VLAN configured by a GVRP registration or de-regisfration
process.

VLAN Administrative
Control

Registration Fixed

Fixed registration ports are permanent VLAN members.

Registration
Forbidden

Ports with registration forbidden are forbidden to join the specified
VLAN.

Normal Registration

Ports dynamically join a VLAN using GVRP.

VLAN Tag Control Tagged Ports belonging to the specified VLAN tag all outgoing frames
fransmitted.
Untagged Ports belonging to the specified VLAN do not tag all outgoing
frames transmitted.
VLAN Port Port VID This is the VLAN ID assigned to untagged frames that this port

received.

Acceptable Frame
Type

You may choose to accept both fagged and untagged incoming
frames, just tagged incoming frames or just untagged incoming
frames on a port.

Ingress filtering

If set, the Switch discards incoming frames for VLANs that do not
have this port as a member.

9.2.0.2 Port VLAN Trunking

Enable VLAN Trunking on a port to allow frames belonging to unknown VLAN groups to pass through
that port. This is useful if you want to set up VLAN groups on end devices without having to configure the
same VLAN groups on intermediary devices.

Refer to the following figure. Suppose you want to create VLAN groups 1 and 2 (V1 and V2) on devices
A and B. Without VLAN Trunking, you must configure VLAN groups 1 and 2 on all intermediary switches C,
D and E; otherwise they will drop frames with unknown VLAN group tags. However, with VLAN Trunking

enabled on ports in each intermediary switch you only need to create VLAN groups in the end devices
(A and B). C, D and E automatically allow frames with VLAN group tags 1 and 2 (VLAN groups that are

unknown to those switches) to pass through their VLAN trunking ports.

Figure 89 Port VLAN Trunking
C E

Vi V2 V1 V2

9.2.0.3 VLAN Priority

At the time of writing, you can create static VLANs, Voice VLANs and Vendor ID-based VLANs on the
Switch when the VLAN type is sef to 802.1Q. When a packet is received, the Switch processes the VLAN
rules in sequence. The sequence (priority) of the VLANS is:

1 VendorID Based VLAN
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2 Voice VLAN

If the packet matches a VLAN rule that has a higher priority, for example, an entry with weight 250 in the

vendor ID to VLAN mapping table, the Switch assigns the corresponding VLAN ID to the packet and
stops checking the subsequent VLAN rules.

9.2.0.4 Select the VLAN Type
Select a VLAN type in the Basic Setting > Switch Setup screen.

Figure 90 Basic Setting > Switch Setup > Select VLAN Type

[ SwilchSelup |
G_APJ Tyos * szia )
Port Bosed
MAC Address Leaming Aging Time 300 econd
ARP Aging Time Aging Time 300 second
Jain Timer 200 millisecond
GARP Timer Leave Timer 00 milliseconds

Leave All Timer 10000 | miliseconds
riority Queue Assignment

Static VLAN

Make sure 802.1Q is selected in the Basic Setting > Switch Setup screen.
Use a static VLAN to decide whether an incoming frame on a port should be

* sentto a VLAN group as normal depending on its VLAN fag.
e sent to a group whether it has a VLAN tag or not.

* blocked from a VLAN group regardless of its VLAN tag.

You can also tag all outgoing frames (that were previously untagged) from a port with the specified
VID.

9.3 VLAN Status

Use this screen to view and search all static VLAN groups. Click Advanced Application > VLAN from the
navigation panel to display the VLAN Status screen as shown next.
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Figure 91 Advanced Application > VLAN: VLAN Status

VLAN Search by VID |

| Search

The Number of VLAN: 2.

1 1
123 VLANT23

Iha 1=

Change Pages

VLAN Ceonfiguration

98:24:33 Static
&£7:30019 Static

The following table describes the labels in this screen.

Table 50 Advanced Application > VLAN: VLAN Status

LABEL DESCRIPTION
VLAN Search by | Enter (an) existing VLAN ID numbers (use a comma (,) to separate individual VLANs or a dash ()
VID fo indicate a range of VLANs. For example, *3,4" or "3-9") and click Search fo display only the

specified VLANs in the list below.

Leave this field blank and click Search to display all VLANs configured on the Switch.

The Number of
VLAN

This is the number of VLANs configured on the Switch.

The Number of
Search Results

This is the number of VLANs that match the searching criteria and display in the list below.

This field displays only when you use the Search button to look for certain VLANSs.

Index This is the VLAN index number. Click an index number to view more VLAN details.

VID This is the VLAN identification number that was configured in the corresponding VLAN
configuration screen.

Name This fields shows the descriptive name of the VLAN.

Tagged Port

This field shows the tagged ports that are participating in the VLAN.

Untagged Port

This field shows the untagged ports that are participating in the VLAN.

Elapsed Time

This field shows how long it has been since a normal VLAN was registered or a static VLAN was
set up.

Status

This field shows how this VLAN was added to the Switch.

¢ Dynamic - using GVRP
e Static — added as a permanent VLAN

Change Pages

Click Previous or Next to show the previous or next screen if all status information cannot be seen
in one screen.

9.3.1 VLAN Details

Use this screen to view detailed port settings and status of the static VLAN group. Click an index number
in the VLAN Status screen to display VLAN details.
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Figure 92 Advanced Application > VLAN > VLAN Detail

VIAN Sotus
Port Number
ViD 2 4 ] & a 2 | Elapsed Time Status
1 3 5 7 ? 1
U U U U U U o )
1 0 0 0 0 0 0 2:16:15 Static

The following table describes the labels in this screen.

Table 51 Advanced Application > VLAN > VLAN Detail

LABEL

DESCRIPTION

VLAN Status

Click this to go to the VLAN Status screen.

VID

This is the VLAN identification number that was configured in the corresponding VLAN
configuration screen.

Port Number

This column displays the ports that are participating in a VLAN. A tagged port is marked as T, an

untagged port is marked as U and ports not participating in a VLAN are marked as .

Elapsed Time

This field shows how long it has been since a normal VLAN was registered or a static VLAN was
set up.

Status

This field shows how this VLAN was added to the Switch.

¢ Dynamic: using GVRP
e Static: added as a permanent entfry

9.4 VLAN Configuration

Use this screen to view IEEE 802.1Q VLAN parameters for the Switch. Click Advanced Application > VLAN
> VLAN Configuration to see the following screen.

Figure 93 Advanced Application > VLAN > VLAN Configuration

VLAN Configuration VLAN Status
Static VLAN Setup Click Here
VLAN Port Sefup Click Here
Voice VLAM Setup Click Here
Vendor ID Based VLAN Setup Click Here

The following table describes the labels in the above screen.

Table 52 Advanced Application > VLAN > VLAN Configuration

LABEL

DESCRIPTION

Static VLAN Setup

Click Click Here to configure the Statfic VLAN for the Switch.

VLAN Port Setup

Click Click Here to configure the VLAN Port for the Switch.

Voice VLAN Setup Click Click Here to configure the Voice VLAN for the Switch.

Vendor ID Based VLAN Setup | Click Click Here to configure the Vendor ID Based VLAN for the Switch.
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9.5 Configure a Static VLAN

Use this screen to configure a static VLAN for the Switch. Click the Static VLAN Setup link in the VLAN
Configuration screen to display the screen as shown next.

Figure 94 Advanced Application > VLAN > VLAN Configuration > Statfic VLAN Setup

ACTIVE
MName

VLAN Group ID

1

VLAN Configuration

Mormal v ¥l Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging
Mormal Fixed Forbidden ¥ Tx Tagging

The following table describes the related labels in this screen.

Table 53 Advanced Application > VLAN > VLAN Configuration > Stafic VLAN Setup

LABEL

DESCRIPTION

ACTIVE

Select this check box to activate the VLAN settings.

Name

Enter a descriptive name for the VLAN group for identification purposes. This name consists of up
to 64 printable characters. Spaces are allowed.

VLAN Group ID

Enter the VLAN ID for this static entry; the valid range is between 1 and 4094.

Port

The port number identifies the port you are configuring.

*

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Control

Select Normal for the port to dynamically join this VLAN group using GVRP. This is the default
selection.

Select Fixed for the port to be a permanent member of this VLAN group.

Select Forbidden if you want to prohibit the port from joining this VLAN group.

Tagging

Select TX Tagging if you want the port to tag all outgoing frames transmitted with this VLAN
Group ID.
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Table 53

Advanced Application > VLAN > VLAN Configuration > Statfic VLAN Setup (continued)

LABEL

DESCRIPTION

Add

Click Add to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

Clear

Click Clear to start configuring the screen again.

VID

This field displays the ID number of the VLAN group. Click the number to edit the VLAN settings.

Active

This field indicates whether the VLAN settings are enabled (Yes) or disabled (No).

Name

This field displays the descriptive name for this VLAN group.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete

Click Delete to remove the selected entry from the summary table.

Cancel

Click Cancel to clear the check boxes.

9.6 Configure VLAN Port Settings

Use this screen to configure the static VLAN (IEEE 802.1Q) settings on a port. Click the VLAN Port Setup link
in the VLAN Configuration screen.

Figure 95 Advanced Application > VLAN > VLAN Configuration > VLAN Port Setup

VLAN Configuration
GVRP O
: O O O O
1 O 1 O Al ~ O |
2 o I 0 0 0
2 O 1 O Al ~ O |
s o I 0 0 0
5 O 1 O Al ~ O |
: o I 0 0 0
7 O 1 O Al ~ O |
8 o I 0 0 0
] O 1 O Al ~ O |
10 O 1 O O i
Cancel
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The following table describes the labels in this screen.

Table 54 Advanced Application > VLAN > VLAN Configuration > VLAN Port Setup

LABEL DESCRIPTION

GVRP GVRP (GARP VLAN Registration Protocol) is a registration protocol that defines a way for
switches to register necessary VLAN members on ports across the network.
Select this check box to permit VLAN groups beyond the local Switch.

Port This field displays the port number.

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Ingress Check

If this check box is selected, the Switch discards incoming frames on a port for VLANs that do
not include this port in its member sef.

Clear this check box to disable ingress filtering.

PVID A PVID (Port VLAN ID) is a tag that adds to incoming untagged frames received on a port so
that the frames are forwarded to the VLAN group that the tag defines.
Enter a number between 1and 4094 as the port VLAN ID.
GVRP Select this check box to allow GVRP on this port.
Acceptable Specify the type of frames allowed on a port. Choices are All, Tag Only and Untag Only.
Frame Type

Select All from the drop-down list box to accept all untagged or tagged frames on this port.
This is the default setting.

Select Tag Only to accept only tfagged frames on this port. All untagged frames will be
dropped.

Select Untag Only to accept only untagged frames on this port. All tagged frames will be
dropped.

VLAN Trunking

Enable VLAN Trunking on ports connected to other switches or routers (but not ports directly
connected to end users) to allow frames belonging to unknown VLAN groups to pass through
the Switch.

Isolation Select this to allows this port to communicate only with the CPU management port and the
ports on which the isolation feature is NOT enabled.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

9.7 Voice VLAN

Voice VLAN is a VLAN that is specifically allocated for voice traffic. It ensures that the sound quality of an
IP phone is preserved from deteriorating when the data traffic on the Switch ports is high. It groups the
voice traffic with defined priority into an assigned VLAN which enables the separation of voice and
data fraffic coming onto the Switch port.

The Switch can determine whether a received packet is

* an untagged voice packet when the incoming port is a fixed port for voice VLAN.
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* atagged voice packet when the incoming port and VLAN tag belongs to a voice VLAN.

It then checks the sourc

e packet's MAC address against an OUl list. If a match is found, the packet is

considered as a voice packet.

You can set priority level to the Voice VLAN and add MAC address of IP phones from specific

manufacturers by using

its ID from the Organizationally Unique Identifiers (OUI).

Click the Voice VLAN Setup link in the VLAN Configuration screen to display the configuration screen as

shown.

Figure 96 Advanced A

pplication > VLAN > VLAN Configuration > Voice VLAN Setup

Voice VLAN OUI Setup

OUl address
QUI mask

Description

VLAN Configuration
Voice VLAN Global Setup
T O Disable
oice N
®
Pty

]

Delete | Cancel

The following table describes the fields in the above screen.

Table 55 Advanced Application > VLAN > VLAN Configuration > Voice VLAN Setfup

LABEL

DESCRIPTION

Voice VLAN Global Setup

Voice VLAN

Click the second radio button if you want to enable the Voice VLAN feature. Type a
VLAN ID number in the box next to the radio button that is associated with the Voice
VLAN. You also need to create a static VLAN with the same VID in the Static VLAN Setup
screen, and then connect the IP phone with the specified OUI MAC address to a port
that joins the static VLAN.

Click Disable radio button if you do not want to enable the Voice VLAN feature.

Priority Select the priority level of the voice traffic from 0 to 7. Default setting is 5. The higher the
numeric value you assign, the higher the priority for this voice fraffic.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel
to save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel fo begin configuring this section afresh.

Clear Click Clear to reset the fields to default settings.

Voice VLAN OUI Setup

OUl address Enter the IP phone manufacturer's OUI MAC address. The first 3 bytes is the manufacturer

identifier, the last 3 bytes is a unique station ID.
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Table 55 Advanced Application > VLAN > VLAN Configuration > Voice VLAN Setup (continued)

LABEL DESCRIPTION

OUlI mask Enter the mask for the specified IP phone manufacturer's OUI MAC address to determine
which bits a packet's MAC address should match.

Enter “f” for each bit of the specified MAC address that the fraffic’s MAC address should
match. Enter “0" for the bits of the matched traffic’s MAC address, which can be of any
hexadecimal characters. For example, if you set the MAC address to 00:13:49:00:00:00
and the mask to ff:ff:ff:00:00:00, a packet with a MAC address of 00:13:49:12:34:56
matches this criteria.

Description Enter a description up to 32 characters for the Voice VLAN device. For example: Siemens.

Add Click Add to save your changes o the Switch’s run-tfime memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel
to save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this section afresh.

Index This field displays the index number of the Voice VLAN.

OUI address This field displays the OUI address of the Voice VLAN.

OUI mask This field displays the OUI mask address of the Voice VLAN.
Description This field displays the description of the Voice VLAN with OUI address.

Select an entry’s check box to select a specific entry. Otherwise, select the check boxin
the table heading row to select all enftries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.

9.8 Vendor ID Based VLAN

The Vendor ID based VLAN feature assigns incoming untagged packets to a VLAN and classifies the
tfraffic based on the source MAC address of the packet. When untagged packets arrive atf the switch,
the source MAC address of the packet is looked up in a Vendor ID to VLAN mapping fable. If an entry is
found, the corresponding VLAN ID is assigned to the packet. The assigned VLAN ID is verified against the
VLAN table. If the VLAN is valid, ingress processing on the packet continues; otherwise, the packet is
dropped.

This feature allows users to change ports without having to reconfigure the VLAN. You can assign a
802.1p priority to the vendor ID based VLAN and define a vendor ID to VLAN mapping fable by entering
a specified source MAC address and mask in the vendor ID based VLAN setup screen. You can also
delete a vendor ID based VLAN enftry in the same screen.

For every vendor ID based VLAN rule you set, you can specify a weight number to define the rule’s
priority level. As rules are processed one after the other, stating a priority order will let you choose which
rule has to be applied first and which second.

Click the Vendor ID Based VLAN Setup link in the VLAN Configuration screen to see the following screen.
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Figure 97 Advanced Application > VLAN > VLAN Configuration > Vendor ID Based VLAN Setup

Name

MAC address
Mask

VLAN

Prionty
Weight

Vendor ID Based VLAN VLAN Configuration

m Cancel

Delete | Cancel

The following table describes the fields in the above screen.

Table 56 Advanced Application > VLAN > VLAN Configuration > Vendor ID Based VLAN Setup

LABEL DESCRIPTION

Name Type a name up to 32 alpha numeric characters for the vendor ID based VLAN enfry.

MAC Address Type a MAC address that is bind to the vendor ID-based VLAN entry. This is the source MAC
address of the data packet that is looked up when untagged packets arrive at the Switch.

Mask Type the mask for the specified source MAC address to determine which bits a packet’s
MAC address should match.
Enter “f” for each bit of the specified MAC address that the traffic’'s MAC address should
match. Enter “0" for the bits of the matched fraffic’'s MAC address, which can be of any
hexadecimal characters. For example, if you set the MAC address to 00:13:49:00:00:00 and
the mask to ff:ff:ff:00:00:00, a packet with a MAC address of 00:13:49:12:34:56 matches this
criteria.

VLAN Type an ID (from 1 to 4094) for the VLAN that is associated with the vendor ID based VLAN
enftry.

Priority Select the priority level that the Switch assigns to frames belonging to this VLAN. The higher
the numeric value you assign, the higher the priority for this vendor ID based VLAN enfry.

Weight Enter a number between 0 and 255 to specify the rule’s weight. This is fo decide the priority
in which the rule is applied. The higher the number, the higher the rule’s priority.

Add Click Add to save the new vendor ID based VLAN enftry.

Cancel Click Cancel to clear the fields in the vendor ID based VLAN enfry.

Index This field displays the index number of the vendor ID based VLAN entry.

Name This field displays the name of the vendor ID based VLAN entry.

MAC Address

This field displays the source MAC address that is bind fo the vendor ID based VLAN entry.

Mask

This field displays the mask for the source MAC address that is bind to the vendor ID based
VLAN enfry.

VLAN This field displays the VLAN ID of the vendor ID based VLAN entry.

Priority This field displays the priority level which is assigned to frames belonging to this vendor ID
based VLAN.

Weight This field displays the weight of the vendor ID based VLAN enfry.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in
the table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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9.9 Port-Based VLAN Setup

Port-based VLANs are VLANs where the packet forwarding decision is based on the destination MAC
address and its associated port.

Port-based VLANs require allowed outgoing ports to be defined for each port. Therefore, if you wish to
allow two subscriber ports to talk fo each other, for example, between conference rooms in a hotel, you
must define the egress (an egress port is an outgoing port, that is, a port through which a data packet
leaves) for both ports.

Port-based VLANs are specific only fo the Switch on which they were created.

Note: When you activate port-based VLAN, the Switch uses a default VLAN ID of 1. You
cannotf change it.

Note: In screens (such as IP Setup and Filtering) that require a VID, you must enter 1 as the VID.

The port-based VLAN setup screen is shown next. The CPU management port forms a VLAN with all
Ethernet ports.

9.9.1 Configure a Port-Based VLAN

Select Port Based as the VLAN Type in the Basic Setting > Switch Setup screen and then click Advanced
Application > VLAN from the navigation panel to display the next screen.

Figure 98 Advanced Application > VLAN: Port Based VLAN Setup (All Connected)
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Figure 99 Advanced Application > VLAN: Port Based VLAN Setup (Port Isolation)
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The following table describes the labels in this screen.

Table 57 Advanced Application > VLAN: Port Based VLAN Setup

LABEL

DESCRIPTION

Setting Wizard

Choose All connected or Port isolation.

All connected means all ports can communicate with each other, that is, there are no virtual
LANs. Allincoming and outgoing ports are selected. This option is the most flexible but also the
least secure.

Port isolation means that each port can only communicate with the CPU management port and
cannot communicate with each other. Allincoming ports are selected while only the CPU
outgoing port is selected. This option is the most limiting but also the most secure.

After you make your selection, click Apply (top right of screen) to display the screens as
mentioned above. You can still customize these settings by adding or deleting incoming or
outgoing ports, but you must also click Apply at the bottom of the screen.

Incoming

These are the ingress ports; an ingress port is an incoming port, that is, a port through which a data
packet enters. If you wish to allow two subscriber ports to talk to each other, you must define the
ingress port for both ports. The numbers in the top row denote the incoming port for the
corresponding port listed on the left (its outgoing port). CPU refers to the Switch management
port. By default it forms a VLAN with all Ethernet ports. If it does not form a VLAN with a particular
port then the Switch cannot be managed from that port.

Outgoing

These are the egress ports; an egress port is an outgoing port, that is, a port through which a data
packet leaves. If you wish to allow two subscriber ports to talk to each other, you must define the
egress port for both ports. CPU refers to the Switch management port. By default it forms a VLAN
with all Ethernet ports. If it does not form a VLAN with a particular port then the Switch cannot be
managed from that port.

Apply

Click Apply to save your changes to the Switch'’s run-fime memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.
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CHAPTER 10
Static MAC Forwarding

10.1 Overview

This chapter discusses how to configure forwarding rules based on MAC addresses of devices on your
network.

Use these screens to configure static MAC address forwarding.

10.1.1 What You Can Do

Use the Static MAC Forwarding screen (Section 10.2 on page 133) to assign static MAC addresses for a
port.

10.2 Configure Static MAC Forwarding

A static MAC address is an address that has been manually entered in the MAC address table. Static
MAC addresses do not age out. When you set up static MAC address rules, you are setting static MAC
addresses for a port. This may reduce the need for broadcasting.

Static MAC address forwarding together with port security allow only computers in the MAC address
table on a port to access the Switch.

Click Advanced Application > Static MAC Forwarding in the navigation panel to display the
configuration screen as shown.

Figure 100 Advanced Application > Static MAC Forwarding

Stafic MAC Forwarding
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The following table describes the labels in this screen.

Table 58 Advanced Application > Static MAC Forwarding

LABEL DESCRIPTION

Active Select this check box to activate your rule. You may temporarily deactivate a rule without
deleting it by clearing this check box.

Name Enter a descriptive name for identification purposes for this static MAC address forwarding rule.

MAC Address

Enter the MAC address in valid MAC address format, that is, six hexadecimal character pairs.

Note: Stafic MAC addresses do NOT age out.

VID Enter the VLAN identification number.

Port Enter the port where the MAC address entered in the previous field will be automatically
forwarded.

Add Click this to create a new entry or to update an existing one.

This saves your rule to the Switch's run-time memory. The Switch loses this rule if it is turned off or
loses power, so use the Save link on the fop navigation panel o save your changes to the non-
volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values.

Clear Click Clear to begin configuring this screen afresh.

Index Click an index number to modify a static MAC address rule for a port.

Active This field displays whether this static MAC address forwarding rule is active (Yes) or not (No). You
may temporarily deactivate a rule without deleting it.

Name This field displays the descriptive name for identification purposes for this static MAC address-
forwarding rule.

MAC Address | This field displays the MAC address that will be forwarded and the VLAN identification number to
which the MAC address belongs.

VID This field displays the ID number of the VLAN group.

Port This field displays the port where the MAC address shown in the next field will be forwarded.
Select an entry’s check box fo select a specific entry. Otherwise, select the check box in the table
heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 11
Static Multicast Forwarding

11.1 Overview

This chapter discusses how to configure forwarding rules based on multicast MAC addresses of devices
on your network.

Use these screens to configure static multicast address forwarding.

11.1.1 What You Can Do

Use the Static Multicast Forwarding screen (Section 11.2 on page 136) to configure rules to forward
specific multicast frames, such as stfreaming or confrol frames, to specific ports.

11.1.2 What You Need To Know

A mulficast MAC address is the MAC address of a member of a multicast group. A stafic multicast
address is a multicast MAC address that has been manually entered in the multicast table. Static
multicast addresses do not age out. Static multicast forwarding allows you (the administrator) to forward
multicast frames to a member without the memlber having to join the group first.

If a multicast group has no members, then the switch will either flood the multicast frames to all ports or
drop them. Figure 101 on page 135 shows such unknown multicast frames flooded to all ports. With static
multicast forwarding, you can forward these multicasts to ports within a VLAN group. Figure 102 on page
136 shows frames being forwarded to devices connected to port 3. Figure 103 on page 136 shows
frames being forwarded to ports 2 and 3 within VLAN group 4.

Figure 101 No Static Multicast Forwarding
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Figure 102 Static Mulficast Forwarding to a Single Port
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11.2 Configure Static Multicast Forwarding

Use this screen to configure rules to forward specific multicast frames, such as streaming or control
frames, to specific ports.

Click Advanced Application > Static Multicast Forwarding to display the configuration screen as shown.

Figure 104 Advanced Application > Static Multicast Forwarding
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The following table describes the labels in this screen.

Table 59 Advanced Application > Static Multicast Forwarding

LABEL DESCRIPTION

Active Select this check box to activate your rule. You may temporarily deactivate a rule without
deleting it by clearing this check box.

Name Type a descriptive name (up to 32 printable ASCII characters) for this static multicast MAC
address forwarding rule. This is for identification only.

MAC Address | Enter a multicast MAC address which identifies the multicast group. The last binary bit of the first
octet pairin a multicast MAC address must be 1. For example, the first octet pair 00000001 is 01
and 00000011 is 03 in hexadecimal, so 01:00:5e:00:00:0A and 03:00:5e:00:00:27 are valid multicast
MAC addresses.

VID You can forward frames with matching destination MAC address to ports within a VLAN group.
Enter the ID that identifies the VLAN group here. If you do NOT have a specific target VLAN, enter
1.

Port Enter the ports where frames with destination MAC address that matched the entry above are
forwarded. You can enter multiple ports separated by (no space) comma (,) or hyphen (-). For
example, enter “3-5" for ports 3, 4, and 5. Enter “3,5,7" for ports 3, 5, and 7.

Add Click this to create a new entry or to update an existing one.

This saves your rule to the Switch's run-time memory. The Switch loses this rule if it is turned off or
loses power, so use the Save link on the top navigation panel to save your changes to the non-
volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values.

Clear Click Clear to begin configuring this screen afresh.

Index Click an index number to modify a static multicast MAC address rule for ports.

Active This field displays whether a static multicast MAC address forwarding rule is active (Yes) or not
(No). You may temporarily deactivate a rule without deleting it.

Name This field displays the descriptive name for identification purposes for a static multicast MAC

address-forwarding rule.

MAC Address

This field displays the multicast MAC address that identifies a multicast group.

VID

This field displays the ID number of a VLAN group fo which frames containing the specified
multicast MAC address will be forwarded.

Port This field displays the ports within an identified VLAN group fo which frames containing the
specified multicast MAC address will be forwarded.
Select an entry’s check box fo select a specific entfry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected enfry from the summary table.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 12
Filtering

12.1 Filtering Overview

This chapter discusses MAC address port filtering.

Filtering means sifting traffic going through the Switch based on the source and/or destination MAC
addresses and VLAN group (ID).

12.1.1 What You Can Do

Use the Filtering screen (Section 12.2 on page 138) to create rules for fraffic going through the Switch.

12.2 Configure a Filtering Rule

Use this screen to create rules for traffic going through the Switch. Click Advanced Application > Filtering
in the navigation panel to display the screen as shown next.

Figure 105 Advanced Application > Filtering
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The following table describes the related labels in this screen.

Table 60 Advanced Application > Filtering

LABEL DESCRIPTION

Active Make sure to select this check box to activate your rule. You may temporarily deactivate a rule
without deleting it by de-selecting this check box.

Name Type a descriptive name (up to 32 printable ASCII characters) for this rule. This is for identification
only.

Action Select Discard source to drop the frames from the source MAC address (specified in the MAC field).
The Switch can sfill send frames to the MAC address.
Select Discard destination to drop the frames to the destination MAC address (specified in the MAC
address). The Switch can still receive frames originating from the MAC address.
Select Discard source and Discard destination to block fraffic to or from the MAC address specified
in the MAC field.

MAC Type a MAC address in valid MAC address format, that is, six hexadecimal character pairs.

VID Type the VLAN group identification number.

Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the fop navigation panel to save your changes to
the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to clear the fields to the factory defaults.

Index This field displays the index number of the rule. Click an index number to change the settings.

Active This field displays Yes when the rule is activated and No when is it deactivated.

Name This field displays the descriptive name for this rule. This is for identification purpose only.

MAC Address

This field displays the source or destination MAC address with the VLAN identification number to
which the MAC address belongs.

VID This field displays the VLAN group idenfification number.

Action This field displays Discard source, Discard destination, or Discard both depending on what you
configured above.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in the table
heading row to select all entries.

Delete Check the rules that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.
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CHAPTER 13
Spanning Tree Protocol

13.1 Spanning Tree Protocol Overview

The Switch supports Spanning Tree Protocol (STP), Rapid Spanning Tree Protocol (RSTP) and Multiple
Spanning Tree Protocol (MSTP) as defined in the following standards.

» |EEE 802.1D Spanning Tree Protocol
¢ |EEE 802.1w Rapid Spanning Tree Protocol
* |EEE 802.1s Multiple Spanning Tree Protocol

The Switch also allows you to set up multiple STP configurations (or frees). Ports can then be assigned to
the trees.

13.1.1 What You Can Do

* Use the Spanning Tree Protocol Status screen (Section 13.2 on page 142) to view the STP status in the
different STP modes (RSTP or MSTP) you can configure on the Switch.

¢ Use the Spanning Tree Configuration screen (Section 13.3 on page 143) to activate one of the STP
modes on the Switch.

* Use the Rapid Spanning Tree Protocol Status screen (Section 13.4 on page 143) to view the RSTP status.
¢ Use the Rapid Spanning Tree Protocol screen (Section 13.5 on page 145) to configure RSTP settings.
* Use the Multiple Spanning Tree Protocol screen (Section 13.6 on page 146) to configure MSTP.

* Use the Multiple Spanning Tree Protocol Status screen (Section 13.7 on page 150) to view the MSTP
status.

13.1.2 What You Need to Know

Read on for concepts on STP that can help you configure the screens in this chapter.

(Rapid) Spanning Tree Protocol

(R)STP detects and breaks network loops and provides backup links between switches, bridges or
routers. It allows a switch to interact with other (R)STP-compliant switches in your network to ensure that
only one path exists between any two stations on the network.

The Switch uses IEEE 802.1w RSTP (Rapid Spanning Tree Protocol) that allows faster convergence of the
spanning tree than STP (while also being backwards compatible with STP-only aware bridges). In RSTP,
topology change information is directly propagated throughout the network from the device that
generates the topology change. In STP, a longer delay is required as the device that causes a topology
change first notifies the root bridge that then notifies the network. Both RSTP and STP flush unwanted
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learned addresses from the filtering database. In RSTP, the port states are Discarding, Learning, and
Forwarding.

Note: In this user’'s guide, “STP" refers to both STP and RSTP.

STP Terminology

The root bridge is the base of the spanning tfree.

Path cost is the cost of fransmitting a frame onto a LAN through that port. The recommended cost is
assigned according to the speed of the link to which a port is attached. The slower the media, the
higher the cost.

Table 61 STP Path Costs
LINK SPEED RECOMMENDED VALUE RECOMMENDED RANGE ALLOWED RANGE
Path Cost | 4 Mbps 250 100 to 1000 1 to 65535
Path Cost | 10 Mbps 100 50 to 600 1 to 65535
Path Cost | 16 Mbps 62 40 to 400 1 to 65535
Path Cost | 100 Mbps 19 10 to 60 1 to 65535
Path Cost | 1 Gbps 4 3to 10 1 to 65535
Path Cost | 10 Gbps 2 1tob5 1 to 65535

On each bridge, the root port is the port through which this bridge communicates with the roof. It is the
port on this switch with the lowest path cost to the root (the root path cost). If there is no root port, then
this switch has been accepted as the root bridge of the spanning free network.

For each LAN segment, a designated bridge is selected. This bridge has the lowest cost to the root
among the bridges connected to the LAN.

How STP Works

After a bridge determines the lowest cost-spanning tree with STP, it enables the root port and the ports
that are the designated ports for connected LANs, and disables all other ports that participate in STP.
Network packets are therefore only forwarded between enabled ports, eliminating any possible
network loops.

STP-aware switches exchange Bridge Protocol Data Units (BPDUs) periodically. When the bridged LAN
topology changes, a new spanning free is constructed.

Once a stable network topology has been established, all bridges listen for Hello BPDUs (Bridge Protocol
Data Units) transmitted from the rooft bridge. If a bridge does not get a Hello BPDU after a predefined

interval (Max Age). the bridge assumes that the link to the root bridge is down. This bridge then initiates
negotiations with other bridges to reconfigure the network to re-establish a valid network topology.

STP Port States

STP assigns five port states to eliminate packet looping. A bridge port is not allowed to go directly from
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blocking state to forwarding state so as fo eliminate fransient loops.

Table 62 STP Port States

PORT STATE DESCRIPTION

Disabled STP is disabled (default).

Blocking Only configuration and management BPDUs are received and processed.

Listening All BPDUs are received and processed.
Note: The listening state does NOT exist in RSTP.

Learning All BPDUs are received and processed. Information frames are submitted fo the learning process
but not forwarded.

Forwarding All BPDUs are received and processed. All information frames are received and forwarded.

Multiple STP

Multiple Spanning Tree Protocol (IEEE 802.1s) is backward compatible with STP/RSTP and addresses the
limitations of existing spanning free protocols (STP and RSTP) in networks o include the following
features:

* One Common and Infernal Spanning Tree (CIST) that represents the entire network’s connectivity.

¢ Grouping of multiple bridges (or switching devices) into regions that appear as one single bridge on
the network.

* A VLAN can be mapped to a specific Multiple Spanning Tree Instance (MSTI). MSTI allows multiple
VLANSs to use the same spanning free.

¢ Load-balancing is possible as traffic from different VLANs can use distinct paths in a region.

13.2 Spanning Tree Protocol Status

The Spanning Tree Protocol status screen changes depending on what standard you choose to
implement on your network. Click Advanced Application > Spanning Tree Protocol to see the screen as
shown.

Figure 106 Advanced Applicatfion > Spanning Tree Protocol

Spanning Tree Protocol Stafus

Spanning Tree Protocol: RSTP

Configuration RSTP MSTP

Bridge Root Owur Bridge

Bridge ID 0000-000000000000 0000-000000000000
Hello Time [second) Q Q

Max Age (second) Q Q

Forwarding Delay (second] Q Q

Cost to Bidge Q

Port ID 0X0000

Topology Changed Times Q

Time Since Last Change 0:00:00

This screen differs depending on which STP mode (RSTP or MSTP) you configure on the Switch. This screen
is described in detail in the section that follows the configuration section for each STP mode. Click
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Configuration to activate one of the STP standards on the Switch.

13.3 Spanning Tree Configuration

Use the Spanning Tree Configuration screen to activate one of the STP modes on the Switch. Click
Configuration in the Advanced Application > Spanning Tree Protocol.

Figure 107 Advanced Applicatfion > Spanning Tree Protocol > Configuration

Spanning Tree Configuration Status

® Ropid Spanning Tree

Spanning Tree Mode @] Multiple Spanning Tree

The following table describes the labels in this screen.

Table 63 Advanced Application > Spanning Tree Protocol > Configuration

LABEL DESCRIPTION
Spanning Tree You can activate one of the STP modes on the Switch.
Mode

Select Rapid Spanning Tree or Multiple Spanning Tree.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

13.4 Rapid Spanning Tree Protocol Status

Figure 108 Advanced Applicatfion > Spanning Tree Protocol

Spanning Tree Protocol Stafus Configuration RSTP MSTP

Spanning Tree Protocol: RSTP

Bridge Root Owur Bridge

Bridge ID 0000-000000000000 0000-000000000000
Hello Time [second) Q Q

Max Age (second) Q Q

Forwarding Delay (second] Q Q

Cost to Bidge Q

Port ID 0X0000

Topology Changed Times Q

Time Since Last Change 0:00:00
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The following table describes the labels in this screen.

Table 64 Advanced Application > Spanning Tree Protocol

LABEL DESCRIPTION

Bridge Root refers to the base of the spanning tree (the root bridge). Our Bridge is this Switch. This
Switch may also be the root bridge.

Bridge ID This is the unique identifier for this bridge, consisting of bridge priority plus MAC address. This ID
is the same for Root and Our Bridge if the Switch is the root switch.

Hello Time This is the time inferval (in seconds) at which the root switch transmits a configuration

(second) message. The root bridge determines Hello Time, Max Age and Forwarding Delay.

Max Age (second)

This is the maximum time (in seconds) the Switch can wait without receiving a configuration
message before attempting to reconfigure.

Forwarding Delay
(second)

This is the fime (in seconds) the root switch will wait before changing states (that is, listening to
learning to forwarding).

Note: The listening state does NOT exist in RSTP.

Cost to Bridge

This is the path cost from the root port on this Switch to the root switch.

Changed Times

Port ID This is the priority and number of the port on the Switch through which this Switch must
communicate with the root of the Spanning Tree.
Topology This is the number of times the spanning free has been reconfigured.

Time Since Last

This is the time since the spanning tree was last reconfigured.

Change
Port This field displays the number of the port on the Switch.
Port State This field displays the port state in STP.
¢ Discarding — The port does not forward or process received frames or learn MAC
addresses, but still listens for BPDUs.
* Learning - The port learns MAC addresses and processes BPDUs, but does NOT forward
frames yet.
* Forwarding — The port is operating normally. It learns MAC addresses, processes BPDUs
and forwards received frames.
Port Role This field displays the role of the port in STP.

* Root - A forwarding port on a non-root bridge, which has the lowest path cost and is the
best port from the non-root bridge to the root bridge. A root bridge does NOT have a root
port.

* Designated - A forwarding port on the designated bridge for each connected LAN
segment. A designated bridge has the lowest path cost to the root bridge among the
bridges connected fo the LAN segment. All the ports on a root bridge (root switch) are
designated ports.

* Alternate - A blocked port, which has a best alternate path to the root bridge. This path is
different from using the root port. The port moves to the forwarding state when the
designated port for the LAN segment fails.

* Backup - A blocked port, which has a backup or redundant path to a LAN segment
where a designated port is already connected when a switch has two links to the same
LAN segment.

* Disabled - Not strictly part of STP. The port can be disabled manually.

Designated Bridge
ID

This field displays the identifier of the designated bridge to which this port belongs when the
port is a designated port. Otherwise, it displays the identifier of the designated bridge for the
LAN segment to which this port is connected.

Designated Port ID

This field displays the priority and number of the bridge port (on the designated bridge),
through which the designated bridge transmits the stored configuration messages.

Designated Cost

This field displays the path cost to the LAN segment to which the port is connected when the
port is a designated port. Otherwise, it displays the path cost fo the root bridge from the
designated port for the LAN segment to which this port is connected.
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13.5 Configure Rapid Spanning Tree Protocol

Use this screen to configure RSTP settings, see Section 13.1 on page 140 for more information on RSTP.
Click RSTP in the Advanced Application > Spanning Tree Protocol screen.

Figure 109 Advanced Application > Spanning Tree Protocol > RSTP
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The following table describes the labels in this screen.

Table 65 Advanced Application > Spanning Tree Protocol > RSTP

LABEL DESCRIPTION
Status Click Status to display the RSTP Status screen.
Active Select this check box to activate RSTP. Clear this check box to disable RSTP.

Note: You must also activate Rapid Spanning Tree in the Advanced Application >
Spanning Tree Protocol > Configuration screen to enable RSTP on the Switch.

Bridge Priority

Bridge priority is used in determining the root switch, root port and designated port. The Switch
with the highest priority (lowest numeric value) becomes the STP root switch. If all Switches
have the same priority, the Switch with the lowest MAC address will then become the root
switch. Select a value from the drop-down list box.

The lower the numeric value you assign, the higher the priority for this bridge.

Bridge Priority determines the root bridge, which in furn determines Hello Time, Max Age and
Forwarding Delay.

Hello Time This is the time interval in seconds between BPDU (Bridge Protocol Data Units) configuration
message generations by the root switch. The allowed range is 1 to 10 seconds.
Max Age This is the maximum time (in seconds) the Switch can wait without receiving a BPDU before

attempting to reconfigure. All Switch ports (except for designated ports) should receive BPDUs
at regular intervals. Any port that ages out STP information (provided in the last BPDU)
becomes the designated port for the attached LAN. If it is a root port, a new root port is
selected from among the Switch ports attached to the network. The allowed range is 6 to 40
seconds.
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Table 65 Advanced Application > Spanning Tree Protocol > RSTP (continued)

LABEL

DESCRIPTION

Forwarding Delay

This is the maximum time (in seconds) the Switch will wait before changing states. This delay is
required because every Switch must receive information about topology changes before it
starts fo forward frames. In addition, each port needs time to listen for conflicting information
that would make it return to a blocking state; otherwise, temporary data loops might result.
The allowed range is 4 to 30 seconds.

As a general rule:

2 * (Forward Delay - 1) >= Max Age >= 2 * (Hello Time + 1)

Port

This field displays the port number.

Settings in this row apply fo all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Active

Select this check box to activate RSTP on this port.

Edge

Select this check box to configure a port as an edge port when it is directly attached to a
computer. An edge port changes its inifial STP port state from blocking state to forwarding
state immediately without going through listening and learning states right after the port is
configured as an edge port or when its link status changes.

Note: An edge port becomes a non-edge port as soon as it receives a Bridge
Protocol Data Unit (BPDU).

Priority

Configure the priority for each port here.

Priority decides which port should be disabled when more than one port forms a loop in a
switch. Ports with a higher priority numeric value are disabled first. The allowed range is
between 0 and 255 and the default value is 128.

Path Cost

Path cost is the cost of fransmitting a frame on to a LAN through that port. It is recommended
to assign this value according to the speed of the bridge. The slower the media, the higher the
cost.

Apply

Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

13.6 Configure Multiple Spanning Tree Protocol

To configure MSTP, click MSTP in the Advanced Application > Spanning Tree Protocol screen.
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Figure 110 Advanced Application > Spanning Tree Protocol > MSTP
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The following table describes the labels in this screen.

Table 66 Advanced Application > Spanning Tree Protocol > MSTP

LABEL DESCRIPTION

Status Click Status to display the MSTP Status screen.

Port Click Port fo display the MSTP Port screen.

Active Select this check box to activate MSTP on the Switch. Clear this check box to disable MSTP on
the Switch.

Note: You must also activate Multiple Spanning Tree in the Advanced Application >
Spanning Tree Protocol > Configuration screen to enable MSTP on the Switch.

Hello Time This is the time inferval in seconds between BPDU (Bridge Protocol Data Units) configuration
message generations by the root switch. The allowed range is 1 to 10 seconds.
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Table 66 Advanced Application > Spanning Tree Protocol > MSTP (continued)

LABEL

DESCRIPTION

MaxAge

This is the maximum fime (in seconds) a switch can wait without receiving a BPDU before
attempting to reconfigure. All switch ports (except for designated ports) should receive BPDUs
at regular intervals. Any port that ages out STP information (provided in the last BPDU)
becomes the designated port for the attached LAN. If it is a root port, a new root port is
selected from among the Switch ports attached to the network. The allowed range is 6 to 40
seconds.

Forwarding Delay

This is the maximum time (in seconds) a switch will wait before changing states. This delay is
required because every switch must receive information about topology changes before it
starts fo forward frames. In addition, each port needs time fo listen for conflicting information
that would make it return to a blocking state; otherwise, temporary data loops might result.
The allowed range is 4 to 30 seconds. As a general rule:

Note: 2 * (Forward Delay - 1) >= Max Age >= 2 * (Hello Time + 1)

Maximum hops

Enter the number of hops (between 1 and 255) in an MSTP region before the BPDU is
discarded and the port information is aged.

Configuration
Name

Enter a descriptive name (up to 32 characters) of an MST region.

Revision Number

Enter a number to identify a region’s configuration. Devices must have the same revision
number to belong to the same region.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Instance Use this section to configure MSTI (Multiple Spanning Tree Instance) settings.

Instance Enter the number you want to use to identify this MST instance on the Switch. The Switch

supports instance numbers 0 — 16.

Bridge Priority

Set the priority of the Switch for the specific spanning tree instance. The lower the number, the
more likely the Switch will be chosen as the root bridge within the spanning tree instance.

Enter priority values between 0 and 61440 in increments of 4096 (thus valid values are 4096,
8192, 12288, 16384, 20480, 24576, 28672, 32768, 36864, 40960, 45056, 49152, 53248, 57344 and
61440).

VLAN Range

Enter the start of the VLAN ID range that you want to add orremove from the VLAN range edit
area in the Start field. Enter the end of the VLAN ID range that you want to add or remove
from the VLAN range edit area in the End field.

Next click:

e Add - to add this range of VLANs to be mapped o the MST instance.
* Remove - to remove this range of VLANs from being mapped to the MST instance.
¢ Clear -toremove all VLANs from being mapped to this MST instance.

Enabled VLAN(s)

This field displays which VLANs are mapped to this MST instance.

Port

This field displays the port number. * means all ports.

*

Settings in this row apply to all ports.

Use this row only if you want fo make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Active

Select this check box to add this port to the MST instance.

Priority

Configure the priority for each port here.

Priority decides which port should be disabled when more than one port forms a loop in the
Switch. Ports with a higher priority numeric value are disabled first. The allowed range is
between 0 and 255 and the default value is 128.
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Table 66 Advanced Application > Spanning Tree Protocol > MSTP (continued)

LABEL DESCRIPTION

Path Cost Path cost is the cost of transmitting a frame on to a LAN through that port. It is recommended
fo assign this value according o the speed of the bridge. The slower the media, the higher the
cost.

Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch’s run-tfime memory. The Switch loses this change if it is
tfurned off or loses power, so use the Save link on the top navigation panel to save your
changes fo the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Instance This field displays the ID of an MST instance.

VLAN This field displays the VID (or VID ranges) to which the MST instance is mapped.

Active Port This field display the ports configured to participate in the MST instance.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Check the rules that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.

13.6.1 Multiple Spanning Tree Protocol Port Configuration

Click Advanced Application > Spanning Tree Protocol > MSTP > Port in the navigation panel to display
the status screen as shown next.

Figure 111 Advanced Application > Spanning Tree Protocol > MSTP > Port
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The following table describes the labels in this screen.

Table 67 Advanced Application > Spanning Tree Protocol > MSTP > Port

LABEL DESCRIPTION
MSTP Click MSTP to edit MSTP settings on the Switch.
Port This field displays the port number. * means all ports.
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Table 67 Advanced Application > Spanning Tree Protocol > MSTP > Port (continued)

LABEL DESCRIPTION

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first fo
set the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Edge Select this check box to configure a port as an edge port when it is directly attached to a
computer. An edge port changes its initial STP port state from blocking state to forwarding
state immediately without going through listening and learning states right after the port is
configured as an edge port or when its link status changes.

Note: An edge port becomes a non-edge port as soon as it receives a Bridge
Protocol Data Unit (BPDU).

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

13.7 Multiple Spanning Tree Protocol Status

Click Advanced Application > Spanning Tree Protocol in the navigation panel to display the status
screen as shown next.

Note: This screen is only available after you activate MSTP on the Switch.
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Figure 112 Advanced Applicatfion > Spanning Tree Protocol > Status: MSTP
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The following table describes the labels in this screen.

Table 68 Advanced Application > Spanning Tree Protocol

LABEL DESCRIPTION

Configuration Click Configuration to specify which STP mode you want to activate. Click MSTP to edit MSTP
settings on the Switch.

CST This section describes the Common Spanning Tree settings.

Bridge Root refers to the base of the spanning free (the root bridge). Our Bridge is this switch. This
Switch may also be the root bridge.

Bridge ID This is the unique identfifier for this bridge, consisting of bridge priority plus MAC address. This ID
is the same for Root and Our Bridge if the Swifch is the root switch.

Hello Time This is the time interval (in seconds) at which the root switch transmits a configuration

(second) message. The root bridge determines Hello Time, Max Age and Forwarding Delay.

Max Age (second)

This is the maximum time (in seconds) the Switch can wait without receiving a configuration
message before attempting to reconfigure.

Forwarding Delay
(second)

This is the fime (in seconds) the root switch will wait before changing states (that is, listening fo
learning to forwarding).

Cost to Bridge

This is the path cost from the root port on this Switch to the roof switch.

Port ID This is the priority and number of the port on the Switch through which this Switch must
communicate with the root of the Spanning Tree.

Configuration This field displays the configuration name for this MST region.

Name

Revision Number

This field displays the revision number for this MST region.
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Table 68 Advanced Application > Spanning Tree Protocol (continued)

Changed Times

LABEL DESCRIPTION

Configuration A configuration digest is generated from the VLAN-MSTI mapping information.

Digest This field displays the 16-octet signature that is included in an MSTP BPDU. This field displays the
digest when MSTP is activated on the system.

Topology This is the number of times the spanning free has been reconfigured.

Time Since Last

This is the fime since the spanning tree was last reconfigured.

Change

Instance These fields display the MSTl to VLAN mapping. In other words, which VLANs run on each
spanning tree instance.

Instance This field displays the MSTI ID.

VLAN This field displays which VLANs are mapped to an MSTI.

MSTI Select the MST instance settings you want to view.

Bridge Root refers to the base of the MST instance. Our Bridge is this switch. This Switch may also be
the rooft bridge.

Bridge ID This is the unique identifier for this bridge, consisting of bridge priority plus MAC address. This ID

is the same for Root and Our Bridge if the Switch is the root switch.

Internal Cost

This is the path cost from the root port in this MST instance to the regional root switch.

Port ID This is the priority and number of the port on the Switch through which this Switch must
communicate with the root of the MST instance.
Port This field displays the number of the port on the Switch.
Port State This field displays the port state in STP.
* Discarding - The port does not forward or process received frames or learn MAC
addresses, but still listens for BPDUs.
* Learning - The port learns MAC addresses and processes BPDUs, but does not forward
frames yet.
* Forwarding — The port is operating normally. It learns MAC addresses, processes BPDUs
and forwards received frames.
Port Role This field displays the role of the port in STP.

* Root - A forwarding port on a non-rooft bridge, which has the lowest path cost and is the
best port from the non-root bridge to the root bridge. A root bridge does not have a root
port.

¢ Designated — A forwarding port on the designated bridge for each connected LAN
segment. A designated bridge has the lowest path cost to the root bridge among the
bridges connected to the LAN segment. All the ports on a root bridge (root switch) are
designated ports.

e Alternate — A blocked port, which has a best alternate path to the root bridge. This path is
different from using the root port. The port moves to the forwarding state when the
designated port for the LAN segment fails.

* Backup - A blocked port, which has a backup or redundant path to a LAN segment
where a designated port is already connected when a switch has two links to the same
LAN segment.

* Disabled - Not strictly part of STP. The port can be disabled manually.

Designated Bridge
ID

This field displays the identifier of the designated bridge to which this port belongs when the
port is a designated port. Otherwise, it displays the identifier of the designated bridge for the
LAN segment to which this port is connected.

Designated Port ID

This field displays the priority and number of the bridge port (on the designated bridge),
through which the designated bridge transmits the stored configuration messages.

Designated Cost

This field displays the path cost to the LAN segment to which the port is connected when the
port is a designated port. Otherwise, it displays the path cost to the root bridge from the
designated port for the LAN segment to which this port is connected.
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13.8 Technical Reference

This section provides technical background information on the topics discussed in this chapter.

13.8.1 MSTP Network Example

The following figure shows a network example where two VLANs are configured on the two switches. If
the switches are using STP or RSTP, the link for VLAN 2 will be blocked as STP and RSTP allow only one link
in the network and block the redundant link.

Figure 113 STP/RSTP Network Example
A
FH HHH

VLAN 1 VLAN 2

B B
B

With MSTP, VLANs 1 and 2 are mapped to different spanning frees in the network. Thus fraffic from the
two VLANs fravel on different paths. The following figure shows the network example using MSTP.

Figure 114 MSTP Network Example
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13.8.2 MST Region

An MST region is a logical grouping of multiple network devices that appears as a single device to the
rest of the network. Each MSTP-enabled device can only belong to one MST region. When BPDUs enter
an MST region, external path cost (of paths outside this region) is increased by one. Internal path cost (of
paths within this region) is increased by one when BPDUs fraverse the region.

Devices that belong to the same MST region are configured to have the same MSTP configuration
identification settings. These include the following parameters:

¢ Name of the MST region

* Revision level as the unique number for the MST region
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* VLAN-to-MST Instance mapping

13.8.3 MST Instance

An MST Instance (MSTI) is a spanning free instance. VLANs can be configured to run on a specific MSTI.
Each created MSTI is identified by a unique number (known as an MST ID) known internally to a region.
Therefore an MSTI does not span across MST regions.

The following figure shows an example where there are two MST regions. Regions 1 and 2 have two
spanning tree instances.

Figure 115 MSTIs in Different Regions
—— Physical Connection

Region 1 Region 2

MSTI 1
— MSTI 3

13.8.4 Common and Internal Spanning Tree (CIST)

A CIST represents the connectivity of the entire network and it is equivalent to a spanning tree in an STP/
RSTP. The CIST is the default MST instance (MSTID 0). Any VLANs that are not members of an MST instance
are members of the CIST. In an MSTP-enabled network, there is only one CIST that runs between MST
regions and single spanning free devices. A network may contain multiple MST regions and other
network segments running RSTP.
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Figure 116 MSTP and Legacy RSTP Network Example
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CHAPTER 14
Bandwidth Control

14.1 Bandwidth Control Overview

This chapter shows you how you can cap the maximum bandwidth using the Bandwidth Control screen.

Bandwidth control means defining a maximum allowable bandwidth for incoming and/or out-going
fraffic flows on a port.

14.1.1 What You Can Do

Use the Bandwidth Control screen (Section 14.2 on page 156) to limit the bandwidth for traffic going
through the Switch.

14.2 Bandwidth Control Setup

Click Advanced Application > Bandwidth Control in the navigation panel to bring up the screen as
shown next.

Figure 117 Advanced Application > Bandwidth Control
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The following table describes the related labels in this screen.

Table 69 Advanced Application > Bandwidth Confrol

LABEL DESCRIPTION

Active Select this check box to enable bandwidth control on the Switch.

Port This field displays the port number.

* Settings in this row apply o all ports.
Use this row only if you want to make some settings the same for all ports. Use this row first to set the
common settings and then make adjustments on a port-by-port basis.
Note: Changes in this row are copied to all the ports as soon as you make them.

Active Select this check box to activate ingress rate limits on this port.

Ingress Rate

Specify the maximum bandwidth allowed in kilobits per second (Kbps) for the incoming tfraffic flow
on a port.

Note: Ingress rate bandwidth control applies to layer 2 traffic only.

Active

Select this check box fo activate egress rate limits on this port.

Egress Rate

Specify the maximum bandwidth allowed in kilobits per second (Kbps) for the out-going traffic
flow on a port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes
if it is turned off or loses power, so use the Save link on the top navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel fo reset the fields.
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CHAPTER 15
Broadcast Storm Control

15.1 Broadcast Storm Control Overview

This chapter infroduces and shows you how to configure the broadcast storm control feature.
Broadcast storm conftrol limits the number of broadcast, multicast and destination lookup failure (DLF)
packets the Switch receives per second on the ports. When the maximum number of allowable
broadcast, multicast and/or DLF packets is reached per second, the subsequent packets are

discarded. Enable this feature to reduce broadcast, multicast and/or DLF packets in your network. You
can specify limits for each packet type on each port.

15.1.1 What You Can Do

Use the Broadcast Storm Control screen (Section 15.2 on page 158) to limit the number of broadcast,
multicast and destination lookup failure (DLF) packets the Switch receives per second on the ports.

15.2 Broadcast Storm Control Setup

Click Advanced Application > Broadcast Storm Control in the navigation panel to display the screen as
shown next.

Figure 118 Advanced Application > Broadcast Storm Control
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The following table describes the labels in this screen.

Table 70 Advanced Application > Broadcast Storm Conftrol

LABEL DESCRIPTION

Active Select this check box to enable traffic storm control on the Switch. Clear this check box to
disable this feature.

Port This field displays the port number.

*

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Broadcast (pkt/s)

Select this option and specify how many broadcast packets the port receives per second.

Multicast (pkt/s)

Select this opfion and specify how many multicast packets the port receives per second.

DLF (pkt/s) Select this option and specify how many destination lookup failure (DLF) packets the port
receives per second.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields.
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CHAPTER 16
Mirroring

16.1 Mirroring Overview

This chapter discusses port mirroring sefup screens.

Port mirroring allows you to copy a traffic flow to a monitor port (the port you copy the traffic to) in order
that you can examine the fraffic from the monitor port without interference.

16.2 Port Mirroring Setup

Click Advanced Application > Mirroring in the navigation panel to display the Mirroring screen. Use this
screen to select a monitor port and specify the traffic flow to be copied to the monitor port.

Figure 119 Advanced Application > Mirroring
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The following table describes the labels in this screen.

Table 71 Advanced Application > Mirroring

LABEL DESCRIPTION

Active Select this check box to activate port mirroring on the Switch. Clear this check box to disable the
feature.

Monitor The monitor port is the port you copy the traffic to in order to examine it in more detail without

Port interfering with the fraffic flow on the original ports. Enter the port number of the monitor port.

Port This field displays the port number.

* Seftings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set the
common setftings and then make adjustments on a port-by-port basis.
Note: Changes in this row are copied to all the ports as soon as you make them.

Mirrored Select this option to mirror the traffic on a port.

Direction Specify the direction of the traffic to mirror by selecting from the drop-down list box. Choices are
Egress (outgoing), Ingress (incoming) and Both.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these changes if
it is furned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields.
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CHAPTER 17
Link Aggregation

17.1 Link Aggregation Overview

This chapter shows you how to logically aggregate physical links to form one logical, higher-bandwidth
link.

Link aggregation (trunking) is the grouping of physical ports into one logical higher-capacity link. You
may want to frunk ports if for example, it is cheaper to use multiple lower-speed links than to under-utilize
a high-speed, but more costly, single-port link. However, the more ports you aggregate then the fewer
available ports you have. A trunk group is one logical link containing multiple ports.

The beginning port of each frunk group must be physically connected to form a trunk group.

17.1.1 What You Can Do

¢ Use the Link Aggregation Status screen (Section 17.2 on page 163) to view ports you have configured
to be in the frunk group, ports that are currently fransmitting data as one logical link in the frunk group
and so on.

* Use the Link Aggregation Setting screen (Section 17.3 on page 164) to configure stafic link
aggregation.

¢ Use the Link Aggregation Control Protocol screen (Section 17.3.1 on page 166) to enable Link
Aggregation Control Protocol (LACP).

17.1.2 What You Need to Know

The Switch supports both static and dynamic link aggregation.

Note: In a properly planned network, it is recommended to implement static link aggregation
only. This ensures increased network stability and control over the trunk groups on your
Switch.

See Section 17.4.1 on page 167 for a static port trunking example.

Dynamic Link Aggregation
The Switch adheres to the [EEE 802.3ad standard for static and dynamic (LACP) port trunking.

The IEEE 802.3ad standard describes the Link Aggregation Control Protocol (LACP) for dynamically
creatfing and managing frunk groups.

When you enable LACP link aggregation on a port, the port can automatically negofiate with the ports
at the remote end of a link to establish trunk groups. LACP also allows port redundancy, that is, if an

XS1930 Series User's Guide

162



Chapter 17 Link Aggregation

operational port fails, then one of the “standby"” ports become operational without user intervention.
Please note that:

* You must connect all ports point-to-point to the same Ethernet switch and configure the ports for
LACP frunking.

* LACP only works on full-duplex links.

* All ports in the same trunk group must have the same media type, speed, duplex mode and flow
control seftings.

Configure trunk groups or LACP before you connect the Ethernet switch to avoid causing network
topology loops.

Link Aggregation ID

LACP aggregation ID consists of the following information':

Table 72 Link Aggregation ID: Local Switch
SYSTEM PRIORITY MAC ADDRESS KEY PORT PRIORITY PORT NUMBER
0000 00-00-00-00-00-00 0000 00 0000

Table 73 Link Aggregation ID: Peer Switch
SYSTEM PRIORITY MAC ADDRESS KEY PORT PRIORITY PORT NUMBER
0000 00-00-00-00-00-00 0000 00 0000

17.2 Link Aggregation Status

Click Advanced Application > Link Aggregation in the navigation panel. The Link Aggregation Status
screen displays by default. See Section 17.1 on page 162 for more information.

Figure 120 Advanced Application > Link Aggregation Status
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1. Port Priority and Port Number are 0 as it is the aggregator ID for the trunk group, not the individual port.
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The following table describes the labels in this screen.

Table 74 Advanced Application > Link Aggregation Status

LABEL DESCRIPTION
Group ID This field displays the group ID to identify a frunk group, that is, one logical link containing multiple
ports.

Enabled Ports These are the ports you have configured in the Link Aggregation screen to be in the trunk group.

The port numbers displays only when this tfrunk group is activated and there is a port belonging fo
this group.

Synchronized These are the ports that are currently tfransmitting data as one logical link in this frunk group.
Ports

Aggregator ID | Link Aggregator ID consists of the following: system priority, MAC address, key, port priority and
port number.

The ID displays only when there is a port belonging to this trunk group and LACP is also enabled
for this group.

Criteria This shows the outgoing traffic distribution algorithm used in this frunk group. Packets from the
same source and/or to the same destination are sent over the same link within the trunk.

src-mac means the Switch distributes traffic based on the packet’s source MAC address.
dst-mac means the Switch distributes traffic based on the packet’s destination MAC address.

src-dst-mac means the Switch distributes traffic based on a combination of the packet’s source
and destination MAC addresses.

src-ip means the Switch distributes fraffic based on the packet’s source IP address.
dst-ip means the Switch distributes traffic based on the packet’s destination IP address.

src-dst-ip means the Switch distributes traffic based on a combination of the packet’s source
and destination IP addresses.

Status This field displays how these ports were added to the trunk group. It displays:

e Static - if the ports are configured as static members of a trunk group.
* LACP -if the ports are configured to join a frunk group through LACP.

17.3 Link Aggregation Setting

Click Advanced Application > Link Aggregation > Link Aggregation Setting fo display the screen shown
next. See Section 17.1 on page 162 for more information on link aggregation.
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Figure 121 Advanced Application > Link Aggregation > Link Aggregation Setting
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The following table describes the labels in this screen.

Table 75 Advanced Application > Link Aggregation > Link Aggregation Setting

LABEL DESCRIPTION

Link This is the only screen you need to configure to enable static link aggregation.

Aggregation

Setting

Group ID The field identifies the link aggregation group, that is, one logical link containing multiple ports.

Active Select this option to activate a frunk group.

Criteria Select the outgoing fraffic distribution type. Packets from the same source and/or to the same
destination are sent over the same link within the trunk. By default, the Switch uses the src-dst-mac
distribution type. If the Switch is behind a router, the packet’s destination or source MAC address
will be changed. In this case, set the Switch to distribute traffic based on its IP address to make
sure port frunking can work properly.

Select src-mac to distribute fraffic based on the packet’s source MAC address.

Select dst-mac to distribute fraffic based on the packet’s destination MAC address.

Select src-dst-mac to distribute traffic based on a combination of the packet’s source and
destination MAC addresses.

Select src-ip to distribute fraffic based on the packet’s source IP address.

Select dst-ip to distribute fraffic based on the packet’s destination IP address.

Select src-dst-ip fo distribute traffic based on a combination of the packet’s source and
destination IP addresses.

Port This field displays the port number.

Group Select the trunk group to which a port belongs.

Note: When you enable the port security feature on the Switch and configure port
security settings for a port, you cannot include the port in an active trunk group.
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Table 75 Advanced Application > Link Aggregation > Link Aggregation Setting (continued)

LABEL

DESCRIPTION

Apply

Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

17.3.1 Link Aggregation Control Protocol

Click Advanced Application > Link Aggregation > Link Aggregation Setting > LACP to display the screen
shown next. See Dynamic Link Aggregation on page 162 for more information on dynamic link

aggregation.

Figure 122 Advanced Application > Link Aggregation > Link Aggregation Setting > LACP
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The following table describes the labels in this screen.

Table 76 Advanced Application > Link Aggregation > Link Aggregation Setting > LACP

LABEL DESCRIPTION

Link ) Note: Do NOT configure this screen unless you want to enable dynamic link
Aggregation i

Confrol aggregation.

Protocol

Active Select this check box to enable Link Aggregation Control Protocol (LACP).
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Table 76 Advanced Application > Link Aggregation > Link Aggregation Setting > LACP (continued)

LABEL DESCRIPTION

System Priority LACP system priority is a number between 1 and 65535. The switch with the lowest system priority
(and lowest port number if system priority is the same) becomes the LACP “server”. The LACP
“server” controls the operation of LACP setup. Enter a number to set the priority of an active port
using Link Aggregation Control Protocol (LACP). The smaller the number, the higher the priority
level.

Group ID The field identifies the link aggregation group, that is, one logical link containing multiple ports.

LACP Active Select this option fo enable LACP for a trunk.

Port This field displays the port number.

* Settings in this row apply to all ports.

Use this row only if you want fo make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.
Note: Changes in this row are copied to all the ports as soon as you make them.

LACP Timeout Timeout is the time interval between the individual port exchanges of LACP packets in order to
check that the peer port in the trunk group is still up. If a port does not respond after three fries,
then it is deemed to be “down” and is removed from the trunk. Set a short timeout (1 second) for
busy trunked links fo ensure that disabled ports are removed from the trunk group as soon as
possible.

Select either 1 second or 30 seconds.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the fop navigation panel fo save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

17.4 Technical Reference

This section provides technical background information on the topics discussed in this chapfter.

17.4.1 Static Trunking Example

This example shows you how to create a static port frunk group for ports 2 - 5.

1 Make your physical connections - make sure that the ports that you want to belong to the trunk group
are connected fo the same destination. The following figure shows ports 2 - 5 on switch A connected to

switch B.

Figure 123 Trunking Example - Physical Connections
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Configure static trunking - Click Advanced Application > Link Aggregation > Link Aggregation Setting. In
this screen activate frunk group T1, select the fraffic distribution algorithm used by this group and select
the ports that should belong to this group as shown in the figure below. Click Apply when you are done.

Figure 124 Trunking Example — Configuration Screen
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Apply

Your frunk group 1 (T1) configuration is now complete.
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CHAPTER 18
Port Authentication

18.1 Port Authentication Overview

This chapter describes the [EEE 802.1x, MAC, and Guest VLAN authentication methods.

Port authentication is a way to validate access to ports on the Switch to clients based on an external
authentication server. The Switch supports the following methods for port authentication:

« |EEE 802.1x2 — An authentication server validates access to a port based on a user name and
password provided by the user. A user that fails an authentication server can still access the port, but
traffic from the user is forwarded to the guest VLAN port.

¢ MAC Authentication — An authentication server validates access to a port based on the MAC address
and password of the client.

¢ Guest VLAN - In either mode, if authentication fails the Switch can still allow the client to access the
network on a Guest VLAN.

Note: All types of authentication use the RADIUS (Remote Authentication Dial In User Service,
RFC 2138, 2139) protocol to validate users. You must configure a RADIUS server before
enabling port authentication.

Note: If you enable IEEE 802.1x authentication and MAC authentication on the same port, the
Switch performs IEEE 802.1x authentication and MAC authentication. If a user fails to
authenticate either through the IEEE 802.1x or MAC authentication method, then
access to the port is denied.

Note: IEEE 802.1x is not supported by all user operating systems. For details on compatibility,
see your operating system documentation. If your operating system does not support
802.1x, you must install 802.1x client software.

18.1.1 What You Can Do
* Use the Port Authentication screen (Section 18.2 on page 171) to display the links to the configuration
screens where you can enable the port authentication methods.
¢ Use the 802.1x screen (Section 18.3 on page 171) to activate IEEE 802.1x security.
¢ Use the MAC Authentication screen (Section 18.4 on page 173) to activate MAC authentication.

* Use the Guest Vlan screen (Section 18.5 on page 174) to enable and assign a guest VLAN to a port.

2. At the fime of writing, IEEE 802.1x is not supported by all operating systems. See your operating system
documentation. If your operating system does not support 802.1x, then you may need to install 802.1x client
software.
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18.1.2 What You Need to Know

|IEEE 802.1x Authentication

The following figure illustrates how a client connecting to a IEEE 802.1x authentication enabled port goes
through a validation process. The Switch prompts the client for login information in the form of a user
name and password after the client responds to its identity request. When the client provides the login
credentials, the Switch sends an authentication request to a RADIUS server. The RADIUS server validates

whether this client is allowed access to the port.

Figure 125 [EEE 802.1x Authentication Process
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18.1.3 MAC Authentication

MAC authentication works in a very similar way to IEEE 802.1x authentication. The main difference is that
the Switch does not prompt the client for login credentials. The login credentials are based on the
source MAC address of the client connecting to a port on the Switch along with a password configured
specifically for MAC authentication on the Switch.
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Figure 126 MAC Authentication Process
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18.2 Port Authentication Configuration

To enable port authentication, first activate the port authentication methods (both on the Switch and
the ports), then configure the RADIUS server settings in the AAA > RADIUS Server Setup screen.

Click Advanced Application > Port Authentication in the navigation panel to display the screen as
shown. Select a port authentication method’s link in the screen that appears.

Figure 127 Advanced Applicafion > Port Authentication

Port Authentication
802.1x Click here
MAC Authentication Click here
Guest Vian Click here

18.3 Activate IEEE 802.1x Security

Use this screen to activate IEEE 802.1x security. In the Port Authentication screen click 802.1x to display
the configuration screen as shown.
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Figure 128 Advanced Application > Port Authentication > 802.1x
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The following table describes the labels in this screen.

Table 77 Advanced Application > Port Authentication > 802.1x

LABEL DESCRIPTION

Active Select this check box to permit 802.1x authentication on the Switch.
Note: You must first enable 802.1x authentication on the Switch before configuring it

on each port.

EAPOL flood Select this check box to flood EAPOL packets to all ports in the same VLAN.
EAP over LAN (EAPOL) is a port authentication protocol used in IEEE 802.1x. It is used to
encapsulate and transmit EAP packets between the supplicant (a client device that requests
access to the network resources or services) and authenticator (the Switch) directly over the
LAN.
Note: EAPOL flood will not take effect when 802.1x authentication is enabled.

Port This field displays the port number. * means all ports.

* Settings in this row apply to all ports.
Use this row only if you want fo make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.
Note: Changes in this row are copied to all the ports as soon as you make them.

Active Select this to permit 802.1x authentication on this port. You must first allow 802.1x
authentication on the Switch before configuring it on each port.

Max-Req Specify the number of fimes the Switch fries to authenticate clients before sending

unresponsive ports to the Guest VLAN.

This is set to 2 by default. That is, the Switch attempts to authenticate a client twice. If the client
does not respond to the first authentication request, the Switch tries again. If the client still does
not respond to the second request, the Switch sends the client to the Guest VLAN. The client
needs to send a new request to be authenticated by the Switch again.
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Table 77 Advanced Application > Port Authentication > 802.1x (continued)

LABEL DESCRIPTION

Reauth
connected fo the port.

Specify if a subscriber has to periodically re-enter his or her user name and password to stay

Reauth-period
secs

Specify the length of time requir
and password to stay connecte

ed to pass before a client has to re-enter his or her user name
d to the port.

Quiet-period secs

Specify the number of seconds the port remains in the HELD state and rejects further
authentication requests from the connected client after a failed authentication exchange.

Tx-period secs
identity request to the client.

Specify the number of seconds the Switch waits for client’s response before re-sending an

Supp-Timeout

Specify the number of seconds the Switch waits for client’s response to a challenge request

secs before sending another request.

Apply Click Apply to save your changes fo the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Use this screen to activate MAC authentication
Authentication to display the configuration scre

18.4 Activate MAC Authentication

. In the Port Authentication screen click MAC

en as shown.

Figure 129 Advanced Application > Port Authentication > MAC Authentication

MAC Avthenticafion

Active O

Port Authentication

MName Prefix

Delimiter

Case Lower

assword Type ) MAC-Address

Password

Timeout |

L T B o I S I .
oot doodoooo

by — o 0

XS1930 Series User's Guide

173




Chapter 18 Port Authentication

The following table describes the labels in this screen.

Table 78 Advanced Application > Port Authentication > MAC Authentication

LABEL

DESCRIPTION

Active

Select this check box to permit MAC authentication on the Switch.

Note: You must first enable MAC authentication on the Switch before configuring it
on each port.

Name Prefix

Type the prefix that is appended to all MAC addresses sent to the RADIUS server for
authentication. You can enter up to 32 printable ASCII characters.

If you leave this field blank, then only the MAC address of the client is forwarded to the RADIUS
server.

Delimiter Select the delimiter the RADIUS server uses to separate the pairs in MAC addresses used as the
account user name (and password). You can select Dash (-), Colon (:), or None to use no
delimiters at all in the MAC address.

Case Select the case (Upper or Lower) the RADIUS server requires for letters in MAC addresses used

as the account user name (and password).

Password Type

Select Static to have the Switch send the password you specify below or MAC-Address to use
the client MAC address as the password.

Password

Type the password the Switch sends along with the MAC address of a client for authentication
with the RADIUS server. You can enter up to 32 printable ASCIl charactersexcept [2], [ | . ['].

["Jorl.].

Timeout

Specify the amount of time before the Switch allows a client MAC address that fails
authentication to fry and authenticate again. Maximum fime is 3000 seconds.

When a client fails MAC authentication, its MAC address is learned by the MAC address table
with a status of denied. The timeout period you specify here is the time the MAC address enfry
stays in the MAC address table until it is cleared. If you specify 0 for the timeout value, the
Switch uses the Aging Time configured in the Switch Setup screen.

Note: If the Aging Time in the Switch Setup screen is set to a lower value, then it
supersedes this sefting.

Port

This field displays a port number. * means all ports.

Use this row to make the setting the same for all ports. Use this row first and then make
adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Active

Select this check box to permit MAC authentication on this port. You must first allow MAC
authentication on the Switch before configuring it on each port.

Apply

Click Apply to save your changes to the Switch'’s run-tfime memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

18.5 Guest VLAN

When 802.1x or MAC Authentication is enabled on the Switch and its ports, clients that do not have the
correct credentials are blocked from using the ports. You can configure your Switch to have one VLAN
that acts as a guest VLAN. If you enable the guest VLAN (102 in the example) on a port (2 in the
example), the user (A in the example) that is not IEEE 802.1x capable or fails to enter the correct user
name and password can still access the port, but traffic from the user is forwarded to the guest VLAN.
That is, unauthenticated users can have access to limited network resources in the same guest VLAN,

XS1930 Series User's Guide
174




Chapter 18 Port Authentication

such as the Internet. The access granted to the Guest VLAN depends on how the network administrator
configures switches or routers with the guest network feature.

Figure 130 Guest VLAN Example
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Use this screen to enable and assign a guest VLAN to a port. In the Port Authentication screen click
Guest Vlan to display the configuration screen as shown.

Figure 131 Advanced Application > Port Authentication > Guest VLAN
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The following fable describes the labels in this screen.

Table 79 Advanced Application > Port Authentication > Guest VLAN

LABEL DESCRIPTION
Port This field displays a port number. * means all ports.
* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Changes in this row are copied to all the ports as soon as you make them.

Active Select this check box to enable the guest VLAN feature on this port.

Clients that fail authentication are placed in the guest VLAN and can receive limited services.
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Table 79 Advanced Application > Port Authentication > Guest VLAN (continued)

LABEL DESCRIPTION

Guest Vlan A guest VLAN is a pre-configured VLAN on the Switch that allows non-authenticated users to
access limited network resources through the Switch. You must also enable IEEE 802.1x
authentication on the Switch and the associated ports. Enter the number that identifies the
guest VLAN.
Make sure this is a VLAN recognized in your network.

Host-mode Specify how the Switch authenticates users when more than one user connect to the port

(using a hub).

Select Multi-Host to authenticate only the first user that connects to this port. If the first user
enters the correct credential, any other users are allowed to access the port without
authentication. If the first user fails to enter the correct credential, they are all put in the guest
VLAN. Once the first user who did authentication logs out or disconnects from the port, the rest
of the users are blocked until a user does the authentication process again.

Select Multi-Secure to authenticate each user that connects to this port.

Multi-Secure Num

If you set Host-mode to Multi-Secure, specify the maximum number of users (between 1 and
24) that the Switch will authenticate on this port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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This chapter shows you how to set up port security.

19.1 About Port Security

Port security allows only packets with dynamically learned MAC addresses and/or configured static
MAC addresses to pass through a port on the Switch. The Switch can learn up to 32K MAC addresses in
total with no limit on individual ports other than the sum cannot exceed 32K.

For maximum port security, enable this feature, disable MAC address learning and configure static MAC
addresses for a port. It is not recommended you disable port security together with MAC address
learning as this will result in many broadcasts. By default, MAC address learning is still enabled even
though the port security is not activated.

19.2 Port Security Setup

Click Advanced Application > Port Security in the navigation panel to display the screen as shown.

Figure 132 Advanced Application > Port Security
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The following table describes the labels in this screen.

Table 80 Advanced Application > Port Security

LABEL DESCRIPTION
Active Select this option to enable port security on the Switch.
Port This field displays the port number.
* Settings in this row apply to all ports.
Use this row only if you want fo make some of the setftings the same for all ports. Use this row first
to set the common settings and then make adjustments on a port-by-port basis.
Note: Changes in this row are copied to all the ports as soon as you make them.
Active Select this check box to enable the port security feature on this port. The Switch forwards

packets whose MAC addresses is in the MAC address table on this port. Packets with no
matching MAC addresses are dropped.

Clear this check box to disable the port security feature. The Switch forwards all packets on this
port.

Address Learning

MAC address learning reduces outgoing broadcast traffic. For MAC address learning to occur
on a port, the port itself must be active with address learning enabled.

Limited Number
of Learned MAC
Address

Use this field to limit the number of (dynamic) MAC addresses that may be learned on a port.
For example, if you set this field to "5" on port 2, then only the devices with these five learned
MAC addresses may access port 2 at any one time. A sixth device must wait until one of the
five learned MAC addresses ages out. MAC address aging out time can be set in the Switch
Setup screen. The valid range is from “0" to “16K". *0"” means this feature is disabled.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 20
Time Range

20.1 Time Range Overview

You can set up one-time and recurring schedules for time-oriented features, such as PoE and classifier.
The UAG supports one-fime and recurring schedules. One-time schedules are effective only once, while
recurring schedules usually repeat. Both types of schedules are based on the current date and time in

the Switch.

The fime range can be configured in two ways — Absolute and Periodic. Absolute is a fixed time range
with a start and end time. Periodic is recurrence of a fime range and does not have an end time.

20.1.1 What You Can Do

Use the Time Range screen (Section 20.2 on page 179) to view or define a schedule on the Switch.

20.2 Configuring Time Range

Click Advanced Application > Time Range in the navigation panel to display the screen as shown.

Figure 133 Advanced Application > Time Range

Name
Type ® Absolute O Periodic
Start 1970 ~ ({01 ~ (|01 ~| |00 ~|:|00 ~
Absolute
End 1970 ~ ({01 ~ (|01 ~| |00 ~|:|00 ~
Monday 00 ~|: 00 to |Monday 00 1|00
Periodic Mon Tus Wed Thu Fri Sat Sun Weskdays Weskend
Diaily | 00 - 00 to |00 - 00
L]
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The following table describes the labels in this screen.

Table 81 Advanced Application > Time Range

LABEL DESCRIPTION

Name Enter a descriptive name for this rule for identifying purposes.

Type Select Absolute to create a one-time schedule. One-time schedules begin on a specific start
date and time and end on a specific stop date and time. One-time schedules are useful for
long holidays and vacation periods.

Alternatively, select Periodic to create a recurring schedule. Recurring schedules begin at a
specific start time and end at a specific stop time on selected days of the week (Sunday,
Monday, Tuesday, Wednesday, Thursday, Friday, and Saturday). Recurring schedules are useful
for defining the workday and off-work hours.

Absolute This section is available only when you set Type to Absolute.

Start Specify the year, month, day, hour and minute when the schedule begins.
End Specify the year, month, day, hour and minute when the schedule ends.

Periodic This section is available only when you set Type to Periodic.

Select the first option if you want to define a recurring schedule for a consecutive time period.
You then select the day of the week, hour and minute when the schedule begins and ends
respectively.

Select the second option if you want to define a recurring schedule for multiple non-
consecutive time periods. You need to select each day of the week the recurring schedule is
effective. You also need to specify the hour and minute when the schedule begins and ends
each day. The schedule begins and ends in the same day.

Add Click Add to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to clear the fields to the factory defaults.

Index This field displays the index number of the rule. Click an index number to change the settfings.

Name This field displays the descriptive name for this rule. This is for identification purpose only.

Type This field displays the type of the schedule.

Range This field displays the time periods to which this schedule applies.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Check the rules that you want fo remove and then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.
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CHAPTER 21
Classifier

21.1 Classifier Overview

This chapter infroduces and shows you how to configure the packet classifier on the Switch. It also
discusses Quality of Service (QoS) and classifier concepts as employed by the Switch.

21.1.1 What You Can Do

* Use the Classifier Status screen (Section 21.1 on page 181) to view the classifiers configured on the
Switch and how many fimes the traffic matches the rules.

¢ Use the Classifier Configuration screen (Section 21.3 on page 182) to define the classifiers and view a
summary of the classifier configuration. After you define the classifier, you can specify actions (or
policy) to act upon the fraffic that matches the rules.

* Use the Classifier Global Setting screen (Section 21.4 on page 187) to configure the match order and
enable logging on the Switch.

21.1.2 What You Need to Know

Quality of Service (QoS) refers to both a network's ability to deliver data with minimum delay, and the
networking methods used to control the use of bandwidth. Without QoS, all traffic data is equally likely
to be dropped when the network is congested. This can cause a reduction in network performance and
make the network inadequate for tfime-critical application such as video-on-demand.

A classifier groups traffic info data flows according to specific criteria such as the source address,
destination address, source port number, destination port number or incoming port number. For
example, you can configure a classifier to select traffic from the same protocol port (such as Telnet) to
form a flow.

Configure QoS on the Switch to group and prioritize application traffic and fine-tune network
performance. Setting up QoS involves two separate steps:

1 Configure classifiers to sort fraffic into different flows.

2 Configure policy rules to define actions to be performed on a classified traffic flow (refer to Chapter 22
on page 190 to configure policy rules).

21.2 Classifier Status

Use this screen to view the classifiers configured on the Switch and how many fimes the traffic matches
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the rules.

Click Advanced Application > Classifier in the navigation panel to display the configuration screen as
shown.

Figure 134 Advanced Application > Classifier > Classifier Status
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The following table describes the labels in this screen.

Table 82 Advanced Application > Classifier > Classifier Status

LABEL DESCRIPTION

Index This field displays the index number of the rule. Click an index number o edit the rule.

Active This field displays Yes when the rule is activated and No when it is deactivated.

Weight This field displays the rule’s weight. This is to indicate a rule’s priority when the match order is set

to manual in the Classifier > Classifier Configuration > Classifier Global Setting screen.

The higher the number, the higher the rule’s priority.

Name This field displays the descriptive name for this rule. This is for identification purpose only.

Match Count This field displays the number of times a rule is applied. It displays '-' if the rule does not have
count enabled.

Rule This field displays a summary of the classifier rule’s seftings.

Any Select Any, then click Clear to clear the matched count for all classifiers.

Classifier Select Classifier, enter a classifier rule name and then click Clear to erase the recorded

statistical information for that classifier, or select Any to clear stafistics for all classifiers.

Clear Click Clear to erase the recorded statistical information for the classifier.

21.3 Classifier Configuration

Use the Classifier Configuration screen to define the classifiers. After you define the classifier, you can
specify actions (or policy) to act upon the traffic that matches the rules.

In the Classifier Status screen click Classifier Configuration fo display the configuration screen as shown.
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Figure 135 Advanced Application > Classifier > Classifier Configuration
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The following table describes the labels in this screen.

Table 83 Advanced Application > Classifier > Classifier Configuration

LABEL DESCRIPTION

Active Select this option to enable this rule.

Name Enter a descriptive name for this rule for identifying purposes.

Weight Enfer a number between 0 and 65535 to specify the rule’s weight. When the match order is in manual
mode in the Classifier Global Setting screen, a higher weight means a higher priority.

Log Select this option to have the Switch create a log message when the rule is applied and record the
number of matched packets in a particular time interval.
Note: Make sure you also enable logging in the Classifier Global Setting screen.

Count Select this option to have the Switch count how many times the rule is applied.

Time Select the name of the pre-configured schedule that you want to apply to the rule. The rule will be

Range active only atf the scheduled date and/or time.

If you select None, the rule will be active all the time.

Ingress Port

Port

Type the port number to which the rule should be applied. You may choose one port only or all ports
(Any).

Trunk

Select Any to apply the rule to all trunk groups.

To specify a trunk group, select the second choice and type a trunk group ID.

Layer 2

Specify the fields below fo configure a layer 2 classifier.

VLAN
VLAN Select Any to classify traffic from any VLAN or select the second option and specify the source VLAN

ID in the field provided.

Priority

Priority | Select Any to classify fraffic from any priority level or select the second option and specify a priority

level in the field provided.

Ethernet Select an Ethernet type or select Other and enter the Ethernet type number in hexadecimal value.

Type

Source

MAC Select Any to apply the rule to all MAC addresses.

Address
To specify a source, select MAC/Mask to enter the source MAC address of the packet in valid MAC
address format (six hexadecimal character pairs) and type the mask for the specified MAC address to
determine which bits a packet’'s MAC address should match.
Enter “f" for each bit of the specified MAC address that the fraffic’s MAC address should match. Enter
“0" for the bits of the matched traffic’'s MAC address, which can be of any hexadecimal characters.
For example, if you set the MAC address to 00:13:49:00:00:00 and the mask to ff:ff:ff:00:00:00, a packet
with a MAC address of 00:13:49:12:34:56 matches this criteria. If you leave the Mask field blank, the
Switch automatically sets the mask to ff:ff:ff:ff:ff:ff.

Destination

XS1930 Series User's Guide

184




Chapter 21 Classifier

Table 83 Advanced Application > Classifier > Classifier Configuration (continued)

LABEL

DESCRIPTION

MAC
Address

Select Any to apply the rule to all MAC addresses.

To specify a destination, select MAC/Mask to enter the destination MAC address of the packet in
valid MAC address format (six hexadecimal character pairs) and type the mask for the specified MAC
address to determine which bits a packet’'s MAC address should match.

Enter “f” for each bit of the specified MAC address that the traffic’s MAC address should match. Enter
“0" for the bifs of the matched traffic’s MAC address, which can be of any hexadecimal characters.
For example, if you set the MAC address to 00:13:49:00:00:00 and the mask to ff:ff:ff:00:00:00, a packet
with a MAC address of 00:13:49:12:34:56 matches this criteria. If you leave the Mask field blank, the
Switch automatically sets the mask to ff:ff:ff:ff:ff:ff.

Layer 3

Specify the fields below to configure a layer 3 classifier.

DSCP Select Any to classify traffic from any DSCP or select the second option and specify a DSCP (DiffServ
Code Point) number between 0 and 63 in the field provided.

IPv4/IPvé

Preceden | Select Any to classify traffic from any precedence or select the second option and specify an IP

ce Precedence (the first 3 bifs of the 8-bit ToS field) value between 0 and 7 in the field provided.

ToS Select Any to classify traffic from any ToS or select the second option and specify Type of Service (the
last 5 bits of the 8-bit ToS field) value between 0 and 255 in the field provided.

IP Protocol | Select an IPv4 protocol type or select Other and enter the protocol number in decimal value.
You may select Establish Only for TCP protocol type. This means that the Switch will pick out the
packets that are sent to establish TCP connections.

IPv6 Next Select an IPvé6 protocol type or select Other and enter an 8-bit next header in the IPvé packet. The

Header Next Header field is similar to the IPv4 Protocol field. The IPvé protocol number ranges from 1 to 255.
You may select Establish Only for TCP protocol type. This means that the Switch will identify packets
that initiate or acknowledge (establish) TCP connections.

Source

IP Entfer a source IP address in dotted decimal notation.

Address/ . . ) .

Address Specify the address prefix by entering the number of ones in the subnet mask.

Prefix A subnet mask can be represented in a 32-bit notation. For example, the subnet mask “255.255.255.0"
can be represented as “11111111.11111111.11111111.00000000", and counting up the number of
ones in this case results in 24.

Destination

P Enfer a destination IP address in dotted decimal notation.

Address/ . . ) .

Address Specify the address prefix by entering the number of ones in the subnet mask.

Prefix

Layer 4

Specify the fields below fo configure a layer 4 classifier.

Source
iﬁﬂ?g;r Note: You must select either UDP or TCP in the IP Protocol field before you configure the
socket numbers.
Select Any to apply the rule to all TCP/UDP protocol port numbers or select the second option and
enter a TCP/UDP protocol port number.
Destination
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Table 83 Advanced Application > Classifier > Classifier Configuration (continued)

LABEL DESCRIPTION
,S\‘%i:g;r Note: You must select either UDP or TCP in the IP Protocol field before you configure the
socket numbers.
Select Any to apply the rule to all TCP/UDP protocol port numbers or select the second option and
enter a TCP/UDP protocol port number.
Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch’s run-fime memory. The Switch loses these changes if it is furned
off or loses power, so use the Save link on the top navigation panel to save your changes to the non-
volatile memory when you are done configuring.
Cancel Click Cancel fo reset the fields back to your previous configuration.
Clear Click Clear to set the above fields back to the factory defaults.

21.3.1 Viewing and Editing Classifier Configuration Summary

To view a summary of the classifier configuration, scroll down to the summary table at the bottom of the
Classifier screen. To change the setftings of a rule, click a number in the Index field.

Note: When two rules conflict with each other, a higher layer rule has priority over lower layer
rule.

Figure 136 Advanced Application > Classifier > Classifier Configuration: Summary Table

L]
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2 fes 32767 rate limit v20 vlon 20; count; O
3 fes 32767 rate limit w30 vlon 30; count; O
4 fes 32767 rate fimit v40 vlon 40; count; O

Delete | Cancel

The following table describes the labels in this screen.

Table 84 Advanced Application > Classifier > Classifier Configuration: Summary Table

LABEL DESCRIPTION

Index This field displays the index number of the rule. Click an index number to edit the rule.

Active This field displays Yes when the rule is activated and No when it is deactivated.

Weight The field displays the priority of the rule when the match order is in manual mode. A higher weight
means a higher priority.

Name This field displays the descriptive name for this rule. This is for identification purpose only.

Rule This field displays a summary of the classifier rule’s settings.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the table
heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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The following table shows some other common Ethernet types and the corresponding protocol number.

Table 85 Common Ethernet Types and Protocol Numbers

ETHERNET TYPE PROTOCOL NUMBER
IP ETHII 0800
X.75 Internet 0801
NBS Internet 0802
ECMA Internet 0803
Chaosnet 0804
X.25 Level 3 0805
XNS Compat 0807
Banyan Systems OBAD
BBN Simnet 5208
IBM SNA 80D5
AppleTalk AARP 80F3

In the Internet Protocol there is a field, called *Protocol”, to identify the next level protocol. The following
table shows some common protocol types and the corresponding protocol number. Refer to http://
www.iana.org/assignments/protocol-numbers for a complete list.

Table 86 Common IP Protocol Types and Protocol Numbers

PROTOCOL TYPE PROTOCOL NUMBER
ICMP 1

TCP 6

uUDP 17

EGP 8

L2TP 115

Some of the most common TCP and UDP port numbers are:

Table 87 Common TCP and UDP Port Numbers

PROTOCOL NAME TCP/UDP PORT NUMBER
FTP 21

Telnet 23

SMTP 25

DNS 53

HTTP 80

POP3 110

21.4 Classifier Global Setting Configuration

Use this screen to configure the match order and enable logging on the Switch. In the Classifier
Configuration screen click Classifier Global Setting fo display the configuration screen as shown.
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Figure 137 Advanced Application > Classifier > Classifier Configuration > Classifier Global Setting

Legging

Classifier Configuration

The following table describes the labels in this screen.

Table 88 Advanced Application > Classifier > Classifier Configuration > Classifier Global Setting

LABEL

DESCRIPTION

Match
Order

Select manual to have classifier rules applied according to the weight of each rule you configured in
Advanced Application > Classifier > Classifier Configuration.

Alternatively, select auto to have classifier rules applied according to the layer of the item configured
in the rule. Layer-4 items have the highest priority, and layer-2 items has the lowest priority. For
example, you configure a layer-2 item (VLAN ID) in classifier A and configure a layer-3 item (source IP
address) in classifier B. When an incoming packet matches both classifier rules, classifier B has priority
over classifier A.

Logging

Active

Select this to allow the Switch to create a log when packets match a classifier rule during a defined
time interval.

Interval

Select the length of the time period (in seconds) to count matched packets for a classifier rule. Enter
an integer from 0 — 65535. 0 means that no logging is done.

Apply

Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these changes if it
is turned off or loses power, so use the Save link on the top navigation panel to save your changes to
the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

21.5 Classifier Example

The following screen shows an example where you configure a classifier that identifies all traffic from
MAC address 00:50:ba:ad:4f:81 on port 2.
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Figure 138 Classifier: Example
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After you have configured a classifier, you can configure a policy (in the Policy screen) to define
actions on the classified traffic flow.
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CHAPTER 22
Policy Rule

22.1 Policy Rules Overview

This chapter shows you how to configure policy rules.
A classifier distinguishes traffic info flows based on the configured criteria (refer to Chapter 21 on page

181 for more information). A policy rule ensures that a fraffic flow gets the requested freatment in the
network.

22.1.1 What You Can Do

Use the Policy Rule screen (Section 22.2 on page 190) to enable the policy and display the active
classifiers you configure in the Classifier screen.

22.2 Configuring Policy Rules

You must first configure a classifier in the Classifier screen.

Click Advanced Application > Policy Rule in the navigation panel to display the screen as shown.

XS1930 Series User's Guide

190



Chapter 22 Policy Rule

Figure 139 Advanced Applicatfion > Policy Rule
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The following table describes the labels in this screen.

Table 89 Advanced Application > Policy Rule

Action field.

LABEL DESCRIPTION

Active Select this option to enable the policy.

Name Enter a descriptive name for identification purposes.

Classifier(s) This field displays the active classifiers you configure in the Classifier screen.
Select the classifiers to which this policy rule applies. To select more than one classifier, press
[SHIFT] and select the choices at the same time.

Parameters

Set the fields below for this policy. You only have to set the fields that is related to the actions you configure in the

General

VLAN ID

Specify a VLAN ID.

Egress Port

Type the number of an outgoing port.

Priority Specify a priority level.

Rate Limit You can configure the desired bandwidth available to a traffic flow. Traffic that exceeds the
maximum bandwidth allocated (in cases where the network is congested) is called out-of-profile
fraffic.

Bandwidth | Specify the bandwidth in kilobit per second (kbps). Enter a number between 1 and 1000000.
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Table 89 Advanced Application > Policy Rule (continued)

LABEL DESCRIPTION

Action

Specify the actions the Switch takes on the associated classified traffic flow.

Note: You can specify only one action (pair) in a policy rule. To have the Switch take multiple actions
on the same traffic flow, you need to define multiple classifiers with the same criteria and apply
different policy rules.

Say you have several classifiers that identify the same traffic flow and you specify a different policy rule for each. If
their policy actions conflict (Discard the packet, Send the packet to the egress port and Rate Limit), the Switch only
applies the policy rules with the Discard the packet and Send the packet to the egress port actions depending on
the classifier names. The longer the classifier name, the higher the classifier priority. If two classifier names are the
same length, the bigger the character, the higher the classifier priority. The lowercase letters (such as a and b)
have higher priority than the capitals (such as A and B) in the classifier name. For example, the classifier with the
name of class 2, class a or class B takes priority over the classifier with the name of class 1 or class A.

Let’s say you set two classifiers (Class 1 and Class 2) and both identify all traffic from MAC address 11:22:33:44:55:66
on port 3.

If Policy 1 applies to Class 1 and the action is to drop the packets, Policy 2 applies to Class 2 and the action is to
forward the packets to the egress port, the Switch will forward the packets.

If Policy 1 applies to Class 1 and the action is fo drop the packets, Policy 2 applies to Class 2 and the action is to
enable bandwidth limitation, the Switch will discard the packets immediately.

If Policy 1 applies to Class 1 and the action is fo forward the packets to the egress port, Policy 2 applies to Class 2
and the action is fo enable bandwidth limitation, the Switch will forward the packets.

Forwarding Select No change to forward the packets.

Select Discard the packet to drop the packets.

Priority Select No change to keep the priority setting of the frames.

Select Set the packet’s 802.1p priority to replace the packet’s 802.1p priority field with the value
you sef in the Priority field.

Outgoing Select Send the packet to the mirror port to send the packet to the mirror port.
Select Send the packet to the egress port o send the packet to the egress port.

Select Set the packet's VLAN ID to sef the packet’s VLAN ID.

Rate Limit Select Enable to activate bandwidth limitation on the traffic flows then set the actions to be
taken on out-of-profile packets.

Add Click Add to inset the entry to the summary table below and save your changes to the Switch's
run-tfime memory. The Switch loses these changes if it is furned off or loses power, so use the Save
link on the top navigation panel to save your changes to the non-volatile memory when you are
done configuring.

Cancel Click Cancel to reset the fields back to your previous configuration.

Clear Click Clear to set the above fields back to the factory defaults.

Index This field displays the policy index number. Click an index number to edit the policy.
Active This field displays Yes when policy is activated and No when is it deactivated.
Name This field displays the name you have assigned to this policy.

Classifier(s) This field displays the names of the classifier to which this policy applies.

Select an enftry’s check box to select a specific entfry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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22.3 Policy Example

The figure below shows an example Policy screen where you configure a policy to limit bandwidth and
discard out-of-profile traffic on a traffic flow classified using the Example classifier (refer to Section 21.5
on page 188).

Figure 140 Policy Example
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CHAPTER 23
Queuing Method

23.1 Queuing Method Overview

This chapter introduces the queuing methods supported.

Queuing is used to help solve performance degradation when there is network congestion. Use the
Queuing Method screen to configure queuing algorithms for outgoing fraffic. See also Priority Queue
Assignment in Switch Setup and 802.1p Priority in Port Setup for related information.

23.1.1 What You Can Do

Use the Queuing Method screen (Section 23.2 on page 195) to seft priorities for the queues of the Switch.
This distributes bandwidth across the different traffic queues.

23.1.2 What You Need to Know

Queuing algorithms allow switches to maintain separate queues for packets from each individual
source or flow and prevent a source from monopolizing the bandwidth.

Strictly Priority Queuing

Strictly Priority Queuing (SPQ) services queues based on priority only. As traffic comes into the Switch,
tfraffic on the highest priority queue, Q7 is fransmitted first. When that queue empties, traffic on the next
highest-priority queue, Q6 is fransmitted unfil Q6 empties, and then traffic is fransmitted on Q5 and so on.
If higher priority queues never empty, then traffic on lower priority queues never gets sent. SPQ does not
automatically adapt to changing network requirements.

Weighted Fair Queuing

Weighted Fair Queuing is used to guarantee each queue's minimum bandwidth based on its bandwidth
weight (portion) (the number you configure in the Weight field) when there is traffic congestion. WFQ is
activated only when a port has more traffic than it can handle. Queues with larger weights get more
guaranteed bandwidth than queues with smaller weights. This queuing mechanism is highly efficient in
that it divides any available bandwidth across the different traffic queues. By default, the weight for Q0
is 1, forQlis 2, for Q2is 3, and so on.

Weighted Round Robin Scheduling (WRR)

Round Robin Scheduling services queues on a rotating basis and is activated only when a port has more
tfraffic than it can handle. A queue is given an amount of bandwidth irrespective of the incoming fraffic
on that port. This queue then moves o the back of the list. The next queue is given an equal amount of
bandwidth, and then moves to the end of the list; and so on, depending on the number of queues
being used. This works in a looping fashion until a queue is empty.
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Weighted Round Robin Scheduling (WRR) uses the same algorithm as round robin scheduling, but
services queues based on their priority and queue weight (the number you configure in the queue
Weight field) rather than a fixed amount of bandwidth. WRR is activated only when a port has more
tfraffic than it can handle. Queues with larger weights get more service than queues with smaller
weights. This queuing mechanism is highly efficient in that it divides any available bandwidth across the
different traffic queues and returns to queues that have not yet emptied.

23.2 Configuring Queuing

Use this screen to set priorities for the queues of the Switch. This distributes bandwidth across the different
tfraffic queues.

Click Advanced Application > Queuing Method in the navigation panel.

Figure 141 Advanced Application > Queuing Method
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The following table describes the labels in this screen.

Table 90 Advanced Application > Queuing Method

LABEL

DESCRIPTION

Port

This label shows the port you are configuring.

*

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set the
common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Method

Select SPQ (Strictly Priority Queuing), WFQ (Weighted Fair Queuing) or WRR (Weighted Round Robin).

Strictly Priority Queuing services queues based on priority only. When the highest priority queue
empties, traffic on the next highest-priority queue begins. Q7 has the highest priority and QO the
lowest.

Weighted Fair Queuing is used to guarantee each queue's minimum bandwidth based on their
bandwidth portion (weight) (the number you configure in the Weight field). Queues with larger
weights get more guaranteed bandwidth than queues with smaller weights.

Weighted Round Robin Scheduling services queues on a rotating basis based on their queue weight
(the number you configure in the queue Weight field). Queues with larger weights get more service
than queues with smaller weights.

Weight

When you select WFQ or WRR enter the queue weight here. Bandwidth is divided across the different
fraffic queues according to their weights.

Hybrid-SPQ
Lowest-
Queue

This field is applicable only when you select WFQ or WRR.

Select a queue (QO to Q7) to have the Switch use SPQ to service the subsequent queues affer and
including the specified queue for the port. For example, if you select Q5, the Switch services traffic on
Q5, Q6 and Q7 using SPQ.

Select None to always use WFQ or WRR for the port.

Apply

Click Apply to save your changes to the Switch'’s run-time memory. The Switch loses these changes if
it is turned off or loses power, so use the Save link on the top navigation panel to save your changes to
the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.
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CHAPTER 24
Multicast

24.1 Multicast Overview

This chapter shows you how to configure various multicast features.

Traditionally, IP packets are fransmitted in one of either two ways - Unicast (one sender to one recipient)
or Broadcast (one sender to everybody on the network). Multicast delivers IP packets to just a group of
hosts on the network.

IGMP (Internet Group Management Protocol) is a network-layer protocol used to establish membership
in a multicast group - it is not used to carry user data. Refer to RFC 1112, RFC 2236 and RFC 3376 for
information on IGMP versions 1, 2 and 3 respectively.

24.1.1 What You Can Do

¢ Use the Multicast Setup screen (Section 24.2 on page 198) to display the links to the configuration
screens where you can configure IPv4 multicast settings.

* Use the IPv4 Multicast Status screen (Section 24.3 on page 198) to view IPv4 multicast group
information.

¢ Use the IGMP Snooping screen (Section 24.3.1 on page 199) to enable IGMP snooping to forward
group multicast traffic only to ports that are members of that group.

* Use the IGMP Snooping VLAN screen (Section 24.3.2 on page 202) to perform IGMP snooping on up to
16 VLANS.

¢ Use the IGMP Filtering Profile (Section 24.3.3 on page 203) to specify a range of multicast groups that
clients connected to the Switch are able to join.

24.1.2 What You Need to Know

Read on for concepts on Multicasting that can help you configure the screens in this chapter.

IP Multicast Addresses

In IPv4, a multicast address allows a device to send packets to a specific group of hosts (multicast
group) in a different subnetwork. A multicast IP address represents a traffic receiving group, not
individual receiving devices. IP addresses in the Class D range (224.0.0.0 to 239.255.255.255) are used for
IP multicasting. Certain IP multicast numbers are reserved by IANA for special purposes (see the IANA
website for more information).

IGMP Snooping

A Switch can passively snoop on IGMP packets transferred between IP multicast routers or switches and
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IP multicast hosts to learn the IP multicast group membership. It checks IGMP packets passing through it,
picks out the group registration information, and configures multicasting accordingly. IGMP snooping
allows the Switch to learn multicast groups without you having to manually configure them.

The Switch forwards multicast traffic destined for multicast groups (that it has learned from IGMP
snooping or that you have manually configured) to ports that are members of that group. IGMP
snooping generates no additional network traffic, allowing you fo significantly reduce multicast fraffic
passing through your Switch.

IGMP Snooping and VLANSs

The Switch can perform IGMP snooping on up to 16 VLANs. You can configure the Switch to
automatically learn multicast group membership of any VLANs. The Switch then performs IGMP
snooping on the first 16 VLANs that send IGMP packets. This is referred to as auto mode. Alternatively,
you can specify the VLANs that IGMP snooping should be performed on. This is referred to as fixed
mode. In fixed mode the Switch does not learn multicast group membership of any VLANs other than
those explicitly added as an IGMP snooping VLAN.

24.2 Multicast Setup

Use this screen to configure IGMP for IPv4. Click Advanced Application > Multicast in the navigation
panel.

Figure 142 Advanced Application > Multicast Setup

Multicast Setup

IPv4 Multicast Click Here

The following table describes the labels in this screen.

Table 91 Advanced Application > Multicast Setup

LABEL DESCRIPTION
IPv4 Multicast Click the link to open screens where you can configure IGMP snooping and IGMP filtering for
IPv4.

24.3 IPv4 Multicast Status

Click Advanced Application > Multicast > IPv4 Multicast to display the screen as shown. This screen
shows the IPv4 multicast group information. See Section 24.1 on page 197 for more information on
multicasting.

Figure 143 Advanced Application > Multicast > IPv4 Multicast

| IPvA Mulicast Status | Mullicast Setup IGMP Snooping
1 1 6 22400251
2 1 6 22400252
2 1 6 239.255.255.250

XS1930 Series User's Guide

198



Chapter 24 Multicast

The following table describes the labels in this screen.

Table 92 Advanced Application > Multicast > IPv4 Multicast

LABEL DESCRIPTION

Index This is the index number of the entry.

VID This field displays the multicast VLAN ID.

Port This field displays the port number that belongs to the multicast group.
Multicast Group This field displays IP multicast group addresses.

24.3.1 IGMP Snooping

Click the IGMP Snooping link in the Advanced Application > Multicast > IPv4 Multicast screen to display
the screen as shown. See Section 24.1 on page 197 for more informatfion on multicasting.

Figure 144 Advanced Application > Mulficast > IPv4 Multicast > IGMP Snooping
IPv4 Mullicast Status IGMP Snooping VLAN IGMP Filtering Profile

Active

Querier

Querier Version
IGMP Snooping

Report Proxy

Hest Timeout

802 1p Priority

IGMP Filtering Active

Unknown Mulficast Frame @® Flocding O Crop on VLAMN
Unknown Mulficast Frame to Gluerer Port @® Drop O Forwarding on VLAN
Reserved Multicast Group ® Flocdin g

O \:\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
O \Z\ [Deny  ~| [Default ~| [Auto v|
» | [cen
[

The following table describes the labels in this screen.

Table 93 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping

LABEL DESCRIPTION

IGMP Snooping Use these settings to configure IGMP snooping.

Active Select Active to enable IGMP Snooping to forward group multicast traffic only fo ports that
are members of that group.
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Table 93 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping (continued)

LABEL

DESCRIPTION

Querier

Select this option to allow the Switch to send IGMP General Query messages to the VLANs with
the multicast hosts attached.

Querier Version

IGMP snooping query works only when both host and Switch support the same IGMP version.
Select v2 to allow the Switch to send IGMPv2 queries only.

Select v3 to allow the Switch to send IGMPv3 queries only.

Report Proxy

Select this option to allow the Switch to act as the IGMP report proxy and leave proxy. It will
report group changes to a connected multicast router.

The Switch not only checks IGMP packets between multicast routers or switches and multicast
hosts to learn the multicast group membership, but also replaces the source MAC address in
an IGMP v1/v2 report with its own MAC address before forwarding to the multicast router or
switch. When the Switch receives more than one IGMP v1/v2 join report that requests to join
the same multicast group, it only sends a new join report with its MAC address. This helps
reduce the number of multicast join reports passed to the multicast router or switch.

The Switch sends a leave message with its MAC address to the multicast router or switch only
when it receives the leave message from the last host in a multicast group.

Host Timeout

Specify the time (from 1 to 16711450) in seconds that elapses before the Switch removes an
IGMP group membership entry if it does not receive report messages from the port.

802.1p Priority

Select a priority level (0 - 7) to which the Switch changes the priority in outgoing IGMP control
packets. Otherwise, select No-Change to not replace the priority.

IGMP Filtering

Select Active to enable IGMP filtering to control which IGMP groups a subscriber on a port
can join.

If you enable IGMP filtering, you must create and assign IGMP filtering profiles for the ports that
you want to allow to join mulficast groups.

Unknown Multicast
Frame

Specify the action to perform when the Switch receives an unknown multicast frame.

e Select Drop to discard the frames.
¢ Select Flooding to send the frames to all ports.

* Select Drop on VLAN and enter the VLAN ID numbers to discard the frames on the
specified VLANs. Use a dash to specify consecutive VLANs and a comma (no spaces) to
specify non-consecutive VLANs. For example, 51-53 includes 51, 52 and 53, but 51,53 does
not include 52.

Unknown Multicast
Frame to Querier
Port

Specify the action to perform when Unknown Multicast Frame is set to Drop.

e Select Drop to discard the frames.
¢ Select Forwarding to send the frames to all querier ports.

* Select Forwarding on VLAN and entfer the VLAN ID numbers to send the frames to the ports
which are used as an IGMP query port on the specified VLANs. Use a dash to specify
consecutive VLANs and a comma (no spaces) to specify non-consecutive VLANs. For
example, 51-53 includes 51, 52 and 53, but 51,53 does not include 52.

Reserved Multficast
Group

The IP address range of 224.0.0.0 to 224.0.0.255 are reserved for multicasting on the local
network only. For example, 224.0.0.1 is for all hosts on a local network segment and 224.0.0.9 is
used to send RIP routing information to all RIP v2 routers on the same network segment. A
multicast router will not forward a packet with the destination IP address within this range to
other networks. See the IANA web site for more information.

The layer-2 multicast MAC addresses used by Cisco layer-2 protocols, 01:00:0C:CC:CC:CC
and 01:00:0C:CC:CC:CD, are also included in this group.

Specify the action to perform when the Switch receives a frame with a reserved multicast
address.

* Select Drop to discard the frames.
* Select Flooding to send the frames to all ports.

Port

This field displays the port number.
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Table 93 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping (continued)

LABEL

DESCRIPTION

*

Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Changes in this row are copied to all the ports as soon as you make them.

Normal Leave

Enter an IGMP normal leave timeout value (from 200 to 6348800) in miliseconds. Select this
option to have the Switch use this timeout to update the forwarding table for the port.

In normal leave mode, when the Switch receives an IGMP leave message from a host on a
port, it forwards the message to the multicast router. The multicast router then sends out an
IGMP Group-Specific Query (GSQ) message to determine whether other hosts connected to
the port should remain in the specific multicast group. The Switch forwards the query message
to all hosts connected to the port and waits for IGMP reports from hosts to update the
forwarding table.

This defines how many seconds the Switch waits for an IGMP report before removing an IGMP
snooping membership entry when an IGMP leave message is received on this port from a
host.

Fast Leave

Enter an IGMP fast leave timeout value (from 200 to 6348800) in miliseconds. Select this option
to have the Switch use this timeout to update the forwarding table for the port.

In fast leave mode, right after receiving an IGMP leave message from a host on a port, the
Switch itself sends out an IGMP Group-Specific Query (GSQ) message to determine whether
other hosts connected to the port should remain in the specific multicast group. This helps
speed up the leave process.

This defines how many seconds the Switch waits for an IGMP report before removing an IGMP
snooping membership entry when an IGMP leave message is received on this port from a
host.

Group Limited

Select this option fo limit the number of multicast groups this port is allowed to join.

Max Group Num.

Enter the number of multicast groups this port is allowed to join. Once a port is registered in the
specified number of multicast groups, any new IGMP join report frames is dropped on this
port.

Throttling

IGMP throttling controls how the Switch deals with the IGMP reports when the maximum
number of the IGMP groups a port can join is reached.

Select Deny to drop any new IGMP join report received on this port unfil an existing multicast
forwarding table entry is aged out.

Select Replace to replace an existing entry in the multicast forwarding table with the new
IGMP reports received on this port.

IGMP Filtering
Profile

Select the name of the IGMP filtering profile to use for this port. Otherwise, select Default to
prohibit the port from joining any mulficast group.

You can create IGMP filtering profiles in the Multicast > IPv4 Multicast > IGMP Snooping > IGMP
Filtering Profile screen.

IGMP Querier
Mode

The Switch freats an IGMP query port as being connected to an IGMP multicast router (or
server). The Switch forwards IGMP join or leave packets to an IGMP query port.

Select Auto to have the Switch use the port as an IGMP query port if the port receives IGMP
query packets.

Select Fixed to have the Switch always use the port as an IGMP query port. Select this when
you connect an IGMP multicast server to the port.

Select Edge to stop the Switch from using the port as an IGMP query port. The Switch will not
keep any record of an IGMP router being connected to this port. The Switch does not forward
IGMP join or leave packets to this port.
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Table 93 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping (continued)
LABEL DESCRIPTION

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

24.3.2 IGMP Snooping VLAN

Click Advanced Application > Multicast > IPv4 Multicast in the navigation panel. Click the IGMP
Snooping link and then the IGMP Snooping VLAN link to display the screen as shown. See IGMP Snooping
and VLANs on page 198 for more information on IGMP Snooping VLAN.

Figure 145 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Snooping VLAN

IGMP Snooping VLAN IGMP Snooping
Mode ® auto O fixed

VLAN

Name
VID

The following table describes the labels in this screen.

Table 94 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Snooping VLAN
LABEL DESCRIPTION

Mode Select auto to have the Switch learn multicast group membership information of any VLANs
automatically.

Select fixed to have the Switch only learn multicast group membership information of the
VLANs that you specify below.

In either auto or fixed mode, the Switch can learn up to 16 VLANSs.
The Switch drops any IGMP confrol messages which do not belong fo these 16 VLANs.

You must also enable IGMP snooping in the Multicast > IPv4 Multicast > IGMP Snooping screen
first.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the fop navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

VLAN Use this section of the screen to add VLANs upon which the Switch is to perform IGMP
snooping.

Name Enter the descriptive name of the VLAN for identification purposes.

VID Enter the ID of a static VLAN; the valid range is between 1 and 4094.
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Table 94 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Snooping VLAN

LABEL DESCRIPTION

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.

Index This is the index number of the IGMP snooping VLAN entry in the table. Click on an index
number to view more details or change the setfings.

Name This field displays the descriptive name for this VLAN group.

VID This field displays the ID number of the VLAN group.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Check the entries that you want to remove, then click the Delete button.

Cancel Click Cancel to clear the check boxes.

24.3.3 IGMP Filtering Profile

An IGMP filtering profile specifies a range of multicast groups that clients connected to the Switch are
able to join. A profile contains a range of multicast IP addresses which you want clients to be able to
join. Profiles are assigned to ports (in the IGMP Snooping screen). Clients connected to those ports are
then able to join the multicast groups specified in the profile. Each port can be assigned a single profile.
A profile can be assigned to multiple ports.

Click Advanced Application > Multicast > IPv4 Multicast in the navigation panel. Click the IGMP
Snooping link and then the IGMP Filtering Profile link to display the screen as shown.

Figure 146 Advanced Application > Multicast > IPv4 Multicast > IGMP Snooping > IGMP Filtering Profile

IGMP Filtering Profile IGMP Snooping
Profile Setup
==
L]
Default O
0.000 0.000 ]
Delete
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The following table describes the labels in this screen.

Table 95 Advanced Application > Mulficast > IPv4 Multicast > IGMP Snooping > IGMP Filtering Profile

LABEL

DESCRIPTION

Profile Name

Enter a descriptive name for the profile for identification purposes.

To configure additional rules for a profile that you have already added, enter the profile
name and specify a different IP multicast address range.

Start Address

Type the starting multicast IP address for a range of multicast IP addresses that you want to
belong to the IGMP filter profile.

End Address

Type the ending multicast IP address for a range of IP addresses that you want to belong to
the IGMP filter profile.

If you want to add a single multicast IP address, enter it in both the Start Address and End
Address fields.

Add Click this to create a new entry.
This saves your changes to the Switch's run-time memory. The Switch loses these changes if it is
turned off or loses power, so use the Save link on the top navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Clear Click Clear to reset the fields to the factory defaults.

Profile Name

This field displays the descriptive name of the profile.

Start Address

This field displays the start of the multicast address range.

End Address

This field displays the end of the multicast address range.

Delete Profile

Select a profile's check box to select a specific profile. Otherwise, select the check box in the
table heading row to select all profiles.

Delete Rule Select the check boxes of the rules that you want to remove from a profile.

Delete To delete the profiles and all the accompanying rules, select the profiles that you want to
remove in the Delete Profile column, then click the Delete button.
To delete arules from a profile, select the rules that you want to remove in the Delete Rule
column, then click the Delete button.

Cancel Click Cancel to clear the Delete Profile or Delete Rule check boxes.
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CHAPTER 25
AAA

Authentication, Authorization and Accounting (AAA)

This chapter describes how to configure authentication, authorization and accounting settings on the
Switch.

The external servers that perform authentication, authorization and accounting functions are known as
AAA servers. The Switch supports RADIUS (Remote Authentication Dial-In User Service) as the external
authentication, authorization, and accounting server.

Figure 147 AAA Server

| | =
e— ’
—r

AAA Server

25.1.1 What You Can Do

¢ Use the AAA screen (Section 25.2 on page 206) to display the links to the screens where you can
enable authentication and authorization or both of them on the Switch.

* use the RADIUS Server Setup screen (Section 25.3 on page 206) to configure your RADIUS server
settings.

¢ Use the AAA Setup screen (Section 25.4 on page 208) to configure authentication, authorization and
accounting settings, such as the methods used to authenticate users accessing the Switch and which
database the Switch should use first.

25.1.2 What You Need to Know

Authentication is the process of determining who a user is and validating access to the Switch. The
Switch can authenticate users who fry to log in based on user accounts configured on the Switch itself.
The Switch can also use an external authentication server to authenticate a large number of users.

Authorization is the process of determining what a user is allowed to do. Different user accounts may
have higher or lower privilege levels associated with them. For example, user A may have the right to
create new login accounts on the Switch but user B cannot. The Switch can authorize users based on
user accounts configured on the Switch itself or it can use an external server to authorize a large number
of users.

Accounting is the process of recording what a user is doing. The Switch can use an external server to
frack when users log in, log out, execute commands and so on. Accounting can also record system
related actions such as boot up and shut down fimes of the Switch.
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Local User Accounts

By storing user profiles locally on the Switch, your Switch is able to authenticate and authorize users
without interacting with a network AAA server. However, there is a limit on the number of users you may
authenticate in this way.

RADIUS

RADIUS is a security protocol used to authenticate users by means of an external server instead of (orin
addition to) an internal device user database that is limited to the memory capacity of the device. In
essence, RADIUS authentication allows you to validate an unlimited number of users from a central
location.

25.2 AAA Screens

The AAA screens allow you to enable authentication and authorization or both of them on the Switch.
First, configure your authentication server seftings and then set up the authentication priority, activate
authorization.

Click Advanced Application > AAA in the navigation panel to display the screen as shown.

Figure 148 Advanced Application > AAA

RADIUS Server Setup Click Here
AAA Setup Click Here

25.3 RADIUS Server Setup

Use this screen to configure your RADIUS server setfings. Click the RADIUS Server Setup link in the AAA
screen o view the screen as shown.
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Figure 149 Advanced Application > AAA > RADIUS Server Setup

Avuthentication Server

RADIUS Server Setup AAA

Mode index-priority v

Timeout 30 seconds
1 [0.0.0.0 1812 |
2 0.0.0.0 1812 |

Accounting Server

Timeout seconds
1 0.0.0.0 1813 |
2 0.0.0.0 1813 |
Attribute
MAS-IP-Address 0.0.0.0

The following table describes the labels in this screen.

Table 96 Advanced Application > AAA > RADIUS Server Setup

LABEL DESCRIPTION

Authentication Use this section o configure your RADIUS authentication settings.

Server

Mode This field is only valid if you configure multiple RADIUS servers.
Select index-priority and the Switch tries to authenticate with the first configured RADIUS server,
if the RADIUS server does not respond then the Switch fries to authenticate with the second
RADIUS server.
Select round-robin to alternate between the RADIUS servers that it sends authentication
requests to.

Timeout Specify the amount of time in seconds that the Switch waits for an authentication request
response from the RADIUS server.
If you are using two RADIUS servers then the timeout value is divided between the two RADIUS
servers. For example, if you set the tfimeout value to 30 seconds, then the Switch waits for a
response from the first RADIUS server for 15 seconds and then tries the second RADIUS server.

Index This is a read-only number representing a RADIUS server entry.

IP Address Enter the IP address of an external RADIUS server in dofted decimal notation.

UDP Port The default port of a RADIUS server for authentication is 1812. You need not change this value
unless your network administrator instructs you to do so.
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Table 96 Advanced Application > AAA > RADIUS Server Setup (confinued)

LABEL

DESCRIPTION

Shared Secret

Specify a password (up to 32 alphanumeric charactersexcept [2]. [ | . [']. ["]or[.]) asthe
key to be shared between the external RADIUS server and the Switch. This key is not sent over
the network. This key must be the same on the external RADIUS server and the Switch.

Delete Check this box if you want to remove an existing RADIUS server entry from the Switch. This enfry
is deleted when you click Apply.

Accounting Use this section to configure your RADIUS accounting server settings.

Server

Timeout Specify the amount of time in seconds that the Switch waits for an accounting request
response from the RADIUS accounting server.

Index This is a read-only number representing a RADIUS accounting server entry.

IP Address Enter the IP address of an external RADIUS accounting server in dotted decimal notation.

UDP Port The default port of a RADIUS accounting server for accounting is 1813. You need not change

this value unless your network administrator instructs you to do so.

Shared Secret

Specify a password (up to 32 alphanumeric charactersexcept [2], [ | 1.['].["]or[.]) as the
key to be shared between the external RADIUS accounting server and the Switch. This key is not
sent over the network. This key must be the same on the external RADIUS accounting server
and the Switch.

Delete Check this box if you want to remove an existing RADIUS accounting server entry from the
Switch. This entry is deleted when you click Apply.
Attribute Use this section to define the RADIUS server attribute for its account.

NAS-IP-Address

Enter the IP address of the NAS (Network Access Server).

Apply

Click Apply to save your changes to the Switch's run-fime memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

25.4 AAA Setup

Use this screen to configure authentication, authorization and accounting setftings on the Switch. Click
on the AAA Setup link in the AAA screen fo view the screen as shown.
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Figure 150 Advanced Applicatfion > AAA > AAA Setup

AAA Setup
Authentication

Login

Authorizafion

Exec
Dotlx

Accounting

Update Period

Systemn
Dotlx

g
=
| =

O radius

O radius
O O - radius
O O start-stop radius

The following table describes the labels in this screen.

Table 97 Advanced Application > AAA > AAA Setup

LABEL DESCRIPTION

Authentication Use this section to specify the methods used to authenticate users accessing the Switch.

Login These fields specify which database the Switch should use (first and second) to authenticate
administrator accounts (users for Switch management).
Configure the local user accounts in the Access Control > Logins screen. The RADIUS is an
external server. Before you specify the priority, make sure you have set up the corresponding
database correctly first.
You can specify up to two methods for the Switch to authenticate administrator accounts. The
Switch checks the methods in the order you configure them (first Method 1, and then Method
2). You must configure the settings in the Method 1 field. If you want the Switch to check
another source for administrator accounts, specify them in the Method 2 field.
Select local to have the Switch check the administrator accounts configured in the Access
Control > Logins screen.
Select radius fo have the Switch check the administrator accounts configured through your
RADIUS server.

Authorization Use this section to configure authorization setftings on the Switch.

Type Set whether the Switch provides the following services to a user.
¢ Exec: Allow an administrator which logs info the Switch through Telnet or SSH to have a

different access privilege level assigned through the external server.
¢ Dotlx: Allow an IEEE 802.1x client to have different bandwidth limit or VLAN ID assigned
through the external server.

Active Select this to activate authorization for a specified event type.

Method RADIUS is the only method for authorization of the Exec type of service.

Accounfing Use this section to configure accounting settings on the Switch.

Update Period

This is the amount of time in minutes before the Switch sends an update to the accounting
server. This is only valid if you select the start-stop option for the Exec or Dotlx enfries.
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Table 97 Advanced Application > AAA > AAA Setup (continued)

LABEL DESCRIPTION

Type The Switch supports the following types of events to be sent to the accounting servers:

» System — Configure the Switch to send information when the following system events occur:
system boofts up, system shuts down, system accounting is enabled, system accounting is
disabled.

* Dotlx — Configure the Switch to send information when an IEEE 802.1x client begins a session
(authenticates through the Switch), ends a session as well as interim updates of a session.

Active Select this fo activate accounting for a specified event type.

Broadcast Select this to have the Switch send accounting information to all configured accounting
servers at the same time.

If you do not select this and you have two accounting servers set up, then the Switch sends
information to the first accounting server and if it does not get a response from the accounting
server then it fries the second accounting server.

Mode The Switch supports two modes of recording login events. Select:

* start-stop — to have the Switch send information to the accounting server when a user begins
a session, during a user’s session (if it lasts past the Update Period), and when a user ends a
session.

* stop-only — fo have the Switch send information to the accounting server only when a user
ends a session.

Method RADIUS is the only method for recording System or Exec type of event.

Apply Click Apply to save your changes fo the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

25.5 Technical Reference

This section provides technical background information on the fopics discussed in this chapter.

25.5.1 Vendor Specific Attribute

RFC 2865 standard specifies a method for sending vendor-specific information between a RADIUS server
and a network access device (for example, the Switch). A company can create Vendor Specific
Attributes (VSAs) to expand the functionality of a RADIUS server.

The Switch supports VSAs that allow you to perform the following actions based on user authentication:

* Limit bandwidth on incoming or outgoing traffic for the port the user connects to.
* Assign account privilege levels (See the CLI Reference Guide for more information on account
privilege levels) for the authenticated user.

The VSAs are composed of the following:

¢ Vendor-ID: An identification number assigned to the company by the IANA (Internet Assigned
Numbers Authority). Zyxel’'s vendor ID is 890.

* Vendor-Type: A vendor specified attribute, identifying the setting you want to modify.

¢ Vendor-data: A value you want to assign to the setting.
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Note: Refer to the documentation that comes with your RADIUS server on how to configure
VSAs for users authenticating through the RADIUS server.

The following table describes the VSAs supported on the Switch.

Table 98 Supported VSAs

FUNCTION ATTRIBUTE
Ingress Bandwidth Vendor-Id = 890
Assignment Vendor-Type = 1

Vendor-data ingress rate (Kbps in decimal format)

Egress Bandwidth
Assignment

Vendor-Id = 890
Vendor-Type = 2
Vendor-data = egress rate (Kbps in decimal format)

Privilege Assignment

Vendor-ID = 890
Vendor-Type = 3
Vendor-Data = "shell:priv-1lvl=N"

or

Vendor-ID = 9 (CISCO)
Vendor-Type 1 (CISCO-AVPAIR)
Vendor-Data = "shell:priv-1lvl=N"

where N is a privilege level (from 0 to 14).

Note: If you set the privilege level of a login account differently on the RADIUS
servers and the Switch, the user is assigned a privilege level from the
database (RADIUS or local) the Switch uses first for user authentication.

25.5.1.1 Tunnel Protocol Attribute

You can configure tunnel protocol attributes on the RADIUS server (refer to your RADIUS server
documentation) to assign a port on the Switch to a VLAN based on IEEE 802.1x authentication. The port
VLAN settings are fixed and untagged. This will also set the port’s VID. The following table describes the
values you need to configure. Note that the bolded values in the table are fixed values as defined in

RFC 3580.

Table 99 Supported Tunnel Protocol Attribute

FUNCTION

ATTRIBUTE

VLAN Assignment

Tunnel-Type = VLAN(13)

Tunnel-Medium-Type = 802 (6)

Tunnel-Private-Group-ID = VLANID

Note: You must also create a VLAN with the specified VID on the Switch.

Note: The bolded values in this table are fixed values as defined in RFC 3580.
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25.5.2 Supported RADIUS Attributes

Remote Authentication Dial-In User Service (RADIUS) attributes are data used to define specific
authentication elements in a user profile, which is stored on the RADIUS server. This section lists the
RADIUS attributes supported by the Switch.

Refer to RFC 2865 for more information about RADIUS attributes used for authentication.

This section lists the attributes used by authentication functions on the Switch. In cases where the
attribute has a specific format associated with it, the format is specified.

25.5.3 Attributes Used for Authentication

The following sections list the atftributes sent from the Switch to the RADIUS server when performing
authentication.

25.5.3.1 Attributes Used for Authenticating Privilege Access
User-Name

—The format of the User-Name attribute is $enab#$, where # is the privilege level (1 - 14).
User-Password

NAS-Identifier
NAS-IP-Address

25.5.3.2 Attributes Used to Login Users
User-Name
User-Password
NAS-Identifier
NAS-IP-Address

25.5.3.3 Attributes Used by the IEEE 802.1x Authentication
User-Name
NAS-Identifier
NAS-IP-Address
NAS-Port
NAS-Port-Type
- This value is set to Ethernet(15) on the Switch.
Calling-Station-Id

Frame-MTU
EAP-Message
State

Message-Authenticator
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CHAPTER 26
DHCP Snooping

26.1 DHCP Snooping Overview

With DHCP snooping, the Switch can block a DHCP server on a snooped VLAN that comes from an
untrusted port in your network.

26.1.1 What You Can Do

Use the DHCP Snooping screen (Section 26.2 on page 213) to look at various statistics about the DHCP
snooping database.

Use this DHCP Snooping Configure screen (Section 26.3 on page 216) to enable DHCP snooping on
the Switch (not on specific VLAN), specify the VLAN where the default DHCP server is located, and
configure the DHCP snooping database.

Use the DHCP Snooping Port Configure screen (Section 26.3.1 on page 218) to specify whether ports
are trusted or untrusted ports for DHCP snooping.

Use the DHCP Snooping VLAN Configure screen (Section 26.3.2 on page 219) to enable DHCP
snooping on each VLAN and to specify whether or not the Switch adds DHCP relay agent option 82
information to DHCP requests that the Switch relays to a DHCP server for each VLAN.

Use the DHCP Snooping VLAN Port Configure screen (Section 26.3.3 on page 220) to apply a different
DHCP option 82 profile to certain ports in a VLAN.

26.2 DHCP Snooping

Use this screen to look at various statistics about the DHCP snooping database.

To open this screen, click Advanced Application > DHCP Snooping.
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Figure 151 Advanced Application > DHCP Snooping
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The following table describes the labels in this screen.

Table 100 Advanced Application > DHCP Snooping

LABEL DESCRIPTION
Database Status This section displays the current settings for the DHCP snooping database. You can
configure them in the DHCP Snooping Configure screen.
Agent URL This field displays the location of the DHCP snooping database.
Write delay timer This field displays how long (in seconds) the Switch tries to complete a specific update

in the DHCP snooping database before it gives up.
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Table 100 Advanced Application > DHCP Snooping (continued)

LABEL

DESCRIPTION

Abort timer

This field displays how long (in seconds) the Switch waits to update the DHCP snooping
database affer the current bindings change.

This section displays information about the current update and the next update of the
DHCP snooping database.

Agent running

This field displays the status of the current update or access of the DHCP snooping
database.

None: The Switch is not accessing the DHCP snooping database.
Read: The Switch is loading dynamic bindings from the DHCP snooping database.
Write: The Switch is updating the DHCP snooping database.

Delay timer expiry

This field displays how much longer (in seconds) the Switch fries to complete the
current update before it gives up. It displays Not Running if the Switch is not updating
the DHCP snooping database right now.

Abort timer expiry

This field displays when (in seconds) the Switch is going to update the DHCP snooping
database again. It displays Not Running if the current bindings have not changed
since the last update.

This section displays information about the last time the Switch updated the DHCP
snooping database.

Last succeeded time

This field displays the last time the Switch updated the DHCP snooping database
successfully.

Last failed time

This field displays the last time the Switch updated the DHCP snooping database
unsuccessfully.

Last failed reason

This field displays the reason the Switch updated the DHCP snooping database
unsuccessfully.

This section displays historical information about the number of times the Switch
successfully or unsuccessfully read or updated the DHCP snooping database.

Total attempts

This field displays the number of fimes the Switch has tried to access the DHCP
snooping database for any reason.

Startup failures

This field displays the number of times the Switch could not create or read the DHCP
snooping database when the Switch started up or a new URL is configured for the
DHCP snooping database.

Successful fransfers

This field displays the number of times the Switch read bindings from or updated the
bindings in the DHCP snooping database successfully.

Failed transfers

This field displays the number of times the Switch was unable to read bindings from or
update the bindings in the DHCP snooping database.

Successful reads

This field displays the number of times the Switch read bindings from the DHCP
snooping database successfully.

Failed reads

This field displays the number of fimes the Switch was unable to read bindings from the
DHCP snooping database.

Successful writes

This field displays the number of times the Switch updated the bindings in the DHCP
snooping database successfully.

Failed writes

This field displays the number of times the Switch was unable to update the bindings in
the DHCP snooping database.

Database detail

First successful access

This field displays the first time the Switch accessed the DHCP snooping database for
any reason.

Last ignored bindings
counters

This section displays the number of times and the reasons the Switch ignored bindings
the last time it read bindings from the DHCP binding database. You can clear these
counters by restarting the Switch or using CLI commands. See the CLI Reference
Guide.

XS1930 Series User's Guide

215




Chapter 26 DHCP Snooping

Table 100 Advanced Application > DHCP Snooping (continued)

LABEL

DESCRIPTION

Binding collisions

This field displays the number of bindings the Switch ignored because the Switch
already had a binding with the same MAC address and VLAN ID.

Invalid interfaces

This field displays the number of bindings the Switch ignored because the port number
was a trusted interface or does not exist anymore.

Parse failures

This field displays the number of bindings the Switch ignored because the Switch was
unable to understand the binding in the DHCP binding database.

Expired leases

This field displays the number of bindings the Switch ignored because the lease time
had already expired.

Unsupported vians

This field displays the number of bindings the Switch ignored because the VLAN ID does
not exist anymore.

Last ignored time

This field displays the last time the Switch ignored any bindings for any reason from the
DHCP binding database.

Total ignored bindings
counters

This section displays the reasons the Switch has ignored bindings any time it read
bindings from the DHCP binding database. You can clear these counters by restarting
the Switch or using CLI commands. See the CLI Reference Guide.

Binding collisions

This field displays the number of bindings the Switch has ignored because the Switch
already had a binding with the same MAC address and VLAN ID.

Invalid interfaces

This field displays the number of bindings the Switch has ignored because the port
number was a trusted interface or does not exist anymore.

Parse failures

This field displays the number of bindings the Switch has ignored because the Switch
was unable to understand the binding in the DHCP binding database.

Expired leases

This field displays the number of bindings the Switch has ignored because the lease
fime had already expired.

Unsupported vians

This field displays the number of bindings the Switch has ignored because the VLAN ID
does not exist anymore.

26.3 DHCP Snooping Configure

Use this screen to enable DHCP snooping on the Switch (not on specific VLAN), specify the VLAN where
the default DHCP server is located, and configure the DHCP snooping database. The DHCP snooping
database stores the current bindings on a secure, external TFTP server so that they are still available after

a restart.

To open this screen, click Advanced Application > DHCP Snooping > Configure.
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Figure 152 Advanced Application > DHCP Snooping > Configure
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The following table describes the labels in this screen.

Table 101 Advanced Application > DHCP Snooping > Configure

LABEL

DESCRIPTION

Active

Select this to enable DHCP snooping on the Switch. You sfill have fo enable DHCP
snooping on specific VLAN and specify trusted ports.

Note: If DHCP is enabled and there are no trusted ports, DHCP requests will
not succeed.

DHCP Vian

Select a VLAN ID if you want the Switch to forward DHCP packets to DHCP servers on a
specific VLAN.

Note: You have to enable DHCP snooping on the DHCP VLAN too.

You can enable Option82 in the DHCP Snooping VLAN Configure screen to help the
DHCP servers distinguish between DHCP requests from different VLAN.

Select Disable if you do not want the Switch to forward DHCP packets to a specific
VLAN.

Database

If Timeout interval is greater than Write delay interval, it is possible that the next update
is scheduled to occur before the current update has finished successfully or timed out.
In this case, the Switch waits to start the next update until it completes the current one.

Agent URL

Enter the location of the DHCP snooping database. The location should be expressed
like this: tftp://{domain name or IP address}/directory, if applicable/file name; for
example, tftp://192.168.10.1/database.txt.

Timeout interval

Enter how long (10 — 65535 seconds) the Switch tries to complete a specific update in
the DHCP snooping database before it gives up.

Write delay interval

Enter how long (10 — 65535 seconds) the Switch waits to update the DHCP snooping
database the first time the current bindings change after an update. Once the next
update is scheduled, additional changes in current bindings are automatically
included in the next update.
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Table 101 Advanced Application > DHCP Snooping > Configure (continued)

LABEL DESCRIPTION
Renew DHCP Enter the location of a DHCP snooping database, and click Renew if you want the
Snooping URL Switch to load it. You can use this to load dynamic bindings from a different DHCP

snooping database than the one specified in Agent URL.

When the Switch loads dynamic bindings from a DHCP snooping database, it does not
discard the current dynamic bindings first. If there is a conflict, the Switch keeps the
dynamic binding in volatile memory and updates the Binding collisions counter in the
DHCP Snooping screen (Section 26.2 on page 213).

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses
these changes if it is furned off or loses power, so use the Save link on the fop
navigation panel to save your changes to the non-volatile memory when you are
done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

26.3.1 DHCP Snooping Port Configure

Use this screen to specify whether ports are trusted or untrusted ports for DHCP snooping.

Note: If DHCP snooping is enabled but there are no trusted ports, DHCP requests cannot
reach the DHCP server.

You can also specify the maximum number for DHCP packets that each port (trusted or untrusted) can
receive each second.

To open this screen, click Advanced Application > DHCP Snooping > Configure > Port.

Figure 153 Advanced Applicafion > DHCP Snooping > Configure > Port
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The following table describes the labels in this screen.

Table 102 Advanced Application > DHCP Snooping > Configure > Port

LABEL DESCRIPTION

Port This field displays the port number. If you configure the * port, the settings are applied to all
of the ports.

* Settings in this row apply to all ports.

Use this row only if you want fo make some settings the same for all ports. Use this row first to
set the common settings and then make adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

Server Trusted state | Select whether this port is a frusted port (Trusted) or an untrusted port (Untrusted).

Trusted ports are connected to DHCP servers or other switches, and the Switch discards
DHCP packets from trusted ports only if the rate at which DHCP packets arrive is foo high.

Untrusted ports are connected to subscribers, and the Switch discards DHCP packets from
untrusted ports in the following situations:

* The packetis a DHCP server packet (for example, OFFER, ACK, or NACK).

¢ The source MAC address and source IP address in the packet do not match any of the
current bindings.

¢ The packetis a RELEASE or DECLINE packet, and the source MAC address and source
port do not match any of the current bindings.

* The rate af which DHCP packets arrive is too high.

Rate (pps) Specify the maximum number for DHCP packets (1 — 256) that the Switch receives from
each port each second. The Switch discards any additional DHCP packets. Enter 0 to
disable this limit, which is recommended for trusted ports.

Apply Click Apply to save your changes to the Switch'’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen to their last-saved values.

26.3.2 DHCP Snooping VLAN Configure

Use this screen to enable DHCP snooping on each VLAN and to specify whether or not the Switch adds
DHCP relay agent opfion 82 information to DHCP requests that the Switch relays to a DHCP server for
each VLAN.

To open this screen, click Advanced Application > DHCP Snooping > Configure > VLAN.

Figure 154 Advanced Application > DHCP Snooping > Configure > VLAN
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The following table describes the labels in this screen.

Table 103 Advanced Application > DHCP Snooping > Configure > VLAN

LABEL

DESCRIPTION

VLAN Search by VID

Specify the VLANs you want fo manage in the section below. Use a comma (,) to separate
individual VLANs or a dash (-) to indicates a range of VLANs. For example, “3,4" or “3-9".

Search Click this to display the specified range of VLANs in the section below.

VID This field displays the VLAN ID of each VLAN in the range specified above. If you configure
the * VLAN, the settings are applied to all VLANSs.

Enabled Select Yes to enable DHCP snooping on the VLAN. You still have to enable DHCP snooping

on the Switch and specify trusted ports.

Note: If DHCP is enabled and there are no frusted ports, DHCP requests will not
succeed.

Option 82 Profile

Select a pre-defined DHCP option 82 profile that the Switch applies to all ports in the
specified VLANs. The Switch adds the information (such as slot number, port number, VLAN
ID and/or system name) specified in the profile to DHCP requests that it broadcasts to the
DHCP VLAN, if specified, or VLAN. You can specify the DHCP VLAN in the DHCP Snooping
Configure screen.

Apply Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values in this screen fo their last-saved values.

Change Pages

Click Previous or Next to show the previous/next screen if all status information cannot be
seen in one screen.

26.3.3 DHCP Snooping VLAN Port Configure

Use this screen to apply a different DHCP option 82 profile to certain ports in a VLAN.

To open this screen, click Advanced Application > DHCP Snooping > Configure > VLAN > Port.

Figure 155 Advanced Application > DHCP Snooping > Configure > VLAN > Port
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The following table describes the labels in this screen.

Table 104 Advanced Application > DHCP Snooping > Configure > VLAN > Port

LABEL DESCRIPTION
VID Enter the ID number of the VLAN you want to configure here.
Port Enter the number of ports to which you want to apply the specified DHCP option 82 profile.

You can enter multiple ports separated by (no space) comma (,) or hyphen (-). For
example, enter *3-5" for ports 3, 4, and 5. Enter “3,5,7" for ports 3, 5, and 7.

Option 82 Profile

Select a pre-defined DHCP option 82 profile that the Switch applies to the specified ports in
this VLAN. The Switch adds the information (such as slot number, port number, VLAN ID and/
or system name) specified in the profile to DHCP requests that it broadcasts to the DHCP
VLAN, if specified, or VLAN. You can specify the DHCP VLAN in the DHCP Snooping
Configure screen.

The profile you select here has priority over the one you select in the DHCP Snooping >
Configure > VLAN screen.

Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch's run-time memory. The Switch loses these changes if
it is furned off or loses power, so use the Save link on the top navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected entry or, if not applicable, to
clear the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change the
settings.

VID This field displays the VLAN to which the ports belong.

Port This field displays the ports to which the Switch applies the settings.

Profile Name

This field displays the DHCP option 82 profile that the Switch applies to the ports.

Delete Select the entries that you want to remove in the Delete column, then click the Delete
button to remove the selected entries from the table.
Cancel Click this to clear the Delete check boxes above.

26.4 Technical Reference

This section provides technical background information on the topics discussed in this chapfter.

26.4.1 DHCP Snooping Overview

Use DHCP snooping fo filter unauthorized DHCP packets on the network and to build the binding table
dynamically. This can prevent clients from getting IP addresses from unauthorized DHCP servers.

26.4.1.1 Trusted vs. Untrusted Ports

Every port is either a frusted port or an untrusted port for DHCP snooping. This setfting is independent of
the trusted or untrusted setting for ARP inspection. You can also specify the maximum number for DHCP
packets that each port (frusted or untrusted) can receive each second.

Trusted ports are connected to DHCP servers or other switches. The Switch discards DHCP packets from
trusted ports only if the rate at which DHCP packets arrive is foo high. The Switch learns dynamic
bindings from frusted ports.
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Note: If DHCP is enabled and there are no trusted ports, DHCP requests will not succeed.

Untrusted ports are connected to subscribers. The Switch discards DHCP packets from untrusted ports in
the following situations:

* The packet is a DHCP server packet (for example, OFFER, ACK, or NACK).

¢ The source MAC address and source IP address in the packet do not match any of the current
bindings.

e The packetis a RELEASE or DECLINE packet, and the source MAC address and source port do not
match any of the current bindings.

¢ The rate at which DHCP packets arrive is too high.

26.4.1.2 DHCP Snooping Database

The Switch stores the binding table in volatile memory. If the Switch restarts, it loads static bindings from
permanent memory but loses the dynamic bindings, in which case the devices in the network have to
send DHCP requests again. As a result, it is recommended you configure the DHCP snooping database.

The DHCP snooping database maintains the dynamic bindings for DHCP snooping and ARP inspection
in a file on an external TFTP server. If you set up the DHCP snooping database, the Switch can reload the
dynamic bindings from the DHCP snooping database after the Switch restarts.

You can configure the name and location of the file on the external TFTP server. The file has the following
format:

Figure 156 DHCP Snooping Database File Format

<initial-checksums>

TYPE DHCP-SNOOPING

VERSION 1

BEGIN

<binding-1> <checksum-1>
<binding-2> <checksum-1-2>

<binding-n> <checksum-1-2-..-n>
END

The <initial-checksum> helps distinguish between the bindings in the latest update and the bindings
from previous updates. Each binding consists of 72 bytes, a space, and another checksum that is used
to validate the binding when it is read. If the calculated checksum is not equal to the checksum in the
file, that binding and all others after it are ignored.

26.4.1.3 DHCP Relay Option 82 Information

The Switch can add information to DHCP requests that it does not discard. This provides the DHCP server
more information about the source of the requests. The Switch can add the following information:

* SlotID (1 byte), port ID (1 byte), and source VLAN ID (2 bytes)
* System name (up fo 32 bytes)

This information is stored in an Agent Information field in the option 82 field of the DHCP headers of client
DHCP request frames.
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When the DHCP server responds, the Switch removes the information in the Agent Information field
before forwarding the response to the original source.

You can configure this setting for each source VLAN. This setting is independent of the DHCP relay
settings.

26.4.1.4 Configuring DHCP Snooping

Follow these steps to configure DHCP snooping on the Switch.

1 Enable DHCP snooping on the Switch.
2 Enable DHCP snooping on each VLAN, and configure DHCP relay option 82.

3 Configure trusted and untrusted ports, and specify the maximum number of DHCP packets that each
port can receive per second.

4 Configure static bindings.
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CHAPTER 27
Loop Guard

27.1 Loop Guard Overview

This chapter shows you how to configure the Switch to guard against loops on the edge of your network.

Loop guard allows you to configure the Switch to shut down a port if it detects that packets sent out on
that port loop back to the Switch. While you can use Spanning Tree Protocol (STP) to prevent loops in the
core of your network. STP cannoft prevent loops that occur on the edge of your network.

Figure 157 Loop Guard vs. STP
STP

Loop Guard

Refer to Section 27.1.2 on page 224 for more information.

27.1.1 What You Can Do

Use the Loop Guard screen (Section 27.2 on page 226) to enable loop guard on the Switch and in
specific ports.

27.1.2 What You Need to Know

Loop guard is designed to handle loop problems on the edge of your network. This can occur when a
port is connected to a Switch that is in a loop state. Loop state occurs as a result of human error. It
happens when two ports on a switch are connected with the same cable. When a switch in loop state
sends out broadcast messages the messages loop back to the switch and are re-broadcast again and
again causing a broadcast storm.

If a switch (not in loop state) connects to a switch in loop state, then it will be affected by the switch in
loop state in the following way:

* The switch (not in loop state) will receive broadcast messages sent out from the switch in loop state.
¢ The switch (not in loop state) will receive its own broadcast messages that it sends out as they loop
back. It will then re-broadcast those messages again.

The following figure shows port N on switch A connected to switch B. Switch B has two ports, x and y,
mistakenly connected to each other. It forms a loop. When broadcast or multicast packets leave port N
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and reach switch B, they are sent back to port N on A as they are rebroadcast from B.

Figure 158 Swiftch in Loop State

The loop guard feature checks to see if a loop guard enabled port is connected to a Switch in loop
state. This is accomplished by periodically sending a probe packet and seeing if the packet returns on
the same port. If this is the case, the Switch will shut down the port connected to the switch in loop state.

Loop guard can be enabled on both Ethernet ports. The following figure shows a loop guard enabled
port N on switch A sending a probe packet P to switch B. Since switch B is in loop state, the probe
packet P returns to port N on A. The Switch then shuts down port N to ensure that the rest of the network
is not affected by the switch in loop state.

Figure 159 Loop Guard - Probe Packet

A B

The Switch also shuts down port N if the probe packet returns to switch A on any other port. In other
words loop guard also protects against standard network loops.

The following figure illustrates three switches forming a loop. A sample path of the loop guard probe
packet is also shown. In this example, the probe packet is sent from port N and returns on another port.
As long as loop guard is enabled on port N. The Switch will shut down port N if it detects that the probe
packet has returned to the Switch.

Figure 160 Loop Guard — Network Loop

A
B

- B e B

Note: After resolving the loop problem on your network you can re-activate the disabled port
through the Web Configurator or through commands (See the CLI Reference Guide).
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27.2 Loop Guard Setup

Click Advanced Application > Loop Guard in the navigation panel to display the screen as shown.

Note: The loop guard feature cannot be enabled on the ports that have Spanning Tree
Protocol (RSTP or MSTP) enabled.

Figure 161 Advanced Application > Loop Guard

Active O
* O
1 O
2 O
3 O
4 O
5 O
6 O
7 |
8 |
T

The following table describes the labels in this screen.

Table 105 Advanced Application > Loop Guard

LABEL DESCRIPTION

Active Select this option fo enable loop guard on the Switch.

The Switch generates syslog, internal log messages as well as SNMP fraps when it shuts down a
port through the loop guard feature.

Port This field displays the port number.

* Settings in this row apply to all ports.

Use this row only if you want to make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.
Note: Changes in this row are copied to all the ports as soon as you make them.

Active Select this check box to enable the loop guard feature on this port. The Switch sends broadcast
and multicast probe packets from this port to check if the switch it is connected to is in loop
state. If the switch that this port is connected is in loop state the Switch will shut down this port.
Clear this check box to disable the loop guard feature.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 28
Layer 2 Protocol Tunneling

28.1 Layer 2 Protocol Tunneling Overview

This chapter shows you how to configure layer 2 protocol funneling on the Switch.

28.1.1 What You Can Do

Use the Layer 2 Protocol Tunnel screen (Section 28.1 on page 227) to enable layer 2 protocol tunneling
on the Switch and specify a MAC address with which the Switch uses to encapsulate the layer 2
protocol packets by replacing the destination MAC address in the packets.

28.1.2 What You Need to Know

Layer 2 protocol tunneling (L2PT) is used on the service provider's edge devices.

L2PT allows edge switches (1 and 2 in the following figure) to tunnel layer 2 STP (Spanning Tree Protocol),
CDP (Cisco Discovery Protocol) and VTP (VLAN Trunking Protocol) packets between customer switches
(A, B and C in the following figure) connected through the service provider's network. The edge switch
encapsulates layer 2 protocol packets with a specific MAC address before sending them across the
service provider’s network to other edge switches.

Figure 162 Layer 2 Protocol Tunneling Network Scenario

A

B

In the following example, if you enable L2PT for STP, you can have switches A, B, C and D in the same
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spanning free, even though switch A is not directly connected to switches B, C and D. Topology change
information can be propagated throughout the service provider's network.

To emulate a point-to-point topology between two customer switches at different sites, such as A and B,
you can enable protocol tunneling on edge switches 1 and 2 for PAgP (Port Aggregation Protocol),
LACP or UDLD (Uni-Directional Link Detection).

Figure 163 L2PT Network Example
A B

28.1.2.1 Layer 2 Protocol Tunneling Mode

Each port can have two layer 2 protocol tunneling modes, Access and Tunnel.

¢ The Access port is an ingress port on the service provider's edge device (1 or 2 in Figure 163 on page
228) and connected to a customer switch (A or B). Incoming layer 2 protocol packets received on an
access port are encapsulated and forwarded to the tunnel ports.

e The Tunnel port is an egress port at the edge of the service provider's network and connected to
another service provider’s switch. Incoming encapsulated layer 2 protocol packets received on a
tunnel port are decapsulated and sent to an access port.

28.2 Configuring Layer 2 Protocol Tunneling

Click Advanced Application > Layer 2 Protocol Tunneling in the navigation panel to display the screen
as shown.

XS1930 Series User's Guide

228



Chapter 28 Layer 2 Protocol Tunneling

Figure 164 Advanced Applicatfion > Layer 2 Protocol Tunneling
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The following table describes the labels in this screen.

Table 106 Advanced Application > Layer 2 Protocol Tunneling

LABEL DESCRIPTION
Active Select this to enable layer 2 protocol tunneling on the Switch.
Destination Specify a MAC address with which the Switch uses to encapsulate the layer 2 protocol packets

MAC Address

by replacing the destination MAC address in the packets.

Note: The MAC address can be either a unicast MAC address or multicast MAC
address. If you use a unicast MAC address, make sure the MAC address does
not exist in the address table of a switch on the service provider's network.

Note: All the edge switches in the service provider’s network should be set to use the
same MAC address for encapsulation.

Port

This field displays the port number. * means all ports.

Use this row to make the setting the same for all ports. Use this row first and then make
adjustments on a port-by-port basis.

Note: Changes in this row are copied to all the ports as soon as you make them.

CDP

Select this option to have the Switch tunnel CDP (Cisco Discovery Protocol) packets so that
other Cisco devices can be discovered through the service provider’s network.

STP

Select this option to have the Switch tunnel STP (Spanning Tree Protocol) packets so that STP can
run properly across the service provider's network and spanning frees can be set up based on
bridge information from all (local and remote) networks.

VTP

Select this option to have the Switch tunnel VTP (VLAN Trunking Protocol) packets so that alll
customer switches can use consistent VLAN configuration through the service provider's
network.

LLDP

Select this option to have the Switch tunnel LLDP (Link Layer Discovery Protocol) packets so that
all network devices can advertise its identity and capabilities through the service provider’s
network.
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Table 106 Advanced Application > Layer 2 Protocol Tunneling (continued)

LABEL

DESCRIPTION

Point to Point

The Switch supports PAQP (Port Aggregation Protocol), LACP (Link Aggregation Control
Protocol) and UDLD (UniDirectional Link Detection) tunneling for a point-to-point topology.

Both PAgP and UDLD are Cisco’s proprietary data link layer protocols. PAgP is similar to LACP
and used to set up a logical aggregation of Ethernet ports automatically. UDLD is to determine
the link’s physical status and detect a unidirectional link.

PAGP

Select this option fo have the Switch send PAgQP packets to a peer to automatically negoftiate
and build a logical port aggregation.

LACP

Select this option to have the Switch send LACP packets to a peer to dynamically create and
manage frunk groups.

ubLD

Select this option to have the Switch send UDLD packets to a peer’s port it connected fo
monitor the physical status of a link.

Mode

Select Access to have the Switch encapsulate the incoming layer 2 protocol packets and
forward them to the funnel ports. Select Access for ingress ports at the edge of the service
provider's network.

Note: You can enable L2PT services for STP, LACP, VTP, CDP, UDLD, PAgP, and LLDP on
the access ports only.

Select Tunnel for egress ports at the edge of the service provider's network. The Switch
decapsulates the encapsulated layer 2 protocol packets received on a tunnel port by
changing the destination MAC address to the original one, and then forward them to an access
port. If the services is not enabled on an access port, the protocol packets are dropped.

Apply

Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the fop navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.
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CHAPTER 29
PPPOE

29.1 PPPOE Intermediate Agent Overview

This chapter describes how the Switch gives a PPPoE termination server additional information that the
server can use fo identify and authenticate a PPPoOE client.

A PPPOE Intfermediate Agent (PPPOE IA) is deployed between a PPPOE server and PPPOE clients. It helps
the PPPOE server identify and authenticate clients by adding subscriber line specific information to
PPPOE discovery packets from clients on a per-port or per-port-per-VLAN basis before forwarding them
to the PPPOE server.

PPPGE Server
PPPoE Client PPPOE IA -
:
-_— I

29.1.1 What You Can Do

* Use the PPPOE screen (Section 29.2 on page 233) to display the main PPPOE screen.

¢ Use the Intermediate Agent screen (Section 29.3 on page 234) to enable the PPPoE Intermediate
Agent on the Switch.

» Use the PPPOE IA Per-Port screen (Section 29.3.1 on page 235) to set the port state and configure
PPPoOE infermediate agent sub-options on a per-port basis.

¢ Use the PPPOE IA Per-Port Per-VLAN screen (Section 29.3.2 on page 236) to configure PPPoE |A settings
that apply to a specific VLAN on a port.

* Use the PPPOE IA for VLAN (Section 29.3.3 on page 237) to enable the PPPoOE Intermediate Agent on a
VLAN.

29.1.2 What You Need to Know

Read on for concepts on ARP that can help you configure the screen in this chapter.

29.1.2.1 PPPOE Intermediate Agent Tag Format

If the PPPOE Intermediate Agent is enabled, the Switch adds a vendor-specific tag to PADI (PPPoOE
Active Discovery Inifialization) and PADR (PPPoOE Active Discovery Request) packets from PPPOE clients.
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This tag is defined in RFC 2516 and has the following format for this feature.

Table 107 PPPoE Intermediate Agent Vendor-specific Tag Format
Tag_Type Tag_Len i i2

(0x0105)

The Tag_Type is 0x0105 for vendor-specific tags, as defined in RFC 2516. The Tag_Len indicates the
length of Value, i1 and i2. The Value is the 32-bit number 0x00000DE?, which stands for the “ADSL Forum”
IANA entry. i1 and i2 are PPPoE infermediate agent sub-options, which contain additional information
about the PPPOE client.

29.1.2.2 Sub-Option Format

There are two types of sub-opftion: “Agent Circuit ID Sub-option” and "Agent Remote ID Sub-option™.
They have the following formats.

Table 108 PPPoE IA Circuit ID Sub-option Format: User-defined String

SubOpt Length Value
0x01 N String
(1 byte) (1 byte) (63 bytes)
Table 109 PPPoE IA Remote ID Sub-option Format
SubOpt Length Value
0x02 N MAC Address or String
(1 byte) (1 byte) (63 bytes)

The 1 in the first field identifies this as an Agent Circuit ID sub-option and 2 identifies this as an Agent
Remote ID sub-option. The next field specifies the length of the field. The Switch takes the Circuit ID string
you manually configure for a VLAN on a port as the highest priority and the Circuit ID string for a port as
the second priority. In addition, the Switch puts the PPPoE client’s MAC address into the Agent Remote
ID Sub-option if you do not specify any user-defined string.

Flexible Circuit ID Syntax with Identifier String and Variables

If you do not configure a Circuit ID string for a VLAN on a specific port or for a specific port, the Switch
adds the user-defined identifier string and variables into the Agent Circuit ID Sub-option. The variables
can be the slot ID of the PPPoOE client, the port number of the PPPoE client and/or the VLAN ID on the
PPPoOE packet.

The identfifier-string, slot ID, port number and VLAN ID are separated from each other by a pound key
(#), semi-colon (;), period (.), comma (,), forward slash (/) or space. An Agent Circuit ID Sub-opftion
example is “Switch/07/0123" and indicates the PPPOE packets come from a PPPOE client which is
connected to the Switch’s port 7 and belong fo VLAN 123.

Table 110 PPPoE IA Circuit ID Sub-option Format: Using Identifier String and Variables

SubOpt  Length Value

0x01 N Identifier delimiter Slot ID delimiter Port No delimiter VLAN ID
Strin

(1 byte) | (1 byte) d (1 byte) (1 byte) | (1 byte) (2 byte) (1 byte) (4
(53 byte) bytes)
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WT-101 Default Circuit ID Syntax

If you do not configure a Circuit ID string for a specific VLAN on a port or for a specific port, and disable
the flexible Circuit ID syntax in the PPPoE > Intermediate Agent screen, the Switch automatically
generates a Circuit ID string according to the default Circuit ID syntax which is defined in the DSL Forum
Working Text (WT)-101. The default access node identifier is the host name of the PPPoE intermediate
agent and the eth indicates “Ethernet”.

Table 111 PPPoE IA Circuit ID Sub-option Format: Defined in WT-101

SubOpt  Length Value
0x01 N Access Space | eth Space | SlotID |/ Port No | : VLAN ID
Node
(1 byte) (1 byte) | \gentifier (1 (3 (1 (1 (1 (2 byte) | (1 (4
byte) byte) | byte) byte) | byte) byte) | bytes)
(20 byte)

29.1.2.3 Port State

Every port is either a trusted port or an untfrusted port for the PPPoE infermediate agent. This sefting is
independent of the trusted or untrusted setting for DHCP snooping or ARP inspection. You can also
specify the agent sub-opftions (circuit ID and remote ID) that the Switch adds to PADI and PADR packets
from PPPOE clients.

Trusted ports are connected to PPPOE servers.

* If a PADO (PPPoE Active Discovery Offer), PADS (PPPOE Active Discovery Session-confirmation), or
PADT (PPPoE Active Discovery Terminate) packet is sent from a PPPoE server and received on a
trusted port, the Switch forwards it fo all other ports.

e |f a PADI or PADR packet is sent from a PPPoE client but received on a trusted port, the Switch
forwards it fo other frusted ports.

Note: The Switch will drop all PPPoE discovery packets if you enable the PPPoE intermediate
agent and there are no frusted ports.

Untrusted ports are connected to subscribers.

e If a PADI, PADR, or PADT packet is sent from a PPPoE client and received on an untrusted port, the
Switch adds a vendor-specific tag to the packet and then forwards it to the trusted ports.

* The Switch discards PADO and PADS packets which are sent from a PPPoE server but received on an
untrusted port.

29.2 PPPOE

Use this screen to configure the PPPOE Intermediate Agent on the Switch.

Click Advanced Application > PPPoE in the navigation panel to display the screen as shown. Click Click
Here to go to the Intermediate Agent screen.

Figure 165 Advanced Application > PPPoE > Intermediate Agent
[ PPPoE |

Intermediate Agent Click here
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29.3 PPPOE Intermediate Agent

Use this screen to configure the Switch to give a PPPoE termination server additional subscriber
information that the server can use to identify and authenticate a PPPoE client.

Click Advanced Application > PPPoE > Intermediate Agent in the navigation panel to display the screen
as shown.

Figure 166 Advanced Application > PPPoE > Infermediate Agent

Intermediate Agent PPPoE Port VLAN

Active |

access-node-identifier |

circuit-id

Active

identifier-string

option

O
spv v
delimiter / ~

The following table describes the labels in this screen.

Table 112 Advanced Application > PPPoE > Intermediate Agent

LABEL DESCRIPTION

Active Select this option to enable the PPPoOE intermediate agent globally on the Switch.
access-node- Enter up to 20 ASCII characters to identify the PPPoE intermediate agent. Hyphens (-) and
identifier spaces are also allowed. The default is the Switch’s host name.

circuit-id Use this section to configure the Circuit ID field in the PADI and PADR packets.

The Circuit ID you configure for a specific port or for a specific VLAN on a port has priority over
this.

The Circuit ID you configure for a specific port (in the Advanced Application > PPPoE >
Intermediate Agent > Port screen) or for a specific VLAN on a port (in the Advanced Application
> PPPOE > Intermediate Agent > Port > VLAN screen) has priority over this. That means, if you also
want to configure PPPOE |IA Per-Port or Per-Port Per-VLAN setting, leave the fields here empty
and configure circuit-id and remote-id in the Per-Port or Per-Port Per-VLAN screen.

Active Select this option fo have the Switch add the user-defined identifier string and variables
(specified in the option field) to PADI or PADR packets from PPPoE clients.

If you leave this option unselected and do not configure any Circuit ID string (using CLI
commands) on the Switch, the Switch will use the string specified in the access-node-identifier

field.
identifier- Specify a string that the Switch adds in the Agent Circuit ID sub-option. You can enter up to 53
string ASCII characters. Spaces are allowed.
option Select the variables that you want the Switch to generate and add in the Agent Circuit ID sub-

option. The variable options include sp, sv, pv and spv which indicate combinations of slot-port,
slot-VLAN, port-VLAN and slot-port-VLAN respectively. The Switch enters a zero into the PADI and
PADR packets for the slot value.

delimiter Select a delimiter to separate the identfifier-string, slot ID, port number and/or VLAN ID from each
other. You can use a pound key (#), semi-colon (;), period (.), comma (,), forward slash (/) or
space.
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Table 112 Advanced Application > PPPoE > Infermediate Agent (continued)

LABEL DESCRIPTION

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel fo save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

29.3.1 PPPOE IA Per-Port

Use this screen to specify whether individual ports are trusted or untrusted ports and have the Switch
add extra information to PPPoOE discovery packets from PPPOE clients on a per-port basis.

Note: The Switch will drop all PPPoE packets if you enable the PPPoE Intermediate Agent on
the Switch and there are no trusted ports.

Click the Port link in the Intermediate Agent screen fo display the screen as shown.

Figure 167 Advanced Application > PPPOE > Infermediate Agent > Port
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The following table describes the labels in this screen.

Table 113 Advanced Application > PPPOE > Infermediate Agent > Port

LABEL

DESCRIPTION

Port

This field displays the port number. * means all ports.

*

Use this row to make the setting the same for all ports. Use this row first and then make
adjustments on a port-by-port basis.

Changes in this row are copied to all the ports as soon as you make them.
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Table 113 Advanced Applicatfion > PPPOE > Infermediate Agent > Port (confinued)

LABEL DESCRIPTION

Server Trusted Select whether this port is a trusted port (Trusted) or an untrusted port (Untrusted).

State
Trusted ports are uplink ports connected to PPPOE servers.

If a PADO (PPPoE Active Discovery Offer), PADS (PPPoE Active Discovery Session-confirmation),
or PADT (PPPoE Active Discovery Terminate) packet is sent from a PPPOE server and received on
a trusted port, the Switch forwards it to all other ports.

If a PADI or PADR packet is sent from a PPPoE client but received on a trusted port, the Switch
forwards it fo other trusted ports.

Untrusted ports are downlink ports connected to subscribers.

If a PADI, PADR, or PADT packet is sent from a PPPoOE client and received on an untrusted port,
the Switch adds a vendor-specific tag to the packet and then forwards it to the trusted ports.
The Switch discards PADO and PADS packets which are sent from a PPPOE server but received
on an untrusted port.

Circuit-id Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Circuit ID sub-
option for PPPOE discovery packets received on this port. Spaces are allowed.

The Circuit ID you configure for a specific VLAN on a port (in the Advanced Application > PPPoE
> Intermediate Agent > Port > VLAN screen) has the highest priority.

Remote-id Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Remote ID sub-
option for PPPoOE discovery packets received on this port. Spaces are allowed.

If you do not specify a string here or in the Remote-id field for a VLAN on a port, the Switch
automatically uses the PPPoE client’'s MAC address.

The Remote ID you configure for a specific VLAN on a port (in the Advanced Application >
PPPOE > Intermediate Agent > Port > VLAN screen) has the highest priority.

Apply Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the fop navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel fo begin configuring this screen afresh.

29.3.2 PPPOE IA Per-Port Per-VLAN

Use this screen to configure PPPOE IA settings that apply to a specific VLAN on a port.

Click the VLAN link in the Intermediate Agent > Port screen to display the screen as shown.

Figure 168 Advanced Application > PPPoE > Intfermediate Agent > Port > VLAN

Show Port

Show VLAN

Port: 0

Port

=
Start VIDI:I End VDI:I

Apply
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The following table describes the labels in this screen.

Table 114 Advanced Application > PPPoOE > Infermediate Agent > Port > VLAN

LABEL

DESCRIPTION

Show Port

Enfer a port number to show the PPPoOE Intfermediate Agent settings for the specified VLANs on
the port.

Show VLAN

Use this section fo specify the VLANs you want to configure in the section below.

Start VID

Enter the lowest VLAN ID you want to configure in the section below.

End VID

Enter the highest VLAN ID you want to configure in the section below.

Apply

Click Apply to display the specified range of VLANs in the section below.

Port

This field displays the port number specified above.

VID

This field displays the VLAN ID of each VLAN in the range specified above. If you configure the *
VLAN, the settings are applied to all VLANS.

Use this row to make the setting the same for all VLANs. Use this row first and then make
adjustments on a VLAN-by-VLAN basis.

Changes in this row are copied to all the VLANs as soon as you make them.

Circuit-id

Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Circuit ID sub-
option for this VLAN on the specified port. Spaces are allowed.

The Circuit ID you configure here has the highest priority.

Remote-id

Enter a string of up to 63 ASCII characters that the Switch adds into the Agent Remote ID sub-
option for this VLAN on the specified port. Spaces are allowed.

If you do not specify a string here or in the Remote-id field for a specific port, the Switch
automatically uses the PPPoE client’'s MAC address.

The Remote ID you configure here has the highest priority.

Apply

Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the fop navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

29.3.3 PPPOE IA for VLAN

Use this screen to set whether the PPPoE Intermediate Agent is enabled on a VLAN and whether the
Switch appends the Circuit ID and/or Remote ID to PPPoE discovery packets from a specific VLAN.

Click the VLAN link in the Intermediate Agent screen to display the screen as shown.

Figure 169 Advanced Applicatfion > PPPoE > Infermediate Agent > VLAN

Show VLAN

Intermediate Agent

Start \-"Dl:l End VIDl:I

Mo v O |
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The following table describes the labels in this screen.

Table 115 Advanced Application > PPPoE > Intermediate Agent > VLAN

LABEL DESCRIPTION

Show VLAN Use this section fo specify the VLANs you want to configure in the section below.

Start VID Enter the lowest VLAN ID you want to configure in the section below.

End VID Enter the highest VLAN ID you want to configure in the section below.

Apply Click Apply to display the specified range of VLANs in the section below.

VID This field displays the VLAN ID of each VLAN in the range specified above. If you configure the *
VLAN, the settings are applied to all VLANs.

* Use this row to make the setting the same for all VLANs. Use this row first and then make
adjustments on a VLAN-by-VLAN basis.

Changes in this row are copied to all the VLANs as soon as you make them.

Enabled Select this option fo turn on the PPPoE Intfermediate Agent on a VLAN.

Circuit-id Select this option to make the Circuit ID settings for a specific VLAN take effect.

Remote-id Select this option fo make the Remote ID settings for a specific VLAN take effect.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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Error-Disable

30.1 Error-Disable Overview

This chapter shows you how to configure the rate limit for control packets on a port, and set the Switch
to take an action (such as to shut down a port or stop sending packets) on a port when the Switch
detects a pre-configured error. It also shows you how to configure the Switch to automatically undo the
action after the error is gone.

30.1.1 CPU Protection Overview

Switches exchange protocol control packets in a network fo get the latest networking information. If a
switch receives large numbers of confrol packets, such as ARP, BPDU or IGMP packets, which are to be
processed by the CPU, the CPU may become overloaded and be unable to handle regular tasks
properly.

The CPU protection feature allows you to limit the rate of ARP, BPDU and IGMP packets to be delivered
to the CPU on a port. This enhances the CPU efficiency and protects against potential DoS attacks or
errors from other networks. You then can choose to drop control packets that exceed the specified rate
limit or disable a port on which the packets are received.

30.1.2 Error-Disable Recovery Overview

Some features, such as loop guard or CPU protection, allow the Switch to shut down a port or discard
specific packets on a port when an error is detected on the port. For example, if the Switch detects that
packets sent out the ports loop back to the Switch, the Switch can shut down the ports automatically.
After that, you need to enable the ports or allow the packets on a port manually through the Web
Configurator or the commands. With error-disable recovery, you can set the disabled ports to become
active or start receiving the packets again after the time interval you specify.

30.1.3 What You Can Do

¢ Use the Errdisable Status screen (Section 30.3 on page 240) to view whether the Switch detected that
control packets exceeded the rate limit configured for a port or a port is disabled according to the
feature requirements and what action you configure, and related information.

¢ Use the CPU Protection screen (Section 30.4 on page 242) to limit the maximum number of control
packets (ARP, BPDU and/or IGMP) that the Switch can receive or fransmit on a port.

» Use the Errdisable Detect screen (Section 30.5 on page 243) to have the Switch detect whether the
control packets exceed the rate limit configured for a port and configure the action fo take once the
limit is exceeded.

¢ Use the Errdisable Recovery screen (Section 30.6 on page 244) to set the Switch to automatically
undo an action after the error is gone.
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30.2 Error-Disable Settings

Use this screen to go to the screens where you can configure error disable related settings. Click
Advanced Application > Errdisable in the navigation panel to open the following screen.

Figure 170 Advanced Application > Errdisable

Errdisable Status Click here
CPU protection Click here
Errdisable Detect Click here
Errdisable Recovery Click here

The following table describes the labels in this screen.

Table 116 Advanced Application > Errdisable

LABEL DESCRIPTION

Errdisable Status Click this link tfo view whether the Switch detected that control packets exceeded the rate
limit configured for a port or a port is disabled according to the feature requirements and
what action you configure, and related information.

CPU protection Click this link to limit the maximum number of control packets (ARP, BPDU and/or IGMP)
that the Switch can receive or tfransmit on a port.

Errdisable Detect Click this link fo have the Switch detect whether the conftrol packets exceed the rate limit
configured for a port and configure the action to take once the limit is exceeded.

Errdisable Recovery Click this link to set the Switch to automatically undo an action after the error is gone.

30.3 Error-Disable Status

Use this screen to view whether the Switch detected that control packets exceeded the rate limit
configured for a port or a port is disabled according to the feature requirements and what action you
configure, and related information. Click the Click here link next to Errdisable Status in the Advanced
Application > Errdisable screen fo display the screen as shown.
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Figure 171 Advanced Application > Errdisable > Errdisable Status

Inactive-reason mode reset
Port List | | Cause
Errdisable Status
Loop Guard NO inactive-port - Forwarding - -
: ARP NO inactive-port 0 Forwarding - -
BPDU NO inactive-port 0 Forwarding - -
IGMP NO inactive-port 0 Forwarding - -
Loop Guard NO inactive-port - Forwarding - -
ARP NO inactive-port 0 Forwarding - -
2 BPDU NO inactive-port 0 Forwarding - -
IGMP NO inactive-port 0 Forwarding - -
Loop Guard NO inactive-port - Forwarding - -
3 ARP NO inactive-port 0 Forwarding - -
BPDU NO inactive-port 0 Forwarding - -
IGMP NO inactive-port 0 Forwarding - -
Loop Guard NO inactive-port - Forwarding - -
4 ARP NO inactive-port 0 Forwarding - -
BPDU NO inactive-port 0 Forwarding - -
IGMP NO inactive-port 0 Forwarding - -
Loop Guard NO inactive-port - Forwarding - -
5 ARP NO inactive-port 0 Forwarding - -
BPDU NO inactive-port 0 Forwarding - -
IGMP NO inactive-port 0 Forwarding - -
Loop Guard NO inactive-port - Forwarding - -
—— T ool T —Rrmadng T
IGMP NO inactive-port 0 Forwarding - -

The following table describes the labels in this screen.

Table 117 Advanced Application > Errdisable > Errdisable Status

LABEL DESCRIPTION
Inactive-reason
mode reset
Port List Enter the number of the ports (separated by a comma) on which you want to reset inactive-
reason status.
Cause Select the cause of inactive-reason mode you want to reset here.
Reset Press to reset the specified ports to handle ARP, BPDU or IGMP packets instead of ignoring them,

if the ports is in inactive-reason mode.

Errdisable Status

Port This is the number of the port on which you want to configure Errdisable Status.

Cause This displays the type of the control packet received on the port or the feature enabled on the
port and causing the Switch to take the specified action.

Active This field displays whether the control packets (ARP, BPDU, and/or IGMP) on the port is being

detected or not. It also shows whether loop guard is enabled on the port.
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Table 117 Advanced Applicatfion > Errdisable > Errdisable Status (continued)

LABEL DESCRIPTION
Mode This field shows the action that the Switch takes for the cause.
* inactive-port — The Switch disables the port.
¢ inactive-reason — The Switch drops all the specified control packets (such as BPDU) on the
port.
¢ rate-limitation — The Switch drops the additional control packets the ports has to handle in
every one second.
Rate This field displays how many control packets this port can receive or transmit per second. It can
be adjusted in CPU Protection. 0 means no rate limit.
Status This field displays the errdisable status
¢ Forwarding: The Switch is forwarding packets. Rate-limitation mode is always in Forwarding
status.
e Err-disable: The Switch disables the port on which the control packets are received
(inactive-port) or drops specified control packets on the port (inactive-reason).
Recovery This field displays the time (seconds) left before the ports becomes active of Errdisable
Time Left Recovery.
(secs)
Total This field displays the total packet number dropped by this port where the packet rate exceeds
Dropped the rate of mode rate-limitation.

30.4 CPU Protection Configuration

Use this screen to limit the maximum number of confrol packets (ARP, BPDU and/or IGMP) that the
Switch can receive or transmit on a port. Click the Click Here link next to CPU protection in the
Advanced Application > Errdisable screen to display the screen as shown.

Note: After you configure this screen, make sure you also enable error detection for the
specific control packets in the Advanced Application > Errdisable > Errdisable Detect

screen.

Figure 172 Advanced Application > Errdisable > CPU protection

Reoson:
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|
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The following table describes the labels in this screen.

Table 118 Advanced Application > Errdisable > CPU protection

LABEL DESCRIPTION
Reason Select the type of confrol packet you want to configure here.
Port This field displays the port number.

*

Use this row fo make the setting the same for all ports. Use this row first and then make
adjustments to each port if necessary.

Changes in this row are copied to all the ports as soon as you make them.

Rate Limit (pkit/s)

Enter a number from 0 to 256 to specify how many confrol packets this port can receive or
transmit per second.

0 means no rate limit.

You can configure the action that the Switch takes when the limit is exceeded.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

30.5 Error-Disable Detect Configuration

Use this screen to have the Switch detect whether the control packets exceed the rate limit configured
for a port and configure the action to fake once the limit is exceeded. Click the Click Here link next to
Errdisable Detect link in the Advanced Application > Errdisable screen to display the screen as shown.

Figure 173 Advanced Application > Errdisable > Errdisable Detect

Erdisable Detect Errdisable
. | inactive-port

ARP O inactive-port v

BPDU O inactive-port v

IGMP O inactive-port v~

The following table describes the labels in this screen.

Table 119 Advanced Application > Errdisable > Errdisable Detect

LABEL

DESCRIPTION

Cause

This field displays the types of control packet that may cause CPU overload.

*

Use this row to make the setting the same for all entries. Use this row first and then make
adjustments to each entry if necessary.

Changes in this row are copied to all the entries as soon as you make them.

Active

Select this option to have the Switch detect if the configured rate limit for a specific conftrol
packet is exceeded and take the action selected below.
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Table 119 Advanced Application > Errdisable > Errdisable Detect (continued)

LABEL DESCRIPTION

Mode Select the action that the Switch takes when the number of control packets exceed the rate
limit on a port, set in the Advanced Application > Errdisable > CPU protection screen.

* inactive-port — The Switch disables the port on which the confrol packets are received.

* inactive-reason — The Switch drops all the specified control packets (such as BPDU) on the
port.

¢ rate-limitation — The Switch drops the additional control packets the ports has to handle in
every one second.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

30.6 Error-Disable Recovery Configuration

Use this screen to configure the Switch to automatically undo an action after the error is gone. Click the
Click Here link next to Errdisable Recovery in the Advanced Application > Errdisable screen o display
the screen as shown.

Figure 174 Advanced Application > Errdisable > Errdisable Recovery

Active

®

loopguard
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BPDU
IGMP
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The following table describes the labels in this screen.

Table 120 Advanced Application > Errdisable > Errdisable Recovery

LABEL DESCRIPTION
Active Select this option fo turn on the error-disable recovery function on the Switch.
Reason This field displays the supported features that allow the Switch to shut down a port or discard

packets on a port according to the feature requirements and what action you configure.

Use this row fo make the setting the same for all entries. Use this row first and then make
adjustments to each enfry if necessary.

Changes in this row are copied to all the entries as soon as you make them.

Timer Status

Select this check box fo allow the Switch to wait for the specified time interval to activate a port
or allow specific packets on a port, after the error was gone. Clear the check box to turn off this
rule.
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Table 120 Advanced Application > Errdisable > Errdisable Recovery (continued)

LABEL DESCRIPTION

Interval Enter the number of seconds (from 30 to 2592000) for the time interval.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 31
Green Ethernet

This chapter shows you how to configure the Switch to reduce the power consumed by switch ports.

31.1 Green Ethernet Overview

Green Ethernet reduces switch port power consumption in the following ways.

IEEE 802.3az Energy Efficient Ethernet (EEE)
If EEE is enabled, both sides of a link support EEE and there is no traffic, the port enters Low Power Idle
(LPI) mode. LPI mode turns off some functions of the physical layer (becomes quiet) to save power.

Periodically the port fransmits a REFRESH signal to allow the link partner to keep the link alive. When there
is traffic fo be sent, a WAKE signal is sent to the link partner to return the link fo active mode.

Auto Power Down

Auto Power Down turns off almost all functions of the port’s physical layer functions when the link is
down, so the port only uses power to check for a link up pulse from the link partner. After the link up
pulse is detected, the port wakes up from Auto Power Down and operates normally.

Short Reach

Traditional Ethernet transmits all data with enough power to reach the maximum cable length. Shorter
cables lose less power, so Short Reach saves power by adjusting the fransmit power of each port
according to the length of cable aftached to that port.

31.2 Configuring Green Ethernet

Click Advanced Application > Green Ethernet in the navigation panel to display the screen as shown.

Note: EEE, Auto Power Down and Short Reach are NOT supported on an uplink port.

XS1930 Series User's Guide

246



Chapter 31 Green Ethernet

Figure 175 Advanced Applicatfion > Green Ethernet
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The following table describes the labels in this screen.

Table 121 Advanced Application > Green Ethernet

LABEL DESCRIPTION

EEE Select this to activate Energy Efficient Ethernet globally.
Auto Power Select this to activate Auto Power Down globally.
Down

Short Reach Select this to activate Short Reach globally.

Port This field displays the port number.

*

Use this row to make the setting the same for all ports. Use this row first and then make
adjustments to each port if necessary.

Changes in this row are copied to all the ports as soon as you make them.

EEE Select this to activate Energy Efficient Ethernet on this port.

Auto Power Select this to activate Auto Power Down on this port.

Down

Short Reach Select this to activate Short Reach on this port.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these

changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 32
Link Layer Discovery Protocol
(LLDP)

32.1 LLDP Overview

The LLDP (Link Layer Discovery Protocol) is a layer 2 protocol. It allows a network device to advertise ifs
identity and capabilities on the local network. It also allows the device to maintain and store information
from adjacent devices which are directly connected to the network device. This helps an administrator
discover network changes and perform necessary network reconfiguration and management. The
device information is encapsulated in the LLDPDUs (LLDP data units) in the form of TLV (Type, Length,
Value). Device information carried in the received LLDPDUs is stored in the standard MIB.

The Switch supports these basic management TLVs.

* End of LLDPDU (mandatory)

¢ Chassis ID (mandatory)

e Port ID (mandatory)

* Time to Live (mandatory)

¢ Port Description (optional)

* System Name (optional)

» System Description (optional)
¢ System Capabilities (optional)

* Management Address (optional)
The Switch also supports the IEEE 802.1 and IEEE 802.3 organizationally-specific TLVs.
IEEE 802.1 specific TLVs:

e Port VLANID TLV (optional)
* Port and Protocol VLAN ID TLV (optional)

IEEE 802.3 specific TLVs:

* MAC/PHY Configuration/Status TLV (optional)
¢ Link Aggregation TLV (optional)
* Maximum Frame Size TLV (optional)

The optional TLVs are inserted between the Time To Live TLV and the End of LLDPDU TLV.
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The next figure demonstrates that the network devices Switches and Routers (S and R) fransmit and
receive device information through LLDPDU and the network manager can query the information using
Simple Network Management Protocol (SNMP).

Figure 176 LLDP Overview

——"

LLDPDU

LLDPDU LLDPDU

32.2 LLDP-MED Overview

LLDP-MED (Link Layer Discovery Protocol for Media Endpoint Devices) is an extension to the standard
LLDP developed by the Telecommunications Industry Association (TIA) TR-41.4 subcommittee which
defines the enhanced discovery capabilities, such as VolP applications, to enable network
administrators manage their network topology application more efficiently. Unlike the traditional LLDP,
which has some limitations when handling multiple application devices, the LLDP-MED offers display of
accurate physical topology, interoperability of devices, and easy frouble shooting for mis-configured IP
addresses. There are three classes of endpoint devices that the LLDP-MED supports:

Class I: IP Communications Controllers or other communication related servers
Class lI: Voice Gateways, Conference Bridges or Media Servers
Class lIl: IP-Phones, PC-based Softphones, End user Communication Appliances supporting IP Media

The following figure shows that with the LLDP-MED, network connectivity devices (NCD) like Switches
and Routers will transmit LLDP TLV to endpoint device (ED) like IP Phone first (1), fo get its device type
and capabilities information, then it will receive that information in LLDP-MED TLV back from endpoint
devices (2), after that the network connectivity devices will transmit LLDP-MED TLV (3) fo provision the
endpoint device to such that the endpoint device's network policy and location idenfification
information is updated. Since LLDPDU updates status and configuration information periodically,
network managers may check the result of provision through remote status. The remote status is
updated by receiving LLDP-MED TLVs from endpoint devices.
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Figure 177 LLDP-MED Overview
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LLDP-TLV (1)

LLDP-TLV (1)

\\\LLDPMED (3)

LLDP-MED (2)
ED ED

32.3 LLDP Settings

Click Advanced Application > LLDP in the navigation panel to display the screen as shown next.

Figure 178 Advanced Application > LLDP

[ uor |
LLDP Local Status Click here
LLDP LLDP Remote Status Click here
LLDP Configuration Click here
LLDP-MED Configuration Click here
LLDP-MED LLDP-MED Metwork Policy Click here
LLDP-MED Location Click here

The following table describes the labels in this screen.

Table 122 Advanced Application > LLDP

LABEL DESCRIPTION
LLDP
LLDP Local Click here to show a screen with the Switch’s LLDP information.
Status
LLDP Remote Click here to show a screen with LLDP information from the neighboring devices.
Status
LLDP Click here to show a screen to configure LLDP parameters.
Configuration
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Table 122 Advanced Application > LLDP (continued)

Network Policy

Endpoint Devices) network policy parameters.

LABEL DESCRIPTION

LLDP-MED
LLDP-MED Click here to show a screen to configure LLDP-MED (Link Layer Discovery Protocol for Media
Configuration Endpoint Devices) parameters.
LLDP-MED Click here to show a screen to configure LLDP-MED (Link Layer Discovery Protocol for Media

LLDP-MED
Location

Click here to show a screen to configure LLDP-MED (Link Layer Discovery Protocol for Media
Endpoint Devices) location parameters.

32.4 LLDP Local Status

This screen displays a summary of LLDP status on this Switch. Click Advanced Application > LLDP > LLDP
Local Status fo display the screen as shown next.

Figure 179 Advanced Application > LLDP > LLDP Local Status
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The following table describes the labels in this screen.

Table 123 Advanced Application > LLDP > LLDP Local Status

LABEL DESCRIPTION

Basic TLV

Chassis ID TLV This displays the chassis ID of the local Switch, that is the Switch you are configuring. The
chassis ID is identified by the chassis ID subtype.

Chassis ID Subtype - this displays how the chassis of the Switch is identified.

Chassis ID - This displays the chassis ID of the local Switch.

System Name This shows the host name of the Switch.
v

System This shows the firmware version of the Switch.
Description TLV

System This shows the System Capabilities enabled and supported on the local Switch.
Capabilities TLV
* System Capabilities Supported - Bridge

¢ System Capabilities Enabled - Bridge

Management The Management Address TLV identifies an address associated with the local LLDP agent
Address TLV that may be used to reach higher layer entities to assist discovery by network management.
The TLV may also include the system interface number and an object identifier (OID) that are
associated with this management address.

This field displays the Management Address settings on the specified ports.

¢ Management Address Subtype - ipv4 or all-802
¢ Interface Number Subtype — unknown

¢ Interface Number -0 (not supported)

* Object Identifier - 0 (nof supported)

LLDP Port This displays the local port information.
Information
Local Port This displays the number of the Switch port which receives the LLDPDU from the remote

device. Click a port number to view the detailed LLDP status on this port in the LLDP Local
Port Status Detail screen.

Port ID Subtype | This indicates how the port ID field is identified.

Port ID This is an alpha-numeric string that contains the specific identifier for the port from which this
LLDPDU was fransmitted.

Port Description | This shows the port description that the Switch will advertise from this port.

32.4.1 LLDP Local Port Status Detail

This screen displays detailed LLDP status for each port on this Switch. Click Advanced Application > LLDP
> LLDP Local Status and then, click a port number, for example 1 in the local port column to display the
screen as shown next.
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LLDP Local Port Status Detail LLDP Local Status

Local Port: 1
Basic TLV
Port ID Subtype local-assigned
Port ID TLV
Port ID 1
Port Description TLV Port Description portl
Dotl TLV
Port VLAN ID TLV Port VLAN ID ]
Dot3 TLV
AN Supported Yes
AN Enabled fes

MAC PHY Configuration & Status
LV . . 10baseT 10baseTFD 100baseTX
AN Advertised C il
vertised Capability 100baseTXFD 1000baseTFD

Oper MAU Type 30
Aggregation Capability Yes
Link Aggregafion TLV Aggregation Status No
Aggregated Port ID 0
Max Frame Size TLV Max Frame Size 1518
MED TLV
Network Palicy Yes
Location Yes
Capabilities TLV Extend Power via MDI PSE No
Extend Power via MDI PD No
Inventory Management No
Device Type TLV Device Type Network Connectivity
Voice

Voice-Signaling
Guest-Voice
Guest-Voice-Signaling
Network Policy TLV
Softphone-Voice
Video-Conferencing
Streaming-Video
Video-Signaling
Coordinate-base LCI

Location Identification TLV Civic LCI

ELIN
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The following table describes the labels in this screen.

Table 124 Advanced Application > LLDP > LLDP Local Status > LLDP Local Port Status Detail

LABEL DESCRIPTION
Local Port This displays the number of the Switch's port.
Basic TLV These are the Basic TLV flags
Port ID TLV The port ID TLV identifies the specific port that fransmitted the LLDP frame.

e Port ID Subtype: This shows how the port is identified.
e Port ID: This is the ID of the port.

Port Description

This displays the local port description.

v
Dot1 TLV
Port VLAN ID This displays the VLAN ID sent by the IEEE 802.1 Port VLAN ID TLV.
LV
Dot3 TLV
MAC PHY The MAC/PHY Configuration/Status TLV advertises the bit-rate and duplex capability of the
(%o?ﬁgTqu\c/:hon & | sending 802.3 node. It also advertises the current duplex and bit-rating of the sending node.
Status Lastly, it advertises whether these setting were the result of auto-negofiation during link
initiation or manual override.
¢ AN Supported - Displays if the port supports or does not support auto-negotiation.
¢ AN Enabled - The current auto-negotiation status of the port.
* AN Advertised Capability — The auto-negotiation capabilities of the port.
* Oper MAU Type - The current Medium Attachment Unit (MAU) type of the port.
Link . The Link Aggregation TLV indicates whether the link is capable of being aggregated,
/TAL%QVGQO“O” whether the link is currently in an aggregation, and if in an aggregation, the port

identification of the aggregation.

e Aggregation Capability — The current aggregation capability of the port.
e Aggregation Status — The current aggregation status of the port.
* Aggregation Port ID — The aggregation ID of the current port.

Max Frame Size
TLV

This displays the maximum supported frame size in octets.

MED TLV

LLDP Media Endpoint Discovery (MED) is an extension of LLDP that provides additional
capabilities to support media endpoint devices. MED enables advertisement and discovery
of network policies, device location discovery fo allow creation of location databases, and
information for tfroubleshooting.

Capabilities TLV

This field displays which LLDP-MED TLV are capable fo transmit on the Switch.

= Network Policy

= Location

= Extend Power via MDI PSE
= Extend Power via MDI PD
= Inventory Management

Device Type

This is the LLDP-MED device class. The Zyxel Switch device type is:

¢ Network Connectivity
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Table 124 Advanced Application > LLDP > LLDP Local Status > LLDP Local Port Status Detail (continued)

LABEL DESCRIPTION
Network Policy | This displays a network policy for the specified application.
v
= Voice
= Voice-Signaling
= Guest-Voice
= Guest-Voice-Signaling
= Softphone-Voice
= Video-Conferencing
= Streaming-Video
« Video-Signaling
Location This shows the location information of a caller by its ELIN (Emergency Location Identifier
Iﬁl\e/nhﬁcohon Number) or the IETF Geopriv Civic Address based Location Configuration Information (Civic

Address LCI).

e Coordinate-based LCI - latitude, longitude and altitude coordinates of the location
Configuration Information (LCI)

e Civic LCI - IETF Geopriv Civic Address based Location Configuration Information
* ELIN - (Emergency Location Identifier Number)

32.5 LLDP Remote Status

This screen displays a summary of LLDP status for each LLDP connection to a neighboring Switch. Click
Advanced Application > LLDP > LLDP Remote Status (Click Here) to display the screen as shown next.

Figure 181 Advanced Application > LLDP > LLDP Remote Statfus

LLDP Remote Status LLDP
08:26:97.c4ic
1 1 0&:26:97:cdiccia2
c:a2
08:26:97.c4ic
2 1 Da:26:97:cd:cciad
cia2
3 3 dcida:3e:d0:ec:5f deidaizeianie

c:5f

4 5 a4:18:6b:f7:ba:0d 39 1243 84 e4:18:6b:f7:ba:0d

The following table describes the labels in this screen.

Table 125 Advanced Application > LLDP > LLDP Remote Status
LABEL DESCRIPTION

Index The index number shows the number of remote devices that are connected to the Switch.
Click on an index number to view the detailed LLDP status for this remote device in the LLDP
Remote Port Status Detail screen.

Local Port This is the number of the Switch's port that received LLDPDU from the remote device.

Chassis ID This displays the chassis ID of the remote device associated with the fransmitting LLDP agent.
The chassis ID is identified by the chassis ID subtype. For example, the MAC address of the
remote device.

Port ID This is an alpha-numeric string that contains the specific identifier for the port from which this
LLDPDU was transmitted. The port ID is identified by the port ID subtype.

Port Description This displays a description for the port from which this LLDPDU was transmitted.

System Name This displays the system name of the remote device.

Management This displays the management address of the remote device. It could be the MAC address or

Address IP address.
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32.5.1 LLDP Remote Port Status Detall

This screen displays detailed LLDP status of the remote device connected to the Switch. Click Advanced
Application > LLDP > LLDP Remote Status (Click Here) and then click an index number, for example 1, in
the Index column in the LLDP Remote Status screen to display the screen as shown next.

Figure 182 Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Basic

TLV)
LLDP Remote Pori Status Detail LLDP Remote Status
Local Port: &
Basic TLV
Chassis ID Subtype mac-address
Chassis ID TLV
Chassis ID e4:18:6b:f7ba:0d
Port ID Subtype ocal-assigned
Port ID TLV
Port ID e
Time To Live TLV Time To Live 120

Port Description TLY

System Mame TLV

System Description TLV

\

System Capabilities TLV

Management Address TLV

Port Description

System Mame 12A3 B4

- - L )[AAGE.2)_20200930 | 0%9/30/20
System Description

System Copabilities Supported bridge

System Copabilities Enabled bridge
Management Address Subtype ALL_802
Manogement Address 24:18:6b:f7:bald
Interface Number Subtype unkncwn

Interface Number ]

Chbject Idenfifier

The following table describes the labels in Basic TLV part of the screen.

Table 126 Advanced Applicatfion > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Basic

TLV)
LABEL DESCRIPTION
Local Port This displays the number of the Switch’s port to which the remote device is connected.
Basic TLV

Chassis ID TLV

* Chassis ID Subtype - this displays how the chassis of the remote device is identified.

* Chassis ID - this displays the chassis ID of the remote device. The chassis ID is idenfified by
the chassis ID subtype.

Port ID TLV

e Port ID Subtype - this displays how the port of the remote device is identified.

* Port ID - this displays the port ID of the remote device. The port ID is identified by the port
ID subtype.

Time To Live TLV

This displays the time-to-live (TTL) multiplier of LLDP frames. The device information on the
neighboring devices ages out and is discarded when its corresponding TTL expires. The TTL
value is to multiply the TTL multiplier by the LLDP frames transmitting interval.

Port Description
v

This displays the remote port description.
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Table 126 Advanced Applicatfion > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Basic

TLV) (continued)

LABEL

DESCRIPTION

System Name
LV

This displays the system name of the remote device.

System
Description TLV

This displays the system description of the remote device.

System
Capabilities TLV

This displays whether the system capabilities are enabled and supported on the remote
device.

= System Capabilities Supported
= System Capabilities Enabled

Management
Address TLV

This displays the management address (IPv4 and IPvé) of the remote device.

= Management Address Subtype
= Management Address

« Interface Number Subtype

« Interface Number

= Object Identifier
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Figure 183 Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Dot
and Dot3 TLV)

Dotl TLV
Port VLAN ID TLV Port VLAN ID
Port-Protocol VLAN ID
Port-Protocol VLAN ID TLV Port-Protocol VLAN ID Supported

Port-Protocol VLAN ID Enabled

VLAN ID
Vlan Name TLV
VLAN Name
Protocol Identity TLV Protocol ID
Dot3 TLV
AN Supported Mo
AN Enabled Mo

MAC PHY Configuration & Status TLV
AN Advertised Capability

Oper MAU type 0
Aggregation Capability Yes

Link Aggregation TLV Aggregation Status Mo
Aggregated Port ID 0
Port Class

MDI Supported

MDI Enabled
Power Via MDI TLV

Pair Controlable

PSE Power Pairs

Power Class

Max Frame Size TLV Max Frame Size

The following table describes the labels in the Dot1 and Dot3 parts of the screen.

Table 127 Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Dot
and Dot3 TLV)

LABEL DESCRIPTION
Dot1 TLV
Port VLAN ID This displays the VLAN ID of this port on the remote device.
TLV
Port-Protocol This displays the IEEE 802.1 Port Protocol VLAN ID TLV, which indicates whether the VLAN ID
VLANID TLV and whether it is enabled and supported on the port of remote Switch which sent the
LLDPDU.
= Port-Protocol VLAN ID
= Port-Protocol VLAN ID Supported
= Port-Protocol VLAN ID Enabled
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Table 127 Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (Dot
and Dot3 TLV) (continued)

LABEL

DESCRIPTION

Vlan Name TLV

This shows the VLAN ID and name for remote device port.

= VLANID
= VLAN Name

Profocol The Protocol Identity TLV allows the Switch to advertise the particular protocols that are
Identity TLV accessible through its port.
Dot3 TLV
MAC PHY The MAC/PHY Configuration/Status TLV advertises the bit-rate and duplex capability of the
(%o?ﬁgTqu\c/}hon & | sending 802.3 node. It also advertises the current duplex and bit-rating of the sending node.
Status Lastly, it advertises whether these setting were the result of auto-negotiation during link
initiation or manual override.
¢ AN Supported - Displays if the port supports or does not support auto-negotiation.
¢ AN Enabled - The current auto-negotiation status of the port.
* AN Advertised Capability - The auto-negotiation capabilities of the port.
* Oper MAU Type - The current Medium Attachment Unit (MAU) type of the port.
Link ] The Link Aggregation TLV indicates whether the link is capable of being aggregated,
ﬁ%gregohon whether the link is currently in an aggregation, and if in an aggregation, the port
identification of the aggregation.
* Aggregation Capability — The current aggregation capability of the port.
e Aggregation Status — The current aggregation status of the port.
e Aggregation Port ID — The aggregation ID of the current port.
Power Via MDI | The Power Via MDI TLV allows network management to advertise and discover the MDI
LV

power support capabilities of the sending port on the remote device.

= Port Class

< MDI Supported
< MDI Enabled

= Pair Controllable
= PSE Power Pairs
= Power Class

Max Frame Size
TLV

This displays the maximum supported frame size in octets.
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Figure 184 Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (MED
TLV)
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Location Identification TLV Civic LCI

ELIN

Hardware Revision

Software Revision

Firmware Revision

Inventory TLV Model Name

Manufacturer

Serial Number

Asset ID

Power Type
Power Source
Extended Power via MDI TLV

Power Priority

Power Value
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The following table describes the labels in the MED TLV part of the screen.

Table 128 Advanced Application > LLDP > LLDP Remote Status > LLDP Remote Port Status Detail (MED

TLV)
LABEL DESCRIPTION
MED TLV LLDP Media Endpoint Discovery (MED) is an extension of LLDP that provides additional

capabilities to support media endpoint devices. MED enables advertisement and discovery
of network policies, device location discovery to allow creation of location databases, and
information for troubleshooting.

Capabilities TLV

This displays the MED capabilities the remote port supports.

= Network Policy

= Location

e Extend Power via MDI PSE
= Extend Power via MDI PD
= Inventory Management

Device Type

LLDP-MED endpoint device classes:

e Endpoint Class |

e Endpoint Class Il

e Endpoint Class |l

¢ Network Connectivity

Network Policy

This displays a network policy for the specified application.

LV
= Voice
= Voice-Signaling
= Guest-Voice
= Guest-Voice-Signaling
= Softphone-Voice
= Video-Conferencing
= Streaming-Video
= Video-Signaling
Location This shows the location information of a caller by its:
Identification
v * Coordinate-base LCI - latitude and longitude coordinates of the Location Configuration
Information (LCI)
e Civic LCI - IETF Geopriv Civic Address based Location Configuration Information
e ELIN - (Emergency Location Identifier Number)
Inventory TLV The majority of IP Phones lack support of management protocols such as SNMP, so LLDP-MED
inventory TLVs are used to provide their inventory information to the Network Connectivity
Devices such as the Switch. The Inventory TLV may contain the following information.
= Hardware Revision
= Software Revision
= Firmware Revision
= Model Name
= Manufacturer
« Serial Number
e AssetID
Extended Extended Power Via MDI Discovery enables detailed power information to be advertised by

Power via MDI
LV

Media Endpoints, such as IP phones and Network Connectivity Devices such as the Switch.

* Power Type — whether it is currently operating from primary power or is on backup power
(backup power may indicate to the Endpoint Device that it should move to a power
conservation mode).

* Power Source — whether or not the Endpoint is currently operating from an external
power source.

e Power Priority — the Endpoint Device's power priority (which the Network Connectivity
Device may use to prioritize which devices will remain in service during power shortages).

* Power Value — power requirement, in fractions of Watts, in current configuration.
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32.6 LLDP Configuration

Use this screen to configure global LLDP settings on the Switch. Click Advanced Application > LLDP >
LLDP Configuration (Click Here) to display the screen as shown next.

Figure 185 Advanced Application > LLDP > LLDP Configuration

Active

Transmit Interval
Transmit Hold
Transmit Delay

Reinificlize Delay

LLDP Configuratfion LLDP Basic TLV Setting Org-specific TLV Seffing

- Disable ~ |
1 Tx-Rx  ~ |
2 TR~ |
3 TR~ |
4 Tx-Rx  ~ |
5 Tx-Rx  ~ |
& TR~ |
7 Tx-Rx  ~ |
8 Tx-Rx  ~ |
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0 seconds
:I'imes
:Iseco".ds
leeconds
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The following table describes the labels in this screen.

Table 129 Advanced Application > LLDP > LLDP Configuration

LABEL

DESCRIPTION

Active

Select to enable LLDP on the Switch. It is enabled by default.

Transmit Interval

Enter how many seconds the Switch waits before sending LLDP packets.

Transmit Hold

Entfer the time-to-live (TTL) multiplier of LLDP frames. The device information on the
neighboring devices ages out and is discarded when its corresponding TTL expires. The TTL
value is to multiply the TTL multiplier by the LLDP packets transmitting interval.

Transmit Delay

Enter the delay (in seconds) between successive LLDPDU fransmissions initiated by value or
status changes in the Switch MIB.

Reinitialize Delay

Enter the number of seconds for LLDP to wait before initializing on a port.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Port This displays the Switch's port number. * means all ports.

Use this row to make the setting the same for all ports. Use this row first and then make
adjustments to each port if necessary.

Changes in this row are copied to all the ports as soon as you make them.
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Table 129 Advanced Application > LLDP > LLDP Configuration (continued)

LABEL

DESCRIPTION

Admin Status

Select whether LLDP transmission and/or reception is allowed on this port.

* Disable — not allowed

e Tx-Only — transmit only

* Rx-Only —receive only

*  Tx-Rx —transmit and receive

Notification Select whether LLDP notification is enabled on this port.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

32.6.1 LLDP Configuration Basic TLV Setting

Use this screen to configure Basic TLV settings. Click Advanced Application > LLDP > LLDP Configuration
(Click Here) > Basic TLV Setting to display the screen as shown next.

Figure 186 Advanced Application > LLDP > LLDP Configuration> Basic TLV Setting

Basic TLV Seffing
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The following table describes the labels in this screen.

Table 130 Advanced Application > LLDP > LLDP Configuration > Basic TLV Setting

LABEL DESCRIPTION
Port This displays the Switch's port number.
* Use this row to make the setting the same for all ports. Use this row first and then make
adjustments to each port if necessary.
Changes in this row are copied to all the ports as soon as you make them.
Management Select the check boxes to enable or disable the sending of Management Address TLVs on
Address the ports.

Port Description

Select the check boxes to enable or disable the sending of Port Description TLVs on the ports.

System Capabilities

Select the check boxes to enable or to disable the sending of System Capabilities TLVs on the
ports.

System Description

Select the check boxes to enable or to disable the sending of System Description TLVs on the
ports.
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Table 130 Advanced Application > LLDP > LLDP Configuration > Basic TLV Setting (continued)

LABEL

DESCRIPTION

System Name

Select the check boxes to enable or to disable the sending of System Name TLVs on the
ports.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

32.6.2 LLDP Configuration Org-specific TLV Setting

Use this screen to configure organization-specific TLV settings. Click Advanced Application > LLDP > LLDP
Configuration (Click Here) > Org-specific TLV Setting to display the screen as shown next.

Figure 187 Advanced Application > LLDP > LLDP Configuration> Org-specific TLV Setting

LLDP Configuration
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The following table describes the labels in this screen.

Table 131 Advanced Application > LLDP > LLDP Configuration > Org-specific TLV Setting

LABEL DESCRIPTION

Port This displays the Switch's port number.

* Use this row to make the setting the same for all ports. Use this row first and then make
adjustments to each port if necessary.

Changes in this row are copied to all the ports as soon as you make them.
Dot1 TLV
Port VLAN ID Select the check boxes to enable or disable the sending of IEEE 802.1 Port VLAN ID TLVs on
the ports. All check boxes in this column are enabled by default.

Dot3 TLV

Link ) Select the check boxes to enable or disable the sending of IEEE 802.3 Link Aggregation TLVs

Aggregation on the ports.

MAC/PHY Select the check boxes to enable or disable the sending of IEEE 802.3 MAC/PHY
Configuration/Status TLVs on the ports. All check boxes in this column are enabled by default.

Max Frame Size | Select the check boxes to enable or disable the sending of IEEE 802.3 Max Frame Size TLVs on
the ports.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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32.7 LLDP-MED Configuration

Click Advanced Application > LLDP > LLDP-MED Configuration to display the screen as shown next.

Figure 188 Advanced Application > LLDP > LLDP-MED Configuration
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The following table describes the labels in this screen.

Table 132 Advanced Application > LLDP > LLDP-MED Configuration

LABEL DESCRIPTION
Port This displays the Switch's port number. Select * to configure all ports simultaneously.
* Use this row to make the setting the same for all ports. Use this row first and then make
adjustments to each port if necessary.
Changes in this row are copied to all the ports as soon as you make them.
Nofification
Topology Select to enable LLDP-MED topology change fraps on this port.
Change
MED TLV Sefting
Location Select to enable transmitting LLDP-MED location TLV.

Network Policy

Select to enable fransmitting LLDP-MED Network Policy TLV.

Apply Click Apply to save the changes to the Switch'’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the fop navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

32.8 LLDP-MED Network Policy

Click Advanced Application > LLDP > LLDP-MED Network Policy (Click Here) fo display the screen as

shown next.
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Figure 189 Advanced Application > LLDP > LLDP-MED Network Policy
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The following table describes the labels in this screen.

Table 133 Advanced Application > LLDP > LLDP-MED Network Policy

LABEL

DESCRIPTION

Port

Enter the port number to set up the LLDP-MED network policy.

Application Type

Select the type of application used in the network policy.

= voice

= voice-signaling

= guest-voice

= guest-voice-signaling
= softphone-voice

= video-conferencing
= streaming-video

= video-signaling

Tag Select fo tag or untag in the network policy.
* tagged
* untagged
VLAN Enter the VLAN ID number. It should be from 1 to 4094. For priority fagged frames, enter “0".
DSCP Enter the DSCP value of the network policy. The value is defined from 0 through 63 with the 0
representing use of the default DSCP value.
Priority Enter the priority value for the network policy.
Add Click Add after finish entering the network policy information. A summary table will list all the
Switch you have added.
Cancel Click Cancel to begin entering the information afresh.
Index This field displays the of index number of the network policy. Click an index number to edit
the rule.
Port This field displays the port number of the network policy.

Application Type

This field displays the application type of the network policy.

Tag This field displays the Tag Status of the network policy.
VLAN This field displays the VLAN ID of the network policy.
Priority This field displays the priority value of the network policy.
DSCP This field displays the DSCP value of the network policy.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row tfo select all entries.
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LABEL DESCRIPTION
Delete Check the rules that you want to remove, then click the Delete button.
Cancel Click Cancel to clear the selected check boxes.

32.9 LLDP-MED Location

Click Advanced Application > LLDP > LLDP-MED Location (Click Here) to display the screen as shown
next.

Figure 190 Advanced Application > LLDP > LLDP-MED Location
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The following table describes the labels in this screen.
Table 134 Advanced Application > LLDP > LLDP-MED Location
LABEL DESCRIPTION
Port Enter the port number you want to set up the location within the LLDP-MED network.
Location The LLDP-MED uses geographical coordinates and Civic Address to set the location
Coordinates information of the remote device. Geographical based coordinates includes latitude,

longitude, altitude and datum. Civic Address includes Country, State, County, City, Street
and other related information.

Latitude Enter the latitude information. The value should be from 0° to 90°. The negative value
represents the South.

= north
= south
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Table 134 Advanced Application > LLDP > LLDP-MED Location (contfinued)

Coordinates

LABEL DESCRIPTION
Longitude Enter the longitude information. The value should be from 0° to 180°. The negative value
represents the West.
- west
- east
Alfitude Enter the altitude information. The value should be from —2097151 to 2097151 in meters or in
floors.
= meters
- floor
Datum Select the appropriate geodetic datum used by GPS.
- WGS84
= NAD83-NAVDS88
= NAD83-MLLW
Civic Address Enter the Civic Address by providing information such as Country, State, County, City, Street,
Number, ZIP code and other additional information. Enter at least 2 fields in this configuration
including the Country. The valid length of the Country field is 2 characters and all other fields
are up to 32 characters.
= Country
= State
< County
e City
= Division
= Neighbor
e Street
* Leading-Street-Direction
= Street-Suffix
« Trailing-Street-Suffix
= House-Number
= House-Number-Suffix
< Landmark
* Additional-Location
= Name
e Zip-Code
= Building
e Unit
« Floor
= Room-Number
= Place-Type
= Postal-Community-Name
= Post-Office-Box
= Additional-Code
ELIN Number Enter a numerical digit string, corresponding to the ELIN identifier which is used during
emergency call setup to a traditional CAMA or ISDN trunk-based PSAP. The valid length is
from 10 to 25 characters.
Add Click Add after finish entering the location information.
Cancel Click Cancel to begin entering the location information afresh.
Index This lists the index number of the location configuration. Click an index number fo view or edit
the location.
Port This lists the port number of the location configuration.
Location This field displays the location configuration information based on geographical coordinates

that includes longitude, latitude, alfitude and datum.
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Table 134 Advanced Application > LLDP > LLDP-MED Location (contfinued)

LABEL

DESCRIPTION

Civic Address

This field displays the Civic Address for the remote device using information such as Country,
State, County, City, Street, Number, ZIP code and additional information.

ELIN Number This field shows the Emergency Location Identification Number (ELIN), which is used to
identify endpoint devices when they issue emergency call services. The valid length is form
10 to 25 characters.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Check the locations that you want to remove, then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.
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CHAPTER 33
Hardware Monitor

33.1 Overview

The Switch supports DDMI (Digital Diagnostics Monitoring Interface) that allows real-time monitoring of
the SFP transceiver's operating temperature. See Section 50.2.2 on page 361 for more details on DDMI.

An SFP fransceiver in full processing mode might reach the High Temperature (C) Warning Threshold (see
Management > Port Status > DDMI > DDMI Details). This will frigger fans to operate at its MAX FAN Speed
(RPM) to decrease the temperature. A properly functioning fan is an essentfial component (along with a
sufficiently ventilated, cool operating environment) for the SFP transceiver to stay within the
temperature threshold.

33.1.1 What You Can Do

Use the Hardware Monitor screen to enable the fan fo adjust its speed accordingly based on real-time
monitoring of the SFP fransceiver’'s operating temperature.

33.2 Hardware Monitor Setting

To open this screen, click Advanced Application > Hardware Monitor.

Figure 191 Advanced Application > Hardware Monitor

Fan Conirol

5SFP Detect

The following table describes the labels in this screen.

Table 135 Advanced Application > Hardware Monitor

LABEL DESCRIPTION

SFP Detect Select this to allow this Switch to get the operating temperature of the SFP fransceiver
connected to its SFP+ slot, and adjust the fan speed accordingly.

Note: It is highly recommended that you enable this setting to prevent the SFP
fransceiver from overheating.
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Table 135 Advanced Application > Hardware Monitor (continued)

LABEL DESCRIPTION

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click this to reset the value in this screen to their last-saved value.
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Static Route

34.1 Static Routing Overview

This chapter shows you how to configure static routes.

The Switch usually uses the default gateway fo route outbound traffic from computers on the LAN to the
Intfernet. To have the Switch send data to devices not reachable through the default gateway, use
static routes.

For example, the next figure shows a computer (A) connected to the Switch. The Switch routes most
fraffic from A to the Internet through the Switch’s default gateway (R1). You create one static route to
connect fo services offered by your ISP behind router R2. You create another static route to
communicate with a separate network behind a router R3 connected to the Switch.

Figure 192 Example of Stafic Routing Topology

R1

A

34.1.1 What You Can Do
* Use the Static Routing screen (Section 34.2 on page 273) to display the link to the IPv4 Static Route
screen.

¢ Use the IPv4 Static Route screen (Section 34.3 on page 273) to configure and enable an IPv4 static
route.

* Use the IPv6 Static Route screen (Section 34.4 on page 274) to configure and enable an IPvé static
route.
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34.2 Static Routing

Click IP Application > Static Routing in the navigation panel to display the screen as shown.

Click the link next to IPv4 Static Route to open a screen where you can create IPv4 static roufing rules.

Click the link next to IPv6 Static Route to open a screen where you can create IPvé static roufing rules.

Figure 193 [P Application > Static Routing

IPv4 Static Route

IPvé Static Route

Click Here

Click Here

34.3 IPv4 Static Route

Click the link next to IPv4 Static Route in the IP Application > Static Routing screen to display the screen

as shown.

Figure 194 [P Application > Static Routing > IPv4 Static Route

1Pv4 Static Route Static Routing
Active |
Name
Destination IP Address 0.0.0.0
IP Subnet Mask 0.0.0.0
Gateway IP Address 0.0.0.0
Meitric

Delete | Cancel

The following table describes the related labels you use to create a static route.

Table 136 P Application > Static Routing > IPv4 Static Route

LABEL DESCRIPTION
Active This field allows you to activate or deactivate this static route.
Name Enter a descriptive name (up to 10 printable ASCII characters) for identification purposes.

Destination IP
Address

This parameter specifies the IP network address of the final destination.

IP Subnet Mask

Enter the subnet mask for this destination. Routing is always based on network number. If you
need to specify aroute to a single host, use a subnet mask of 255.255.255.255 in the subnet mask
field to force the network number to be identical to the host ID.

Gateway IP
Address

Enter the IP address of the gateway. The gateway is an immediate neighbor of your Switch that
will forward the packet to the destination. The gateway must be a router on the same segment
as your Switch.
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Table 136 [P Application > Static Routing > IPv4 Stafic Route (continued)

LABEL DESCRIPTION

Metric The metric represents the “cost” of tfransmission for routing purposes. IP routing uses hop count as
the measurement of cost, with a minimum of 1 for directly connected networks. Enter a number
that approximates the cost for this link. The numlber need not be precise, but it must be between
1 and 15. In practice, 2 or 3 is usually a good number.

Add Click Add to insert a new static route to the Switch's run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the above fields to your previous configuration.

Clear Click Clear to set the above fields back to the factory defaults.

Index This field displays the index number of the route. Click a number to edit the static route entry.

Active This field displays Yes when the static route is activated and NO when it is deactivated.

Name This field displays the descriptive name for this route. This is for identification purposes only.

Destination This field displays the IP network address of the final destination.

Address

Subnet Mask This field displays the subnet mask for this destination.

Gateway This field displays the IP address of the gateway. The gateway is an immediate neighbor of your

Address Switch that will forward the packet to the destination.

Metric This field displays the cost of fransmission for routing purposes.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel fo clear the check boxes.

34.4 |IPv6 Static Route

Click the link next to IPv6 Static Route in the IP Application > Static Routing screen to display the screen

as shown.

Figure 195 IP Application > Static Routing > IPvé Static Route
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The following table describes the related labels you use to create a static route.

Table 137 IP Application > Static Routing > IPvé Static Route

LABEL DESCRIPTION
Route Enter the IPvé address of the final destination.
Destination

Prefix Length

Enter the prefix length number of up to 64 for this destfination.

Next Hop

Enter the IPvé address of the next-hop router.

Interface Type

Select the type of the IPvé inferface through which the IPvé packets are forwarded.

The Switch supports only the VLAN interface type at the tfime of wrifing.

Destination/Prefix
Length

Interface ID Enter the ID number of the IPvé interface through which the IPvé packets are forwarded.

Add Click Add to insert a new static route to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Index This field displays the index number of the route. Click a number to edit the static route entry.

Interface This field displays the descriptive name of the interface that is used to forward the packets to
the destination.

Route This field displays the IPvé subnet prefix and prefix length of the final destination.

Next Hop This field displays the IPvé address of the gateway that helps forward the packet to the
destination.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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DHCP

35.1 DHCP Overview

This chapter shows you how to configure the DHCP feature.

DHCP (Dynamic Host Configuration Protocol RFC 2131 and RFC 2132) allows individual computers to
obtain TCP/IP configuration at start-up from a server. If you configure the Switch as a DHCP relay agent,
then the Switch forwards DHCP requests fo DHCP server on your network. If you do not configure the
Switch as a DHCP relay agent then you must have a DHCP server in the broadcast domain of the client
computers or else the client computers must be configured manually.

35.1.1 What You Can Do

¢ Use the DHCPv4 Status screen (Section 35.3 on page 277) to display the relay mode.

* Use the DHCPv4 Option 82 Profile screen (Section 35.4.2 on page 279) to create DHCPv4 option 82
profiles.

¢ Use the DHCPv4 Global Relay screen (Section 35.4.3 on page 280) to configure global DHCPv4 relay.

* Use the DHCPv4 Global Relay Port screen (Section 35.4.4 on page 281) to apply a different DHCP
option 82 profile to certain ports on the Switch.

¢ Use the VLAN Setting screen (Section 35.4.6 on page 283) to configure your DHCPv4 settings based on
the VLAN domain of the DHCPv4 clients.

* Use the DHCPv4 VLAN Port screen (Section 35.4.7 on page 285) to apply a different DHCP option 82
profile to certain ports in a VLAN.

¢ Use the DHCPv6 Relay screen (Section 35.5 on page 287) to enable and configure DHCPvé relay.

35.1.2 What You Need to Know

Read on for concepts on DHCP that can help you configure the screens in this chapter.

DHCP Modes
If there is already a DHCP server on your network, then you can configure the Switch as a DHCP relay

agent. When the Switch receives a request from a computer on your network, it contacts the DHCP
server for the necessary IP information, and then relays the assigned information back fo the computer.

DHCPv4 Configuration Options

The DHCPv4 configuration on the Switch is divided into Global and VLAN screens. The screen you should
use for configuration depends on the DHCP services you want to offer the DHCP clients on your network.
Choose the configuration screen based on the following criteria:

¢ Global - The Switch forwards all DHCP requests to the same DHCP server.

XS1930 Series User's Guide

276



Chapter 35 DHCP

* VLAN - The Switch is configured on a VLAN by VLAN basis. The Switch can be configured to relay
DHCP requests to different DHCP servers for clients in different VLAN.

35.2 DHCP Configuration

Click IP Application > DHCP in the navigation panel to display the screen as shown. Click the link next to
DHCPv4 to open screens where you can enable and configure DHCPvA4 relay settings and create option
82 profiles. Click the link next to DHCPv6 to open a screen where you can configure DHCPvé6 relay

settings.

Figure 196 IP Application > DHCP

DHCPw4
DHCPvé

Click Here

Click Here

35.3 DHCPv4

Status

Click IP Application > DHCP > DHCPv4 in the navigation panel. The DHCP Status screen displays.

Figure 197 IP Application > DHCP > DHCPv4

Relay Status

Relay Mode

DHCP Status DHCP Option 82 Profile Global VLAN

Mone

The following table describes the labels in this screen.

Table 138 IP Application > DHCP > DHCPv4

LABEL DESCRIPTION
Relay Status | This section displays configuration settings related to the Switch’s DHCP relay mode.
Relay Mode | This field displays:
None - if the Switch is not configured as a DHCP relay agent.
Global - if the Switch is configured as a DHCP relay agent only.
VLAN - followed by a VLAN ID or multiple VLAN IDs if it is configured as a relay agent for specific
VLANSs.
VID This field displays the ID number of the VLAN for which the Switch acts as a DHCP relay agent.
Current This field displays the source IP address of the DHCP requests that the Switch forwards to a DHCP
Source server.
Address
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35.4 DHCPv4 Relay

Configure DHCP relay on the Switch if the DHCP clients and the DHCP server are not in the same
broadcast domain. During the initial IP address leasing, the Switch helps to relay network information
(such as the IP address and subnet mask) between a DHCP client and a DHCP server. Once the DHCP
client obtains an IP address and can connect to the network, network information renewal is done
between the DHCP client and the DHCP server without the help of the Switch.

The Switch can be configured as a global DHCP relay. This means that the Switch forwards all DHCP
requests from all domains to the same DHCP server. You can also configure the Switch to relay DHCP
information based on the VLAN membership of the DHCP clients.

35.4.1 DHCPv4 Relay Agent Information

The Switch can add information about the source of client DHCP requests that it relays to a DHCP server
by adding Relay Agent Information. This helps provide authentication about the source of the requests.
The DHCP server can then provide an IP address based on this information. Please refer to RFC 3046 for
more deftails.

The DHCP Relay Agent Information feature adds an Agent Information field (also known as the Option
82 field) to DHCP requests. The Option 82 field is in the DHCP headers of client DHCP request frames that
the Switch relays to a DHCP server.

Relay Agent Information can include the System Name of the Switch if you select this option. You can
change the System Name in Basic Setting > General Setup.

The following describes the DHCP relay agent information that the Switch sends to the DHCP server:

Table 139 Relay Agent Information

FIELD LABELS DESCRIPTION

Slot ID (1 byte) This value is always 0 for stand-alone switches.

Port ID (1 byte) This is the port that the DHCP client is connected to.

VLAN ID (2 bytes) This is the VLAN that the port belongs to.

Information (up to 64 bytes) This optional, read-only field is set according to system name set in Basic
Setting > General Setup.

35.4.1.1 DHCPv4 Relay Agent Information Format

A DHCP Relay Agent Information option has the following format.

Table 140 DHCP Relay Agent Information Option Format
Code Length il i2

(82) (N)

i1, 2 and iN are DHCP relay agent sub-options, which contain additional information about the DHCP
client. You need to define at least one sub-option.
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35.4.1.2 Sub-Option Format

There are two types of sub-opftion: “Agent Circuit ID Sub-option” and *Agent Remote ID Sub-option”.
They have the following formats.

Table 141 DHCP Relay Agent Circuit ID Sub-option Format
SubOpt Code  Length Value

1 N Slot ID, Port ID, VLAN ID, System Name or String

(1 byte) (1 byte)

Table 142 DHCP Relay Agent Remote ID Sub-option Format
SubOpt Code  Length Value

2 N MAC Address or String

(1 byte) (1 byte)

The 1 in the first field identfifies this as an Agent Circuit ID sub-option and two identifies this as an Agent
Remote ID sub-option. The next field specifies the length of the field.

35.4.2 DHCPv4 Option 82 Profile

Use this screen to create DHCPv4 option 82 profiles. Click IP Application > DHCP > DHCPv4 in the
navigation panel and click the Option 82 Profile link to display the screen as shown.

Figure 198 I[P Application > DHCP > DHCPv4 > Option 82 Profile

DHCP Oplion 82 Profile DHCP Setiing
Profile Setup
Name | |
[ Enable
Circuit-ID slot-port vion hostname
string
[ Enable
Remote-ID mac
string
[ Add |
L]
default] Yes slet-port, vian Mo - O
t-port, vian,
default? Yes slerpar, vien Mo - O
hostname

The following table describes the labels in this screen.

Table 143 IP Application > DHCP > DHCPv4 > Option 82 Profile

LABEL DESCRIPTION

Name Enter a descriptive name for the profile for identification purposes. You can use up to 32 ASCII
characters. Spaces are allowed.

Circuit-ID Use this section to configure the Circuit ID sub-option to include information that is specific fo
the relay agent (the Switch).

Enable Select this option to have the Switch add the Circuit ID sub-option to client DHCP requests that it
relays to a DHCP server.
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Table 143 IP Application > DHCP > DHCPv4 > Option 82 Profile (continued)

LABEL DESCRIPTION
slot-port Select this option to have the Switch add the number of port that the DHCP client is connected
fo.
vian Select this option to have the Switch add the ID of VLAN which the port belongs fo.
hostname This is the system name you configure in the Basic Setting > General Setup screen.
Select this option for the Switch to add the system name to the client DHCP requests that it
relays to a DHCP server.
string Enter a string of up to 64 ASCIl characters that the Switch adds into the client DHCP requests.
Spaces are allowed.
Remote-ID Use this section to configure the Remote ID sub-option to include information that identifies the
relay agent (the Switch).
Enable Select this option to have the Switch append the Remote ID sub-option to the option 82 field of
DHCP requests.
mac Select this option to have the Switch add its MAC address to the client DHCP requests that it
relays to a DHCP server.
string Enter a string of up fo 64 ASCIl characters for the remote ID information in this field. Spaces are
allowed.
Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.
Cancel Click Cancel to reset the fields to their last saved values.

Profile Name

This field displays the descriptive name of the profile. Click the name fo change the settings.

Circuit-ID This section displays the Circuit ID sub-option including information that is specific to the relay
agent (the Switch).
Enable This field displays whether the Circuit ID sub-option is added to client DHCP requests.
Field This field displays the information that is included in the Circuit ID sub-opftion.
Remote-ID This section displays the Remote ID sub-opftion including information that identifies the relay
agent (the Switch).
Enable This field displays whether the Remote ID sub-option is added fo client DHCP requests.
Field This field displays the information that is included in the Remote ID sub-option.
Select an entry’s check box fo select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.
Delete Check the entries that you want to remove and then click the Delete button.
Cancel Click Cancel to clear the selected check boxes.

35.4.3 Configuring DHCPv4 Global Relay

Use this screen to configure global DHCPv4 relay. Click IP Application > DHCP > DHCPv4 in the
navigation panel and click the Global link to display the screen as shown.
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Figure 199 [P Application > DHCP > DHCPv4 > Global

DHCP Relay Stafus Port
Active |
Remote DHCP Server 1 0.0.0.0
Remote DHCP Server 2 0.0.0.0
Remote DHCP Server 3 0.0.0.0
Option 82 Profile -

The following table describes the labels in this screen.

Table 144 IP Application > DHCP > DHCPv4 > Global

LABEL DESCRIPTION

Active Select this check box to enable DHCPv4 relay.

Remote DHCP Enter the IP address of a DHCPv4 server in dotted decimal notation.
Server1..3

Option 82 Profile

Select a pre-defined DHCPv4 option 82 profile that the Switch applies to all ports. The Switch
adds the Circuit ID sub-option and/or Remote ID sub-option specified in the profile to DHCP
requests that it relays to a DHCP server.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

35.4.4 Configure DHCPv4 Global Relay Port

Use this screen to

apply a different DHCP option 82 profile to certain ports on the Switch. To open this

screen, click IP Application > DHCP > DHCPv4 > Global > Port.

Figure 200 IP Application > DHCP > DHCPv4 > Global > Port

Port
Option 82 Profile

DHCP relay
L]
Delete
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The following table describes the labels in this screen.

Table 145 IP Application > DHCP > DHCPv4 > Global > Port

LABEL

DESCRIPTION

Port

Enter the number of ports to which you want to apply the specified DHCP option 82 profile.

You can enter multiple ports separated by (no space) comma (,) or hyphen (). For example,
enter “3-5" for ports 3, 4, and 5. Enter “3,5,7" for ports 3, 5, and 7.

Option 82 Profile

Select a pre-defined DHCP option 82 profile that the Switch applies to the specified ports. The
Switch adds the Circuit ID sub-option and/or Remote ID sub-option specified in the profile to
DHCP requests that it relays to a DHCP server.

The profile you select here has priority over the one you select in the DHCP > DHCPv4 > Global
screen.

Add Click this to create a new enfry or fo update an existing one.
This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected entry or, if not applicable, to clear
the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change the
settings.

Port This field displays the ports to which the Switch applies the settings.

Profile Name

This field displays the DHCP option 82 profile that the Switch applies to the ports.

Select an entry’s check box to select a specific enfry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Select the entries that you want to remove, then click the Delete button to remove the selected
entries from the table.
Cancel Click this to clear the check boxes above.

35.4.5 Global DHCP Relay Configuration Example

The follow figure shows a network example where the Switch is used to relay DHCP requests for the
VLAN1 and VLAN2 domains. There is only one DHCP server that services the DHCP clients in both

domains.
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Figure 201 Global DHCP Relay Network Example

DHCP Server:
192.168.1.100

\

\

VLAN 1 VLAN 2

Configure the DHCP Relay screen as shown. Make sure you select a DHCP option 82 profile (defaultl in
this example) to set the Switch to send additional information (such as the VLAN ID) together with the
DHCP requests to the DHCP server. This allows the DHCP server to assign the appropriate IP address
according to the VLAN ID.

Figure 202 DHCP Relay Configuration Example

DHCP Relay Status Port
Active
Remote DHCP Server 1 192.148.1.100
Remote DHCP Server 2 0.0.0.0
Remote DHCP Server 3 0.0.0.0
Option 82 Profile default] |
YW N
EXAMPLE

35.4.6 DHCPv4 VLAN Setting

Use this screen to configure your DHCP settings based on the VLAN domain of the DHCP clients. Click IP
Application > DHCP > DHCPv4 in the navigation panel, then click the VLAN link In the DHCP Status screen

that displays.

Note: You must set up a management IP address for each VLAN that you want to configure
DHCP settings for on the Switch.
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Figure 203 IP Application > DHCP > DHCPv4 > VLAN

[ VIANSeffing | Siatus_Port
viD L]
Relay
Remote DHCP Server 1 0.0.0.0
Remote DHCP Server 2 0.0.0.0
Remote DHCP Server 3 0.0.0.0
Source Address 0.0.0.0
Option 82 Profile -

Delete | Cancel

The following table describes the labels in this screen.

Table 146 IP Application > DHCP > DHCPv4 > VLAN

LABEL DESCRIPTION
VID Enter the ID number of the VLAN to which these DHCP seftings apply.
Relay Use this section if you want to configure the Switch to function as a DHCP relay for this VLAN.
Remote Enter the IP address of a DHCP server in dotted decimal notation.
DHCP Server
1..3
Source Enter the source IP address that the Switch adds to DHCP requests from clients on this VLAN
Address before forwarding them. If you leave this field set to 0.0.0.0, the Switch automatically sets the
source IP address of the DHCP requests to the IP address of the interface on which the packet is
received.
The source IP address helps DHCP clients obtain an appropriate IP address when you configure
multiple routing domains on a VLAN.
Option 82 Select a pre-defined DHCP option 82 profile that the Switch applies to all ports in this VLAN. The
Profile Switch adds the Circuit ID sub-option and/or Remote ID sub-option specified in the profile to
DHCP requests that it relays to a DHCP server.
Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch's run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your changes
fo the non-volatile memory when you are done configuring.
Cancel Click Cancel fo begin configuring this screen afresh.
Clear Click Clear to reset the fields to the factory defaults.
VID This field displays the ID number of the VLAN group fo which this DHCP settings apply.
Type This field displays Relay for the DHCP mode.
DHCP Status For DHCP server configuration, this field displays the starting IP address and the size of the IP

address pool.

For DHCP relay configuration, this field displays the first remote DHCP server IP address.

Source Address

This field displays the source IP address you configured for DHCP requests from clients on this
VLAN.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.
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Table 146 P Application > DHCP > DHCPv4 > VLAN (continued)

LABEL DESCRIPTION
Delete Select the configuration entries you want to remove and click Delete to remove them.
Cancel Click Cancel fo clear the check boxes.

35.4.7 Configure DHCPv4 VLAN Port

Use this screen to apply a different DHCP option 82 profile to certain portsin a VLAN. To open this screen,
click IP Application > DHCP > DHCPv4 > VLAN > Port.

Figure 204 IP Application > DHCP > DHCPv4 > VLAN > Port

[ port | VLAN Seffing
VID
Port
Option 82 Profile -
L]
Delete

The following table describes the labels in this screen.

Table 147 IP Application > DHCP > DHCPv4 > VLAN > Port

LABEL DESCRIPTION
VID Enter the ID number of the VLAN you want to configure here.
Port Enter the number of ports to which you want to apply the specified DHCP option 82 profile.

You can enter multiple ports separated by (no space) comma (,) or hyphen (). For example,
enter “3-5" for ports 3, 4, and 5. Enter “3,5,7" for ports 3, 5, and 7.

Option 82 Profile | Select a pre-defined DHCP option 82 profile that the Switch applies to the specified ports in this
VLAN. The Switch adds the Circuit ID sub-option and/or Remote ID sub-option specified in the
profile to DHCP requests that it relays to a DHCP server.

The profile you select here has priority over the one you select in the DHCP > DHCPv4 > VLAN
screen.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch's run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

Cancel Click this to reset the values above based on the last selected entry or, if not applicable, to
clear the fields above.

Clear Click Clear to reset the fields to the factory defaults.

Index This field displays a sequential number for each entry. Click an index number to change the
settings.

VID This field displays the VLAN to which the ports belongs.

Port This field displays the ports to which the Switch applies the settings.

Profile Name This field displays the DHCP option 82 profile that the Switch applies to the ports in this VLAN.
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Table 147 IP Application > DHCP > DHCPv4 > VLAN > Port (continued)

LABEL DESCRIPTION

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Select the entries that you want to remove, then click the Delete button to remove the selected
entries from the table.

Cancel Click this to clear the check boxes above.

35.4.8 Example: DHCP Relay for Two VLANSs

The following example displays two VLANs (VIDs 1 and 2) for a campus network. Two DHCP servers are
installed fo serve each VLAN. The system is set up to forward DHCP requests from the dormitory rooms
(VLAN 1) to the DHCP server with an IP address of 192.168.1.100. Requests from the academic buildings
(VLAN 2) are sent to the other DHCP server with an IP address of 172.16.10.100.

Figure 205 DHCP Relay for Two VLANs

DHCP: 192.168.1.100

EEEH B

VLAN 2

DHCP: 172.16.10.100

For the example network, configure the VLAN Setting screen as shown.

Figure 206 DHCP Relay for Two VLANs Configuration Example

Status port
Relay
Remote DHCP Server 1
Remote DHCP Server 2
Remote DHCP Server 3
Source Address 0.0.0.0
\

Option 82 Profile v

(EXAMPLE)

L
1 Relay 192.168.1.100 0.0.0.0 O
2 Relay 172.16.10.100 0.0.0.0 O
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35.5 DHCPv6 Relay

A DHCPvé relay agent is on the same network as the DHCPvé clients and helps forward messages
between the DHCPv6 server and clients. When a client cannot use its link-local address and a well-
known multicast address to locate a DHCPvé server on its network, it then needs a DHCPvé relay agent
to send a message to a DHCPvé server that is not attached to the same network.

The DHCPvVé relay agent can add the remote identification (remote-ID) option and the interface-ID
option to the Relay-Forward DHCPvé messages. The remote-ID option carries a user-defined string, such
as the system name. The interface-ID option provides slot number, port information and the VLAN ID to
the DHCPvé server. The remote-ID option (if any) is stripped from the Relay-Reply messages before the
relay agent sends the packets to the clients. The DHCPvé server copies the interface-ID option from the
Relay-Forward message into the Relay-Reply message and sends it to the relay agent. The interface-ID
should not change even after the relay agent restarts.

Use this screen to configure DHCPVé relay settings for a specific VLAN on the Switch. Click IP Application
> DHCP > DHCPv6 > DHCPvV6 Relay in the navigation panel to display the screen as shown.

Figure 207 IP Application > DHCP > DHCPvé Relay

DHCPvé Relay DHCP
VID
Helper Address
. O Interface ID
Options
L]
100 1886::200 disable disable O

Delete | Cancel

The following table describes the labels in this screen.

Table 148 P Application > DHCP > DHCPvé Relay

LABEL DESCRIPTION

VID Enter the ID number of the VLAN you want to configure here.

Helper Address Enter the remote DHCPvVé server address for the specified VLAN.

Options

Interface ID Select this option to have the Switch add the interface-ID option in the DHCPvé requests from
the clients in the specified VLAN before the Switch forwards them to a DHCPvé server.

Remote ID Enter a string of up to 64 printable characters to be carried in the remote-ID option. The Switch
adds the remote-ID option in the DHCPvé6 requests from the clients in the specified VLAN before
the Switch forwards them to a DHCPvé server.

Add Click this to create a new enfry or fo update an existing one.

This saves your changes to the Switch’s run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your changes
to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to their last saved values.

Clear Click Clear to reset the fields to the factory defaults.
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LABEL DESCRIPTION

VID This field displays the VLAN ID number. Click the VLAN ID to change the settings.

Helper Address This field displays the IPvé address of the remote DHCPvé server for this VLAN.

Interface ID This field displays whether the interface-ID option is added to DHCPvé requests from clients in this
VLAN.

Remote ID This field displays whether the remote-ID option is added to DHCPvé requests from clients in this
VLAN.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Check the entries that you want to remove and then click the Delete button.

Cancel Click Cancel to clear the selected check boxes.
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CHAPTER 36
ARP Setup

36.1 ARP Overview

Address Resolution Protocol (ARP) is a protocol for mapping an Internet Protocol address (IP address) to
a physical machine address, also known as a Media Access Control or MAC address, on the local area
network.

An IP (version 4) address is 32 bits long. In an Ethernet LAN, MAC addresses are 48 bits long. The ARP
table maintains an association between each MAC address and its corresponding IP address.

36.1.1 What You Can Do

Use the ARP Learning screen (Section 36.2.1 on page 291) to configure ARP learning mode on a per-port
basis.

Use the Static ARP screen (Section 36.2.2 on page 292) to create static ARP entries that will display in the
Management > ARP Table screen and will not age out.

36.1.2 What You Need to Know

Read on for concepts on ARP that can help you configure the screen in this chapter.

36.1.2.1 How ARP Works

When an incoming packet destined for a host device on a local area network arrives at the Switch, the
Switch looks in the ARP Table and if it finds the address, it sends it fo the device.

If no entry is found for the IP address, ARP broadcasts the request to all the devices on the LAN. The
Switch fills in its own MAC and IP address in the sender address fields, and puts the known IP address of
the target in the target IP address field. In addition, the Switch puts all ones in the target MAC field
(FF.FF.FF.FF.FF.FF is the Ethernet broadcast address). The replying device (which is either the IP address of
the device being sought or the router that knows the way) replaces the broadcast address with the
target's MAC address, swaps the sender and target pairs, and unicasts the answer directly back to the
requesting machine. ARP updates the ARP Table for future reference and then sends the packet to the
MAC address that replied.

36.1.2.2 ARP Learning Mode

The Switch supports three ARP learning modes: ARP-Reply, Gratuitous-ARP, and ARP-Request.
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ARP-Reply

The Switch in ARP-Reply learning mode updates the ARP table only with the ARP replies to the ARP
requests sent by the Switch. This can help prevent ARP spoofing.

In the following example, the Switch does not have IP address and MAC address mapping information
for hosts A and B in its ARP table, and host A wants to ping host B. Host A sends an ARP request to the
Switch and then sends an ICMP request after getting the ARP reply from the Switch. The Switch finds no
matched entry for host B in the ARP table and broadcasts the ARP request fo all the devices on the LAN.
When the Switch receives the ARP reply from host B, it updates its ARP table and also forwards host A's
ICMP request to host B. After the Switch gets the ICMP reply from host B, it sends out an ARP request to
get host A’'s MAC address and updates the ARP table with host A’s ARP reply. The Switch then can
forward host B's ICMP reply to host A.

N s EE R

ARP Request

ARP Reply

F 3

ICMP Request

ARP Request
ARP Reply

>

A

ICMP Request

ICMP Reply

ARP Request
ARP Reply

A

ICMP Reply

Gratuitous-ARP

A gratuitous ARP is an ARP request in which both the source and destfination IP address fields are set to
the IP address of the device that sends this request and the destination MAC address field is set to the
broadcast address. There will be no reply to a gratuitous ARP request.

A device may send a gratuitous ARP packet to detect IP collisions. If a device restarts or its MAC address
is changed, it can also use gratuitous ARP to inform other devices in the same network to update their
ARP table with the new mapping information.

In Gratuitous-ARP learning mode, the Switch updates its ARP table with either an ARP reply or a
gratuitous ARP request.
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ARP-Request

When the Switch is in ARP-Request learning mode, it updates the ARP table with both ARP replies,
gratuitous ARP requests and ARP requests.

Therefore in the following example, the Switch can learn host A's MAC address from the ARP request
sent by host A. The Switch then forwards host B's ICMP reply fo host A right after getting host B's MAC
address and ICMP reply.

ARP Request

ARP Reply
ICMP Request

v

ARP Request
ARP Reply

ICMP Request

A J

ICMP Reply

F 3

ICMP Reply

F 3

36.2 ARP Setup

Click IP Application > ARP Setup in the navigation panel to display the screen as shown. Click the link
next to ARP Learning to open a screen where you can set the ARP learning mode for each port. Click
the link next to Static ARP to open a screen where you can create static ARP entries on the Switch.

Figure 208 IP Application > ARP Setup

ARP Learning Click Here
Static ARP Click Here

36.2.1 ARP Learning

Use this screen to configure each port’'s ARP learning mode. Click the link next to ARP Learning in the IP
Application > ARP Setup screen to display the screen as shown next.
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Figure 209 [P Application > ARP Setup > ARP Learning
Age setup

ARP-Reply ~
ARP-Reply ~
ARP-Reply ~
ARP-Reply ~
ARP-Reply ~
ARP-Request ~
ARP-Reply ~
Gratuitous-ARP ~
ARP-Reply ~

ARP ~
\/\/\/\/\/\J/Av‘\/\/

Z (= I I R L *

The following table describes the labels in this screen.

Table 149 P Application > ARP Setup > ARP Learning

LABEL DESCRIPTION

Port This field displays the port number.

*

Settings in this row apply to all ports.

Use this row only if you want fo make some settings the same for all ports. Use this row first to set
the common settings and then make adjustments on a port-by-port basis.

Changes in this row are copied to all the ports as soon as you make them.

ARP Learning Select the ARP learning mode the Switch uses on the port.

Mode
Select ARP-Reply to have the Switch update the ARP table only with the ARP replies to the ARP

requests sent by the Switch.

Select Gratuitous-ARP to have the Switch update its ARP table with either an ARP reply or a
gratuitous ARP request.

Select ARP-Request to have the Switch update the ARP table with both ARP replies, gratuitous
ARP requests and ARP requests.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

36.2.2 Static ARP

Use this screen to create static ARP enfries that will display in the Management > ARP Table screen and
will not age out. Click the link next to Static ARP in the IP Application > ARP Setup screen to display the
screen as shown.
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Figure 210 IP Application > ARP Setup > Static ARP

Port

[ StaicARP | ARP Setup
Active
MName
IP Address
MAC Address
VID

The following table describes the related labels in this screen.

Table 150 IP Application > ARP Setup > Static ARP

LABEL DESCRIPTION

Active Select this check box to activate your rule. You may temporarily deactivate a rule without
deleting it by clearing this check box.

Name Enter a descriptive name (up to 32 printable ASCII characters) for identification purposes.

IP Address Enter the IP address of a device connected to a Switch port with the corresponding MAC

address below.

MAC Address

Enter the MAC address of the device with the corresponding IP address above.

VID

Enter the ID number of VLAN fo which the device belongs.

Port Enter the number of port to which the device connects.

Add Click this to create a new entry or to update an existing one.
This saves your changes to the Switch's run-time memory. The Switch loses these changes if it is
turned off or loses power, so use the Save link on the top navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to set the above fields back to the factory defaults.

Index This field displays the index number of an entry. Click an index number to change the setfings.

Active This field displays Yes when the entry is activated and NO when it is deactivated.

Name This field displays the descriptive name for this entry. This is for identification purposes only.

IP Address This is the IP address of a device connected to a Switch port with the corresponding MAC
address below.

MAC Address This is the MAC address of the device with the corresponding IP address above.

VID This field displays the VLAN to which the device belongs.

Port This field displays the port to which the device connects.
Select an entry’s check box to select a specific entfry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entry from the summary table.

Cancel Click Cancel to clear the check boxes.
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CHAPTER 37
Maintenance

37.1 Overview

This chapter explains how to configure the screens that let you maintain the firmware and configuration
files.

37.1.1 What You Can Do

¢ Use the Maintenance screen (Section 37.2 on page 294) to manage firmware and your configuration
files.

* Use the Firmware Upgrade screen (Section 37.3 on page 298) to upload the latest firmware.

¢ Use the Restore Configuration screen (Section 37.4 on page 299) to upload a stored device
configuration file.

* Use the Backup Configuration screen (Section 37.5 on page 300) to save your configurations for later
use.

¢ Use the Erase Running-Configuration screen (Section 37.2.1 on page 296) to reset the configuration to
the Zyxel default configuration settings.

» Use the Save Configuration screen (Section 37.2.2 on page 296) to save the current configuration
settings to a specific configuration file on the Switch.

¢ Use the Reboot System screen (Section 37.2.3 on page 296) to restart the Switch without physically
turning the power off and load a specific configuration file.

* Use the Tech-Support screen (Section 37.6 on page 300) to create reports for customer support if
there are problems with the Switch.

¢ Use the Certificates screen (Section 37.7 on page 302) to see the Certificate screen and import the
Switch's CA-signed certificates.

37.2 Maintenance Settings

Use this screen to manage firmware and your configuration files. Click Management > Maintenance in
the navigation panel to open the following screen.

XS1930 Series User's Guide

294



Chapter 37 Maintenance

Figure 211 Management > Maintenance

Firmware Upgrade

Restore Configuration
Backup Configuration

Erase Running-Configuration

Save Configuration

Reboot System

Cumrent: Configuration 1

Tech-Support

Certificates

Click Hers
Click Hers
Click Hers

Factory Default
Custom Default

Click Hers
Click

Hers

The following table describes the labels in this screen.

Table 151 Management > Maintenance
LABEL DESCRIPTION
Firmware Click Click Here to go to the Firmware Upgrade screen.
Upgrade
Restore Click Click Here to go fo the Restore Configuration screen.
Configuration
Backup Click Click Here to go to the Backup Configuration screen.
Configuration

Erase Running-
Configuration

Click Click Here to reset the configuration to the Zyxel default configuration settings. Note that
this will not reset the configuration to the factory default settings.

Save
Configuration

Click Config 1 to save the current configuration settings to Configuration 1 on the Switch.
Click Config 2 to save the current configuration settings to Configuration 2 on the Switch.

Click Custom Default fo save the current configuration settings to a customized default file on
the Switch. This file can be used instead of the Zyxel factory default configuration file.

Rebooft System

Click Config 1 to reboot the Switch and load Configuration 1 on the Switch.
Click Config 2 to reboot the Switch and load Configuration 2 on the Switch.

Click Factory Default to reboot the Switch and load the Zyxel factory default configuration
settings on the Switch.

Click Custom Default to reboot the Switch and load a saved customized default file on the
Switch.

Note: Make sure to click the Save button in any screen to save your seftings fo the
current configuration on the Switch.

Current

This field displays which configuration (Configuration 1 or Configuration 2) is currently operating
on the Switch.

Tech-Support

Click Click Here to see the Tech-Support screen. You can set CPU and memory thresholds for
log reports and download related log reports for issue analysis. Log reports include CPU history
and utilization, crash and memory.

Certificates

Click Click Here to see the Certificate screen and import the Switch's CA-signed certificates.
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37.2.1 Erase Running-Configuration

Follow the steps below to remove the running configuration on the Switch. Unlike when you reset the
Switch to the factory defaults, the user name, password, system logs, memory logs, baud rate and SSH
service are not removed.

1 In the Maintenance screen, click the Click Here button next to Erase Running-Configuration to clear all
Switch configuration information you configured and return to the Zyxel default configuration settings.

2 Click OK to reset all Switch configurations.

Figure 212 Erase Running-Configuration: Confirmation

Are you sure you want to erase running configuration?

Cancel

3 Inthe Web Configurator, click the Save button in the fop of the screen to make the changes take
effect. If you want to access the Switch Web Configurator again, you may need to change the IP
address of your computer to be in the same subnet as that of the default Switch IP address (192.168.1.1
or DHCP-assigned IP).

37.2.2 Save Configuration

Click Config 1 to save the current configuration settings permanently to Configuration 1 on the Switch.
These configurations are set up according to your network environment.

Click Config 2 to save the current configuration settings permanently to Configuration 2 on the Switch.
These configurations are set up according to your network environment.

Click Custom Default to save the current configuration settings permanently to a customized default file
on the Switch. If configuration changes cause the Switch to behave abnormally, click Custom Default
(next to Reboot System) to have the Switch automatically reboot and restore the saved Custom Default
configuration file.

Alternaftively, click Save on the top right in any screen to save the configuration changes to the current
configuration.

37.2.3 Reboot System

Reboot System allows you fo restart the Switch without physically furning the power off. It also allows you
to load configuration one (Config 1), configuration two (Config 2), a Custom Default or the Factory
Default configuration when you rebooft. Follow the steps below to reboot the Switch.

1 Inthe Maintenance screen, click a configuration button next to Reboot System to reboot and load that
configuration file. The confirmation screen displays.

2 Click OK again and then wait for the Switch to restart. This takes up to 2 minutes. This does not affect the
Switch’s configuration.

Click Config 1 and follow steps 1 fo 2 to reboot and load configuration one on the Switch.
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Click Config 2 and follow steps 1 to 2 to reboot and load configuration two on the Switch.

Click Factory Default and follow steps 1 to 2 fo reboot and load Zyxel factory default configuration
settings on the Switch.

Click Custom Default and follow steps 1 to 2 to reboot and load a customized default file on the Switch.
This will save the custom default configuration settings to both Configuration 1 and Configuration 2.

Note: If a customized default file was not saved, clicking Custom Default loads the factory
default configuration on the Switch.

37.2.4 Factory Default
Follow the steps below to reset the Switch back to the factory defaults.

1 Click the Factory Default button.

2 Click OK to continue or Cancel to abort.

Figure 213 Load Factory Default: Confirmation

Are you sure you want to reboot system to factory default?

Cancel

If you want to access the Switch Web Configurator again, you may need to change the IP address of
your computer to be in the same subnet as that of the default Switch IP address (192.168.1.1 or DHCP-
assigned IP).

37.2.5 Custom Default

Follow the steps below to reset the Switch back to the Custom Default configuration file you created.
This will save the custom default configuration settings to both Configuration 1 and Configuration 2.

1 Click the Custom Default button.

2 Click OK to continue or Cancel to abort.

Note: If you did not save a Custom Default file in the Web Configurator or CLI using copy
running-config custom-default, then the factory default file is restored after you
press click Custom Default (next to Reboot System) on the Switch. You will then have to
make all your configurations again on the Switch.

Figure 214 Load Custom Default: Confirmation

Are you sure you want to reboot system to custom default?

Cancel

XS1930 Series User's Guide

297



Chapter 37 Maintenance

37.3 Firmware Upgrade

Use the following screen to upgrade your Switch to the latest firmware. The Switch supports dual
firmware images, Firmware 1 and Firmware 2. Use this screen to specify which image is updated when
firmware is uploaded using the Web Configurator and to specify which image is loaded when the
Switch starts up.

Make sure you have downloaded (and unzipped) the correct model firmware and version to your
computer before uploading to the device.

Be sure to upload the correct model firmware as uploading the wrong
model firmware may damage your device.

Click Management > Maintenance > Firmware Upgrade fo view the screen as shown next.

Figure 215 Management > Maintenance > Firmware Upgrade

Maintenance
Running 05/11/2021
X51930-12HP Firmware 1 04/28/2021
Firmware 2 05/11/2021
Curmrent Boot Image Firmware 2
Config Boot Image Firmware
To upgrade the intermal switch firmware, browse the location of the binary (.BIM] file and click Upgrade buttan.
Firmware EI File Path Choose File | Mo file chosen

The top of firmware upgrade screen shows which firmware version is currently running on the Switch.
Enter the path and file name of the firmware file you wish to upload to the Switch in the File Path text box
or click Choose File or Browse to locate it. Firmware upgrades are only applied after a reboot. Click
Upgrade fo load the new firmware. Select the Config Boot Image drop-down list box if you want to
reboot the Switch and click Apply to apply the new firmware immediately. Click Upgrade to load the
new firmware.
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After the process is complete, see the System Info screen fo verify your current firmware version number.

Table 152 Management > Maintenance > Firmware Upgrade

LABEL DESCRIPTION
Name This is the name of the Switch that you are configuring.
Version The Switch has 2 firmware sets, Firmware 1 and Firmware 2, residing in flash.

* Running shows the version number (and model code) and MM/DD/YYYY creation date
of the firmware currently in use on the Switch (Firmware 1 or Firmware 2). The firmware
information is also displayed at System Information in Basic Setting.

e Firmware 1 shows its version number (and model code) and MM/DD/YYYY creation
date.

* Firmware 2 shows its version number (and model code) and MM/DD/YYYY creation
date.

Current Boot Image

This displays which firmware is currently in use on the Switch (Firmware 1 or Firmware 2).

Config Boot Image

Select which firmware (Firmware 1 or Firmware 2) should load, click Apply and reboot the
Switch to see changes, you will also see changes in the Current Boot Image field above as
well.

Apply Click Apply to save your changes fo the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the fop navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Firmware Choose to upload the new firmware to (Firmware) 1 or (Firmware) 2.
File Path Type the path and file name of the firmware file you wish to upload to the Switch in the File
Path text box or click Choose File or Browse to locate if.
Upgrade Click Upgrade to load the new firmware. s are only applied after a reboot. To reboot, go to

Management > Maintenance > Reboot System and click Config 1, Config 2 or Factory
Default (Config 1, Config 2 and Factory Default are the configuration files you want the
Switch to use when it restarts).

37.4 Restore Configuration

Use this screen to restore a previously saved configuration from your computer to the Switch.

Figure 216 Management > Maintenance > Restore Configuration

click Restore button.

Restore Configuration Maintenance

To restore the device's configuration from a file, browse the location of the configuration file and

File Path Browse... Mo file selected.

Restore

Enter the path and file name of the configuration file you wish o restore in the File Path text box or click
Choose File or Browse to locate it. After you have specified the file, click Restore. "config"is the name of
the configuration file on the Switch, so your backup configuration file is automatically renamed when
you restore using this screen.
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37.5 Backup Configuration

Backing up your Switch configurations allows you to create various “snap shots” of your device from
which you may restore at a later date.

Back up your current Switch configuration to a computer using the Backup Configuration screen.

Figure 217 Management > Maintenance > Backup Configuration

Backup Configuration Maintenance

This page dllows you to back up the device's cumrent configuration to your workstation. Now
click the Backup button.
Configuration |Runn|'ng Config V|

Follow the steps below to back up the current Switch configuration to your computer in this screen.

1 Select which Switch configuration file you want to download to your computer.
2 Click Backup.

3 If the current configuration file is open and/or downloaded fo your computer automatically, you can
click File > Save As to save the file to a specific place.

If a dialog box pops up asking whether you want to open or save the file, click Save or Save File to
download it to the default downloads folder on your computer. If a Save As screen displays after you
click Save or Save File, choose a location to save the file on your computer from the Save in drop-down
list box and type a descriptive name for it in the File name list box. Click Save to save the configuratfion
file to your computer.

37.6 Tech-Support

The Tech-Support feature is a log enhancement tool that logs useful information such as CPU utilization
history, memory and Mbuf (Memory Buffer) log and crash reports for issue analysis by customer support
should you have difficulty with your Switch. The Tech Support menu eases your effort in obtaining reports.

Click Management > Maintenance > Tech-Support to see the following screen.
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Figure 218 Management > Maintenance > Tech-Support

CPU
Mbuf

All

Crash

CPU history
Memaory section
Mbuf

ROM

L

%)

threshold 100 |keep

threshold |50

Maintenance

5 seconds

Apply

Download
Download
Download
Download
Download

Download

E]
0
a
=
]
o

Download

You may need WordPad or similar software to see the log report correctly. The table below describes
the fields in the above screen.

Table 153 Management > Maintenance > Tech-Support

LABEL

DESCRIPTION

CPU

Type a number ranging from 50 to 100 in the CPU threshold box, and type another
number ranging from 5 to 60 in the seconds box then click Apply.

For example, 80 for CPU threshold and 5 for seconds means a log will be created when
CPU utilization reaches over 80% and lasts for 5 seconds.

The log report holds 7 days of CPU log data and is stored in volatile memory (RAM). The
datais lost if the Switch is furned off or in event of power outage. After 7 days, the logs
wrap around and new ones and replace the earliest ones.

The higher the CPU threshold number, the fewer logs will be created, and the less data
technical support will have to analyze and vice versa.

Mbuf

Type a number ranging from 50 to 100 in the Mbuf (Memory Buffer) threshold box. The
Mbuf log report is stored in flash (permanent) memory.

For example, Mbuf 50 means a log will be created when the Mbuf utilization is over 50%.

The higher the Mbuf threshold number, the fewer logs will be created, and the less data
technical support will have to analyze and vice versa.

Apply

Click Apply to save your changes o the Switch's run-time memory. The Switch loses
these changes if it is furned off or loses power, so use the Save link on the top navigation
panel to save your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

All

Click Download to see all the log report and system status. This log report is stored in flash
memory. If the All log report is too large, you can download the log reports separately
below.

Crash

Click Download to see the crash log report. The log will include information of the last
crash and is stored in flash memory.

CPU history

Click Download to see the CPU history log report. The 7-days log is stored in RAM and you
will need to save it, otherwise it will be lost when the Switch is shutdown or during power
outage.

Memory Section

Click Download to see the memory section log report. This log report is stored in flash
memory.

Mbuf

Click Download to see the Mbuf log report. The log includes Mbuf over threshold
information. This log report is stored in flash memory.
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Table 153 Management > Maintenance > Tech-Support (confinued)

LABEL DESCRIPTION

ROM Click Download to see the Read Only Memory (ROM) log report. This report is stored in
flash memory.

L3 Click Download to see the layer-3 Switch log report. The log only applies to the layer-3
Switch models. This report is stored in flash memory.

37.6.1 Tech-Support Download

When you click Download to save your current Switch configuration to a computer, the following screen
appears. When the log report has downloaded successfully, click Back to return to the previous screen.

Figure 219 Management > Maintenance > Tech-Support: Download

'ech-Support download|

Downloading the tech-support file. Please wait for @ moment.

37.7 Certificates

The Switch can use HTTPS certificates that are verified by a third party to create secure HTTPS
connections between your computer and the Switch. This way, you may securely access the Switch
using the Web Configurator. See Section 38.8.3 on page 322 for more information about HTTPS.

Certificates are based on public-private key pairs. A certificate contains the certificate owner's identity
and public key. Certificates provide a way to exchange public keys for use in authentication.

Click Management > Maintenance > Certificates to open the following screen. Use this screen to import

the Switch's CA-signed certificates.

Figure 220 Management > Maintenance > Certificates

Maintenance
Please specify the location of the HTTPS cerlificate file to be imperted.The certificate file must be the Binary PKC5#12 format.
File Path Choose File | Mo file chosen
Password |
HITPS JCN=X51920 0019cb000001  /CHN=X519300019cb000001  Jon 100:00:15 20146 G har 24 O
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The following table describes the labels in this screen.

Table 154 Management > Maintenance > Certificates

LABEL

DESCRIPTION

File Path

Click Choose File or Browse to find the certificate file you want to upload.

Password

Enter the certificate file's password that was created when the PKCS #12 file was exported.
The password consists of up to 32 ASCIl characters.

Import

Click this button to save the certificate that you have enrolled from a certification authority
from your computer fo the Switch.

Service

This field displays the service type that this certificate is for.

Subject

This field displays identifying information about the certificate’s owner, such as CN
(Common Name), OU (Organizational Unit or department), O (Organization or company)
and C (Country). It is recommended that each certificate have unique subject
information.

Issuer

This field displays identifying information about the certificate’s issuing certification
authority, such as a common name, organizational unit or department, organization or
company and country.

Valid From

This field displays the date that the certificate becomes applicable.

Valid To

This field displays the date that the certificate expires.

Select an entry’s check box to select a specific entry.

Delete

Click this button to delete the certificate (or certification request). You cannot delete a
certificate that one or more features is configured to use.

37.7.1 HTTPS Certificates

Use this screen to view the HTTPS certificate details. Click a hyperlink in the Service column in the
Management > Maintenance > Certificates screen to open the following screen.
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Figure 221 Management > Maintenance > Certificates > HTTPS

Cerlificates
Certificate:
Data:
Version: 3 (0x2)
Sericl Mumber:
bc:99:11:%bibéed
Signoture Algorithm: sha238WithRSAEncryption
ssuer CH=X338600 be?9115bbéel
Validity
Mot Before: Jan 1 00:00:35 2016 GMT
Mat After : Mar 26 00:00:35 2074 GMT
Subject: CN=X53800 bc9%119bbéed
Subject Public Key Info:
Public Key Algorithm: rsaEncryption
Public-Key: (2048 bit)
hedulus:
00:c2:f0:% e fd:c5:c0:aB:a3:02:
54:66:64:08:07:32:4fef 4e:2b:80:59:d7:dB:dT:
04:7f:7ciad:Toi43:4d:09:09:15:10:a0: 54k %l
cBréfb3:82:42:07:29:55 23k 7bdaT0T:
18:08:4f:c3:0f-be:60:Fé:0b:15:c3:7 2:dd:1 5:24:
7o 1:94:19:65:09:7 2:{%:4d He:

)6 4748 2ef4eb2fb2:c7:d2:
a4l cilbo47:82:78:1:67:05:27:3a:
$9:42:92:92:01:03:3b:dlicoaT 4abé:F7 0% 2a:
47:15:08:14:22:d% eebé4]1:] liecicoid§: 297 d:
“dé:48: 2al:28:08:07: :11:05:72:

ebrd1:79:85:c8:21 :cdidf:a2:c?:f 110 55:f0:
éscidl4fbfc2iceTolbed: 1 bidlicePerl U:fl:
£e:43:68:54:41:28:21 :28:3b:41:88:7b:91:28:70:
ébdeifiiélboich el e 1 4:48: 1 bidf: ] 1:d2:
70:7 1:06:40:9:61:60:7 2:8d:5:f4:de:éd:7F:03:
f9:bb:dafdica:e?:26:c1:31:7c:3c:97:82: 1 eV a:
7009

Exponent: 5537 [0x10001)

X50%v3 extensions:
X50%v3 Basic Constraints:

CATRUE

X50%v3 Key Usoge:

Digital Signature, Key Encipherment, Certificate Sign
Signoture Algorithm: sha238WithRSAEncryption
05:51:65:67:37:42:c6:20:7:04:ff: 2e:f5:dd:99:31:56:Fa:
ebibf:8%:01:4a:d7: 07 édibbeeTiec: 1 7:d0:37 :22:34:d3:
Sedbibd:f4:1 a1 3:c8ib a0 8:3b:7 6:4é0efn0:4%:0b:
f:83:15:71:00:61:20:8c:7f:2f 0cref: 204310 1 :a4:8a:cT:

a5:d7:19:3f:c4:47:3d:33:cerflifee2:0d:55:00:27:07:23: v
45:90:3c:7:49:8d:05:51:55:21:24:90:21 :32:4 1 :08:dE:31: y
Fon rrinra e mmm  ra oa men e 7

37.8 Technical Reference

This section provides technical background information on the topics discussed in this chapfter.

37.8.1 FTP Command Line

This section shows some examples of uploading to or downloading files from the Switch using FTP
commands. First, understand the filename conventions.

37.8.2 Filename Conventions

The configuration file (also known as the romfile or ROM) contains the Zyxel factory default configuration
settings in the screens such as password, Switch setup, IP Setup, and so on. Once you have customized
the Switch’s seftings, they can be saved back fo your computer under a filename of your choosing.

ZyNOS (Zyxel Network Operating System sometimes referred to as the "ras” file) is the system firmware

XS1930 Series User's Guide

304



Chapter 37 Maintenance

and has a "bin” flename extension.

Table 155 Filename Conventions

FILE TYPE INTERNAL NAME EXTERNAL NAME DESCRIPTION

Configuration File | config *.cfg This is the configuration filename on the
Switch. Uploading the config file replaces
the specified configuration file system,
including your Switch configurations,
system-related data (including the default
password), the error log and the frace log.

Firmware ras *.bin This is the generic name for the ZyNOS
firmware on the Switch.

37.8.2.1 Example FTP Commands

ftp> put firmware.bin ras
This is a sample FTP session showing the transfer of the computer file "firmware.bin" to the Switch.
ftp> get config config.cfg

This is a sample FTP session saving the current configuration to a file called “config.cfg” on your
computer.

If your (T)FTP client does not allow you to have a destination filename different than the source, you will
need to rename them as the Switch only recognizes “config” and “ras”. Be sure you keep unaltered
copies of both files for later use.

Be sure to upload the correct model firmware as uploading the wrong
model firmware may damage your device.

37.8.3 FTP Command Line Procedure

1

Launch the FTP client on your computer.

Enter open, followed by a space and the IP address of your Switch.

Press [ENTER] when prompted for a user name.

Enter your password as requested (the default is *1234").

Enter bin to set transfer mode to binary.

Use put to transfer files from the computer to the Switch, for example, put firmware.bin ras transfers
the firmware on your computer (firmware.bin) to the Switch and renames it to “ras”. Similarly, put
config.cfg config transfers the configuration file on your computer (config.cfg) to the Switch and
renames it fo “config”. Likewise get config config.cfg transfers the configuration file on the Switch
to your computer and renames it to “config.cfg”. See Table 155 on page 305 for more information on

filename conventions.

Enter quit to exit the ftp prompt.
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37.8.4 GUI-based FTP Clients

The following table describes some of the commands that you may see in GUI-based FTP clients.

Table 156 General Commands for GUI-based FTP Clients

COMMAND DESCRIPTION
Host Address Enter the address of the host server.
Login Type Anonymous.

This is when a user |.D. and password is automatically supplied to the server for
anonymous access. Anonymous logins will work only if your ISP or service administrator
has enabled this option.

Normal.

The server requires a unique User ID and Password to login.

Transfer Type Transfer files in either ASCII (plain text format) or in binary mode. Configuration and
firmware files should be transferred in binary mode.

Initial Remote Directory | Specify the default remote directory (path).

Initial Local Directory Specify the default local directory (path).

37.8.5 FTP Restrictions

FTP will not work when:

e FTP service is disabled in the Service Access Control screen.

* The IP addresses in the Remote Management screen does not match the client IP address. If it does
not match, the Switch will disconnect the FTP session immediately.
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CHAPTER 38
Access Control

38.1 Access Control Overview

This chapter describes how to control access to the Switch.

FTP is allowed one session each, Telnet and SSH share nine sessions, up o five web sessions (five different
user names and passwords) and/or limitless SNMP access control sessions are allowed.

Table 157 Access Control Overview

SSH | Telnet FTP Web SNMP

Share up fo nine sessions One session Up to five accounts | No limit

38.1.1 What You Can Do

Use the Access Control screen (Section 38.2 on page 307) to display the main screen.
Use the SNMP screen (Section 38.3 on page 308) fo configure your SNMP seftings.

Use the Trap Group screen (Section 38.3.1 on page 309) to specify the types of SNMP traps that should
be sent to each SNMP manager.

Use the User Information screen (Section 38.3.3 on page 311) to create SNMP users for authentication
with managers using SNMP v3 and associafte them to SNMP groups.

Use the Logins screens (Section 38.4 on page 313) to assign which users can access the Switch
through Web Configurator at any one fime.

Use the Service Access Control screen (Section 38.5 on page 314) to decide what services you may
use fo access the Switch.

Use the Remote Management screen (Section 38.6 on page 315) to specify a group of one or more
“trusted computers” from which an administrator may use a service to manage the Switch.

Use the Account Security screen (Section 38.7 on page 316) to encrypt all passwords configured in
the Switch. You can also display the authentication, authorization, external authentication server
information (RADIUS), system and SNMP user account information in the configuration file saved.

38.2 Access Control Main Settings

Use this screen to display the main screen.

Click Management > Access Control in the navigation panel to display the main screen as shown.
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Figure 222 Man

agement > Access Control

SMMP Click Here
Logins Click Here
Service Access Conirol Click Here
Remote Management Click Here
Account Security Click Here

The following table describes the labels in this screen.

Table 158 Management > Access Control

LABEL DESCRIPTION

SNMP Click this link to configure your SNMP settings.

Logins Click this link to assign which users can access the Switch through Web Configurator at any
one time.

Service Access Click this link to decide what services you may use fo access the Switch.

Control

Remote Click this link to specify a group of one or more “trusted computers” from which an

Management administrator may use a service to manage the Switch.

Account Security

Click this link to encrypt all passwords configured in the Switch. You can also display the
authentication, authorization, external authentication server information (RADIUS), system
and SNMP user account information in the configuration file saved.

38.3 Configure SNMP

Use this screen to configure your SNMP settings.

Click Management > Access Control > SNMP to view the screen as shown.

Figure 223 Man

agement > Access Control > SNMP

Access Confrol Trap Group User
General Setting
Version v2c v
Get Community public
Set Community private
Trap Community public123
Trap Destination
IVQC—VI 192.168.1.223 162
v2c v 0.0.0.0 162
v2c v 0.0.0.0 162
[vec | 0.0.0.0 162
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The following table describes the labels in this screen.

Table 159 Management > Access Control > SNMP

LABEL

DESCRIPTION

General Setting

Use this section fo specify the SNMP version and community (password) values.

Version

Select the SNMP version for the Switch. The SNMP version on the Switch must match the
version on the SNMP manager. Choose SNMP version 2¢ (v2c), SNMP version 3 (v3) or both
(v3v2c).

SNMP version 2c is backwards compatible with SNMP version 1.

Get Community

Enter the Get Community string, which is the password for the incoming Get- and GetNext-
requests from the management station.

The Get Community string is only used by SNMP managers using SNMP version 2c or lower.

Set Community

Enter the Set Community, which is the password for incoming Set- requests from the
management station.

The Set Community string is only used by SNMP managers using SNMP version 2c or lower.

Trap Community

Enter the Trap Community string, which is the password sent with each frap to the SNMP
manager.

The Trap Community string is only used by SNMP managers using SNMP version 2c or lower.

Trap Destination

Use this section to configure where to send SNMP fraps from the Switch.

Version Specify the version of the SNMP trap messages.

P Enter the IP addresses of up fo four managers to send your SNMP traps to.

Port Enter the port number upon which the manager listens for SNMP traps.

Username Enter the user name to be sent to the SNMP manager along with the SNMP v3 trap.

This user name must match an existing account on the Switch (configured in the
Management > Access Control > SNMP > User screen).

Apply Click Apply to save your changes to the Switch’s run-fime memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

38.3.1 Configure SNMP Trap Group

From the SNMP screen, click Trap Group fo view the screen as shown. Use the Trap Group screen to
specify the types of SNMP fraps that should be sent to each SNMP manager.

Figure 224 Management > Access Control > SNMP > Trap Group

Trap Desfination [P
System -
Interface -
AAA -
IP -
Switch -

SNMP Setting Port

[ coldstart O warmstart O pos
O linkup O fnkdown O lidp
O cuthentication

O ping [ tracercute

O stp [ tmen
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The following table describes the labels in this screen.

Table 160 Management > Access Control > SNMP > Trap Group

LABEL

DESCRIPTION

Trap Destination IP

Select one of your configured frap destination IP addresses. These are the IP addresses of the
SNMP managers. You must first configure a trap destination IP address in the SNMP Setting
screen.

Use the rest of the screen fo select which fraps the Switch sends to that SNMP manager.

Type

Select the categories of SNMP traps that the Switch is to send to the SNMP manager.

Options

Select the individual SNMP fraps that the Switch is to send to the SNMP station.

The fraps are grouped by category. Selecting a category automatically selects all of the
category’s traps. Clear the check boxes for individual traps that you do not want the Switch
fo send to the SNMP station. Clearing a category’s check box automatically clears all of the
category’s trap check boxes (the Switch only sends traps from selected categories).

Apply

Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

38.3.2 Enable or Disable Sending of SNMP Traps on a Port

From the SNMP > Trap Group screen, click Port fo view the screen as shown. Use this screen to set
whether a frap received on the ports would be sent fo the SNMP manager.

Figure 225 Management > Access Control > SNMP > Trap Group > Port

Trap Group Porl

Option:

[ RN

~ o fn e

Irap Group

o000 @@O

The following table describes the labels in this screen.

Table 161 Management > Access Control > SNMP > Trap Group > Port

LABEL DESCRIPTION
Option Select the trap type you want to configure here.
Port This field displays a port number.
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Table 161 Management > Access Control > SNMP > Trap Group > Port (continued)

LABEL DESCRIPTION

* Settings in this row apply to all ports.

Use this row only if you want to make some of the settings the same for all ports. Use this row
first fo set the common settings and then make adjustments on a port-by-port basis.

Changes in this row are copied to all the ports as soon as you make them.

Active Select this check box to enable the trap type of SNMP traps on this port. The Switch sends the
related traps received on this port to the SNMP manager.

Clear this check box to disable the sending of SNMP fraps on this port.

Apply Click Apply to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

38.3.3 Configure SNMP User

From the SNMP screen, click User fo view the screen as shown. Use the User screen to create SNMP users
for authentication with managers using SNMP v3 and associate them to SNMP groups. An SNMP user is
an SNMP manager.

Figure 226 Management > Access Control > SNMP > User

SNMP Setiing
Username
Security Leve! @I
Authentication @I Password
Privacy E Possword
Group [agmin -]

Delete | Cancel

The following table describes the labels in this screen.

Table 162 Management > Access Control > SNMP > User

LABEL DESCRIPTION

User Information Note: Use the user name and password of the login accounts you specify in this

screen to create accounts on the SNMP v3 manager.

Username Specify the user name of a login account on the Switch.
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Table 162 Management > Access Control > SNMP > User (confinued)

LABEL

DESCRIPTION

Security Level

Select whether you want to implement authentication and/or encryption for SNMP
communication from this user. Choose:

* noauth - fo use the user name as the password string to send to the SNMP manager. This is
equivalent to the Get, Set and Trap Community in SNMP v2c. This is the lowest security
level.

¢ auth - fo implement an authentication algorithm for SNMP messages sent by this user.

e priv —to implement authentication and encryption for SNMP messages sent by this user.
This is the highest security level.

Note: The settings on the SNMP manager must be set at the same security level or
higher than the security level settings on the Switch.

Authentication Select an authentication algorithm. MD5 (Message Digest 5) and SHA (Secure Hash Algorithm)
are hash algorithms used to authenticate SNMP data. SHA authentication is generally
considered stronger than MDS, but is slower.

Password Enter the password of up to 32 ASCIl characters (except [¢], [ | I.[']. ["]or[.]) for SNMP
user authentication.

Privacy Specify the encryption method for SNMP communication from this user. You can choose one
of the following:

e DES - Datfa Encryption Standard is a widely used (but breakable) method of data
encrypftion. It applies a 56-bit key to each é4-bit block of data.
e AES - Advanced Encryption Standard is another method for data encryption that also
uses a secret key. AES applies a 128-bit key to 128-bit blocks of data.
Password Enter the password of up to 32 ASCIl characters (except [2 ], [ | I.[']. ["]or[.]) for
encrypting SNMP packets.

Group SNMP v3 adopts the concept of View-based Access Control Model (VACM) group. SNMP
managers in one group are assigned common access rights to MIBs. Specify in which SNMP
group this user is.
admin — Members of this group can perform all types of system configuration, including the
management of administrator accounts.
readwrite — Members of this group have read and write rights, meaning that the user can
create and edit the MIBs on the Switch, except the user account and AAA configuration.
readonly — Members of this group have read rights only, meaning the user can collect
information from the Switch.

Add Click this to create a new entry or to update an existing one.

This saves your changes to the Switch's run-time memory. The Switch loses these changes if it is
furned off or loses power, so use the Save link on the top navigation panel to save your
changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to reset the fields to your previous configuration.

Clear Click Clear to reset the fields to the factory defaults.

Index This is a read-only number identifying a login account on the Switch. Click on an index number
to view more details and edit an existing account.
Username This field displays the user name of a login account on the Switch.

Security Level

This field displays whether you want to implement authentication and/or encryption for SNMP
communication with this user.

Authentication

This field displays the authentication algorithm used for SNMP communication with this user.

Privacy

This field displays the encryption method used for SNMP communication with this user.

Group

This field displays the SNMP group to which this user belongs.

Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.
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Table 162 Management > Access Control > SNMP > User (confinued)

LABEL DESCRIPTION
Delete Click Delete to remove the selected entry from the summary table.
Cancel Click Cancel to begin configuring this screen afresh.

38.4 Set Up Login Accounts

Up fo five people (one administrator and four non-administrators) may access the Switch through Web
Configurator at any one time.

* An administrator is someone who can both view and configure Switch changes. The user name for
the Administrator is always admin. The default administrator password is 1234.

Note: It is highly recommended that you change the default administrator password (1234).

* A non-administrator (user name is something other than admin) is someone who can view and/or
configure Switch settings. The configuration right varies depending on the user’s privilege level.

Click Management > Access Control > Logins to view the screen as shown.

Figure 227 Management > Access Control > Logins

Access Control
Administrator

Old Password

MNew Password

Retype to confirm

Please record your new password whenever you change it. The system will lock you out if you have
forgotten your password.

Edit Logins

R R

The following table describes the labels in this screen.

Table 163 Management > Access Conftrol > Logins

LABEL DESCRIPTION

Administrator

This is the default administrator account with the “admin” user name. You cannot change the default administrator
user name.

Old Password Type the existing system password (1234 is the default password when shipped).

New Password | Enfer your new system password.

Retype to Retype your new system password for confirmation.
confirm
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Table 163 Management > Access Control > Logins (continued)

LABEL DESCRIPTION

Edit Logins

You may configure passwords for up to four users. These users can have read-only access.

User Name Set a user name (up to 32 ASCIl characters long).

Password Enter your new system password.

Retype to Retype your new system password for confirmation.

confirm

Privilege Type the privilege level for this user. At the time of writing, users may have a privilege level of 0,

3, 13, or 14 representing different configuration rights as shown below.

e 0-Display basic system information.
* 3 -Display configuration or status.

* 13- Configure features except for login accounts, SNMP user accounts, the
authentication method sequence and authorization settings, multiple logins, administrator
and enable passwords, and configuration information display.

* 14 - Configure login accounts, SNMP user accounts, the authentication method
sequence and authorization settings, multiple logins, and administrator and enable
passwords, and display configuration information.

Users can run command lines if the session’s privilege level is greater than or equal to the
command’s privilege level. The session privilege initially comes from the privilege of the login
account. For example, if the user has a privilege of 5, he or she can run commands that
requires privilege level of 5 or less but not more.

Apply Click Apply to save your changes o the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

38.5 Service Access Control

Service Access Control allows you to decide what services you may use to access the Switch. You may
also change the default service port and configure “trusted computers” for each service in the Remote
Management screen (discussed later). Click Access Control to go back to the main Access Control
screen.

Figure 228 Management > Access Control > Service Access Control

Service Access Control Access Control
Telnet 23 |5 |M'|nu'es Seconds
S5H 22
FTP 21 5 Minutes
HTTP 80 55 Minutes
HTTPS 443
ICMP
SMMP
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The following table describes the fields in this screen.

Table 164 Management > Access Control > Service Access Control

LABEL DESCRIPTION

Services Services you may use fo access the Switch are listed here.

Active Select this option for the corresponding services that you want to allow to access the Switch.
Service Port For Telnet, SSH, FTP, HTTP or HTTPS services, you may change the default service port by typing

the new port number in the Service Port field. If you change the default port number then you
will have to let people (who wish to use the service) know the new port number for that
service.

Timeout Enter how many minutes (from 1 to 255) a management session can be left idle before the
session times out. After it times out you have to log in with your password again. Very long idle
fimeouts may have security risks.

Login Timeout The Telnet or SSH server do not allow multiple user logins at the same fime. Enter how many
seconds (from 30 to 300 seconds) a login session times out. After it fimes out you have to start
the login session again. Very long login session timeouts may have security risks.

For example, if User A attempts to connect to the Switch (through SSH), but during the login
stage, do not enter the user name and/or password, User B cannot connect to the Switch
(through SSH) before the Login Timeout for User A expires (default 150 seconds).

Apply Click Apply to save your changes to the Switch’s run-fime memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

38.6 Remote Management

Use this screen to specify a group of one or more “trusted computers” from which an administrator may
use a service fo manage the Switch.

Click Management > Access Control > Remote Management to view the screen as shown next.

Click Access Control to return to the Access Control screen.
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Figure 229 Management > Access Control > Remote Management

Remole Managemeni Access Confrol
Secured Client Setup
1 0.0.0.0 0.0.0.0
2 O 0.0.0.0 0.0.0.0 o o o o o o d
3 O 0.0.0.0 0.0.0.0 o o o o o o d
4 O 0.0.0.0 0.0.0.0 o o o o o o d
5 O 0.0.0.0 0.0.0.0 o o o o o o d
6 O 0.0.0.0 0.0.0.0 o o o o o o d
7 O 0.0.0.0 0.0.0.0 o o o o o o d
8 O 0.0.0.0 0.0.0.0 o o o o o o d
E O 0.0.0.0 0.0.0.0 o o o o o o d
1w O 0.0.0.0 0.0.0.0 o o o o o o d
11 O 0.0.0.0 0.0.0.0 o o o o o o d
1z O 0.0.0.0 0.0.0.0 o o o o o o d
1z O 0.0.0.0 0.0.0.0 o o o o o o d
14O 0.0.0.0 0.0.0.0 o o o o o o d
15 0O 0.0.0.0 0.0.0.0 o o o o o o d
16O 0.0.0.0 0.0.0.0 o o o o o o d

The following table describes the labels in this screen.

Table 165 Management > Access Control > Remote Management

LABEL DESCRIPTION

Entry This is the client set index number. A “client set” is a group of one or more “frusted computers”
from which an administrator may use a service to manage the Switch.

Active Select this check box to activate this secured client set. Clear the check box if you wish to
temporarily disable the set without deleting it.

Start Address Configure the IP address range of trusted computers from which you can manage this Switch.

End Address The Switch checks if the client IP address of a computer requesting a service or protocol matches
the range set here. The Switch immediately disconnects the session if it does not match.

Telnet/FTP/ Select services that may be used for managing the Switch from the specified trusted computers.

HTTP/ICMP/

SNMP/SSH/

HTTPS

Apply Click Apply to save your changes to the Switch's run-fime memory. The Switch loses these

changes if it is furned off or loses power, so use the Save link on the fop navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

38.7 Account Security

Use this screen to encrypt all passwords configured in the Switch. This setting will affect how the
password is shown (as plain text or encrypted text) in the configuration file saved in Management >
Maintenance > Save Configuration.

Note: Make sure o enable Password Encryption to avoid displaying passwords as plain text in
the configuration file.
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Password Encryption encrypfs all passwords in the configuration file. However, if you want to show some
passwords as plain text in the configuration file, select them as below.

Note: Be careful who can access configuration files with plain text passwords!

* Authentication information configured for Authentication in the Advanced Application > AAA > AAA
Setup screen (Method 1/2/3 setting in the Privilege Enable and Login fields).

¢ Authorization information configured for Authorization in the Advanced Application > AAA > AAA
Setup screen (Active/Console/Method setfing in the Exec and Dotlx fields).

* Server information configured for Authentication Server in the Advanced Application > AAA > RADIUS
Server Setup screen (Mode/Timeout fields).

¢ System account information configured in the Switch (admin, user login name, and password).

¢ SNMP user account information configured in the Management > Access Control > SNMP > User
screen (password for SNMP user authentfication in the Authentication field, and the password for the
encryption method for SNMP communication in the Privacy field).

Note: The passwords will appear as encrypted text when Password Encryption is Active.

Click Management > Access Control > Account Security to view the screen as shown next.

Click Access Control to return to the Access Control screen.

Figure 230 Management > Access Control > Account Security

Password Encryption

Display

User

Access Control
Active [

[ Authentication
[ Authorization
O server

O System
N

The following table describes the labels in this screen.

Table 166 Management > Access Control > Account Security

LABEL DESCRIPTION

Account Security

Password Select this check box to encrypt all passwords configured on the Switch. This displays the

Encryption password as encrypted text, in a saved configuration file.

Otherwise, the passwords configured on the Switch are displayed in plain text.

Apply Click Apply to save your changes for Account Security to the Switch's run-time memory. The
Switch loses these changes if it is furned off or loses power, so use the Save link on the top
navigation panel to save your changes to the non-volatile memory when you are done
configuring.

Cancel Click Cancel to begin configuring Account Security afresh.

Display
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Table 166 Management > Access Control > Account Security (continued)
LABEL DESCRIPTION

Display Select which specific information to display in plain text, in the saved configuration file.

= Authentication
« Authorization

= Server
User Select which user account information to display in plain text, in the saved configuration file.
= System
= SNMP
Apply Click Apply to save your changes for Display to the Switch’s run-time memory. The Switch loses

these changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring Display afresh.

38.8 Technical Reference

This section provides technical background information on the topics discussed in this chapfter.

38.8.1 About SNMP

Simple Network Management Protocol (SNMP) is an application layer protocol used to manage and
monitor TCP/IP-based devices. SNMP is used to exchange management information between the
network management system (NMS) and a network element (NE). A manager station can manage and
monitor the Switch through the network through SNMP version 1 (SNMPv1), SNMP version 2c or SNMP
version 3. The next figure illustrates an SNMP management operation. SNMP is only available if TCP/IP is
configured.

Figure 231 SNMP Management Model

Manager
Agent Agent Agent
Managed Device Managed Device Managed Device

An SNMP managed network consists of two main components: agents and a manager.

An agent is a management software module that resides in a managed Switch (the Switch). An agent
translates the local management information from the managed Switch into a form compatible with
SNMP. The manager is the console through which network administrators perform network management
functions. It executes applications that control and monitor managed devices.
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The managed devices contain object variables or managed objects that define each piece of
information to be collected about a Switch. Examples of variables include number of packets received,
node port status, and so on. A Management Information Base (MIB) is a collection of managed objects.
SNMP allows a manager and agents fo communicate for the purpose of accessing these objects.

SNMP itself is a simple request or response protocol based on the manager or agent model. The
manager issues a request and the agent returns responses using the following protocol operations:

Table 167 SNMP Commands

LABEL DESCRIPTION
Get Allows the manager to retrieve an object variable from the agent.
GetNext Allows the manager to retfrieve the next object variable from a table or list within an agent. In

SNMPv1, when a manager wants to retrieve all elements of a table from an agent, it initiates a
Get operation, followed by a series of GetNext operations.

Set Allows the manager to set values for object variables within an agent.

Trap Used by the agent to inform the manager of some events.

SNMP v3 and Security

SNMP v3 enhances security for SNMP management. SNMP managers can be required to authenticate
with agents before conducting SNMP management sessions.

Security can be further enhanced by encrypting the SNMP messages sent from the managers.
Encryption protects the contents of the SNMP messages. When the contents of the SNMP messages are
encrypted, only the intended recipients can read them.

Supported MIBs
A MIB is a collection of managed objects that is organized according to hierarchy. The objects define
the afttributes of the managed device, which includes the names, status, access rights, and data types.

Each object can be addressed through an object identifier (OID).

MIBs let administrators collect statistics and monitor status and performance. The Switch uses standard
public (RFC-defined) MIBs for standard functionality.

To view a list of standard MIBs supported by your Switch, see the product datasheet at www.zyxel.com
(Support > Download Library > Datasheet).

SNMP Traps

The Switch sends traps to an SNMP manager when an event occurs. The following tables outline the
SNMP traps by category.

Table 168 SNMP System Traps

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
coldstart coldStart 1.3.6.1.6.3.1.1.5.1 This trap is sent when the Switch is furned on.
warmstart warmStart 1.3.6.1.6.3.1.1.5.2 This trap is sent when the Switch restarts.
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Table 168 SNMP System Traps (continued)

OPTION OBJECT LABEL OBJECT ID DESCRIPTION
poe pethPsePortOnOffNofification |1.3.6.1.2.1.105.0.1 | This trap is sent when the PoE port delivers
power or delivers no power fo a PD.
(For POE models
only) pethMainPowerUsageOnNo 1.3.6.1.2.1.105.0.2 | This trap is sent when the usage power is
tification above the usage indication threshold.
pethMainPowerUsage OffNo 1.3.6.1.2.1.105.0.3 | This trap is sent when the usage power is
fification below the usage indication threshold.
Table 169 SNMP Interface Traps
OPTION OBJECT LABEL OBJECT ID DESCRIPTION
linkup linkUp 1.3.6.1.6.3.1.1.5.4 This trap is sent when the Ethernet link is up.
linkdown linkDown 1.3.6.1.6.3.1.1.5.3 This trap is sent when the Ethernet link is
down.
lldp lldpRemTablesChange 1.0.8802.1.1.2.0.0.1 | The trap is sent when entries in the remote
database have any updates.
Link Layer Discovery Protocol (LLDP), defined
as |EEE 802.1ab, enables LAN devices that
support LLDP to exchange their configured
settings. This helps eliminate configuration
mismaftch issues.
Table 171 SNMP IP Traps
OPTION OBJECT LABEL OBJECT ID DESCRIPTION
ping pingProbeFailed 1.3.6.1.2.1.80.0.1 This frap is sent when a single ping probe
fails.
pingTestFailed 1.3.6.1.2.1.80.0.2 This trap is sent when a ping fest (consisting
of a series of ping probes) fails.
pingTestCompleted 1.3.6.1.2.1.80.0.3 This trap is sent when a ping fest is
completed.
fraceroute fraceRouteTestFailed 1.3.6.1.2.1.81.0.2 This trap is sent when a traceroute test fails.
fraceRouteTestCompleted 1.3.6.1.2.1.81.0.3 This frap is sent when a traceroute test is
completed.
Table 172 SNMP Switch Traps
OPTION OBJECT LABEL OBJECT ID DESCRIPTION
rmon RmonRisingAlarm 1.3.6.1.2.1.16.0.1 This trap is sent when a variable goes over
the RMON 'rising" threshold.
RmonFallingAlarm 1.3.6.1.2.1.16.0.2 This trap is sent when the variable falls below

the RMON "falling" threshold.
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38.8.2 SSH Overview

Unlike Telnet or FTP, which transmit data in clear text, SSH (Secure Shell) is a secure communication
protocol that combines authentication and data encryption to provide secure encrypted
communication between two hosts over an unsecured network.

Figure 232 SSH Communication Example

SSH Server . SSH Client
38.8.2.1 How SSH Works

The following table summarizes how a secure connection is established between two remote hosts.

Figure 233 How SSH Works

Encrypfion Method to Use

v

r Y

Password/User Name

r 3

1 Host Identification

The SSH client sends a connection request to the SSH server. The server identifies itself with a host key. The
client encrypts a randomly generated session key with the host key and server key and sends the result
back to the server.

The client automatically saves any new server public keys. In subsequent connections, the server public
key is checked against the saved version on the client computer.
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2 Encryption Method

Once the identfification is verified, both the client and server must agree on the type of encryption
method to use.

3 Avuthentication and Data Transmission

After the identification is verified and data encryption activated, a secure tunnelis established between
the client and the server. The client then sends its authentication information (user name and password)
to the server to log in to the server.

38.8.2.2 SSH Implementation on the Switch

Your Switch supports SSH version 2 using RSA authentication and three encryption methods (DES, 3DES
and Blowfish). The SSH server is implemented on the Switch for remote management and file fransfer on
port 22. Only one SSH connection is allowed at a time.

38.8.2.3 Requirements for Using SSH

You must install an SSH client program on a client computer (Windows or Linux operating system) that is
used to connect to the Switch over SSH.

38.8.3 Introduction to HTTPS

HTTPS (HyperText Transfer Protocol over Secure Socket Layer, or HTTP over SSL) is a web protocol that
encrypts and decrypts web pages. Secure Socket Layer (SSL) is an application-level protocol that
enables secure transactions of data by ensuring confidentiality (an unauthorized party cannot read the
fransferred data), authentication (one party can identify the other party) and data integrity (you know if
data has been changed).

It relies upon certificates, public keys, and private keys.

HTTPS on the Switch is used so that you may securely access the Switch using the Web Configurator. The
SSL protocol specifies that the SSL server (the Switch) must always authenticate itself to the SSL client (the
computer which requests the HTTPS connection with the Switch), whereas the SSL client only should
authenticate itself when the SSL server requires it to do so. Authenticating client certificates is optional
and if selected means the SSL-client must send the Switch a certificate. You must apply for a certificate
for the browser from a Certificate Authority (CA) that is a tfrusted CA on the Switch.

Please refer to the following figure.

1 HTTPS connection requests from an SSL-aware web browser go to port 443 (by default) on the Switch’s
WS (web server).

2 HTTP connection requests from a web browser go to port 80 (by default) on the Switch’'s WS (web
server).
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Figure 234 HTIPS Implementation

WS

HTTPS HTTP

Note: If you disable HTTP in the Service Access Control screen, then the Switch blocks all HTTP
connection aftempts.

38.8.3.1 HTTPS Example

If you have not changed the default HTTPS port on the Switch, then in your browser enter “https://Switch
IP Address/” as the web site address where “Switch IP Address” is the IP address or domain name of the
Switch you wish to access.

Internet Explorer Warning Messages
Internet Explorer 6

When you attempt to access the Switch HTTPS server, a Windows dialog box pops up asking if you trust
the server certificate.

You see the following Security Alert screen in Internet Explorer. Select Yes to proceed fo the Web
Configurator login screen; if you select No, then Web Configurator access is blocked.

Figure 235 Security Alert Dialog Box (Internet Explorer 6)

|

ri‘l Information you exchange with this site cannot be viewed or
?. changed by others. However, there is a problem with the site's
* zecurty certificate.

The zecurity certificate was issued by a company you have
hot chosen ta tust. Yiew the certificate to determing whether
you want ba trust the certifying authority,

o The security certificate date iz valid.

The name on the security certificate is invalid or does not
match the name of the site

Do you want to procesd?

Yes Mo | Wiew Certificate

Internet Explorer 7 later version

When you attempt to access the Switch HTTPS server, a screen with the message '"There is a problem
with this website's security certificate." may display. If that is the case, click Continue to this website (not
recommended) to proceed to the Web Configurator login screen.
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Figure 236 Security Certificate Warning (Internet Explorer 11)

4
|@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authaority.
The security certificate presented by this website was issued for a different website's address.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
SErver,

We recommend that you close this webpage and do not conti to this websit

@ Click here to dose this webpage.

(@ Continue to this website (not recommended].)

® More information

After you log in, you will see the red address bar with the message Certificate Error. Click on Certificate
Error next to the address bar and click View certificates.

Figure 237 Certificate Error (Internet Explorer 11)

= (=B &
/ JipSyehtml O = @ Cenificate ox €| @ Web Configurstor x | iy ki
PO | -
Certificate Invalid = e
@ ; ome Page €Y KEEETSHT fiv B - 0 g v Pagew Safety~ Tooks~ @~
The security certificate presented by this
website has errors. @ @ @ @
This problem might indicate an attempt to Refresh Save Status Legout Hele

fool you or intercept any data you send to
the server.

We recommend that you close this webpage. Varning:
About certificate errors
As a security precaution, it is highly recommended that you should change the admin password.

The SNMP community is used for SNMP management and is set to public by default. To avoid security breach.

please change the community string to a value other than default setting.

Configure Password / SNMP_ setting

( EXAMPLE )

©® Copyright 1995-2017 by Iyxel Communications Corp.

Click Install Certificate... and follow the on-screen instructions to install the certificate in your browser.

XS1930 Series User's Guide
324



Chapter 38 Access Control

Figure 238 Certificate (Internet Explorer 11)

Certificate M
General | Details | Certification Path

@a Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

LE
IPLE

valid from 1/ 1/ 2016 to 3/ 26/ 2076

‘Insiall Certificate... ’ Issuer Statement

Learn more about

Mozilla Firefox Warning Messages

When you attempt o access the Switch HTTPS server, a Your connection is not secure screen may
display. If that is the case, click | Understand the Risks and then the Add Exception... button.

Figure 239 Security Alert (Mozilla Firefox)

— [Slal |
/1 Insecure Connection * '\k+

€ ) 0 hitpsy//192168.11 || Q Search %Ba ¥+ # =

@l Most Visited Q Getting Started @ Agile Product Lifecycl... @ Google @ elTS - ZyXEL Commu... @ ZyPartner @ ZyPartner Download L... O eFlow @ ZyKEL Wiki »

% Your connection is not secure

The owner of 192.168.1.1 has configured their website improperly. To protect your information from being stolen,
Firefox has not connected to this website.

Learn more...

Report errors like this to help Mozilla identify and block malicious sites

m

192.168.11 uses an invalid security certificate.

The certificate is not trusted because it is self-signed.
The certificate is not valid for the name 192.168.11.

Error code: SEC_ERROR_UNKNOWN_ISSUER

Add Exception...
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Confirm the HTTPS server URL matches. Click Confirm Security Exception to proceed to the Web
Configurator login screen.

Figure 240 Security Alert (Mozilla Firefox)
Add Security Exception Iﬁ

You are about to override how Firefox identifies this site.

H & Legitimate banks, stores, and other public sites will not ask you to do this.

Server

(Location: | https://192168.1.1 ) Get Certificate

Certificate Status

This site attempts to identify itself with invalid information.
Wrong Site

The certificate belongs to a different site, which could mean that someone is trying to
impersonate this site.

Unknown Identity

N 4 ) N
The certificate is not trusted@!w*mM‘ﬁgued by a trusted

authority using a secure signature.

Permanently store this exception

([ LConfirm Security Exception ])I Cancel ]

38.8.4 Google Chrome Warning Messages

When you attempt to access the Switch HTTPS server, a Your connection is not private screen may
display. If that is the case, click Advanced and then Proceed to x.x.x.x (unsafe) to proceed to the Web
Configurator login screen.
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Figure 241 Security Alert (Google Chrome 58.0.3029.110)

\ S
x W

-

/ Privacy error
W,

€ C | A Notsecure | baps,//192.168.11 %t |

HH Apps D Agile Product Lifecyc & Google D elTS - ZyXEL Commu z ZyPartner z ZyPartner Download '. eFlow [l ZyXEL Wiki »

A

Your connection is not private

Attackers might be trying to steal your information from 192.168.1.1 (for example,
passwords, messages or credit cards). NET:ERR_CERT_COMMON_NAME_INVALID

| Automatically report details of possible security incidents to Google. Privacy Policy

HIDE ADVANCED Back to safety

This server could not prove that it is 192.168.1.1; its security certificate is from
[missing_subjectAltName]. This may be caused by a misconfiguration or an attacker
intercepting your connection. Find out maore.

Groceed 10 192.168.1.1 [unsafe»

38.8.4.1 Main Settings

After you accept the certificate and enter the login user name and password, the Switch main screen
appears. The lock displayed in the bottom right of the browser status bar or next to the website address
denotes a secure connection.

XS1930 Series User's Guide

327



Figure 242 Example: Lock Denoting a Secure Connection
_@rza;au.nn_p_s_y;nmu ¢ |9 pe "B +$ A O =

ZYXEL cse @ & ® 6 ©

Ralresh Save Stahus Logout Help
Menu
Basic Setting Status Neighbor =
Advanced Application Device Information
1P Application Device Type gnATATAN System Name GEnn
Boot Varion VIO | 01/258/2015 System Location
Management Fimmware Vergion e # e sTermeen | nEmamm T Sycter Time 017012016 07:43:56
Seral Number FOO00000O00000! System Up Time: 000 diays.07 hours.43 mins, 59 secs
MAC Addrass 01 9:c00:01 02 Login Timaoutimins| 3
Deigl
P Address Informafion
1PV4 Address 1
Subnet Mask 255.255.252.0 i
Dafoult Gatawy 1B Setup
IPV4 Global Unicent Addres
1PYé Link-Local Address [Exé confiauration

Device Status and Quick Configuralic 4

3P Dizable 1 d Enable  Sating

Port Mimaring Dlsable 5o Dsoble  Saffing

Starm Centrol Disable Seffing DHCF Relay Decble  Sefling

IGIMF Snooping Disoble  affing W50 Disoble  Saffing

Stocking Stotus Disable  Sotfing -
Quick Links
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CHAPTER 39
Diagnostic

39.1 Overview

This chapter explains the Diagnostic screen. You can use this screen to help you identify problem:s.

39.2 Diagnostic

Click Management > Diagnostic in the navigation panel fo open this screen. Use this screen to ping IP
addresses, run a fraceroute, perform port tests or show the Switch's location between devices.

Figure 243 Management > Diagnostic

Diagnostic
-Info -
P
® Pus
O Pue v
Fing Test IP Address/Host Hame | | m
Source IP Address | |
Count
® Pus
O 1pve
IP Addrsss/Host Name | |
Trace Route Test
Tl 30
Wait Time Seconds
Queries
Cable Diagnostics () Port \:\
Locater LED Minutes m
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The following table describes the labels in this screen.

Table 173 Management > Diagnostic

LABEL DESCRIPTION
Ping Test
IPv4 Select this option if you want to ping an IPv4 address. Otherwise, select — to send ping
requests to all VLANs on the Switch.
IPvé Select this option if you want to ping an IPvé address. You can also select vlan and specify

the ID number of the VLAN to which the Switch is to send ping requests. Otherwise, select - to
send ping requests to all VLANs on the Switch.

IP Address/Host

Type the IP address or host name of a device that you want to ping in order to test a

Name connection.
Click Ping to have the Switch ping the IP address.
Source IP Type the source IP address that you want to ping in order to test a connection.
Acdress Click Ping to have the Switch ping the IP address.
Count Enter the number of ICMP Echo Request (ping) messages the Switch contfinuously sends.

Trace Route Test

IPv4

Select this opftion if you want to frace the route packets taken to a device with an IPv4
address. Otherwise, select - fo trace the path on any VLAN.

Note: The device to which you want to run a traceroute must belong to the VLAN
you specify here.

IPvé

Select this option if you want to frace the route packets taken to a device with an IPvé
address.

IP Address/Host
Name

Enter the IP address or host name of a device to which you want to perform a fraceroute.

Click Trace Route to have the Switch perform the traceroute function. This determines the
path a packet takes to the specified device.

TTL

Enter the Time To Live (TTL) value for the ICMP Echo Request packets. This is to set the
maximum number of the hops (routers) a packet can fravel through. Each router along the
path will decrement the TTL value by one and forward the packets. When the TIL value
becomes zero and the destination is not found, the router drops the packets and informs the
sender.

Wait Time

Specify how many seconds the Switch waits for a response to a probe before running
another traceroute.

Queries

Specify how many times the Switch performs the fraceroute function.

Cable Diagnostics

Enter an Ethernet port number and click Diagnose to perform a physical wire-pair test of the
Ethernet connections on the specified ports. The following fields display when you diagnose
a port.

Port This is the number of the physical Ethernet port on the Switch.

Channel An Ethernet cable usually has four pairs of wires. A T0BASE-T or 100BASE-TX port only use and
test two pairs, while a 1000BASE-T port requires all four pairs.
This displays the descriptive name of the wire-pair in the cable.

Pair status Ok: The physical connection between the wire-pair is okay.

Open: There is no physical connection (an open circuit detected) between the wire-pair.
Short: There is an short circuit detected between the wire-pair.
Unknown: The Switch failed to run cable diagnostics on the cable connected this port.

Unsupported: The port is a fiber port or it is not active.
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LABEL DESCRIPTION
Cable length This displays the total length of the Ethernet cable that is connected to the port when the
Pair status is Ok and the Switch chipset supports this feature.
This shows N/A if the Pair status is Open or Short. Check the Distance to fault.
This shows Unsupported if the Switch chipset does not support to show the cable length.
Distance fo This displays the distance between the port and the location where the cabile is open or
fault shorted.

This shows N/A if the Pair status is Ok.

This shows Unsupported if the Switch chipset does not support fo show the distance.

Locator LED

Enter a time interval (in minutes) and click Blink to show the actual location of the Switch
between several devices in a rack.

The default time interval is 30 minutes.

Click Stop to have the Switch terminate the blinking locater LED.
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CHAPTER 40
System Log

40.1 Overview

A log message stores the information for viewing.

40.2 System Log

Click Management > System Log in the navigation panel fo open this screen. Use this screen to check
current system logs.

Note: When a log reaches the maximum number of log messages, new log messages
automatically overwrite existing log messages, starting with the oldest existing log
message first.

Figure 244 Management > System Log

Syslem Log
1 2020-01-01707:05:081 IMN authentication: HTTR(s) user admin login [P oddress = 172.21 40.31]
2 2020-01-01T04:25:147 M authentication: HTTP[s) user admin login [IP address = 172.21 40.31]
3 2020-01-01701:28:451 IM authentication: HTTP[s) user admin login [IP address = 172.21.40.31]
4 2020-01-01T00:00:531 DE interface: Port 12 ink up 1G/F
5 2020-01-01T00:00:437 ER system: Gets the time and date from o time server failed
& 2020-01-01700:00:33Z NO system: System cold start
7 2020-01-01700:00:33Z IN system: Image 1 F/W version Y4.70(ABRT.1]b1 | 11/10/2020 beot up
8 2020-01-01T00:00:337 AL system: System has reset without management command
9 2020-01-01T01:20:171 IM authentication: HTTP[s) user admin login [IP address = 172.21.40.31]
10 2020-01-01T00:00:531 DE interface: Port 12 link up 1G/F
11 2020-01-01T00:00:4231 ER system: Gets the time and date from a time server foiled
12 2020-01-071700:00:323Z MO system: System cold start
13 2020-01-01T00:00:33Z IN system: Image 1 F/W version V4.70[ABRT.1)b1 | 11/10/2020 boot up
14 2020-01-01T00:00:337 AL system: System haos reset without menagement command
15 2020-01-01705:46:407 IN authentication: HTTP(s] user admin login [IF address = 172.21.40.31]
16 2020-01-01703:464:531 IN authentication: HTTP(s| user admin login [IF oddress = 172.21.40.31]
17 2020-01-01T02:45:347 IN authentication: HTTP(s} user admin logout [IP address = 172.21.40.31]
18 2020-01-01703:05:007 IN authentication: HTTP({s] user admin login [IF address = 172.21.40.31]
19 2020-01-01701:164:111 IN authentication: HTTP(s| user admin login [IF oddress = 172.21.40.31]
20 2020-01-01700:00:527 DE interface: Port 12 link up 1G/F
21 2020-01-01T00:00:431 ER system: Gets the time and date from a time server failed
22 2020-01-01T00:00:321 MO system: System cold start
23 2020-01-01700:00:327 IM system: Image 1 F/W version W4 70[ABRT 1)b1 | 11/10/2020 boot up
24 2020-01-01T00:00:327 AL system: System has reset without management command
25 2020-01-01701:00:041 NO system: Conflict IP detected : IP 192.168.1.1. MACT 00:08:54:72:ad:bc, VLAM 1, Port 2
26 2020-01-01700:59:041 NO systern: Conflict P detected : IP 192.148.1.1, MAC 00:08:54:72:ad:be, VLAM 1, Port 2
27 2020-01-01700:58:047 NO systern: Conflict IP detected : IP 192.148.1.1, MAC 00:08:54:72:ad:be, VLAN 1, Port 2
28 H20-01-01T00-57-047 MO svstern: Canflict IP defected - IP 192 148 1 1. MAC OD-08-54 77 ad be. VIAM 1. Port 2

The summary table shows the fime the log message was recorded and the reason the log message was
generated. Click Refresh to update this screen. Click Clear to clear the whole log, regardless of what is
currently displayed on the screen. Click Download to save the log to your computer.
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Syslog Setup

41.1 Syslog Overview

This chapter explains the syslog screens.

The syslog protocol allows devices to send event notification messages across an IP network to syslog
servers that collect the event messages. A syslog-enabled device can generate a syslog message and
send it fo a syslog server.

Syslog is defined in RFC 3164. The RFC defines the packet format, content and system log related
information of syslog messages. Each syslog message has a facility and severity level. The syslog facility
identifies a file in the syslog server. Refer to the documentation of your syslog program for details. The
following table describes the syslog severity levels.

Table 174 Syslog Severity Levels
CODE SEVERITY

0 Emergency: The system is unusable.

1 Alert: Action must be taken immediately.

Critical: The system condition is critical.

Error: There is an error condifion on the system.

Warning: There is a warning condition on the system.

Nofice: There is a normal but significant condition on the system.

Informational: The syslog contains an informational message.

N[Ol M| W[ DN

Debug: The message is intended for debug-level purposes.

41.1.1 What You Can Do

Use the Syslog Setup screen (Section 41.2 on page 333) to configure the device's system logging
settings and configure a list of external syslog servers.

41.2 Syslog Setup

The syslog feature sends logs fo an external syslog server. Use this screen to configure the device's
system logging setftings and configure a list of external syslog servers.

Click Management > Syslog Setup in the navigation panel to display this screen.
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Figure 245 Management > Syslog Setup

Syslog Setup
Syslog Active
System ocaluse 1 ~
Interface ocaluse 2 ~
Switch O ocaluse 3 ~
AAA O ocaluse 4 ~
P O ocaluse 5 ~
Syslog Server Setup
Active O
Server Address
UDP Port 514
Log Level Leveld -~
L]
1 Yes 192.168.1.223 514 0-7 O
Docie

The following table describes the labels in this screen.

Table 175 Management > Syslog Setup

LABEL DESCRIPTION

Syslog Select Active to turn on syslog (system logging) and then configure the syslog setting.

Logging Type This column displays the names of the categories of logs that the device can generate.

Active Select this option to sef the device to generate logs for the corresponding category.

Facility The log facility allows you to send logs to different files in the syslog server. Refer to the
documentation of your syslog program for more details.

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is furned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Syslog Server Setup

Active

Select this check box to have the device send logs to this syslog server. Clear the check box
if you want to create a syslog server entry but not have the device send logs to it (you can
edit the entry later).

Server Address

Enter the IPv4 or IPvé address of the syslog server.

UDP Port The default syslog server port is 514. If your syslog server uses a different port, configure the
one it uses here.
Log Level Select the severity levels of the logs that you want the device to send to this syslog server.

The lower the number, the more critical the logs are.
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Table 175 Management > Syslog Setup (continued)

LABEL DESCRIPTION

Add Click Add to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clear Click Clear to return the fields to the factory defaults.

Index This is the index number of a syslog server entry. Click this number to edit the entry.

Active This field displays Yes if the device is to send logs fo the syslog server. No displays if the
device is not to send logs to the syslog server.

IP Address This field displays the IP address of the syslog server.

UDP Port This field displays the port of the syslog server.

Log Level This field displays the severity level of the logs that the device is to send to this syslog server.
Select an entry’s check box to select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Delete Click Delete to remove the selected entries.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 42
Cluster Management

42.1 Cluster Management Overview

This chapter infroduces cluster management.

Cluster Management allows you to manage switches through one Switch, called the cluster manager.
The switches must be directly connected and be in the same VLAN group so as to be able to
communicate with one another.

Table 176 Zyxel Clustering Management Specifications
Maximum number of cluster members | 24

Cluster Member Models Must be compatible with Zyxel cluster management
implementation.

Cluster Manager The Switch through which you manage the cluster member
switches.

Cluster Members The switches being managed by the cluster manager Switch.

In the following example, switch A in the basement is the cluster manager and the other switches on the
upper floors of the building are cluster members.

Figure 246 Clustering Application Example

an s e - - .

42.1.1 What You Can Do

¢ Use the Cluster Management Status screen (Section 42.2 on page 337) to view the role of the Switch
within the cluster and to access a cluster member Switch's Web Configurator.
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* Use the Clustering Management Configuration screen (Section 42.3 on page 338) to configure
clustering management.

42.2 Cluster Management Status

Use this screen to view the role of the Switch within the cluster and to access a cluster member Switch's
Web Configurator.

Click Management > Cluster Management in the navigation panel to display the following screen.
Note: A cluster can only have one manager.

Figure 247 Management > Cluster Management Status

Clustering Management Status Configuration
Status MNone
Manager 00:00:00:00:00:00

The Number Of Member = 0

The following table describes the labels in this screen.

Table 177 Management > Cluster Management Status

LABEL DESCRIPTION
Status This field displays the role of this Switch within the cluster.
Manager

Member (you see this if you access this screen in the cluster member Switch directly and not
through the cluster manager)

None (neither a manager nor a member of a cluster)

Manager This field displays the cluster manager Switch's hardware MAC address.

The Number of | This field displays the number of switches that make up this cluster. The following fields describe

Member the cluster member switches.

Index You can manage cluster member switches through the cluster manager Switch. Each number in
the Index column is a hyperlink leading o the cluster member Switch’s Web Configurator.

MacAddr This is the cluster member Switch's hardware MAC address.

Name This is the cluster member Switch’s System Name.

Model This field displays the model name.

Status This field displays:

Online (the cluster member Switch is accessible)

Error (for example the cluster member Switch password was changed or the Switch was set as
the manager and so left the member list, and so on)

Offline (the Switch is disconnected - Offline shows approximately 1.5 minutes affer the link
between cluster member and manager goes down)
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42.3 Clustering Management Configuration

Use this screen to configure clustering management. Click Management > Cluster Management >
Configuration to display the next screen.

Figure 248 Management > Cluster Management > Configuration

Clustering Management Configuration Status

Clustering Manager

Active O

Name

VID 1
Clustering Candidate

List

Password |

L]

The following table describes the labels in this screen.

Table 178 Management > Cluster Management > Configuration

LABEL DESCRIPTION
Clustering Manager | The following fields relate to configuring the cluster manager.

Active Select Active to have this Switch become the cluster manager switch. A cluster can only
have one manager. Other (directly connected) switches that are set to be cluster
managers will not be visible in the Clustering Candidates list. If a switch that was previously a
cluster member is later set to become a cluster manager, then its Status is displayed as Error
in the Cluster Management Status screen and a warning icon ( /& ) appears in the member
summary list below.

Name Type a name to identify the Clustering Manager. You may use up to 32 printable characters
(spaces are allowed).

VID This is the VLAN ID and is only applicable if the Switch is set fo 802.1Q VLAN. All switches must
be directly connected and in the same VLAN group to belong to the same cluster. Switches
that are not in the same VLAN group are not visible in the Clustering Candidates list. This field
is ignored if the Clustering Manager is using Port-based VLAN.

Apply Click Apply to save your changes fo the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.

Clustering The following fields relate fo the switches that are potential cluster members.
Candidate
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Table 178 Management > Cluster Management > Configuration (continued)

LABEL

DESCRIPTION

List

A list of suitable candidates found by auto-discovery is shown here. The switches must be
directly connected. Directly connected switches that are set to be cluster managers will not
be visible in the Clustering Candidate list. Switches that are not in the same management
VLAN group will not be visible in the Clustering Candidate list.

Password

Each cluster member’s password is its Web Configurator password. Select a member in the
Clustering Candidate list and then enter its Web Configurator password. If that switch
administrator changes the Web Configurator password afterwards, then it cannot be
managed from the Cluster Manager. Its Status is displayed as Error in the Cluster
Management Status screen.

If multiple devices have the same password then hold [SHIFT] and click those switches to
select them. Then enter their common Web Configurator password.

Add

Click Add to save your changes to the Switch's run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to
save your changes to the non-volatile memory when you are done configuring.

Cancel

Click Cancel to begin configuring this screen afresh.

Refresh

Click Refresh to perform auto-discovery again fo list potential cluster members.

The next summary table shows the information for the clustering members configured.

Index This is the index number of a cluster member switch.

MacAddr This is the cluster member switch's hardware MAC address.

Name This is the cluster member switch's System Name.

Model This is the cluster member switch’'s model name.
Select an entry’s check box fo select a specific entry. Otherwise, select the check box in the
table heading row to select all entries.

Remove Click the Remove button to remove the selected cluster member switches from the cluster.

Cancel Click Cancel to begin configuring this screen afresh.

42.4 Technical Reference

This section provides technical background information on the topics discussed in this chapfter.

42.4.1 Cluster Member Switch Management

Go to the Clustering Management Status screen of the cluster manager switch and then select an Index
hyperlink from the list of members to go to that cluster member switch's Web Configurator home page.
This cluster member Web Configurator home page and the home page that you would see if you
accessed it directly are different.
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Figure 249 Cluster Management: Cluster Member Web Configurator Screen

Advanced Application

IP Application Management
| i i

uting Maintenance

ard
VLAMN Mapping
Layer 2 Protocol Tunn

42.4.1.1 Uploading Firmware to a Cluster Member Switch

You can use FTP to upload firmware to a cluster member switch through the cluster manager switch as
shown in the following example.
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Figure 250 Example: Uploading Firmware to a Cluster Member Switch

C:\>ftp 192.168.1.1

Connected to 192.168.1.1.

220 Switch FTP version 1.0 ready at Thu Jan 1 00:58:46 1970
User (192.168.0.1: (none)): admin

331 Enter PASS command

Password:

230 Logged in

ftp> 1s

200 Port command okay

150 Opening data connection for LIST

--W--W--W- 1 owner group 3042210 Jul 01 12:00 ras

-TW-TW-YW- 1 owner group 393216 Jul 01 12:00 config

--W--W--W- 1 owner group 0 Jul 01 12:00 fw-00-a0-c5-01-23-46
-rW-TW-Trw- 1 owner group 0 Jul 01 12:00 config-00-a0-c5-01-23-46

226 File sent OK

ftp: 297 bytes received in 0.00Seconds 297000.00Kbytes/sec.
ftp> bin

200 Type I OK

ftp> put 460ABPI0.bin fw-00-a0-c5-01-23-46

200 Port command okay

150 Opening data connection for STOR fw-00-a0-c5-01-23-46
226 File received OK

ftp: 262144 bytes sent in 0.63Seconds 415.44Kbytes/sec.
ftp>

The following table explains some of the FTP parameters.

Table 179 FTP Upload to Cluster Member Example

FTP PARAMETER DESCRIPTION

User Enter “admin”.

Password The Web Configurator password default is 1234.

1s Enter this command to list the name of cluster member switch's firmware and
configuration file.

460ABPI0.bin This is the name of the firmware file you want to upload to the cluster member
switch.

fw-00-a0-c5-01-23-46 This is the cluster member switch’s firmware name as seen in the cluster

manager switch.

config-00-a0-c5-01-23-46 | Thisis the cluster member switch's configuration file name as seen in the cluster
manager switch.
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MAC Table

43.1 MAC Table Overview

This chapter introduces the MAC Table screen.

The MAC Table screen (a MAC table is also known as a filtering database) shows how frames are
forwarded or filtered across the Switch’s ports. It shows what device MAC address, belonging to what
VLAN group (if any) is forwarded to which ports and whether the MAC address is dynamic (learned by
the Switch) or static (manually entered in the Static MAC Forwarding screen).

43.1.1 What You Can Do

Use the MAC Table screen (Section 43.2 on page 343) to check whether the MAC address is dynamic or
static.

43.1.2 What You Need to Know

The Switch uses the MAC Table to determine how to forward frames. See the following figure.

1 The Switch examines a received frame and learns the port on which this source MAC address came.

2 The Switch checks to see if the frame's destination MAC address matches a source MAC address
already learned in the MAC Table.

 |f the Switch has already learned the port for this MAC address, then it forwards the frame to that port.

¢ |f the Switch has not already learned the port for this MAC address, then the frame is flooded to alll
ports. Too much port flooding leads to network congestion, then the Switch sends an ARP to request
the MAC address. The Switch then learns the port that replies with the MAC address.

 |f the Switch has already learned the port for this MAC address, but the destination port is the same as
the port it came in on, then it filters the frame.
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Figure 251 MAC Table Flowchart

v

Is destination
MAC address
in the MAC Table?

Yes

Forward to
all ports.

Is the outgoing
port different from the
incoming port?

Filter this Forward to
frame. outgoing port,

43.2 Viewing the MAC Table

Use this screen to search specific MAC addresses. You can also directly add dynamic MAC addresses
into the static MAC forwarding table or MAC filtering table from the MAC table using this screen.

Click Management > MAC Table in the navigation panel to display the following screen.

Figure 252 Management > MAC Table

MAC table

® Al
O static
i O MmAC | |
Condifion O vip \—[
O port ’—‘

O Trunk |
Sort by MAC W
e e e 'E?E' Dynamic to MAC forwarding
) Dynamic to MAC filtering
1 00:00:5e:00:01:02 1 3 Dynamic
2 00:03:21:10:be:00 1 3 Dynamic
3 00:03:21:10:07:7 ¢ 1 3 Dynamic
4 00:03:21:10:07:7d 1 3 Dynamic
5 00:03:21:11:02:al 1 3 Dynamic
-] 00:08:54:72:ad:bc 1 3 Dynamic
7 00:0e:e3:00:3d:0d 1 3 Dynamic
8 00:0e:e3:00:3d:48 1 3 Dynamic
? 00:0e:e3:01:75:e2 1 3 Dynamic
10 00:0e:e3:03:e5:e6 1 3 Dynamic
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The following table describes the labels in this screen.

Table 180 Management > MAC Table

LABEL

DESCRIPTION

Condition

Select one of the buttons and click Search to only display the data which matches the criteria
you specified.

Select All to display any entry in the MAC table of the Switch.
Select Static to display the MAC entries manually configured on the Switch.
Select MAC and enter a MAC address in the field provided to display a specified MAC entry.

Select VID and enter a VLAN ID in the field provided to display the MAC entries belonging fo the
specified VLAN.

Select Port and enter a port number in the field provided to display the MAC addresses which
are forwarded on the specified port.

Select Trunk and type the ID of a tfrunk group to display all MAC addresses learned from the ports
in the trunk group.

Sort by

Define how the Switch displays and arranges the data in the summary table below.
Select MAC to display and arrange the data according to MAC address.
Select VID to display and arrange the data according to VLAN group.

Select PORT to display and arrange the data according fo port number.

Transfer Type

Select Dynamic to MAC forwarding and click the Transfer button to change all dynamically
learned MAC address entries in the summary table below into stafic entries. They also display in
the Static MAC Forwarding screen.

Select Dynamic to MAC filtering and click the Transfer button to change all dynamically learned
MAC address entries in the summary table below into MAC filtering entries. These enftries will then
display only in the Filtering screen and the default filtering action is Discard source.

Search

Click this o search data in the MAC table according fo your input criteria.

Transfer

Click this to perform the MAC address transferring you selected in the Transfer Type field.

Cancel

Click Cancel to change the fields back to their last saved values.

Index

This is the incoming frame index number.

MAC Address

This is the MAC address of the device from which this incoming frame came.

VID

This is the VLAN group to which this frame belongs.

Port

This is the port where the above MAC address is forwarded.

Type

This shows whether the MAC address is dynamic (learned by the Switch) or static (manually
entered in the Static MAC Forwarding screen).
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IP Table

This chapter introduces the IP table.

44.1 IP Table Overview

The IP Table screen shows how packets are forwarded or filtered across the Switch's ports. When a
device (which may belong fo a VLAN group) sends a packet which is forwarded to a port on the Switch,
the IP address of the device is shown on the Switch’s IP Table. The IP Table also shows whether the IP
address is dynamic (learned by the Switch) or stafic (belonging to the Switch).

The Switch uses the IP Table to determine how to forward packets. See the following figure.

1 The Switch examines a received packet and learns the port from which this source IP address came.

2 The Switch checks to see if the packet's destination IP address matches a source IP address already
learned in the IP Table.

* If the Switch has already learned the port for this IP address, then it forwards the packet to that
port.

* If the Switch has not already learned the port for this IP address, then the packet is flooded to all
ports. Too much port flooding leads to network congestion then the Switch sends an ARP to request
the MAC address. The Switch then learns the port that replies with the MAC address.

* If the Switch has already learned the port for this IP address, but the destination port is the same as
the port it came in on, then it filters the packet.

Figure 253 IP Table Flowchart

'

Is destination
IP address
in the IP Table?

Yes

Send ARP to
request MAC.

Is the outgoing
port different from the
incoming port?

No

Filter this Forward to
packet. outgoing port.
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44.2 Viewing the IP Table

Click Management > IP Table in the navigation panel to display the following screen.

Figure 254 Management > IP Table

[ IPTable |
sy @ =
1 192.148.1.3 1 26 dynamic
2 192.168.11.3 1 CFU static
3 192.148.1.1 1 CFU static
4 192.188.11.1 11 CFU static
5 10.2.1.23 123 CFU static

The following table describes the labels in this screen.

Table 181

Management > IP Table

LABEL

DESCRIPTION

Sort by

Click one of the following buttons to display and arrange the data according to that button type.
The information is then displayed in the summary table below.

IP

Click this button to display and arrange the data according fo IP address.

VID

Click this button to display and arrange the data according to VLAN group.

Port

Click this button to display and arrange the data according fo port number.

Index

This field displays the index number.

IP Address

This is the IP address of the device from which the incoming packets came.

VID

This is the VLAN group to which the packet belongs.

Port

This is the port from which the above IP address was learned. This field displays CPU to indicate the
IP address belongs to the Switch.

Type

This shows whether the IP address is dynamic (learned by the Switch) or static (belonging to the
Switch).
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ARP Table

45.1 Overview

This chapter introduces ARP Table.

Address Resolution Protocol (ARP) is a protocol for mapping an Internet Protocol address (IP address) to
a physical machine address, also known as a Media Access Control or MAC address, on the local area
network.

An IP (version 4) address is 32 bits long. In an Ethernet LAN, MAC addresses are 48 bits long. The ARP
Table maintains an association between each MAC address and its corresponding IP address.

45.1.1 What You Can Do

Use the ARP Table screen (Section 45.2 on page 347) to view IP-to-MAC address mappings.

45.1.2 What You Need to Know

When an incoming packet destined for a host device on a local area network arrives at the Switch, the
Switch's ARP program looks in the ARP Table and if it finds the address, it sends it to the device.

If no entry is found for the IP address, ARP broadcasts the request to all the devices on the LAN. The
Switch fills in its own MAC and IP address in the sender address fields, and puts the known IP address of
the target in the target IP address field. In addition, the Switch puts all ones in the target MAC field
(FF.FF.FF.FF.FF.FF is the Ethernet broadcast address). The replying device (which is either the IP address of
the device being sought or the router that knows the way) replaces the broadcast address with the
target's MAC address, swaps the sender and target pairs, and unicasts the answer directly back to the
requesting machine. ARP updates the ARP Table for future reference and then sends the packet to the
MAC address that replied.

45.2 Viewing the ARP Table

Use the ARP table to view IP-to-MAC address mappings and remove specific dynamic ARP entries.

Click Management > ARP Table in the navigation panel to open the following screen.
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Figure 255 Management > ARP Table

Condition

R

1 CPU ] static

1 & 100 dynamic
1 ] 33 dynamic
1 ] 265 dynamic

The following table describes the labels in this screen.

Table 182 Management > ARP Table

LABEL DESCRIPTION
Condition Specify how you want the Switch to remove ARP entries when you click Flush.
Select All to remove all of the dynamic entries from the ARP table.
Select IP Address and enter an IP address to remove the dynamic entries learned with the
specified IP address.
Select Port and enter a port number to remove the dynamic enfries learned on the specified port.
Flush Click Flush to remove the ARP entries according to the condition you specified.
Cancel Click Cancel fo return the fields to the factory defaults.
Index This is the ARP table entry number.
IP Address This is the IP address of a device connected to a Switch port with the corresponding MAC address

below.

MAC Address

This is the MAC address of the device with the corresponding IP address above.

VID

This field displays the VLAN to which the device belongs.

Port This field displays the port to which the device connects. CPU means this IP address is the Switch's
management [P address.

Age(s) This field displays how long (in seconds) an entry can still remain in the ARP table before it ages out
and needs to be relearned. This shows 0 for a static entry.

Type This shows whether the IP address is dynamic (learned by the Switch) or static (manually

configured in the Basic Setting > IP Setup or IP Application > ARP Setup > Static ARP screen).
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CHAPTER 46
Routing Table

This chapter intfroduces the routing table.

46.1 Routing Table Overview

The routing table contains the route information to the networks that the Switch can reach.

46.2 The Routing Table Main Screen

Click Management > Routing Table in the navigation panel to display the main screen as shown. Click
the link next to IPv4 Routing Table to open a screen where you can view the IPv4 routing table
information. Click the link next to IPv6 Routing Table to open a screen where you can view the IPvé
routing table information.

Figure 256 Management > Routing Table

IPv4 Routing Table Click Here

IPvé Routing Table Click Here

46.3 IPv4 Routing Table

Use this screen to view IPv4 routing table information. Click Management > Routing Table > IPv4 Routing
Table in the navigation panel to display the screen as shown.

Figure 257 Management > Routing Table > IPv4 Routing Table

IPv4 Roufing Table Routing Table
1 192.1658.1.0/24 192.148.1.1 192.148.1.1 1 LOCAL 10:01:02
2 172.21.40.0/22 172.21.40.5 172.21.40.5 1 LOCAL 9:59:55
3 12700014 127.0.0.1 127.0.0.1 1 LOCAL 10:01:14
4 default 172.21.43.254 172.21.40.5 2 STATIC 9:59:55
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The following table describes the labels in this screen.

Table 183 Management > Routing Table > IPv4 Routing Table

LABEL DESCRIPTION
Index This field displays the index number.
Destination This field displays the destination IP routing domain.
Gateway This field displays the IP address of the gateway device.
Interface This field displays the IP address of the IPv4 Interface.
Metric This field displays the cost of the route.
Type This field displays the method used fo learn the route.
STATIC — added as a static entry.
LOCAL — added as a local interface entry.
Uptime This field displays how long the route has been running since the Switch learned the route and

added an entry in the routfing table.

46.4 IPv6 Routing Table

Use this screen to view IPvé routing table information. Click Management > Routing Table > IPv6 Routing
Table in the navigation panel to display the screen as shown.

Figure 258 Management > Routing Table > IPvé Routing Table

IPvé Routing Table

Routing Table

The following table describes the labels in this screen.

Table 184 Management > Routing Table > IPvé Routing Table

LABEL DESCRIPTION
Index This field displays the index number.
Route This field displays the IPvé subnet prefix and prefix length of the final destination.

Destination/
Prefix Length

Next Hop This field displays the IPvé address of the gateway that helps forward the packet to the
destination.

Interface This field displays the descriptive name of the IPvé interface that is used to forward the packets to
the desfination.

Metric This field displays the cost of the route.

Type This field displays the method used fo learn the route.

STATIC - added as a static entry.

Connect - added as a local interface entry.
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CHAPTER 47
Path MTU Table

47.1 Path MTU Overview

This chapter infroduces the IPvé Path MTU table.

The largest size (in bytes) of a packet that can be fransferred over a data link is called the maximum
fransmission unit (MTU). The Switch uses Path MTU Discovery to discover Path MTU (PMTU), that is, the
minimum link MTU of all the links in a path to the destination. If the Switch receives an ICMPvé Packet Too
Big error message after sending a packet, it fragments the next packet according to the suggested MTU
in the error message.

47.2 Viewing the Path MTU Table

Use this screen to view IPvé path MTU information on the Switch. Click Management > Path MTU Table in
the navigation panel to display the screen as shown.

Figure 259 Management > Path MTU Table

Path MTU Table

Path MTU aging time : 10 minuies

The following table describes the labels in this screen.

Table 185 Management > Path MTU Table

LABEL

DESCRIPTION

Path MTU
aging fime

This field displays how long an entry remains in the Path MTU table before it ages out and needs to
be relearned.

Index

This field displays the index number of each entry in the table.

Destination
Address

This field displays the destination IPvé address of each path or entry.

MTU

This field displays the maximum transmission unit of the links in the path.

Expire

This field displays how long (in minutes) an entry can still remain in the Path MTU table before it
ages out and needs to be relearned.
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CHAPTER 48
Configure Clone

48.1 Overview

This chapter shows you how you can copy the settings of one port onto other ports.

48.2 Configure Clone

Cloning allows you to copy the basic and advanced settings from a source port to a destination port or
ports. Click Management > Configure Clone to open the following screen.
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Figure 260 Management > Configure Clone

Port Features

Basic Setfing

® ron| |

Advanced Application

I

D -

O Active

O Name

O Speed / Duplex

[ Flow Contral

O vianig

O viANTg Member

[ Bandwidth Control

O Port Security

[ Broadcast Storm Conrol
O Mirroring

[ Port Authentication

O Queuving Method

O 1GMP Filtering

O Spanning Tree Protocol
O Pert-based VLAN

[ MAC Authenfication
O Loop Guard

O Layer 2 Protocol Tunneling
O Loe

[ PePeE 1A

O arp Learning

[ crU Pratection

O Multiple Spanning Tree Protocol
[ Power over Ethermet

O sNMP Trep

[ Green Ethemet

The following table describes the labels in this screen.

Table 186 Management > Configure Clone

LABEL DESCRIPTION
Source/ Enter the source port under the Source label. This port’s attributes are copied.
Destination
Enter the destination port or ports under the Destination label. These are the ports which are going
Port to have the same attributes as the source port. You can enter individual ports separated by a
comma or a range of ports by using a dash.
Example:
2, 4, 6 indicates that ports 2, 4 and é are the destination ports.
2-6 indicates that ports 2 through 6 are the destination ports.
* Select * to apply all seftings to the port. Use this first to select the common setftings and then
remove the settings you do not want copied.
Basic Setting Select which port settings (you configured in the Basic Setting menus) should be copied to the
destination ports.
Advanced Select which port setftings (you configured in the Advanced Application menus) should be copied
Application to the destination ports.
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Table 186 Management > Configure Clone (continued)

LABEL DESCRIPTION

Apply Click Apply to save your changes to the Switch’s run-time memory. The Switch loses these
changes if it is turned off or loses power, so use the Save link on the top navigation panel to save
your changes to the non-volatile memory when you are done configuring.

Cancel Click Cancel to begin configuring this screen afresh.
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CHAPTER 49
IPv6 Neighbor Table

49.1 IPv6 Neighbor Table Overview

This chapter infroduces the IPvé neighbor table.

An IPvé host is required to have a neighbor table. If there is an address to be resolved or verified, the
Switch sends out a neighbor solicitation message. When the Switch receives a neighbor adverfisement
in response, it stores the neighbor’s link-layer address in the neighbor table. You can also manually
create a static IPvé neighbor entry using the Basic Setting > IPv6 > IPv6 Configuration > IPv6 Neighbor
Setup screen.

When the Switch needs to send a packet, it first consults other table to determine the next hop. Once
the next hop IPvé address is known, the Switch looks info the neighbor table to get the link-layer address
and sends the packet when the neighbor is reachabile. If the Switch cannot find an entry in the
neighbor table or the state for the neighbor is not reachable, it starts the address resolution process. This
helps reduce the number of IPvé solicitation and advertisement messages.

49.2 Viewing the IPv6 Neighbor Table

Use this screen to view IPvé neighbor information on the Switch. Click Management > IPv6 Neighbor
Table in the navigation panel to display the screen as shown.

Figure 261 Management > IPvé Neighbor Table

Sortby:
1 feg0:219:caff:fedl:bod 00:19:ca:01:0b:0d R L VLAMI
2 fe80::1458:63cd:d345:4780 00:00:00:00:00:00 A D VLAMNT
3 feB0n39ffici44:0846:783 90:2b:34:bb:7ai04 5 D VLAMI
4 feB0::486c:c733:6008:c292 O4:d4:c4:bl:abed 5 D VLAMI
5 fe80:4d24:c05c:81c3:5504 30:65eci49:85:c3 3 D VLANT
& fes0:4d76:d275:b%ef:2c91 fa:a9:63:e8:befa 5 D VLAMI
7 fe80::8527:9b83:3713:69b7 90:2b:34:bb:7a:81 5 D VLAMI
8 fe80:a954:c1d:{468:2214 Oc:9d:92:52:60:89 5 D VLAMI
? fes0:d8es:6a49:b436:80c? dc:0e:al:afic3:ac 5 D VLAMI
10 feB0neddc:67ff:8464:d233 00:00:8:88:27:52 5 D VLAMI
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The following table describes the labels in this screen.

Table 187 Management > IPvé Neighbor Table

LABEL DESCRIPTION

Sort by Select this fo display and arrange the data according to IPvé address (Address), MAC address
(MAC) or IPvé interface (Interface). The information is then displayed in the summary table below.

Index This field displays the index number of each entry in the table.

Address This field displays the IPvé address of the Switch or a neighboring device.

MAC This field displays the MAC address of the IPvé interface on which the IPvé address is configured or
the MAC address of the neighboring device.

Status This field displays whether the neighbor IPvé interface is reachable. In IPvé, “reachable” means an
IPvé packet can be correctly forwarded fo a neighbor node (host or router) and the neighbor
can successfully receive and handle the packet. The available options in this field are:
¢ reachable (R): The interface of the neighboring device is reachable. (The Switch has received

aresponse to the initial request.)

« stale (S): The last reachable time has expired and the Switch is waiting for a response to
another initial request. The field displays this also when the Switch receives an unrequested
response from the neighbor’s interface.

* delay (D): The neighboring interface is no longer known to be reachable, and traffic has been
sent fo the neighbor recently. The Switch delays sending request packets for a short to give
upper-layer protocols a chance to determine reachability.

e probe (P): The Switch is sending request packets and waiting for the neighbor’s response.

* invalid (IV): The neighbor address is with an invalid IPvé address.

e unknown (2): The status of the neighboring interface cannot be determined for some reason.

e incomplete (l): Address resolution is in progress and the link-layer address of the neighbor has
not yet been determined. The interface of the neighboring device did not give a complete
response.

Type This field displays the type of an address mapping to a neighbor interface. The available options in
this field are:

e other (O): none of the following type.

e local (L): A Switch interface is using the address.

e dynamic (D): The IP address to MAC address can be successfully resolved using IPvé Neighbor
Discovery protocol. Is it similar as IPv4 ARP (Address Resolution protocol).

e static (S): The interface address is statically configured.

Interface This field displays the ID number of the IPvé interface on which the IPvé address is created or

through which the neighboring device can be reached.
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Port Status

50.1 Overview

This chapter introduces the port status screens.

50.2 Port Status

This screen displays a port statistical summary with links to each port showing statistical details. To view
the port statistics, click Status in all Web Configurator screens and then the Port Status link in the Quick
Links section of the Status screen to display the Port Status screen as shown next. You can also click
Management > Port Status to see the following screen.

Figure 262 Management > Port Status

[ portstabs | DoMI utization
1 Down STOP Off Disabled o] o] o] 0.0 0.0 0:00:00
2 Down STOP Off Disabled 0 o 0.0 0.0 0:00:00
3 1G/F FORWARDING Off Disabled 79868 31771 o 0.749 0.706 1:03:51
4 Down STOP Off Dizabled 0 o] 0.0 0.0 0:00:00
5 100M/F FORWARDING Off Disabled 29270 77169 o] 0.706 0.74% 1:03:46
& Down STOP Off Disabled o] 0 o] 0.0 0.0 0:00:00
z Down 3TOP Off Disabled 0 0 o 0.0 0.0 0:00:00
8 Down 3TOP Off Disabled 0 0 o 0.0 0.0 0:00:00 |
2 STOP - 0

= "] 7000
® Any
Orot[ ]

The following table describes the labels in this screen.

Table 188 Management > Port Status

LABEL DESCRIPTION

Port This identifies the Ethernet port. Click a port number to display the Port Details screen.

Name This is the name you assigned to this port in the Basic Setting > Port Setup screen.

Link This field displays the speed (such as 100M for 100 Mbps, 1G for 1000 Mbps or 1 Gbps, 2.5G for 2.5

Gbps, 5G for 5 Gbps, or 10G for 10 Gbps) and the duplex (F for full duplex). This field displays
Down if the port is not connected to any device.

State If STP (Spanning Tree Protocol) is enabled, this field displays the STP state of the port.
If STP is disabled, this field displays FORWARDING if the link is up, otherwise, it displays STOP.

When LACP (Link Aggregation Control Protocol) and STP are in blocking state, it displays
Blocking.
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Table 188 Management > Port Status (continued)

LABEL DESCRIPTION

PD For POE models only.
This field displays whether or not a powered device (PD) is allowed fo receive power from the
Switch on this port.

LACP This fields displays whether LACP (Link Aggregation Control Protocol) has been enabled on the
port.

TxPkts This field shows the number of transmitted frames on this port.

RxPkts This field shows the number of received frames on this port.

Errors This field shows the number of received errors on this port.

Tx KB/s This field shows the number of kilobytes per second fransmitted on this port.

Rx KB/s This field shows the number of kilobytes per second received on this port.

Up Time This field shows the total amount of time in hours, minutes and seconds the port has been up.

Clear Counter Select Port, enter a port number and then click Clear Counter to erase the recorded statistical
information for that port, or select Any to clear statistics for all ports.

50.2.1 Port Detalls

Click a number in the Port column in the Port Status screen to display individual port stafistics. Use this
screen to check status and detailed performance data about an individual port on the Switch.

XS1930 Series User's Guide

358




Chapter 50 Port Status

Figure 263 Management > Port Status > Port Details

Port Details Port Status

MName

Down
State STOP
LACP Disabled
TxPlts a
RxPlkts a
Errors a
Tx kB/s 00
Tx Utilization% 00
Rx kB/s 00
Rx Utilization® 00
Up Time 0:00:00
Multicast a
Broadcast a
Pause a
Multicast a
Broadcast a
Pause a
Multiple Q
Excessive a

0
Length Q
Runt a
&5t 127 0
128 to 255 0
256 1o 511 0
512 to 1023 0
1024 t0 1518 0
Giant a

The following table describes the labels in this screen.

Table 189 Management > Port Status > Port Details

LABEL DESCRIPTION
Port Info

Port NO. This field displays the port number you are viewing.

Name This field displays the name of the port.

Link This field displays the speed (such as 100M for 100Mbps, 1G for 1000 Mbps or 1 Gbps, 2.5G for 2.5
Gbps, 5G for 5 Gbps, or 10G for 10 Gbps) and the duplex (F for full duplex). This field displays Down
if the port is not connected to any device.

State If STP (Spanning Tree Protocol) is enabled, this field displays the STP state of the port.

If STP is disabled, this field displays FORWARDING if the link is up, otherwise, it displays STOP.
When LACP (Link Aggregation Control Protocol), STP, and dot1x are in blocking state, it displays
Blocking.

LACP This field shows if LACP is enabled on this port or not.

TxPkts This field shows the number of tfransmitted frames on this port.

RxPkts This field shows the number of received frames on this port.

Errors This field shows the number of received errors on this port.

Tx kB/s This field shows the number of kilobytes per second transmitted on this port.
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Table 189 Management > Port Status > Port Details (continued)

LABEL DESCRIPTION
Tx This field shows the percentage of actual fransmitted frames on this port as a percentage of the
Utilization% Link SpeedA
Rx kB/s This field shows the number of kilobytes per second received on this port.

Rx
Utilization%

This field shows the percentage of actual received frames on this port as a percentage of the Link
speed.

Up Time

This field shows the total amount of time the connection has been up.

Tx Packet

The following fields display detailed information about packets fransmitted.

Unicast This field shows the number of good unicast packets fransmitted.
Multicast This field shows the number of good multicast packets tfransmitted.
Broadcast | This field shows the number of good broadcast packets transmitted.
Pause This field shows the number of 802.3x pause packets fransmitted.

Rx Packet

The following fields display detailed information about packets received.

Unicast This field shows the number of good unicast packets received.
Multicast This field shows the number of good multicast packets received.
Broadcast | This field shows the number of good broadcast packets received.
Pause This field shows the number of 802.3x pause packets received.

TX Collision

The following fields display information on collisions while tfransmitting.

Single This is a count of successfully transmitted packets for which transmission is inhibited by exactly one
collision.

Multiple This is a count of successfully fransmitted packets for which fransmission was inhibited by more
than one collision.

Excessive | Thisis a count of packets for which transmission failed due to excessive collisions. Excessive
collision is defined as the number of maximum collisions before the retfransmission count is reset.

Late This is the number of times a late collision is detected, that is, after 512 bits of the packets have

already been transmitted.

Error Packet

The following fields display detailed information about packets received that were in error.

RX CRC This field shows the number of packets received with CRC (Cyclic Redundant Check) errors.

Length This field shows the number of packets received with a length that was out of range.

Runt This field shows the number of packets received that were too short (shorter than 64 octets),
including the ones with CRC errors.

Distribution

64 This field shows the number of packets (including bad packets) received that were 64 octets in
length.

6510 127 This field shows the number of packets (including bad packefts) received that were between 65
and 127 octetsin length.

128 to 255 | This field shows the number of packets (including bad packets) received that were between 128
and 255 octets in length.

256 to 511 | This field shows the number of packets (including bad packets) received that were between 256
and 511 octets in length.

512 to This field shows the number of packets (including bad packets) received that were between 512

1023

and 1023 octets in length.
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Table 189 Management > Port Status > Port Details (continued)

LABEL DESCRIPTION
1024 to This field shows the number of packets (including bad packets) received that were between 1024
1518 and 1518 octets in length.
Giant This field shows the number of packets (including bad packets) received that were between 1519

octets and the maximum frame size.

The maximum frame size varies depending on your switch model.

50.2.2 DDMI

The optical SFP transceiver’s support for the Digital Diagnostics Monitoring Interface (DDMI) function lets
you monitor the fransceiver’s parameters to perform component monitoring, fault isolation and failure
prediction tasks. This allows proactive, preventative network maintenance to help ensure service
continuity.

Use this screen to view the DDMI status of the Switch's SFP transceivers. Click Management > Port Status >
DDMI to see the following screen. Alternatively, click Status from any Web Configurator screen and then
the Port Status link in the Quick Links section of the Status screen to display the Port Status screen and
then click the DDMI link tab.

Figure 264 Management > Port Status > DDMI
[ oom | Port Stalus

|\'}| |J-\ |J-\ |J-\ |J-\ |J-\
(=) ST Fo R N )

'

'

'

'

'

'

The following table describes the labels in this screen.

Table 190 Management > Port Status > DDMI

LABEL DESCRIPTION

Port This identifies the SFP port.

Vendor This displays the vendor name of the opfical transceiver.
Part Number This displays the part number of the optical transceiver.

Serial Number This displays the serial number of the optical fransceiver.

Revision This displays the revision number of the opftical tfransceiver.
Date Code This displays the date when the optical transceiver was manufactured.
Transceiver This displays the type of transceiver installed in the SGP slot.

50.2.3 DDMI Details

Use this screen to view the real-time SFP (Small Form Factor Pluggable) transceiver information and
operating parameters on the SFP port. The parameters include, for example, tfransmitting and receiving
power, and module temperature.

Click a number in the Port column in the DDMI screen to view current transceivers’ status.
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Figure 265 Management > Port Status > DDMI > DDMI Details

DDMI Details

o
o

Transceiver Information

Connector Type
Vendor

Part Number
Serial Number
Revision

Date Code
Transcelver
Calibration

DDMI Information

Temperature(C)
Voltage(V)
TX Bias{mA)

TX Power(dbm)

RX Power(dbm)

SFP

FINISAR
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AMBSTKOM
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29.44 78.00 73.00 -8.00 -13.00
3.27 3.70 3.60 3.00 290
/.79 11.80 10.80 5.00 4.00
-1.90 -0.80 -1.80 -5.00 -6.00
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The following table describes the labels in this screen.

Table 191

Management > Port Status > DDMI > DDMI Details

LABEL

DESCRIPTION

Transceiver Informa

fion

Port No

This identifies the SFP port.

Connector Type

This displays the connector type of the optical transceiver.

Vendor

This displays the vendor name of the optical fransceiver.

Part Number

This displays the part number of the optical transceiver.

Serial Number

This displays the serial number of the optical transceiver.

Revision This displays the revision number of the opfical transceiver.

Date Code This displays the date when the opfical fransceiver was manufactured.
Transceiver This displays details about the type of transceiver installed in the SFP slot.
Calibration This field is available only when an SFP transceiver is inserted into the SFP slot.

Internal displays if the measurement values are calibrated by the transceiver. External displays
if the measurement values are raw data which the Switch calibrates.

DDMI Information

Type This displays the DDMI parameter.
Temperature This displays the temperature inside the SFP transceiver in degrees Celsius or Fahrenheit.
(C/F)
Voltage (V) This displays the level of voltage being supplied to the SFP transceiver.
TX Bias (mA) This displays the milliamps (mA) being supplied to the SFP transceiver’s Laser Diode Transmitter.
TX Power This displays the amount of power the SFP transceiver is fransmitting.
(dbm)
RX Power This displays the amount of power the SFP fransceiver is receiving from the fiber cable.
(dbm)
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Table 191 Management > Port Status > DDMI| > DDMI Details (continued)

LABEL DESCRIPTION

Current This displays the current status for each monitored DDMI parameter.

High Alarm This displays the high value alarm threshold for each monitored DDMI parameter. An alarm
Threshold signal is reported to the Switch if the monitored DDMI parameter reaches this value.

High Warn This displays the high value warning threshold for each monitored DDMI parameter. A warning
Threshold signal is reported to the Switch if the monitored DDMI parameter reaches this value.

Low Warn This displays the low value warning threshold for each monitored DDMI parameter. A warning
Threshold signal is reported to the Switch if the monitored DDMI parameter reaches this value.

Low Alarm This displays the low value alarm threshold for each monitored DDMI parameter. An alarm
Threshold signal is reported to the Switch if the monitored DDMI parameter reaches this value.

50.2.4 Port Utilization

This screen displays the percentage of actual transmitted or received frames on a port as a percentage
of the Link speed. To view port utilization, click Management > Port Status > Port Utilization to see the
following screen. Alternatively, click Status from any Web Configurator screen and then the Port Status

link in the Quick Links section of the Status screen to display the Port Status screen and then click the
Utilization link tab.

Figure 266 Management > Port Status > Utilization
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The following table describes the labels in this screen.

Table 192 Management > Port Status > Utilization

LABEL DESCRIPTION

Port This identifies the Ethernet port.

Link This field displays the speed (such as 100M for 100 Mbps, 1000M for 1000 Mbps, or 10G for 10 Gbps)
and the duplex (F for full duplex). This field displays Down if the port is not connected to any
device.

Tx kB/s This field shows the transmission speed of data sent on this port in kilobytes per second.

Tx Utilization% | This field shows the percentage of actual transmitted frames on this port as a percentage of the
Link speed.

Rx KB/s This field shows the fransmission speed of data received on this port in kilobytes per second.

Rx Utilization% | This field shows the percentage of actual received frames on this port as a percentage of the Link
speed.
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CHAPTER 51
Troubleshooting

This chapter offers some suggestions to solve problems you might encounter. The potential problems are
divided into the following categories.

e Power, Hardware Connections, and LEDs
¢ Switch Access and Login

* Switch Configuration

51.1 Power, Hardware Connections, and LEDs

The Switch does not turn on. None of the LEDs turn on.

1  Make sure you are using the power adapter or cord included with the Switch.

2 Make sure the power adapter or cord is connected to the Switch and plugged in to an appropriate
power source. Make sure the power source is turned on.

3 Disconnect and re-connect the power adapter or cord to the Switch.

4 If the problem continues, contact the vendor.

One of the LEDs does not behave as expected.

1 Make sure you understand the normal behavior of the LED. See Section 3.3 on page 40.
2 Check the hardware connections. See Section 3.1 on page 33.

3 Inspect your cables for damage. Contact the vendor to replace any damaged cables.
4 Disconnect and re-connect the power adapter or cord to the Switch.

5 |If the problem continues, contact the vendor.
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51.2 Switch Access and Login

| forgot the IP address for the Switch.

1 The default IP address is http://DHCP-assigned IP (when connecting to a DHCP server) or 192.168.1.1.

2 Use the NCC (Nebula Control Center) or the ZON utility fo find the IP address. The Switch must be
registered and added fo a site in Nebula in order for it fo be managed using Nebula.

3 If the Switch isremoved from a site in Nebula, all the setftings in the configuration file are reset fo the
Nebula factory defaults except for the IP address. If you changed the default dynamic IP address to a
static IP address while the Switch was in a site in Nebula, the Switch will retain that stafic IP address after
you remove it from the site in Nebula.

4 If this does not work, you have to reset the device to its factory defaults. See Section 4.8 on page 67.

| forgot the user name and/or password.

1 The default user name is admin and the default password is 1234.

2 If this does not work, you have to reset the device to its factory defaults. See Section 4.8 on page 67.

| cannot see or access the Login screen in the Web Configurator.

1 Make sure you are using the correct IP address.

* The default IP address is http://DHCP-assigned IP (when connecting to a DHCP server) or
192.168.1.1.

¢ If you changed the IP address, use the new IP address.
 |f you changed the IP address and have forgotten it, see the troubleshooting suggestions for |
forgot the IP address for the Switch.

2 Check the hardware connections, and make sure the LEDs are behaving as expected. See Section 3.3
on page 40.

3  Make sure your Internet browser does not block pop-up windows and has JavaScripts and Java
enabled.

4 Make sure your computer is in the same subnet as the Switch. (If you know that there are routers
between your computer and the Switch, skip this step.)

5 Reset the device to ifs factory defaults, and try to access the Switch with the default IP address. See
Section 4.8 on page 67.
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6 If the problem confinues, contact the vendor, or fry the advanced suggestion.
Advanced Suggestion

* Try to access the Switch using another service, such as Telnet. If you can access the Switch, check the
remote management settings to find out why the Switch does not respond to HTTP.

| can see the Login screen, but | cannot log in to the Switch.

1 Make sure you have entered the user name and password correctly. The default user name is admin,
and the default password is 1234. These fields are case-sensitive, so make sure [Caps Lock] is not on.

2 You may have exceeded the maximum number of concurrent Telnet sessions. Close other Telnet
sessions or fry connecting again later.

Check that you have enabled logins for HTTP or Telnet. If you have configured a secured client IP
address, your computer’s IP address must match it. Refer to the chapter on access conftrol for details.

3 Disconnect and re-connect the cord to the Switch.

4 [f this does not work, you have to reset the device to its factory defaults. See Section 4.8 on page 67.

Pop-up Windows, JavaScripts and Java Permissions

In order to use the Web Configurator you need to allow:

¢ Web browser pop-up windows from your device.
» JavaScripts (enabled by default).

¢ Java permissions (enabled by default).

There is unauthorized access to my Switch through telnet, HTTP and SSH.

Click the Display button in the System Log field in the Management > Diagnostic screen fo check for
unauthorized access to your Switch. To avoid unauthorized access, configure the secured client setting
in the Management > Access Control > Remote Management screen for telnet, HTTP and SSH (see
Section 38.6 on page 315). Computers not belonging to the secured client set cannot get permission to
access the Switch.
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51.3 Switch Configuration

| lost my configuration settings after | restart the Switch.

Make sure you save your configuration into the Switch’s non-volatile ] - o
memory each time you make changes. Click Save at the top right of the @ e @ et
Web Configurator to save the configuration permanently. See also Section

37.2.2 on page 296 for more information about how to save your configuration.

| accidentally unplugged the Switch. | am not sure which configuration file will be loaded.

If you plug the power cable back to the Switch, it will reboot and load the configuration file that was
used the last time. For example, if Config 1 was used on the Switch before you accidentally unplugged
the Switch, Config 1 will be loaded when rebooting.
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Customer Support

In the event of problems that cannot be solved by using this manual, you should contact your vendor. If
you cannot contact your vendor, then contact a Zyxel office for the region in which you bought the
device.

For Zyxel Communication products, see https://service-provider.zyxel.com/global/en/contact-us for the
latest information.

For Zyxel Network products, see https://www.zyxel.com/about_zyxel/zyxel_worldwide.shtml for the latest
information.

Please have the following information ready when you contact an office.

Required Information
* Product model and serial number.
e Warranty Information.
* Date that you received your device.

 Brief description of the problem and the steps you took to solve it.

Corporate Headquarters (Worldwide)

Asia

Taiwan
e Zyxel Communications Corporation

e https://www.zyxel.com

China

* Zyxel Communications (Shanghai) Corp.
Zyxel Communications (Beijing) Corp.
Zyxel Communications (Tianjin) Corp.

 https://www.zyxel.com/cn/zh/

India
¢ Zyxel Technology India Pvt Ltd.

e https://www.zyxel.com/in/en/

Kazakhstan

e Zyxel Kazakhstan
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Europe

e https://www.zyxel.kz

Korea

* Zyxel Korea Corp.

* http://www.zyxel.kr

Malaysia
e Zyxel Malaysia Sdn Bhd.

e http://www.zyxel.com.my

Pakistan
e Zyxel Pakistan (Pvt.) Ltd.

e http://www.zyxel.com.pk

Philippines
e Zyxel Philippines

e http://www.zyxel.com.ph

Singapore
* Zyxel Singapore Pte Lid.

e http://www.zyxel.com.sg

Taiwan
* Zyxel Communications Corporation

e https://www.zyxel.com/tw/zh/

Thailand

e Zyxel Thailand Co., Lid.
e https://www.zyxel.com/th/th/

Vietnam
* Zyxel Communications Corporation-Vietham Office

e https://www.zyxel.com/vn/vi

Belarus
e Zyxel BY
e https://www.zyxel.by

Bulgaria

e Zyxel bbarapus
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e https://www.zyxel.com/bg/bg/

Czech Republic
e Zyxel Communications Czech s.r.o

e https://www.zyxel.com/cz/cs/

Denmark
e Zyxel Communications A/S

 https://www.zyxel.com/dk/da/

Finland
* Zyxel Communications

e https://www.zyxel.com/fi/fi/

France

e Zyxel France

e hitps://www.zyxel.fr

Germany
* Zyxel Deutschland GmbH

 https://www.zyxel.com/de/de/

Hungary
e Zyxel Hungary & SEE

e https://www.zyxel.com/hu/hu/

Italy
e Zyxel Communications Italy

* https://www.zyxel.com/it/it/

Netherlands
* Zyxel Benelux

 https://www.zyxel.com/nl/nl/

Norway
* Zyxel Communications

e https://www.zyxel.com/no/no/

Poland
e Zyxel Communications Poland

* https://www.zyxel.com/pl/pl/
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Romania
e Zyxel Romania

e https://www.zyxel.com/ro/ro

Russia

e Zyxel Russia

e https://www.zyxel.com/ru/ru/

Slovakia
* Zyxel Communications Czech s.r.o. organizacna zlozka

o https://www.zyxel.com/sk/sk/

Spain
* Zyxel Communications ES Ltd.

 https://www.zyxel.com/es/es/

Sweden

¢ Zyxel Communications

e https://www.zyxel.com/se/sv/

Switzerland
e Studerus AG
e https://www.zyxel.ch/de
* https://www.zyxel.ch/fr

Turkey
e Zyxel Turkey A.S.

 https://www.zyxel.com/tr/tr/

UK

* Zyxel Communications UK Ltd.

* https://www.zyxel.com/uk/en/

Ukraine

e Zyxel Ukraine

e http://www.ua.zyxel.com

South America

Argentina

e Zyxel Communications Corporation
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e https://www.zyxel.com/co/es/

Brazil

¢ Zyxel Communications Brasil Ltda.

* https://www.zyxel.com/br/pt/

Colombia
* Zyxel Communications Corporation

 https://www.zyxel.com/co/es/

Ecuador
e Zyxel Communications Corporation

e https://www.zyxel.com/co/es/

South America

e Zyxel Communications Corporation

e https://www.zyxel.com/co/es/

Middle East

Israel
e Zyxel Communications Corporation

e http://il.zyxel.com/

North America

USA

e Zyxel Communications, Inc. — North America Headquarters

* https://www.zyxel.com/us/en/
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APPENDIX B
Common Services

The following table lists some commonly-used services and their associated protocols and port numbers.
For a comprehensive list of port numbers, ICMP type or code numbers and services, visit the IANA
(Intfernet Assigned Number Authority) web site.

¢ Name: This is a short, descriptive name for the service. You can use this one or create a different one,
if you like.

* Protocol: This is the type of IP protocol used by the service. If this is TCP/UDP, then the service uses the
same port number with TCP and UDP. If this is User-Defined, the Port(s) is the IP protocol number, not
the port number.

¢ Port(s): This value depends on the Protocol. Please refer to RFC 1700 for further information about port
numbers.

e |f the Protocol is TCP, UDP, or TCP/UDP, this is the IP port number.
* |If the Protocol is USER, this is the IP protocol number.

» Description: This is a brief explanation of the applications that use this service or the situations in which
this service is used.

Table 193 Commonly Used Services

NAME PROTOCOL PORT(S) DESCRIPTION

AH (IPSEC_TUNNEL) User-Defined 51 The IPSEC AH (Authentication Header) tunneling
protocol uses this service.

AIM/New-ICQ TCP 5190 AOL's Internet Messenger service. It is also used
as a listening port by ICQ.

AUTH TCP 113 Authentication protocol used by some servers.

BGP TCP 179 Border Gateway Protocol.

BOOTP_CLIENT ubp 68 DHCP Client.

BOOTP_SERVER ubP 67 DHCP Server.

CU-SEEME TCP 7648 A popular videoconferencing solution from
White Pines Software.

ubP 24032

DNS TCP/UDP 53 Domain Name Server, a service that matches
web names (for example www.zyxel.com) to IP
numbers.

ESP (IPSEC_TUNNEL) User-Defined 50 The IPSEC ESP (Encapsulation Security Protocol)
tunneling profocol uses this service.

FINGER TCP 79 Finger is a UNIX or Internet related command
that can be used to find out if a user is logged
on.

FTP TCP 20 File Transfer Program, a program to enable fast

transfer of files, including large files that may not

cp 21 be possible by email.
H.323 TCP 1720 NetMeeting uses this protocol.
HTTP TCP 80 Hyper Text Transfer Protocol — a client or server

protocol for the world wide web.
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Table 193 Commonly Used Services (continued)

NAME PROTOCOL PORT(S) DESCRIPTION

HTTPS TCP 443 HTTPS is a secured http session often used in e-
commerce.

ICMP User-Defined 1 Internet Control Message Protocol is offen used
for diagnostic or routing purposes.

ICQ ubprP 4000 This is a popular Internet chat program.

IGMP (MULTICAST) User-Defined 2 Internet Group Multicast Protocol is used when
sending packets to a specific group of hosts.

IKE ubP 500 The Internet Key Exchange algorithm is used for
key distribution and management.

IRC TCP/UDP 6667 This is another popular Internet chat program.

MSN Messenger TCP 1863 Microsoft Networks' messenger service uses this
protocol.

NEW-ICQ TCP 5190 An Internet chat program.

NEWS TCP 144 A protocol for news groups.

NFS UbP 2049 Network File System — NFS is a client or server
distributed file service that provides transparent
file sharing for network environments.

NNTP TCP 119 Network News Transport Protocol is the delivery
mechanism for the USENET newsgroup service.

PING User-Defined 1 Packet INternet Groper is a protocol that sends
out ICMP echo requests to test whether or not a
remote host is reachable.

POP3 TCP 110 Post Office Protocol version 3 lets a client
computer get e-mail from a POP3 server through
a temporary connection (TCP/IP or other).

PPTP TCP 1723 Point-to-Point Tunneling Protocol enables secure
fransfer of data over public networks. This is the
confrol channel.

PPTP_TUNNEL (GRE) User-Defined 47 PPTP (Point-to-Point Tunneling Protocol) enables
secure tfransfer of data over public networks. This
is the data channel.

RCMD TCP 512 Remote Command Service.

REAL_AUDIO TCP 7070 A streaming audio service that enables real time
sound over the web.

REXEC TCP 514 Remote Execution Daemon.

RLOGIN TCP 513 Remote Login.

RTELNET TCP 107 Remote Telnet.

RTSP TCP/UDP 554 The Real Time Streaming (media control)
Protocol (RTSP) is a remote control for multimedia
on the Internet.

SFTP TCP 115 Simple File Transfer Protocol.

SMTP TCP 25 Simple Mail Transfer Protocol is the message-
exchange standard for the Internet. SMTP
enables you to move messages from one email
server to another.

SNMP TCP/UDP 161 Simple Network Management Program.

SNMP-TRAPS TCP/UDP 162 Traps for use with the SNMP (RFC:1215).
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Table 193 Commonly Used Services (continued)

NAME

PROTOCOL

PORT(S)

DESCRIPTION

SQL-NET

TCP

1521

Structured Query Language is an interface o
access data on many different types of
database systems, including mainframes,
midrange systems, UNIX systems and network
servers.

SSH

TCP/UDP

22

Secure Shell Remote Login Program.

STRM WORKS

UbP

1558

Stream Works Protocol.

SYSLOG

ubp

514

Syslog allows you to send system logs to a UNIX
server.

TACACS

ubp

49

Login Host Protocol used for (Terminal Access
Controller Access Control System).

TELNET

TCP

23

Telnet is the login and terminal emulation
protocol common on the Internet and in UNIX
environments. It operates over TCP/IP networks.
Its primary function is to allow users to log into
remotfe host systems.

TFTP

UbP

69

Trivial File Transfer Protocol is an Internet file
fransfer protocol similar to FTP, but uses the UDP
(User Datagram Protocol) rather than TCP
(Transmission Control Protocol).

VDOLIVE

TCP

7000

Another videoconferencing solution.
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IPVv6

Overview

IPvé (Internet Protocol version 6), is designed to enhance IP address size and features. The increase in
IPvé address size to 128 bits (from the 32-bit IPv4 address) allows up to 3.4 x 1038 |P addresses.

IPv6 Addressing

The 128-bit IPv6 address is written as eight 16-bit hexadecimal blocks separated by colons (:). This is an
example IPvé address 2001 : 0db8:1a2b:0015:0000:0000:1a2f:0000.

IPvé addresses can be abbreviated in two ways:

* Leading zeros in a block can be omitted. SO 2001:0db8:1a2b:0015:0000:0000:1a2£:0000 can be
written as 2001:db8:1a2b:15:0:0:1a2f: 0.

* Any number of consecutive blocks of zeros can be replaced by a double colon. A double colon can
only appear once in an IPvé address. SO 2001:0db8:0000:0000:1a2f:0000:0000:0015 can be
written as 2001 :0db8: :1a2£:0000:0000:0015, 2001: 0db8:0000:0000:1a2f::0015,
2001:db8::1a2f:0:0:150r2001:db8:0:0:1a2f::15.

Prefix and Prefix Length

Similar to an IPv4 subnet mask, IPvé uses an address prefix to represent the network address. An IPvé
prefix length specifies how many most significant bits (start from the left) in the address compose the
network address. The prefix length is written as “/x” where x is a number. For example,

2001:db8:1a2b:15::1a2f:0/32

means that the first 32 bits (2001 : db8g) is the subnet prefix.

Link-local Address

A link-local address uniquely identifies a device on the local network (the LAN). It is similar to a “private IP
address” in IPv4. You can have the same link-local address on multiple interfaces on a device. A link-
local unicast address has a predefined prefix of fe80::/10. The link-local unicast address format is as
follows.

Table 194 Link-local Unicast Address Format

1111111010 0 Interface ID
10 bits 54 bits 64 bits

Global Address

A global address uniquely identifies a device on the Internet. It is similar to a "public IP address” in IPv4. A
global unicast address starts with a 2 or 3.
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Unspecified Address

An unspecified address (0:0:0:0:0:0:0:0 or ::) is used as the source address when a device does not have
its own address. It is similar to *0.0.0.0" in IPv4.

Loopback Address

A loopback address (0:0:0:0:0:0:0:1 or ::1) allows a host to send packets to itself. It is similar fo “127.0.0.1"
in IPv4.

Multicast Address

In IPv6, multicast addresses provide the same functionality as IPv4 broadcast addresses. Broadcasting is
not supported in IPv6. A multicast address allows a host fo send packets to all hosts in a multicast group.

Multicast scope allows you to determine the size of the multicast group. A multicast address has a
predefined prefix of ff00::/8. The following table describes some of the predefined multicast addresses.

Table 195 Predefined Multicast Address

MULTICAST ADDRESS DESCRIPTION
FF01:0:0:0:0:0:0:1 All hosts on a local node.
FF01:0:0:0:0:0:0:2 All routers on a local node.
FF02:0:0:0:0:0:0:1 All hosts on a local connected link.
FF02:0:0:0:0:0:0:2 All routers on a local connected link.
FF05:0:0:0:0:0:0:2 All routers on a local site.
FF05:0:0:0:0:0:1:3 All DHCP severs on a local site.

The following table describes the multicast addresses which are reserved and cannot be assigned to a
multicast group.

Table 196 Reserved Multicast Address
MULTICAST ADDRESS

FF00:0:0:0:0:0:0:0

FF01:0:0:0:0:0:0:0

FF02:0:0:0:0:0:0:0

FF03:0:0:0:0:0:0:0

FF04:0:0:0:0:0:0:0

FF05:0:0:0:0:0:0:0

FF06:0:0:0:0:0:0:0

FF07:0:0:0:0:0:0:0

FF08:0:0:0:0:0:0:0

FF09:0:0:0:0:0:0:0

FFOA:0:0:0:0:0:0:0

FFOB:0:0:0:0:0:0:0

FF0C:0:0:0:0:0:0:0

FFOD:0:0:0:0:0:0:0

FFOE:0:0:0:0:0:0:0

FFOF:0:0:0:0:0:0:0
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Subnet Masking

Both an IPvé address and IPvé subnet mask compose of 128-bit binary digits, which are divided info
eight 16-bit blocks and written in hexadecimal notation. Hexadecimal uses 4 bits for each character (1 -
10, A-F). Each block’s 16 bits are then represented by 4 hexadecimal characters. For example,
FFFF:FFFF:FFFF:FFFF:FC00:0000:0000:0000.

Interface ID

EUI-64

DHCPv6

In IPvé, an interface ID is a é64-bit identifier. It identifies a physical interface (for example, an Ethernet
port) or a virtual interface (for example, the management IP address for a VLAN). One interface should
have a unique interface ID.

The EUI-64 (Extended Unique Identfifier) defined by the IEEE (Institute of Electrical and Electronics
Engineers) is an interface ID format designed to adapt with IPvé. It is derived from the 48-bit (6-byte)
Ethernet MAC address as shown next. EUI-64 inserts the hex digits fffe between the third and fourth bytes
of the MAC address and complements the seventh bit of the first byte of the MAC address. See the
following example.

Table 197

‘ MAC ‘oo ‘:‘13 |:|49 S 12 |:‘34 |:‘56 ‘
Table 198

‘ EUI-64 ‘02‘:‘13 ‘:‘49 :‘FF HFE ‘:12 |:|34 HSé ‘

The Dynamic Host Configuration Protocol for IPvé (DHCPvé, RFC 3315) is a server-client protocol that
allows a DHCP server to assign and pass IPvé network addresses, prefixes and other configuration
information to DHCP clients. DHCPvé6 servers and clients exchange DHCP messages using UDP.

Each DHCP client and server has a unique DHCP Unique IDentifier (DUID), which is used for identification
when they are exchanging DHCPvé messages. The DUID is generated from the MAC address, time,
vendor assigned ID and/or the vendor's private enterprise number registered with the IANA. It should not
change over fime even after you rebooft the device.

Identity Association

An Identity Association (IA) is a collection of addresses assigned to a DHCP client, through which the
server and client can manage a set of related IP addresses. Each IA must be associated with exactly
one interface. The DHCP client uses the IA assigned to an interface to obtain configuration from a DHCP
server for that interface. Each IA consists of a unique IAID and associated IP information.

The IA type is the type of address in the IA. Each IA holds one type of address. IA_NA means an identity
association for non-temporary addresses and IA_TA is an identity association for temporary addresses.
An IA_NA option contains the T1 and T2 fields, but an IA_TA option does not. The DHCPvé server uses T1
and T2 to control the time at which the client contacts with the server to extend the lifetimes on any
addresses in the IA_NA before the lifetimes expire. After T1, the client sends the server (S1) (from which
the addresses in the IA_NA were obtained) a Renew message. If the time T2 is reached and the server
does not respond, the client sends a Rebind message to any available server (S2). For an IA_TA, the
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client may send a Renew or Rebind message at the client's discretion.
| T2

|
| |
l |
|
' Rencn Ren W . 4
46 S1 1o
\W\REQ?\VL W “Rel

: to S1 toS toS I \

T1
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DHCP Relay Agent

A DHCP relay agent is on the same network as the DHCP clients and helps forward messages between
the DHCP server and clients. When a client cannot use its link-local address and a well-known mulficast
address to locate a DHCP server on its network, it then needs a DHCP relay agent fo send a message to
a DHCP server that is not attached to the same network.

The DHCP relay agent can add the remote identification (remote-ID) option and the interface-ID option
to the Relay-Forward DHCPvé messages. The remote-ID option carries a user-defined string, such as the
system name. The interface-ID option provides slot number, port information and the VLAN ID to the
DHCPvé server. The remote-ID option (if any) is stripped from the Relay-Reply messages before the relay
agent sends the packets to the clients. The DHCP server copies the interface-ID opfion from the Relay-
Forward message into the Relay-Reply message and sends it to the relay agent. The interface-ID should
not change even after the relay agent restarts.

Prefix Delegation

Prefix delegation enables an IPvé router to use the IPvé prefix (network address) received from the ISP (or
a connected uplink router) for its LAN. The Switch uses the received IPvé prefix (for example, 2001:db2::/
48) to generate its LAN IP address. Through sending Router Advertisements (RAs) regularly by multicast,
the Switch passes the IPvé prefix information to its LAN hosts. The hosts then can use the prefix to
generate their IPvé addresses.

ICMPVv6

Internet Control Message Protocol for IPvé (ICMPv6 or ICMP for IPvé) is defined in RFC 4443. ICMPvé has
a preceding Next Header value of 58, which is different from the value used to identify ICMP for IPv4.
ICMPvé is an integral part of IPvé. IPvé nodes use ICMPvVé to report errors encountered in packet
processing and perform other diagnostic functions, such as "ping".

Neighbor Discovery Protocol (NDP)

The Neighbor Discovery Protocol (NDP) is a protocol used to discover other IPvé devices and track
neighbor’s reachability in a network. An IPvé device uses the following ICMPvé messages types:

¢ Neighbor solicitation: A request from a host to determine a neighbor’s link-layer address (MAC
address) and detect if the neighbor is still reachable. A neighbor being “reachable” means it
responds fo a neighbor solicitation message (from the host) with a neighbor advertisement message.

* Neighbor advertisement: A response from a node to announce its link-layer address.

¢ Router solicitation: A request from a host to locate a router that can act as the default router and
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forward packets.

¢ Router advertisement: A response to a router solicitation or a periodical multicast advertisement from
a router to advertise its presence and other parameters.

IPv6 Cache

An IPvé host is required to have a neighbor cache, destination cache, prefix list and default router list.
The Switch maintains and updates its IPvé caches constantly using the information from response
messages. In IPvé, the Switch configures a link-local address automatically, and then sends a neighbor
solicitation message to check if the address is unique. If there is an address to be resolved or verified, the
Switch also sends out a neighbor solicitation message. When the Switch receives a neighbor
advertisement in response, it stores the neighbor’s link-layer address in the neighbor cache. When the
Switch uses a router solicitation message to query for a router and receives a router advertisement
message, it adds the router’s information to the neighbor cache, prefix list and destination cache. The
Switch creates an entry in the default router list cache if the router can be used as a default router.

When the Switch needs to send a packet, it first consults the destination cache to determine the next
hop. If there is no matching entry in the destination cache, the Switch uses the prefix list to determine
whether the destination address is on-link and can be reached directly without passing through a router.
If the address is onlink, the address is considered as the next hop. Otherwise, the Switch determines the
next-hop from the default router list or routing table. Once the next hop IP address is known, the Switch
looks into the neighbor cache to get the link-layer address and sends the packet when the neighbor is
reachable. If the Switch cannot find an entry in the neighbor cache or the state for the neighbor is not
reachable, it starts the address resolution process. This helps reduce the number of IPvé solicitation and
advertisement messages.

Multicast Listener Discovery
The Multicast Listener Discovery (MLD) protocol (defined in RFC 2710) is derived from IPv4's Internet
Group Management Protocol version 2 (IGMPv2). MLD uses ICMPvé message types, rather than IGMP

message types. MLDv1 is equivalent to IGMPv2 and MLDv2 is equivalent to IGMPV3.

MLD allows an IPvé switch or router to discover the presence of MLD listeners who wish to receive
multicast packets and the IP addresses of multicast groups the hosts want to join on its network.

MLD snooping and MLD proxy are analogous to IGMP snooping and IGMP proxy in IPv4.

MLD filtering controls which mulficast groups a port can join.

MLD Messages

A multicast router or switch periodically sends general queries to MLD hosts to update the multicast
forwarding table. When an MLD host wants to join a multicast group, it sends an MLD Report message
for that address.

An MLD Done message is equivalent fo an IGMP Leave message. When an MLD host wants to leave a
multicast group, it can send a Done message to the router or switch. The router or switch then sends a
group-specific query to the port on which the Done message is received to determine if other devices
connected to this port should remain in the group.
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Example - Enabling IPv6 on Windows XP/2003/Vista

By default, Windows XP and Windows 2003 support IPvé. This example shows you how to use the ipveé
install command on Windows XP or 2003 to enable IPvé. This also displays how to use the ipconfig
command to see auto-generated IP addresses.

C:\>ipv6 install
Installing...
Succeeded.

C:\>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix . :
IP Address. . . . . . . . . . . . : 10.1.1.46

Subnet Mask . . . . . . . . . . . : 255.255.255.0
IP Address. . . . . . . . . . . . : feB80::2d0:59ff:feb8:103c%4
Default Gateway . . . . . . . . . : 10.1.1.254

IPvé is installed and enabled by default in Windows Vista. Use the ipconfig command fo check your
automatic configured IPvé address as well. You should see at least one IPvé address available for the
inferface on your computer.

Example - Enabling DHCPv6 on Windows XP
Windows XP does not support DHCPVé. If your network uses DHCPvé for IP address assignment, you have
to additionally install a DHCPvé client software on your Windows XP. (Note: If you use stafic IP addresses

or Router Advertisement for IPvé address assignment in your network, ignore this section.)

This example uses Dibbler as the DHCPvé client. To enable DHCPvé client on your computer:

1 Install Dibbler and select the DHCPvVé client option on your computer.
2 After the installation is complete, select Start > All Programs > Dibbler-DHCPv6 > Client Install as service.
3 Select Start > Control Panel > Administrative Tools > Services.

4 Double click Dibbler — a DHCPV6 client.
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5

1

2

3

Services

File  Action Wiew Help

| EFRR @B »

|

% Services (Local) Services (Local)
Dibbler - a DHCPv6 client Mame Description Stakus Startup Type Log &n As

%DCOM Server Process Launcher Provides la...  Started Aukomatic Local System
) DHCE Clisnt Manages tarted Abamatic L oral System

Stirt the service %Dibbler - a DHCPve client Dibbler -a ... Automatic Local System)
Distributed Link Tracking Client Maintains li.., Started Automatic Local System
%Distributed Transaction Coordinator  Coordinate... Manual Mebwork 5.
Description: %DNS Client Resolves a...  Started Aukomatic Mebwork 5.
Dibbler - a portable DHCPVE. %Error Reporting Service Allows erro,..  Started Automatic Local System
e & : %Event Log Enables ev... Started Automatic Local System
This is DHCPv6 cient, version %Extensible Authentication Prokocol,..  Provides wi... Manual Local System
0.7.2. %Fast User Switching Compatibility Provides m... Manual Local System
%FLEXnet Licensing Service This servic, .. Manual Local System

\ Extended A Standard /

Click Start and then OK.

-~

;

Dibbler - a DHCPvé client Properties (Local Computer)
General | LogOn | Fecovery | Dependencies
Service name: DHCPvEClient
Display name: Dibbler - a DHCPvE client

Descriptior: Dibbler - & portable DHCPYE. This is DHEPYE client,
wversion 0.7.2.

Path to executable:
C:\Program Files\DHCPvEClient_dibblertdibbler-client exe service -d "C:APr

Startup type: | Automatic w

Service statuz:  Stopped

“Y'ou can specify the start parameters that apply when pou start the service
fram here.

Start parameters: | |

( Ok ])[ Cancel ]

X

Now your computer can obtain an IPvé address from a DHCPvé server.

Example - Enabling IPv6 on Windows 7

Windows 7 supports IPvé by default. DHCPvé is also enabled when you enable IPvé on a Windows 7

computer.

To enable IPvé in Windows 7:

Select Control Panel > Network and Sharing Center > Local Area Connection.

Select the Internet Protocol Version 6 (TCP/IPv6) check box to enable it.

Click OK to save the change.
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Y Local Area Connection Properties @

Metworking

Connect using:

¥ Gigabit Ethemet

This connection uses the following items:
0% Client for Microsoft Networks
EQDS Packet Scheduler
E ile and Printer Sharng for Microsoft Ne

Intemet Protocol Version & (TCP/IPvE)

i [ntemet Protocol Version 4 (TCP/1Pv4)

Description

TCP/IP version &. The latest version of the intemet protocol
that provides communication across diverse interconnected
networks.

([ oK D[ Cancel ]

4 Click Close to exit the Local Area Connection Status screen.
5 Select Start > All Programs > Accessories > Command Prompt.

6 Use the ipconfig command to check your dynamic IPvé address. This example shows a global address
(2001:b021:2d::1000) obtained from a DHCP server.

C:\>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix

IPv6 Address. . . . . . . . . . . : 2001:b021:2d::1000
Link-local IPvé Address . . . . . : fe80::25d8:dcab:c80a:5189%11
IPv4 Address. . . . . . . . . . . :172.16.100.61

Subnet Mask . . . . . . . . . . . : 255.255.255.0

Default Gateway . . . . . . . . . : fe80::213:49ff:feaa:7125%11

172.16.100.254

Example - Enabling IPv6 on Windows 10
Windows 10 supports IPvé by default. DHCPvé is enabled when you enable IPvé on a Windows 10 PC.

To enable IPvé in Windows 10:

1 Select Control Panel > Network and Sharing Center.
2 On the left side of the Network and Sharing Center, select Change adapter settings.

3 Right-click your network connection and select Properties.
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4 Select the Internet Protocol Version 6 (TCP/IPv6) check box to enable it.

5 Click OK to save the changes for the selected network adapter.

W Ethernet 2 Properties *

Networking  Authertication
Connect using:

@ Realtek PCle GBE Family Cortroller #2

. Intemet Protocol Version 4 (TCP/1Pv4) ~
2. Microsoft Network Adapter Multiplexor Protocol

. Microsoft LLDP Protocol Driver

s, Win10Pcap Packet Capture Driver

This connection uses the following items:

RERROX

Intemet Protocol Version 6 (TCP/IPvE) B,

Link-Layer Topology Discovery Responder

. Link-Layer Topology Discovery Mapper 10 Driver W

£ >
Install... Uninstall Properties

Description

TCP/IP version 6. The latest version of the intemet protocol

that provides communication across diverse interconnected
networks.

6 Click OK to exit the selected network adapter Properties screen.

Example - Enabling DHCPv6 on Windows 10
Windows 10 supports DHCPvé by default. To enable DHCPvé client on your computer:
1 Select Start > Settings > Network & Internet.

On the left side of the Network & Internet, select Ethernet. Then select the Ethernet network you are
connected to.

3 Under IP assignment, select Edit.

Under Edit IP settings, select Automatic (DHCP) or Manual. Then click Save.

Edit IP settings

Automatic (DHCP)

Manual

Save Cancel

* When you select Automatic (DHCP), the IP address seftings and DNS server address sefting are set
automatically by your router.

¢ When you select Manual, you can manually set your IP address settings and DNS server address.

Now your computer can obtain an IPvé address from a DHCPvé server.
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APPENDIX D
Legal Information

Copyright © 2021 by Zyxel and/or its affiliates.

The contents of this publication may not be reproduced in any part or as a whole, franscribed, stored in a retrieval system, translated into any
language, or transmitted in any form or by any means, electronic, mechanical, magnetic, optical, chemical, photocopying, manual, or
otherwise, without the prior written permission of Zyxel and/or its aoffiliates.

Published by Zyxel and/or its affiliates. All rights reserved.

Disclaimer

Zyxel does not assume any liability arising out of the application or use of any products, or software described herein. Neither does it convey any
license under its patent rights nor the patent rights of others. Zyxel further reserves the right to make changes in any products described herein
without notice. This publication is subject to change without notice.

Regulatory Notice and Statement

United States of America

Canada

The following information applies if you use the product within USA area.
US Importer: Zyxel Communications, Inc, 1130 North Miller Street Anaheim, CA92806-2001, https://www.zyxel.com/us/en/

Federal Communications Commission (FCC) EMC Statement
¢ This device complies with Part 15 of FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference that may cause undesired operations.

* Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the
equipment.

* This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference at his own expense.

The following information applies if you use the product within Canada area.

Innovation, Science and Economic Development Canada ICES statement
CAN ICES-3 (A)/NMB-3(A)

European Union and United Kingdom

UK
and Cn

The following information applies if you use the product within the European Union and United Kingdom.

CE EMC statement

WARNING: This equipment is compliant with Class A of EN55032. In a residential environment this equipment may cause radio interference.
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List of National Codes

COUNTRY ISO 3166 2 LETTER CODE | COUNTRY 1SO 3166 2 LETTER CODE
Austria AT Liechtenstein LI
Belgium BE Lithuania LT
Bulgaria BG Luxembourg LU
Croatia HR Malta MT
Cyprus CY Netherlands NL
Czech Republic CR Norway NO
Denmark DK Poland PL
Estonia EE Portugal PT
Finland Fl Romania RO
France FR Serbia RS
Germany DE Slovakia SK
Greece GR Slovenia N
Hungary HU Spain ES
Iceland IS Sweden SE
Ireland IE Switzerland CH
Italy IT Turkey R
Latvia Lv United Kingdom GB
Safety Warnings

To avoid possible eye injury, do NOT look into an operating fiber-optic module's connector.

Do NOT use this product near water, for example, in a wet basement or near a swimming pool.

Do NOT expose your device to dampness, dust or corrosive liquids.

Do NOT store things on the device.

Do NOT obstruct the device ventilation slots as insufficient airflow may harm your device. For example, do not place the device in an
enclosed space such as a box or on a very soft surface such as a bed or sofa.

Do NOT install, use, or service this device during a thunderstorm. There is a remote risk of electric shock from lightning.

Connect ONLY suitable accessories to the device.

Do NOT open the device or unit. Opening or removing covers can expose you to dangerous high voltage points or other risks. Only qualified
service personnel should service or disassemble this device. Please contact your vendor for further information.

Make sure to connect the cables to the correct ports.

Place connecting cables carefully so that no one will step on them or stumble over them.

Always disconnect all cables from this device before servicing or disassembling.

Do NOT remove the plug and connect it to a power outlet by itself; always attach the plug to the power adaptor first before connecting it to
a power outlet.

Do NOT allow anything to rest on the power adaptor or cord and do NOT place the product where anyone can walk on the power adaptor
or cord.

Please use the provided or designated connection cables/power cables/adaptors. Connect it to the right supply voltage (for example, 110V
AC in North America or 230V AC in Europe). If the power adaptor or cord is damaged, it might cause electrocution. Remove it from the
device and the power source, repairing the power adapter or cord is prohibited. Contact your local vendor to order a new one.

Do NOT use the device outside, and make sure all the connections are indoors. There is a remote risk of electric shock from lightning.
CAUTION: RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT TYPE, DISPOSE OF USED BATTERIES ACCORDING TO THE INSTRUCTION.
Dispose them at the applicable collection point for the recycling of electrical and electronic device. For detailed information about
recycling of this product, please contact your local city office, your household waste disposal service or the store where you purchased the
product.

Use ONLY power wires of the appropriate wire gauge for your device. Connect it to a power supply of the correct voltage.

Fuse Warning! Replace a fuse only with a fuse of the same type and rating.

The POE (Power over Ethernet) devices that supply or receive power and their connected Ethernet cables must all be completely indoors.
The following warning statements apply, where the disconnect device is not incorporated in the device or where the plug on the power
supply cord is intended to serve as the disconnect device,

— For PERMANENTLY CONNECTED DEVICES, a readily accessible disconnect device shall be incorporated external to the device;
— For PLUGGABLE DEVICES, the socket-outlet shall be installed near the device and shall be easily accessible.

This device must be grounded by qualified service personnel. Never defeat the ground conductor or operate the device in the absence of a
suitably installed ground conductor. Contact the appropriate electrical inspection authority or an electrician if you are uncertain that
suitable grounding is available.

If your device has an earthing screw (frame ground), connect the screw to a ground terminal using an appropriate AWG ground wire. Do this
before you make other connections.

If your device has no earthing screw, but has a 3-prong power plug, make sure to connect the plug to a 3-hole earthed socket.

When connecting or disconnecting power to hot-pluggable power supplies, if offered with your system, observe the following guidelines:

- Install the power supply before connecting the power cable to the power supply.
- Unplug the power cable before removing the power supply.
—If the system has multiple sources of power, disconnect power from the system by unplugging all power cables from the power supply.

CLASS 1 LASER PRODUCT
APPAREIL A LASER DE CLASS 1
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e PRODUCT COMPLIES WITH 21 CFR 1040.10 AND 1040.11.
e PRODUIT CONFORME SELON 21 CFR 1040.10 ET 1040.11.

Important Safety Instructions

4

Warning! Energy Hazard. Remove all metal jewelry, watches, and so on from your hands and wrists
before serving this device.

Caution! The RJ-45 jacks are not used for telephone line connection.

88 Hazardous Moving Parts. Keep body parts away from fan blades.

Hot Surface. Do not touch.

> B>

Avertissement: Risque de choc électrique. Retirer tout bijoux en métal et votre montre de vos mains et
poignets avant de manipuler cet appareil.

Attention: Les cdbles RJ-45 ne doivent pas étre utilisés pour les connections téléphoniques.

88 Mobilité des pieces détachées. S'assurer que les pieces détachées ne sont pas en contact avec
les pales du ventilateur.

5>

Surface brGlante. Ne pas toucher.

>

Environment Statement

Disposal and Recycling Information

The symbol below means that according to local regulations your product and/or its battery shall be disposed of separately from domestic
waste. If this product is end of life, take it to a recycling station designated by local authorities. At the time of disposal, the separate collection of
your product and/or its battery will help save natural resources and ensure that the environment is sustainable development.

Die folgende Symbol bedeutet, dass Inr Produkt und/oder seine Batterie gemdB den &értlichen Bestimmungen getrennt vom HausmUll entsorgt
werden muss. Wenden Sie sich an eine Recyclingstation, wenn dieses Produkt das Ende seiner Lebensdauer erreicht hat. Zum Zeitpunkt der
Entsorgung wird die getrennte Sammlung von Produkt und/oder seiner Batterie dazu beitragen, natUrliche Ressourcen zu sparen und die Umwelt
und die menschliche Gesundheit zu schitzen.

El simbolo de abajo indica que segun las regulaciones locales, su producto y/o su bateria deberdn depositarse como basura separada de la
domeéstica. Cuando este producto alcance el final de su vida Util, llévelo a un punto limpio. Cuando llegue el momento de desechar el
producto, la recogida por separado éste y/o su bateria ayudard a salvar los recursos naturales y a proteger la salud humana y
medioambiental.

Le symbole ci-dessous signifie que selon les réglementations locales votre produit et/ou sa batterie doivent étre éliminés séparément des ordures
ménageres. Lorsque ce produit atteint sa fin de vie, amenez-le & un centre de recyclage. Au moment de la mise au rebut, la collecte séparée
de votre produit et/ou de sa batterie aidera a économiser les ressources naturelles et protéger I'environnement et la santé humaine.

Il simbolo sotto significa che secondo i regolamentilocaliil vostro prodotto e/o batteria deve essere smaltito separatamente dai rifiuti domestici.
Quando questo prodotto raggiunge la fine della vita di servizio portarlo a una stazione diriciclaggio. Almomento dello smaltimento, la raccolta
separata del vostro prodotto e/o della sua batteria aiuta a risparmiare risorse naturali e a proteggere 'ambiente e la salute umana.

Symbolen innebdr att enligt lokal lagstiftning ska produkten och/eller dess batteri kastas separat frdn hushdlisavfallet. N&r den hér produkten ndr
slutet av sin livsidngd ska du ta den till en Gtervinningsstation. Vid tiden for kasseringen bidrar du fill en bé&ttre milié och mansklig halsa genom att
gora dig av med den pd ett dtervinningsstdlle.
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UM EERREREEESEE
- EEPENENER EERENREPEER  UESEMSETE EEEENT  CAZEIWRERRNELEENHE -

ZE2EE - BTANEZE  BAFEUTESRETR:
. BEIRBEMBLIK XEANEESRIIRIE -
- MRRBEE
- HIRES - V7R B ERABK - K - BRE - S5KEM PEE’MQ S E KD -
- RERTY - tI7RERE - 54~ D1 - RYSEMASENME -
BRARR  AB2RE  FRIBEBIRE - AEISENER -
o UI7EEIERRE  UERALERNEREERS -
. EBELAEBRNERZERRTERIENER -
- BIBERERERANEM -
. WMREMAERZEMEN  FARENER  FRESHRBEEEEMBZEM -
. FREEEBHEECREENERAEFREELE -
- BEARRERERE -
. F7EBREREEL EZERHERAERITERRBIES -
. JEEEEEE’J%IW# 1REE (30 b=/ & EE 110V AC - BUMZ 230V AC) -
REERNEREBRNEMRIBIR  FUEENRE  EAREERERR  ZABETTNER -
- BZUEEEEREERATREERNER  FARE  FEEMSCHEENER  BE-—ERNEREES -
. BARLRBLEEREIN  LWRHEEBEGHEREA -
. BORE—BRAREE -
- FEZREmMBMEINRERTEINE -
- BEEERIBNRFELNFXRE -
- RELEARM - BMERARFRKIRE A E?%E%%?ﬁﬁﬂéii WRAEEEN S AEETEERUMBARNE R REMERE -
o MRCRERHNZRPHRHUENER - BRUERERFEBEUTEERA:
- RERERRERRE  BEESR -
- GHIRERBRIRERERBNEIRR -
-MREZHREZEER - FRFAEERZEFNERRBHEFAREER
- EmSAHERENEZRAERANERAREEREN &  UTEEBER:!
- HXAERZRE  ERFEINBETRIBREERE
- HEEA T RE - BEARRIZRZMEMEZSNER -

]]III""

About the Symbols

Various symbols are used in this product to ensure correct usage, to prevent danger to the user and others, and to prevent property damage.
The meaning of these symbols are described below. It is important that you read these descriptions thoroughly and fully understand the
contents.
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Explanation of the Symbols

SYMBOL EXPLANATION

Alternating current (AC):
/-\/ AC is an electric current in which the flow of electric charge periodically reverses direction.

Direct current (DC):

DC if the unidirectional flow or movement of electric charge carriers.

Earth; ground:

A wiring terminal intended for connection of a Protective Earthing Conductor.

Class Il equipment:
I:l The method of protection against electric shock in the case of class Il equipment is either double insulation
or reinforced insulation.

Viewing Certifications

Go to http://www.zyxel.com to view this product's documentation and certifications.

Zyxel Limited Warranty

Zyxel warrants fo the original end user (purchaser) that this product is free from any defects in material or workmanship for a specific period (the
Warranty Period) from the date of purchase. The Warranty Period varies by region. Check with your vendor and/or the authorized Zyxel local
distributor for details about the Warranty Period of this product. During the warranty period, and upon proof of purchase, should the product
have indications of failure due to faulty workmanship and/or materials, Zyxel will, at its discretion, repair or replace the defective products or
components without charge for either parts or labor, and to whatever extent it shall deem necessary to restore the product or components to
proper operating condition. Any replacement will consist of a new or re-manufactured functionally equivalent product of equal or higher value,
and will be solely at the discretion of Zyxel. This warranty shall not apply if the product has been modified, misused, tampered with, damaged by
an act of God, or subjected to abnormal working conditions.

Note

Repair or replacement, as provided under this warranty, is the exclusive remedy of the purchaser. This warranty is in lieu of all other warranties,
express or implied, including any implied warranty of merchantability or fitness for a particular use or purpose. Zyxel shall in no event be held
liable for indirect or consequential damages of any kind fo the purchaser.

To obtain the services of this warranty, contact your vendor. You may also refer to the warranty policy for the region in which you bought the
device at http://www.zyxel.com/web/support_warranty_info.php.

Registration

Register your product online at www.zyxel.com to receive email notices of firmware upgrades and related information.

Trademarks

The trademarks mentioned in this publication are used for identification purposes only and may be properties of their respective owners.
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